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1 Supported Models 

The SCPI commands listed in this document are applicable to the SIGLENT SNA5000A Series, 

SNA6000A Series, SHN900A Series, and SNA5000X-E Series vector network analyzers. The port 

number and frequency range information of each series model is shown in the following table: 

Model Ports Frequency range 

SNA5002A 2 9kHz-4.5GHz 

SNA5004A 4 9kHz-4.5GHz 

SNA5012A 2 9kHz-8.5GHz 

SNA5014A 4 9kHz-8.5GHz 

SNA5022A 2 100kHz-13.5GHz 

SNA5032A 2 100kHz-26.5GHz 

SNA6022A 2 100kHz-13.5GHz 

SNA6122A 2（Including front panel jumper interface） 100kHz-13.5GHz 

SNA6024A 4 100kHz-13.5GHz 

SNA6124A 4（Including front panel jumper interface） 100kHz-13.5GHz 

SNA6032A 2 100kHz-26.5GHz 

SNA6132A 2（Including front panel jumper interface） 100kHz-26.5GHz 

SNA6034A 4 100kHz-26.5GHz 

SNA6134A 4（Including front panel jumper interface） 100kHz-26.5GHz 

SHN914A 2 30kHz-14GHz 

SHN920N 2 30kHz-20GHz 

SHN926A 2 30kHz-26.5GHz 

SNA5003X-E 2 9kHz-3GHz 

SNA5006X-E 2 9kHz-6.5GHz 
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2 Programming Overview 

The Vector Network Analyzer support LAN, USB Device, and GPIB-USB Host interfaces. By using 

these interfaces, in combination with programming languages and/or NI- VISA software, users can 

remotely control the analyzer based on SCPI (Standard Commands for Programmable Instruments) 

command set, and interoperate with other programmable instruments. 

This chapter introduces how to build communication between the spectrum analyzer and a 

controller computer with these interfaces. 

 

2.1 Establishing Communications 

The Vector Network Analyzer provides both the USB and LAN connection which allows you to set 

up a remote operation environment with a controller computer. A controller computer could be a 

personal computer (PC) or a minicomputer. Some intelligent instruments also function as 

controllers. 

2.1.1 Install NI-VISA  

USB control requires the National Instruments NI-VISA Library for communications. We also 

recommend using it for LAN communications for its ease of use, but sockets, telnet, and VXI-11 

can also be implemented via LAN connections.  

 

Currently, NI-VISA is packaged in two versions: A full version and a Run-Time Engine version. The 

full version includes the NI device drivers and a tool named NI MAX which is a user interface to 

control and test remotely connected devices. The Run-Time Engine is recommended, as it is a 
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much smaller download than the full version and includes the necessary tools for basic 

communication to instruments. 

 

For example, you can get the NI-VISA 5.4 full version from http://www.ni.com/download/ni-visa-

5.4/4230/en/. 

 

You also can download NI-VISA Run-Time Engine 5.4 to your PC and install it as the default 

selection. Its installation process is similar to the full version. 

 

After you downloaded the file, follow these steps to install NI-VISA (The full version of NI-VISA 5.4 

is used in this example. Newer versions are likely and should be compatible with SIGLENT 

instrumentation. Download the latest version available for the operating system being used by the 

controlling computer): 

 

a. Double click the visa540_full.exe, the dialog will be similar to that shown below: 

 

b. Click Unzip, the installation process will automatically launch after unzipping files. If your 

http://www.ni.com/download/ni-visa-5.4/4230/en/
http://www.ni.com/download/ni-visa-5.4/4230/en/
http://ftp.ni.com/support/softlib/visa/NI-VISA/5.4/windows/visa540_runtime.exe
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computer needs to install .NET Framework 4, it may auto start. 

 

c. The NI-VISA installing dialog is shown above. Click Next to start the installation process. 

 

d. Set the install path. The default path is “C:\Program Files\National Instruments\”, you can 

change it. Click Next, dialog shown as above. 
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e. Click Next twice, in the License Agreement dialog, select the “I accept the above 2 License 

Agreement(s).”, and click Next, dialog shown as below: 

 

f. Click Next to begin the installation. 
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g. Now the installation is complete. Reboot your PC.  
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2.1.2 Connecting the Instrument 

2.1.2.1 Connecting the Analyzer via the USB Device port 

Refer to the following steps to finish the connection via USB-Device: 

1. Install NI-VISA on your PC for USB-TMC driver. 

2. Connect the analyzer USB Device port to a PC with a USB A-B cable. 

 

3. Switch on the analyzer. 

The analyzer will be detected automatically as a new USB hardware. 

 

2.1.2.2 Connecting the Analyzer via the LAN port 

Refer to the following steps to finish the connection via LAN: 

1. Install NI-VISA on your PC for VXI driver. Or without NI-VISA, using socket or telnet in your 

PC’s Operating System. 

2. Connect the analyzer to PC or the local area network with a LAN cable 

 

3. Switch on the analyzer. 
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4. Press button on the front panel  System  → LAN Status to enter the LAN Config 

5. Select the IP Config between Static and DHCP 

◆ DHCP: the DHCP server in the current network will assign the network parameters 

automatically (IP address, subnet mask, gate way) for the analyzer. 

◆ Static: you can set the IP address, subnet mask, gate way manually. Press Apply. 

 

The analyzer will be detected automatically or manually as a new LAN point. 
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2.1.2.3 Connecting the Analyzer via the USB-Host port (With USB-GPIB Adaptor) 

Refer to the following steps to finish the connection via USB. 

1. Install NI-VISA on your PC for GPIB driver. 

2. Connect the analyzer USB Host port to a PC’s GPIB card port, with SIGLENT USB- GPIB 

adaptor. 

 

3. Switch on the analyzer 

4. Press button on the front panel  System  →GPIB to enter the GPIB number. 

The analyzer will be detected automatically as a new GPIB point. 

 

2.2 Remote Control 

2.2.1 Send SCPI Commands via NI-MAX 

2.2.1.1 Using USB 

Run NI MAX software. 

1. Click "Device and interface" at the upper left corner of the software. 

2. Find the "USBTMC" device symbol. 
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3. Click "Open VISA Test Panel" option button, then the following interface will appear. 

4. Click the "Input/Output" option button and click the "Query" option button in order to view 

the operation information. 

 

NOTE: The "*IDN?" command (known as the Identification Query) returns the instrument 

manufacturer, instrument model, serial number, and other identification information. 

 

2.2.1.2 Using LAN 

Select, "Add Network Device", and select "VISA TCP/IP Resource" as shown: Run NI MAX software. 
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1. Click "Device and interface" at the upper left corner of the software. 

2. Find the "Network Devices" symbol; click "Add Network Devices". 

 

3. Select "Manual Entry of LAN instrument", select "Next", and enter the IP address as shown. 

Click Finish to establish the connection: 

 

NOTE: Leave the LAN Device Name BLANK or the connection will fail. 
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4. After a brief scan, the connection should be shown under "Network Devices": 

 

5. Right-click on the product and select "Open NI-VISA Test Panel": 

 

6. Click "Input/Output" option button and click "Query" option button. If everything is OK, you will 

see the Read operation information returned as shown below. 
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2.2.2 Using SCPI with Telnet 

Telnet provides a means of communicating with the Vector Network Analyzer over a LAN 

connection. The Telnet protocol sends SCPI commands to the Analyzer from a PC and is similar to 

communicating with the Vector Network Analyzer over USB. It sends and receives information 

interactively: one command at a time. Windows operating systems use a command prompt style 

interface for the Telnet client. The steps are as follows: 

1. On your PC, click Start > All Programs > Accessories > Command Prompt. 

2. At the command prompt, type in telnet. 

3. Press the Enter key. The Telnet display screen will be displayed. 

 

4. At the Telnet command line, type: open XXX.XXX.XXX.XXX 5024 

Where XXX.XXX.XXX.XXX is the instrument’s IP address and 5024 is the port. You should see 

a response similar to the following: 
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5. At the SCPI> prompt, input the SCPI commands such as *IDN? to return the company name, 

model number, serial number, and firmware version number. 

 

6. To exit the SCPI> session, press the Ctrl+] keys simultaneously. 

7. Type quit at the prompt or close the Telnet window to close the connection to the instrument 

and exit Telnet. 
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2.2.3 Using SCPI with Sockets 

Socket API can be used to control the Vector Network Analyzer via LAN without installing any other 

libraries. This can reduce the complexity of programming. 

 

SOCKET ADDRESS IP address+port number 

IP ADDRESS SDS IP address 

PORT NUMBER 5025 

 

 

2.2.4 Using SCPI with Webserver 

The analyzer can be controlled remotely from a Web browser on a PC or mobile terminal, and no 

drivers need to be installed. It mimics the touch-screen/mouse-clickable display function, just like 

a physical instrument. The browser also supports Screen Shot and FirmWare Update functions. 

https://en.wikipedia.org/wiki/IP_address
https://en.wikipedia.org/wiki/Port_number
https://en.wikipedia.org/wiki/IP_address
https://en.wikipedia.org/wiki/Port_number
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* web browsers that support HTML5, such as Chrome or Firefox, are recommended. 
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2.3 Introduction to the SCPI Language 

2.3.1 Command Format 

SCPI commands present a hierarchical tree structure containing multiple subsystems, and each of 

the subsystems is made up of a root keyword and several subkeywords. The command string 

usually starts with ":", the keywords are separated by ":" and the followed parameter settings are 

separated by space. Query commands add "?" at the end of the string. 

For example: 

:SENSe:FREQuency:CENTer <freq> 

:SENSe:FREQuency:CENTer? 

SENSe is the root key of the command, FREQuency and CENTer are second and third keywords. 

The command begins with ":", and separates the keywords at the same time, and the <freq> 

separated by space and represents the parameter available for setting; "?" represents a query. 

 

2.3.2 Symbol Instruction 

The following four symbols are not the content of SCPI commands and cannot be sent with the 

commands, but are usually used in the commands. 

1. Braces {} 

The parameters in the braces are optional which can be ignored or set for one or more times. For 

example: 

":SENSe<cnum>:SEGMent:LIST:CONTrol:DATA <Boolean>{,<Boolean>}" in the command, the 
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{,<Boolean>} parameters can be ignored or set for one or more times. 

2. Vertical Bar | 

The vertical bar is used to separate multiple parameters and when sending the command, you can 

choose one of the parameters. For example, In the ":DISPlay:MAXimize ON|OFF|1|0" command, the 

parameters available are "OFF", "ON", "0" or "1". 

3. Square Brackets [ ] 

The content in the square brackets can be ignored. When the parameter is ignored, the instrument 

will set the parameter to its default. For example, 

In the ":SENSe:CORRection:IMPedance[:INPut][:MAGNitude]?" command, sending any of the four 

commands below can generate the same effect: 

:SENSe:CORRection:IMPedance? 

:SENSe:CORRection:IMPedance:INPut? 

:SENSe:CORRection:IMPedance:MAGNitude? 

:SENSe:CORRection:IMPedance:INPut:MAGNitude? 

4. Triangle Brackets < > 

The parameter in the triangle brackets must be replaced by an effective value. For example, 

Send the ":SENSe1:SWEep:POINts <value>" command in ":SENSe1:SWEep:POINts 201". 

 

2.3.3 Parameter Type 
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The parameters in the commands introduced in this manual include 5 types: Boolean, enumeration, 

integer, float and string. 

1. Boolean 

The parameters in the commands could be "OFF", "ON", "0" or "1". For example, 

:SENSe1:AVERage:STATe <bool> 

:SENSe1:AVERage:STATe? 

<bool> can be set to ON|OFF|0|1 

The query returns 1 or 0 

 

2. Enumeration 

The parameter could be any of the values listed. For example: 

:SENSe1:SWEep:TYPE <type> 

:SENSe1:SWEep:TYPE? 

<type> can be set to LINear | LOGarithmic | POWer | CW|SEGMent 

The query returns an abbreviated form as: LIN|LOG|POW|CW|SEGM 

 

3. Integer 

Except other notes, the parameter can be any integer within the effective value range. For example: 

:SYSTem:COMMunicate:GPIB:ADDRess <value> 
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:SYSTem:COMMunicate:GPIB:ADDRess? 

<value>  can be an integer between 0 and 30. 

The query returns an integer between 0 and 30. 

4. Float 

The parameter could be any value within the effective value range according to the accuracy 

requirement (the default accuracy contains up to 9 digits after the decimal points). For example: 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold <value> 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold? 

<value> can set to a real number between -5E2 (i.e. -500dB) and 5E2 (i.e. 500dB). 

The query returns the set float number. 

 

5. String 

The parameter should be the combinations of ASCII characters. For example: 

:SYSTem:COMMunicate:LAN:IPADdress <"xxx.xxx.xxx.xxx"> 

The parameter can be set as "192.168.1.12" string. 

 

2.3.4 Return Value 

The analyzer sends different response data types depending on the parameter being queried. 

There are four types of data: numeric data, character data, string data, and block data. 
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1. Numeric Data 

All numeric data sent over the GPIB is ASCII character data. Your programming environment may 

convert the character data to numeric data for you. Boolean data (1 | 0 ) is a type of numeric data. 

 

2. Character Data 

Character data consists of ASCII characters grouped together in mnemonics that represent 

specific analyzer settings. 

 

3. String Data 

String data consists of ASCII characters. String parameters can contain virtually any set of ASCII 

characters. When sending string data to the analyzer, the string must begin with a single quote ( ' ) 

or a double quote ( " ) and end with the same character (called the delimiter). 

The analyzer always encloses data in double quotes when it returns string data. 

 

4. Block Data 

Block data is used to transfer measurement data. Although the analyzer will accept either definite 

length blocks or indefinite length blocks, it always returns definite length block data in response to 

queries unless the specified format is ASCII.  
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Example of Definite Block Data: #212ABCDEF123456 

Where: 

⚫ # - always sent before definite block data 

⚫ 2 - specifies that the byte count is two digits (2) 

⚫ 12 - specifies the number of data bytes that will follow 

⚫ ABCDEF123456 - 12 digits of data 

 

 

2.3.5 Command Abbreviation 

All of the commands are not case sensitive, so you can use any of them. But if abbreviation is used, 

all the capital letters in the command must be written completely. For example: 

:CALCulate1:TRACe1:BLIMit:MINimum?  

Can be abbreviated to: 

:CALC1:TRAC1:BLIM:MIN? 

 

2.4 Format Conventions in this Manual 

1. Key 

The key on the front panel is denoted by the format of “Key Name (Bold) + Text Box” in the 
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manual. For example, Avg BW denotes the “Avg BW” key. 

2. Menu 

The menu items are denoted by the format of “Menu word + Character Shading”. For example,  

Smooth Percent denotes the “Smooth Percent” menu item under “Smoothing”. 

3. Operation Procedures 

> denotes the next step of operation. For example, Smoothing > Smooth Percent denotes that 

first press Smoothing, and then press the Smooth Percent key. 
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3 System Commands 

This chapter describes the format, functions, parameters, and usage of the commands in the 

Network Vector Analysis command set. 

 

The main content of this chapter: 

1. IEEE Common Commands 

2. AVG BW Commands 

3. Cal Commands  

4. Display Commands 

5. Format Commands 

6. Frequency Commands 

7. Math Commands 

8. Marker Commands 

9. Meas Commands 

10. Power Commands 

11. SaveRecall Commands 

12. Scale Commands 

13. Search Commands 

14. Service Commands 

15. Sweep Commands 

16. System Commands 

17. Trigger Commands 

18. Pulse Measurement Commands (Option, SHN900A series models do not support) 
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19. Spectrum Analyzer Commands(Option) 

20. MIXER Commands(Option, SHN900A series models do not support) 

21. TDR Commands(Option) 

 

 

 

 

 

 

3.1 IEEE Common Commands 

3.1.1 Command List 

Identification Query (*IDN) *IDN? 

Reset (*RST) *RST 
Clear Status (*CLS) *CLS 

Standard Event Status Enable (*ESE) *ESE 
Standard Event Status Register 
Query (*ESR) 

*ESR 

Operation Complete Query (*OPC) *OPC 
Service Request Enable (*SRE) *SRE 

Status Byte Query (*STB) *STB 
Wait-to-Continue (*WAI) *WAI 
Trigger a sweep (*TRG) *TRG 

 

3.1.2 Identification Query (*IDN) 

Command Format *IDN? 

Instruction Returns an instrument identification information string. The string will 
contain the manufacturer, model number, serial number, and software 
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number. 

Menu None 

Example *IDN? 

Return: Siglent Technologies,SNA5084X,1234567890,V1.0.0.1.5 

 

3.1.3 Reset (*RST) 

Command Format *RST 

Instruction This command presets the instrument to a factory defined condition that 
is appropriate for remote programming operation. *RST is equivalent to 
performing the two commands :SYSTem:PRESet and *CLS. This command 
always performs a factory preset. 

Menu None 

Example *RST 

 

3.1.4 Clear Status (*CLS) 

Command Format *CLS 

Instruction Clears the status byte register. It does this by emptying the error queue 
and clearing all bits in all of the event registers. The status byte register 
summarizes the states of the other registers. It is also responsible for 
generating service requests. 

Menu None 

Example *CLS 

 

3.1.5 Standard Event Status Enable (*ESE) 

Command Format *ESE <numeric> 

*ESE? 



VNA Series Programming Guide 

34                                                                                                                                                                                    int.siglent.com 

Instruction Set the bits in the Standard Event Status Enable Register. This register 
monitors I/O errors and synchronization conditions such as operation 
complete, request control, query error, device dependent error, 
execution error, command error and power on. A summary bit is 
generated on execution of the command. 

The query returns the state of the Standard Event Status Enable 
Register. 

Menu None 

Example *ESE 16 

*ESE? 

Return: 16 

 

3.1.6 Standard Event Status Register Query (*ESR) 

Command Format *ESR? 

Instruction This command reads the value of the Standard Event Status Register. 
Execution of this command clears the register value. 

Menu None 

Example *ESR? 

 

3.1.7 Operation Complete Query (*OPC) 

Command Format *OPC 

*OPC? 

Instruction Set bit 0 in the Standard Event Status Register to "1" when all pending 
operations have finished. 

The query stops any new commands from being processed until the 
current processing is complete. Then it returns a "1", and the program 
continues. This query can be used to synchronize events of other 
instruments on the external bus. 

Returns a "1" if the last processing is complete. Use this query when 
there’s a need to monitor the command execution status, such as a 
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sweep execution. 

Menu None 

Example TRIG:SOUR BUS 

INIT:CONT ON 

TRIG:SING 

*OPC? 

 

3.1.8 Service Request Enable (*SRE) 

Command Format *SRE <integer> 

*SRE? 

Instruction This command enables the desired bits of the Service Request Enable 
Register. The query returns the value of the register, indicating which 
bits are currently enabled. The default value is 0. 

Menu None 

Example *SRE 1 

*SRE? 

3.1.9 Status Byte Query (*STB) 

Command Format *STB? 

Instruction This command reads the value of Status Byte Register. 

Menu None 

Example *STB? 

 

3.1.10 Wait-to-Continue (*WAI) 

Command Format *WAI 

Instruction This command causes the instrument to wait until all pending 
commands are completed before executing any additional commands. 
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There is no query form to the command. 

Menu None 

Example *WAI 

 

3.1.11 Trigger a sweep (*TRG) 

Command Format *TRG 

Instruction This command triggers the SNA if the trigger source is set to BUS. 

Menu None 

Example *TRG 

3.2 AVG BW Commands 

3.2.1 Command List 

State of Average :SENSe<cnum>:AVERage[:STATe] 

Average Count :SENSe<cnum>:AVERage:COUNt  

current average number :SENSe<cnum>:AVERage:CURRent? 

Completion status of the average :SENSe<cnum>:AVERage:COMPlete? 

Average Restart :SENSe<cnum>:AVERage:CLEar 

IF Bandwidth :SENSe<cnum>:BANDwidth[:RESolution] 

Smooth State :CALCulate<cnum>:TRACe<tnum>:SMOothing[:STATe] 

Smooth Aperture :CALCulate<cnum>:TRACe<tnum>:SMOothing:APERture 

Smooth Points :CALCulate<cnum>:MEASure<tnum>:SMOothing:POINts 

 

3.2.2 State of Average 

Command Format :SENSe<cnum>:AVERage[:STATe] <bool> 

:SENSe<cnum>:AVERage[:STATe]? 

Instruction This command sets/gets the averaging function of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<bool>:= ON|OFF|1|0 
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Return Boolean 

Default OFF 

Menu Avg BW > Averaging > Averaging Enable 

Example :SENSe1:AVERage 1 

:SENSe1:AVERage? 

Return: 1 

 

3.2.3 Average Count 

Command Format :SENSe<cnum>:AVERage:COUNt <numeric> 

:SENSe<cnum>:AVERage:COUNt? 

Instruction This command sets/gets the averaging factor of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the average count, and the parameter range: 
2~999. 

Return Integer 

Default 16 

Menu Avg BW > Averaging > Averaging 

Example :SENSe1:AVERage:COUNt 10 

:SENSe1:AVERage:COUNt? 

Return: 10 

 

3.2.4 current average number 

Command Format :SENSe<cnum>:AVERage:CURRent? 

Instruction This command gets the current average number of times of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 
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Return Integer 

Default None 

Menu None 

Example :SENSe1:AVERage:CURRent? 

Return: 10 

 

3.2.5 Completion status of the average 

Command Format :SENSe<cnum>:AVERage:COMPlete? 

Instruction This command gets the completion status of the average count of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Boolean 

Default None 

Menu None 

Example :SENSe1:AVERage:COMPlete? 

Return: 1 

 

3.2.6 Average Restart 

Command Format :SENSe<cnum>:AVERage:CLEar 

Instruction This command resets the data count to 0, used for averaging of 
selected channel. Measurement data before the execution of this 
object is not used for averaging. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default None 
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Menu Avg BW > Averaging > Averaging Restart 

Example :SENSe1:AVERage:CLEar 

 

3.2.7 IF Bandwidth 

Command Format :SENSe<cnum>:BANDwidth[:RESolution] <numeric> 

:SENSe<cnum>:BANDwidth[:RESolution]? 

:SENSe<cnum>:BWIDth[:RESolution] <numeric> 

:SENSe<cnum>:BWIDth[:RESolution]? 

Instruction This command sets/gets the IF bandwidth of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:={1|2|3|4|5|6|7|10|15|20|30|40|50|70|100|150|200|300|400|
500|700|1E3|1.5E3|2E3|3E3|4E3|5E3|7E3|10E3|15E3|20E3|30E3|40E3|
50E3|70E3|100E3|150E3|200E3|300E3|400E3|500E3|700E3|1E6|1.5E
6|2E6|3E6|4E6|5E6|7E6|10E6}, unit: Hz. 

Return Enumeration, unit: Hz 

Default 10 kHz 

Menu Avg BW > Averaging > IF Bandwidth 

Example :SENSe1:BANDwidth 7e3 

:SENSe1:BANDwidth? 

Return: 7000 

 

3.2.8 Smooth State 

Command Format :CALCulate<cnum>[:SELected]:SMOothing[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:SMOothing[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:SMOothing[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:SMOothing[:STATe]? 

Instruction This command turns ON/OFF the smoothing for the active trace of 
selected channel (Ch). 

javascript:BSSCPopup('../link/Val_Ch.htm');
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This command turns ON/OFF the smoothing for the selected trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Avg BW > Smoothing > Smoothing 

Example :CALCulate1:SMOothing ON 

:CALCulate1:SMOothing? 

Return: 1 

 

:CALCulate1:TRACe1:SMOothing OFF 

:CALCulate1:TRACe1:SMOothing? 

Return: 0 

 

3.2.9 Smooth Aperture 

Command Format :CALCulate<cnum>[:SELected]:SMOothing:APERture <numeric> 

:CALCulate<cnum>[:SELected]:SMOothing:APERture? 

:CALCulate<cnum>:TRACe<tnum>:SMOothing:APERture <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SMOothing:APERture? 

Instruction This command sets/gets the smoothing aperture for the active trace of 
selected channel (Ch). 

This command sets/gets the smoothing aperture for the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

javascript:BSSCPopup('../link/Val_Ch.htm');
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<numeric>:represents the smoothing aperture, and the parameter 
range: 1~25. 

Return Float, unit % 

Default 2.49 

Menu Avg BW > Smoothing > Smoothing Percent 

Example :CALCulate1:SMOothing:APERture 14.43 

:CALCulate1:SMOothing:APERture? 

Return: 14.4278606965174 

 

:CALCulate1:TRACe1:SMOothing:APERture 20 

:CALCulate1:TRACe1:SMOothing:APERture? 

Return: 19.4029850746269 

 

3.2.10 Smooth Points 

Command Format :CALCulate<cnum>:MEASure<tnum>:SMOothing:POINts <numeric> 

:CALCulate<cnum>:MEASure<tnum>:SMOothing:POINts? 

Instruction This command sets/gets the smoothing points for the active trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the smoothing points, and the parameter 
range: 1~4999. 

Return Interger 

Default 5 

Menu Avg BW > Smoothing > Smoothing Points 

Example :CALCulate1:MEASure1:SMOothing:POINts 15 

:CALCulate1:MEASure1:SMOothing:POINts? 

Return: 15 

javascript:BSSCPopup('../link/Val_Ch.htm');
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3.3 Cal Commands 

3.3.1 Cal 

3.3.1.1 Basic Cal 

3.3.1.1.1 Command List 

Cancel the Calibration Measurement :SENSe<cnum>:CORRection:COLLect:CLEar 

Save Calibration Data :SENSe<cnum>:CORRection:COLLect:SAVE 

Set Calibration Type to 
Response(Open) 

:SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:OPEN 

Set Calibration Type to 
Response(Short) 

:SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:SHORt 

Set Calibration Type to Response(Thru) :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:THRU 

Calibration Type to Enhanced 
Response 

:SENSe<cnum>:CORRection:COLLect:METHod:ERESponse 

Set Calibration Type to OSL :SENSe<cnum>:CORRection:COLLect:METHod:SOLT1 

Set Calibration Type to 2-Port SOLT :SENSe<cnum>:CORRection:COLLect:METHod:SOLT2 

Set Calibration Type to 3-Port SOLT :SENSe<cnum>:CORRection:COLLect:METHod:SOLT3 

Set Calibration Type to 4-Port SOLT :SENSe<cnum>:CORRection:COLLect:METHod:SOLT4 

Set Calibration Type to 2-port TRL :SENSe<cnum>:CORRection:COLLect:METHod:TRL2 

Set Calibration Type to 3-port TRL :SENSe<cnum>:CORRection:COLLect:METHod:TRL3 

Set Calibration Type to 4-port TRL :SENSe<cnum>:CORRection:COLLect:METHod:TRL4 

Measure Open Calibration Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:OPEN 

Measure Short Calibration Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:SHORt 

Measure Load Calibration Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:LOAD 

Measure Thru Calibration Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:THRU 

Measure Isolation Calibration Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:ISOLation 

Measure TRL Calibration Thru Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLThru 

Measure TRL Calibration Reflect Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLReflect 

Measure TRL Calibration Line Data :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLLine 

Clear Error Coefficient :SENSe<cnum>:CORRection:CLEar 

Error Coefficient Data :SENSe<cnum>:CORRection:COEFficient[:DATA] 
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Import Response(Open) Data :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:OPEN 

Import Response(Short) Data :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:SHORt 

Import Response(Thru) Data :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:THRU 

Import Enhanced Response Data :SENSe<cnum>:CORRection:COEFficient:METHod:ERESponse 

Import 1 Port SOLT Data :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT1 

Import 2 Port SOLT Data :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT2 

Import 3 Port SOLT Data :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT3 

Import 4 Port SOLT Data :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT4 

Save Error Coefficient Data :SENSe<cnum>:CORRection:COEFficient:SAVE 

Save Partially Rewritten Calibration 
Data 

:SENSe<cnum>:CORRection:COLLect:PARTial:SAVE 

 

3.3.1.1.2 Cancel the Calibration Measurement 

Command Format :SENSe<cnum>:CORRection:COLLect:CLEar 

Instruction This command clears the calibration measurement data when the 
frequency offset feature is off, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu Cal > Basic Cal > Cancel 

Cal > Basic Cal > Next > Cancel 

Example :SENSe1:CORRection:COLLect:CLEar 

 

3.3.1.1.3 Save Calibration Data 

Command Format :SENSe<cnum>:CORRection:COLLect:SAVE 

Instruction This command calculates the calibration coefficients depending on the 
calibration type selection, from the measured calibration data and save 
it.  
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu Cal > Basic Cal > Finish 

Example :SENSe1:CORRection:COLLect:SAVE 

 

3.3.1.1.4 Set Calibration Type to Response(Open) 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:OPEN 
<pnum> 

Instruction This command sets the calibration type to the response calibration 
(open) of the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Basic Cal > Response(Open) 

Example :SENSe1:CORRection:COLLect:METHod:OPEN 2 

 

3.3.1.1.5 Set Calibration Type to Response(Short) 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:SHORt 
<pnum> 

Instruction This command sets the calibration type to the response calibration 
(short) of the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 
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Return None 

Default None 

Menu Cal > Basic Cal > Response(Short) 

Example :SENSe1:CORRection:COLLect:METHod:SHORt 3 

 

3.3.1.1.6 Set Calibration Type to Response(Thru) 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod[:RESPonse]:THRU 
<pnum1>,<pnum2> 

Instruction This command sets the calibration type to the response calibration 
(thru) between the specified 2 ports, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

Return None 

Default None 

Menu Cal > Basic Cal > Response(Thru) 

Example :SENSe1:CORRection:COLLect:METHod:THRU 1,2 

 

3.3.1.1.7 Calibration Type to Enhanced Response 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:ERESponse 
<pnum1>,<pnum2> 

Instruction This command sets the calibration type to the enhanced response 
calibration between the two specified ports, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 
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Return None 

Default None 

Menu Cal > Basic Cal > Enhanced Response 

Example :SENSe1:CORRection:COLLect:METHod:ERESponse 1,2 

 

3.3.1.1.8 Set Calibration Type to OSL 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:SOLT1 <pnum> 

Instruction This command sets the calibration type to the 1-port calibration OSL 
of the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Basic Cal > OSL 

Example :SENSe1:CORRection:COLLect:METHod:SOLT1 3 

 

3.3.1.1.9 Set Calibration Type to 2-Port SOLT 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:SOLT2  

<pnum1>,<pnum2> 

Instruction This command sets the calibration type to the 2-port calibration SOLT 
of the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1> :={1|2|3|4}, specifies port number for 2-port calibration. 

<pnum2> :={1|2|3|4}, specifies port number for 2-port calibration. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. The order of the 2 port numbers to be specified is 
arbitrary. 
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Return None 

Default None 

Menu Cal > Basic Cal > SOLT 

Example :SENSe1:CORRection:COLLect:METHod:SOLT2 1,2 

 

3.3.1.1.10 Set Calibration Type to 3-Port SOLT 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:SOLT3 
<pnum1>,<pnum2>,<pnum3> 

Instruction This command sets the calibration type to the 3-port calibration SOLT 
between the specified 3 ports, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies port number for 3-port calibration. 

<pnum2>:={1|2|3|4}, specifies port number for 3-port calibration. 

<pnum3>:={1|2|3|4}, specifies port number for 3-port calibration. 

If you specify the same port number to 3 port numbers, an error occurs 
when executed. The order of the 3 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > Basic Cal > SOLT 

Example :SENSe1:CORRection:COLLect:METHod:SOLT3 1,2,4 

 

3.3.1.1.11 Set Calibration Type to 4-Port SOLT 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:SOLT4 
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

Instruction This command sets the calibration type to the full 4-port calibration 
SOLT, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies port number for 4-port calibration. 

<pnum2>:={1|2|3|4}, specifies port number for 4-port calibration. 

<pnum3>:={1|2|3|4}, specifies port number for 4-port calibration. 

<pnum4>:={1|2|3|4}, specifies port number for 4-port calibration. 

If you specify the same port number to 4 port numbers, an error occurs 
when executed. The order of the 4 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > Basic Cal > SOLT 

Example :SENSe1:CORRection:COLLect:METHod:SOLT4 1,2,3,4 

 

3.3.1.1.12 Set Calibration Type to 2-port TRL 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:TRL2 
<pnum1>,<pnum2> 

Instruction This command sets the calibration type to 2-port TRL between the 2 
specified ports, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1> :={1|2|3|4}, specifies port number for TRL 2-port calibration. 

<pnum2> :={1|2|3|4}, specifies port number for TRL 2-port calibration. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. the order of the 2 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > Basic Cal > TRL 

Example :SENSe1:CORRection:COLLect:METHod:TRL2 1,2 
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3.3.1.1.13 Set Calibration Type to 3-port TRL 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:TRL3 
<pnum1>,<pnum2>,<pnum3> 

Instruction This command sets the calibration type to 3-port TRL between the 3 
specified ports, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1> :={1|2|3|4}, specifies port number for TRL 3-port calibration. 

<pnum2> :={1|2|3|4}, specifies port number for TRL 3-port calibration. 

<pnum3> :={1|2|3|4}, specifies port number for TRL 3-port calibration. 

If you specify the same port number to 3 port numbers, an error occurs 
when executed. the order of the 3 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > Basic Cal > TRL 

Example :SENSe1:CORRection:COLLect:METHod:TRL3 1,2,3 

 

3.3.1.1.14 Set Calibration Type to 4-port TRL 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:TRL4 
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

Instruction This command sets the calibration type to the 4-port calibration TRL 
between the 4 specified ports, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1> :={1|2|3|4}, specifies port number for TRL 4-port calibration. 

<pnum2> :={1|2|3|4}, specifies port number for TRL 4-port calibration. 

<pnum3> :={1|2|3|4}, specifies port number for TRL 4-port calibration. 

<pnum4> :={1|2|3|4}, specifies port number for TRL 4-port calibration. 

If you specify the same port number to 4 port numbers, an error occurs 
when executed. the order of the 4 port numbers to be specified is 
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arbitrary. 

Return None 

Default None 

Menu Cal > Basic Cal > TRL 

Example :SENSe1:CORRection:COLLect:METHod:TRL4 1,2,3,4 

 

3.3.1.1.15 Measure Open Calibration Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:OPEN <pnum> 

Instruction This command measures the calibration data of the OPEN standard for 
the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Basic Cal > Response(Open) > Open 

Cal > Basic Cal > OSL > Open 

Cal > Basic Cal > Enhanced Response > Open 

Cal > Basic Cal > SOLT > Open 

Cal > Basic Cal > SOLR > Open 

Example :SENSe1:CORRection:COLLect:OPEN 1 

 

3.3.1.1.16 Measure Short Calibration Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:SHORt <pnum> 

Instruction This command measures the calibration data of the Short standard for 
the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Basic Cal > Response(Short) > Short 

Cal > Basic Cal > OSL > Short 

Cal > Basic Cal > Enhanced Response > Short 

Cal > Basic Cal > SOLT > Short 

Cal > Basic Cal > SOLR > Short 

Example :SENSe1:CORRection:COLLect:SHORt 1 

 

3.3.1.1.17 Measure Load Calibration Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:LOAD <pnum> 

Instruction This command measures the calibration data of the load standard for 
the specified port, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Basic Cal > Response(Open) > Load(Optional) 

Cal > Basic Cal > Response(Short) > Load(Optional) 

Cal > Basic Cal > OSL > Load 

Cal > Basic Cal > Enhanced Response > Load 

Cal > Basic Cal > SOLT > Load 

Cal > Basic Cal > SOLR > Load 

Example :SENSe1:CORRection:COLLect:LOAD 1 

 

3.3.1.1.18 Measure Thru Calibration Data 
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Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:THRU 
<pnum1>,<pnum2> 

Instruction This command measures the calibration data of the Thru sdandard 
from the specified stimulus port to the specified response port, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. 

Return None 

Default None 

Menu Cal > Basic Cal > Response(Thru) > Thru 

Cal > Basic Cal > Enhanced Response > Thru 

Cal > Basic Cal > SOLT > Thru 

Cal > Basic Cal > SOLR > Unknown Thru 

Example :SENSe1:CORRection:COLLect:THRU 1,4 

 

3.3.1.1.19 Measure Isolation Calibration Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:ISOLation 
<pnum1>,<pnum2> 

Instruction This command measures the calibration data of the isolation from the 
specified stimulus port to the specified response port, for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. 
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Return None 

Default None 

Menu Cal > Basic Cal > Response(Thru) > Isolation-Load(Optional) 

Cal > Basic Cal > Enhanced Response > Isolation-Load(Optional) 

Cal > Basic Cal > SOLT > Isolation-Load(Optional) 

Cal > Basic Cal > SOLR > Isolation-Load(Optional) 

Example :SENSe1:CORRection:COLLect:ISOLation 1,2 

 

3.3.1.1.20 Measure TRL Calibration Thru Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLThru 
<pnum1>,<pnum2> 

Instruction This command executes THRU measurement of the TRL calibration for 
the selected calibration kit, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. 

Return None 

Default None 

Menu Cal > Basic Cal > TRL > Thru 

Example :SENSe1:CORRection:COLLect:TRLThru 1,2 

 

3.3.1.1.21 Measure TRL Calibration Reflect Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLReflect <pnum> 

Instruction This command executes the reflection measurement of the TRL 
calibration for the selected calibration kit, for the selected channel. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Basic Cal > TRL > Reflect 

Example :SENSe1:CORRection:COLLect:TRLReflect 1 

 

3.3.1.1.22 Measure TRL Calibration Line Data 

Command Format :SENSe<cnum>:CORRection:COLLect[:ACQuire]:TRLLine 
<pnum1>,<pnum2> 

Instruction This command executes LINE or MATCH measurement of the TRL 
calibration for the selected calibration kit, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. 

Return None 

Default None 

Menu Cal > Basic Cal > TRL > Line 

Example :SENSe1:CORRection:COLLect:TRLLine 3,4 

 

3.3.1.1.23 Clear Error Coefficient 

Command Format :SENSe<cnum>:CORRection:CLEar 

Instruction This command clears the error coefficient for calibration of  the select 
channel. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:CLEar 

 

3.3.1.1.24 Error Coefficient Data 

Command Format :SENSe<cnum>:CORRection:COEFficient[:DATA] <type>,<numeric 
1>,<numeric 2>,<numeric 3>,...,<numeric 2+n*2> 

:SENSe<cnum>:CORRection:COEFficient[:DATA]?  

<type>,<numeric 1>,<numeric 2> 

Instruction This command sets/gets the calibration coefficient data for specified 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={ES|ER|ED|EL|ET|EX}: error type 

"ES": Source match 

"ER": Reflection tracking 

"ED": Directivity 

"EL": Load match 

"ET": Transmission tracking 

"EX": Isolation 

 

<numeric 1>: Response port 

Integer. Range: 1~4 

If ES, ER, or ED is used, the response port and the stimulus port must 
be the same, while EL, ET, or EX is used, the response port and the 
stimulus port must be different. 

 

<numeric 2>: Stimulus port 
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Integer. Range: 1~4 

 

<numeric 3>,...,<numeric 2+n*2>: error coefficient 

Indicates the array data (formatted data array) of NOP (number of 
measurement points)×2. Where n is an integer between 1 and NOP. 

Data(n×2-2): Data (primary value) at the n-th measurement point. 

Data(n×2-1): Data (secondary value) at the n-th measurement point. 
Always 0 when the data format is not the Smith chart format or the 
polar format. 

The index of the array starts from 0. 

Return Indicates the array data (formatted data array) of NOP (number of 
measurement points)×2. Where n is an integer between 1 and NOP. 

Data(n×2-2): Data (primary value) at the n-th measurement point. 

Data(n×2-1): Data (secondary value) at the n-th measurement point. 
Always 0 when the data format is not the Smith chart format or the 
polar format. 

The index of the array starts from 0. 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:THRU 2,1 

:SENSe1:CORRection:COEFficient ET,2,1,-1,0,-0.5,0,0.5,0 

:SENSe1:CORRection:COEFficient:SAVE 

:SENSe1:CORRection:COEFficient? ET,2,1 

Return: -1.000000000000e+00,0.000000000000e+00, 
-5.000000000000e-01,0.000000000000e+00, 
5.000000000000e-01,0.000000000000e+00 

 

3.3.1.1.25 Import Response(Open) Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:OPEN 
<pnum> 

Instruction This command sets the calibration type to the response calibration 
(open) of the specified port when the calibration coefficient data array 
is written with the SENSe<cnum>:CORRection:COEFficient:DATA 
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command, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:OPEN 1 

 

3.3.1.1.26 Import Response(Short) Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]:SHOR
t <pnum> 

Instruction This command sets the calibration type to the response calibration 
(short) of the specified port when the calibration coefficient data array 
is written with the SENSe<cnum>:CORRection:COEFficient:DATA 
command, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:SHORt 1 

 

3.3.1.1.27 Import Response(Thru) Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod[:RESPonse]: 
THRU <pnum1>,<pnum2> 

Instruction This command sets the calibration type to the response 
calibration(thru) between the two specified ports when the calibration 
coefficient data array is written with the 
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SENSe<cnum>:CORRection:COEFficient:DATA command, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:THRU 1,2 

 

3.3.1.1.28 Import Enhanced Response Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod:ERESponse 
<pnum1>,<pnum2> 

Instruction This command sets the calibration type to the enhanced response 
calibration between the two specified ports when the calibration 
coefficient data array is written with the 
SENSe<cnum>:CORRection:COEFficient:DATA command, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:ERESponse 1,2 

 

3.3.1.1.29 Import 1 Port SOLT Data 
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Command Format :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT1 <pnum> 

Instruction This command sets the calibration type to the full 1-port calibration of 
the specified port, when the calibration coefficient data array is written 
with theSENSe<cnum>:CORRection:COEFficient:DATA command, for 
the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:SOLT1 1 

 

3.3.1.1.30 Import 2 Port SOLT Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT2 
<pnum1>,<pnum2> 

Instruction This command sets the calibration type to full 2-port calibration 
between the two specified ports, when the calibration coefficient data 
array is written with 
theSENSe<cnum>:CORRection:COEFficient:DATA command, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies a port for full 2-port calibration. 

<pnum2>:={1|2|3|4}, specifies a port for full 2-port calibration. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:SOLT2 1,2 
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3.3.1.1.31 Import 3 Port SOLT Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT3 
<pnum1>,<pnum2>,<pnum3> 

Instruction This command sets the calibration type to full 3-port calibration 
between the three specified ports, when the calibration coefficient 
data array is written with 
theSENSe<cnum>:CORRection:COEFficient:DATA command, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies a port for full 3-port calibration. 

<pnum2>:={1|2|3|4}, specifies a port for full 3-port calibration. 

<pnum3>:={1|2|3|4}, specifies a port for full 3-port calibration. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:SOLT3 1,2,4 

 

3.3.1.1.32 Import 4 Port SOLT Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:METHod:SOLT4 
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

Instruction This command sets the calibration type to full 4-port calibration 
between the four specified ports, when the calibration coefficient data 
array is written with 
theSENSe<cnum>:CORRection:COEFficient:DATA command, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies a port for full 4-port calibration. 

<pnum2>:={1|2|3|4}, specifies a port for full 4-port calibration. 

<pnum3>:={1|2|3|4}, specifies a port for full 4-port calibration. 
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<pnum4>:={1|2|3|4}, specifies a port for full 4-port calibration. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:METHod:SOLT4 1,2,3,4 

 

3.3.1.1.33 Save Error Coefficient Data 

Command Format :SENSe<cnum>:CORRection:COEFficient:SAVE 

Instruction This command enables the calibration coefficients depending on the 
selected calibration type from the writing calibration data. If you 
execute this command before all calibration data needed for 
calculating the calibration coefficients are written, an error occurs and 
the command is ignored. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COEFficient:SAVE 

 

3.3.1.1.34 Save Partially Rewritten Calibration Data 

Command Format :SENSe<cnum>:CORRection:COLLect:PARTial:SAVE 

Instruction This command is used for partial overwrite, recalculates the calibration 
coefficients depending on the selected calibration type from the 
measured calibration data. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 
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Menu Cal > Basic Cal > Overwrite 

Example :SENSe1:CORRection:COLLect:PARTial:SAVE 

 

3.3.1.2 Cal Kit 

3.3.1.2.1 Command List 

Label of Cal Kit :SENSe<cnum>:CORRection:COLLect:CKIT:LABel 

Standard for Open Measurement :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 

Standard for Short Measurement :SENSe:CORRection:COLLect:CKIT:ORDer:SHORt 

Standard for Load Measurement :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 

Standard for Thru Measurement :SENSe:CORRection:COLLect:CKIT:ORDer:THRU 

Standard for TRL Line 
Measurement 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine 

Standard for TRL Reflect :SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect 

Standard for TRL Thru 
Measurement 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru 

Reset Cal Kit :SENSe:CORRection:COLLect:CKIT:RESet 

Select Cal Kit :SENSe:CORRection:COLLect:CKIT[:SELect] 

Standard Type :SENSe:CORRection:COLLect:CKIT:STAN<snum>:TYPE 

C0 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C0 

C1 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C1 

C2 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C2 

C3 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C3 

L0 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L0 

L1 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L1 

L2 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L2 

L3 Value of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L3 

Label of Cal Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:LABel 

Delay of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:DELay 

Min Frequency of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMINimum 
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Max Frequency of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMAXimum 

Loss of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:LOSS 

Z0 of the Standard :SENSe:CORRection:COLLect:CKIT:STAN<snum>:Z0 

TRL Reference Impedance :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance 

TRL Calibration Plane :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane 

 

3.3.1.2.2 Label of Cal Kit 

Command Format :SENSe<cnum>:CORRection:COLLect:CKIT:LABel <string> 

:SENSe<cnum>:CORRection:COLLect:CKIT:LABel? 

Instruction This command sets/gets the calibration kit name for the calibration kit 
selected, for selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<string>: represents the calibration kit name. 

Return String 

Default None 

Menu Cal > Cal Kit > Edit > Cal Kit Name 

Example :SENSe1:CORRection:COLLect:CKIT:LABel "F503ME_1" 

:SENSe1:CORRection:COLLect:CKIT:LABel? 

Return: F503ME_1 

 

3.3.1.2.3 Standard for Open Measurement 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

Instruction This command sets/gets the standard(s) used for the open 
measurement for a calibration kit selected. 

Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 
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Return Integer or array  

Default None 

Menu Cal > Cal Kit > Edit > SOLT > OPEN 

Example :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 2,3 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

Return: 2,3 

 

3.3.1.2.4 Standard for Short Measurement 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:SHORt 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:SHORt? 

Instruction This command sets/gets the standard(s) used for the short 
measurement, for a calibration kit selected. 

Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 

Return Integer or array  

Default None 

Menu Cal > Cal Kit > Edit > SOLT > SHORT 

Example :SENSe1:CORRection:COLLect:CKIT:ORDer:SHORt 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:SHORt? 

Return: 3 

 

3.3.1.2.5 Standard for Load Measurement 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:LOAD? 

Instruction This command sets/gets the standard(s) used for the load 
measurement for a calibration kit selected. 
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Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 

Return Integer or array 

Default None 

Menu Cal > Cal Kit > Edit > SOLT > LOAD 

Example :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 2 

:SENSe:CORRection:COLLect:CKIT:ORDer:LOAD? 

Return: 2 

 

3.3.1.2.6 Standard for Thru Measurement 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:THRU 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:THRU? 

Instruction This command sets/gets the standard(s) used for the thru 
measurement, for the calibration kit selected. 

Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 

Return Integer or array  

Default None 

Menu Cal > Cal Kit > Edit > SOLT > THRU 

Example :SENSe1:CORRection:COLLect:CKIT:ORDer:THRU 4,2 

:SENSe1:CORRection:COLLect:CKIT:ORDer:THRU? 

Return: 4,2 

 

 

3.3.1.2.7 Standard for TRL Line Measurement 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine 
<numeric1>{,<numeric2>,…,<numeric n>} 
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:SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine? 

Instruction This command sets/gets the standard used for the line measurement 
of TRL calibration, for the calibration kit selected. 

Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 

Return Integer or array  

Default None 

Menu Cal > Cal Kit > Edit > TRL > LINE/MATCH 

Example :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLLine 2 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLLine? 

Return: 2 

 

3.3.1.2.8 Standard for TRL Reflect 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect? 

Instruction This command sets/gets the standard used for the reflection 
measurement of the TRL calibration, for the calibration kit selected. 

Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 

Return Integer or array  

Default None 

Menu Cal > Cal Kit > Edit > TRL > REFLECT 

Example :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLReflect 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLReflect? 

Return: 3 

 

3.3.1.2.9 Standard for TRL Thru Measurement 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    67 

Command Format :SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru 
<numeric1>{,<numeric2>,…,<numeric n>} 

:SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru? 

Instruction This command sets/gets the standard used for the thru measurement 
of TRL calibration, for the calibration kit selected. 

Parameter Type <numeric1>{,<numeric2>,…,<numeric n>}:specifies the order of 
standard, and the parameter range: 1~21. 

Return Integer or array 

Default None 

Menu Cal > Cal Kit > Edit > TRL > THRU 

Example :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLThru 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLThru? 

Return: 3 

 

3.3.1.2.10 Reset Cal Kit 

Command Format :SENSe:CORRection:COLLect:CKIT:RESet 

Instruction This command resets the calibration kit selected to the default factory 
setting state. 

Parameter Type None 

Return None 

Default None 

Menu None 

Example :SENSe:CORRection:COLLect:CKIT 2 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 1,3 

:SENSe:CORRection:COLLect:CKIT:RESet 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

Return: 2 

3.3.1.2.11 Select Cal Kit 
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Command Format :SENSe:CORRection:COLLect:CKIT[:SELect] <numeric> 

:SENSe:CORRection:COLLect:CKIT[:SELect]? 

Instruction This command sets/gets the order of the selected calibration kit. 

Parameter Type <numeric>:represents the order of the selected calibration kit, and the 
parameter range: 1~32. 

Return Integer 

Default 1 

Menu None 

Example :SENSe:CORRection:COLLect:CKIT 2 

:SENSe:CORRection:COLLect:CKIT? 

Return: 2 

 

3.3.1.2.12 Standard Type 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:TYPE <type> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:TYPE? 

Instruction This command sets/gets the standard type for the calibration kit 
selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<type>:= {OPEN|SHORt|LOAD|THRU} 

Return Enumeration 

Default OPEN 

Menu Cal > Cal Kit > Edit Kit > Standards > Add > Add Standard 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:TYPE LOAD 

:SENSe:CORRection:COLLect:CKIT:STAN1:TYPE? 

Return: LOAD 

 

3.3.1.2.13 C0 Value of the Standard 
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Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C0 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C0? 

Instruction This command sets/gets the C0 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the C0 value. 

Return Float 

Unit: fF (femto farad), 1E-15 F (farad) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C0 

Example :SENSe:CORRection:COLLect:CKIT:STAN2:C0 100 

:SENSe:CORRection:COLLect:CKIT:STAN2:C0? 

Return: 100 

 

3.3.1.2.14 C1 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C1 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C1? 

Instruction This command sets/gets the C1 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the C1 value. 

Return Float 

Unit: 1E-27 F/Hz (1E-27 farad / hertz) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C1 

Example :SENSe:CORRection:COLLect:CKIT:STAN2:C1 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN2:C1? 
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Return: 12.3 

 

3.3.1.2.15 C2 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C2 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C2? 

Instruction This command sets/gets the C2 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the C2 value. 

Return Float 

Unit: 1E-36 F/Hz² (1E-36 farad /hertz²) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C2 

Example :SENSe:CORRection:COLLect:CKIT:STAN2:C2 25 

:SENSe:CORRection:COLLect:CKIT:STAN2:C2? 

Return: 25 

 

3.3.1.2.16 C3 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:C3 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:C3? 

Instruction This command sets/gets the C3 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the C3 value. 

Return Float 

Unit: 1E-45 F/Hz³ (1E-45 farad / hertz³) 

Default None 
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Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C3 

Example :SENSe:CORRection:COLLect:CKIT:STAN2:C3 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN2:C3? 

Return: 12.3 

 

3.3.1.2.17 L0 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L0 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L0? 

Instruction This command sets/gets the L0 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the L0 value. 

Return Float 

Unit: pH (pico henry) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L0 

Example :SENSe:CORRection:COLLect:CKIT:STAN3:L0 10 

:SENSe:CORRection:COLLect:CKIT:STAN3:L0? 

Return: 10 

 

3.3.1.2.18 L1 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L1 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L1? 

Instruction This command sets/gets the L1 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the L1 value. 
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Return Float 

Unit: 1E-24 H/Hz (1E-24 henry / hertz) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L1 

Example :SENSe:CORRection:COLLect:CKIT:STAN3:L1 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L1? 

Return: 12.3 

 

3.3.1.2.19 L2 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L2 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L2? 

Instruction This command sets/gets the L2 value of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the L2 value. 

Return Float 

Unit: 1E-33 H/Hz² (1E-33 henry / hertz²) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L2 

Example :SENSe:CORRection:COLLect:CKIT:STAN3:L2 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L2? 

Return: 12.3 

 

3.3.1.2.20 L3 Value of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:L3 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:L3? 

Instruction This command sets/gets the L3 value of the selected standard, for the 
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calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the L3 value. 

Return Float 

Unit: 1E-42 H/Hz³ (1E-42 henry / hertz³) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L3 

Example :SENSe:CORRection:COLLect:CKIT:STAN3:L3 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L3? 

Return: 12.3 

 

3.3.1.2.21 Label of Cal Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:LABel <string> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:LABel? 

Instruction This command sets/gets the name of the selected standard, for the 
calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<string>: represents the name of the selected standard. 

Return String 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Label 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:LABel "LOAD_1" 

:SENSe:CORRection:COLLect:CKIT:STAN1:LABel? 

Return: LOAD_1 

 

3.3.1.2.22 Delay of the Standard 
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Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:DELay <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:DELay? 

Instruction This command sets/gets the value of the offset delay of the selected 
standard, for the calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the value of the offset delay. 

Return Float 

Unit: s (second) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Delay Characteristics > 
Delay 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:DELay 1 

:SENSe:CORRection:COLLect:CKIT:STAN1:DELay? 

Return: 1 

 

3.3.1.2.23 Min Frequency of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMINimum 
<numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMINimum? 

Instruction This command sets/gets the value of the start frequency of the 
selected standard, for the calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the value of the start frequency. 

Return Float 

Unit: Hz (hertz) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Frequency Range > MIN 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:FMINimum 500e6 
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:SENSe:CORRection:COLLect:CKIT:STAN1:FMINimum? 

Return: 500000000 

 

3.3.1.2.24 Max Frequency of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMAXimum 
<numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:FMAXimum? 

Instruction This command sets/gets the value of the stop frequency of the selected 
standard, for the calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the value of the stop frequency. 

Return Float 

Unit: Hz (hertz) 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Frequency Range > Max 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:FMAXimum 4.5e9 

:SENSe:CORRection:COLLect:CKIT:STAN1:FMAXimum? 

Return: 4500000000 

 

3.3.1.2.25 Loss of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:LOSS <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:LOSS? 

Instruction This command sets/gets the value of the loss of the selected standard, 
for the calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the value of the loss. 

Return Float 
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Unit: ohm/s 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Delay Characteristics > 
Loss 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:LOSS 0.5 

:SENSe:CORRection:COLLect:CKIT:STAN1:LOSS? 

Return: 0.5 

 

3.3.1.2.26 Z0 of the Standard 

Command Format :SENSe:CORRection:COLLect:CKIT:STAN<snum>:Z0 <numeric> 

:SENSe:CORRection:COLLect:CKIT:STAN<snum>:Z0? 

Instruction This command sets/gets the value of the offset Z0 of the selected 
standard, for the calibration kit selected. 

Parameter Type <snum>:= {[1]-30}: represents the standard serial number of the 
calibration kit. 

<numeric>:represents the value of the offset Z0. 

Return Float 

Unit: ohm 

Default None 

Menu Cal > Cal Kit > Edit Kit > Standards > Edit > Delay Characteristics > Z0 

Example :SENSe:CORRection:COLLect:CKIT:STAN1:Z0 75 

:SENSe:CORRection:COLLect:CKIT:STAN1:Z0? 

Return: 75 

 

3.3.1.2.27 TRL Reference Impedance 

Command Format :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance <type> 

:SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance? 

Instruction This command sets/gets the reference impedance during the TRL 
calibration. 
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Parameter Type <type>:= {LINE|SYSTem} 

Return Enumeration 

Default SYSTem 

Menu Cal > Cal Kit > Edit Kit > TRL > Calibration Reference Z0 

Example :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance LINE 

:SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance? 

Return: LINE 

 

3.3.1.2.28 TRL Calibration Plane 

Command Format :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane <type> 

:SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane? 

Instruction This command sets/gets the reference plane during the TRL 
calibration. 

Parameter Type <type>:= {THRU|REFLect} 

Return Enumeration 

Default THRU 

Menu Cal > Cal Kit > Edit Kit > TRL > Test Port reference Plane 

Example :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane REFLect 

:SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane? 

Return: REFL 

 

3.3.1.3 Cal Correction 

3.3.1.3.1 Command List 

Correction State :SENSe<cnum>:CORRection:STATe 

Power Calibration 
Correction State 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection[:STATe] 

Power Calibration :SOURce<cnum>:POWer:PORT<pnum>:CORRection:DATA 
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Correction Data 

Take Cal Sweep :SOURce{<cnum>:POWer:PORT<pnum>:CORRection:COLLect[:ACQuire] 

Max Iteratin Count :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:ITERation[:COU
Nt] 

Num of Readings :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:AVERage[:COU
Nt] 

Loss Compensation 
State 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS[:ST
ATe] 

Loss Compensation 
Data 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABLe:LOSS:DA
TA 

 

3.3.1.3.2 Correction State 

Command Format :SENSe<cnum>:CORRection:STATe <bool> 

:SENSe<cnum>:CORRection:STATe? 

Instruction This turns ON/OFF or gets the status of the error correction of selected 
channel 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Cal > Correction 

Example :SENSe1:CORRection:STATe ON 

:SENSe1:CORRection:STATe? 

Return: 1 

 

3.3.1.3.3 Power Calibration Correction State 

Command Format :SOURce<cnum>:POWer:PORT<pnum>:CORRection[:STATe] 
<bool> 
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:SOURce<cnum>:POWer:PORT<pnum>:CORRection[:STATe]? 

Instruction This command turns ON/OFF or returns the status of the power level 
error correction, for the selected port of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Cal > Power Cal… 

Example :SOURce1:POWer:PORT1:CORRection ON 

:SOURce1:POWer:PORT1:CORRection? 

Return: 1 

 

3.3.1.3.4 Power Calibration Correction Data 

Command Format :SOURce<cnum>:POWer:PORT<pnum>:CORRection:DATA 
<numeric 1>, ..,<numeric NOP> 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:DATA? 

Instruction This command sets/gets the power calibration data array, for the 
selected port of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<numeric 1>, ..,<numeric NOP>: 

Indicates the array data (power calibration data array) of NOP (number 
of points). Where n is an integer between 1 and NOP. 

Data(n-1): Data at the n-th measurement point 

The index of the array starts from 0. 

Return Data array 

Default None 
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Menu None 

Example :SENSe1:SWEep:POINts 5 

:SOURce1:POWer:PORT2:CORRection:DATA 1,2,3,4,5 

:SOURce1:POWer:PORT2:CORRection:DATA? 

Return: 1,2,3,4,5 

 

3.3.1.3.5 Take Cal Sweep 

Command 
Format 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect[:ACQuire] 

Instruction This command excute the power calibration of select port. When the 
measurement is complete successfully, the power level error correction is 
automatically turned ON. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If not 
specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 

Menu Cal > Power Cal > Take Cal Sweep 

Example :SOURce1:POWer:PORT2:CORRection:COLLect 

 

3.3.1.3.6 Max Iteratin Count 

Command 
Format 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:ITERati
on[:COUNt] <numeric> 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:ITERati
on[:COUNt]? 

Instruction This command sets/gets the maximum number of readings to take at 
each source power data point for the selected port and channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2}, specifies the measurement port number. 
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<numeric>:represents the maximum number of readings to take at each 
source power data point, and the parameter range: 0~50. 

Return Interger 

Default 0 

Menu Cal > Power Cal > Max Iteration 

Example :SOURce1:POWer:PORT2:CORRection:COLLect:ITERation 10 

:SOURce1:POWer:PORT2:CORRection:COLLect:ITERation? 

Return: 10 

 

3.3.1.3.7 Num of Readings 

Command 

Format 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:AVER
age[:COUNt] <numeric> 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:AVER
age[:COUNt]? 

Instruction This command sets/gets the number of power calibration data 
measurements per measurement point for the selected port of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2}, specifies the measurement port number. 

<numeric>:represents the number of power calibration data 
measurements per measurement point, and the parameter range: 
1~50. 

Return Interger 

Default 1 

Menu Cal > Power Cal > Num of Readings 

Example :SOURce1:POWer:PORT2:CORRection:COLLect:AVERage 5 

:SOURce1:POWer:PORT2:CORRection:COLLect:AVERage? 

Return: 5 

 



VNA Series Programming Guide 

82                                                                                                                                                                                    int.siglent.com 

3.3.1.3.8 Loss Compensation State 

Command Format :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABL
e:LOSS[:STATe] <bool> 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABL
e:LOSS[:STATe]? 

Instruction This command turns ON/OFF or returns the status of the loss 
compensation, for the selected port of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Power Cal > Loss Compen Off  > Power Loss Compensation > 
Compensation On 

Example :SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS ON 

:SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS? 

Return: 1 

 

3.3.1.3.9 Loss Compensation Data 

Command Format :SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABL
e:LOSS:DATA <numeric 1>,...,<numeric 1+(Nx2)> 

:SOURce<cnum>:POWer:PORT<pnum>:CORRection:COLLect:TABL
e:LOSS:DATA? 

Instruction This command sets/gets the loss compensation table, for the selected 
port of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number 

 

<numeric 1>,...,<numeric 1+(Nx2)>:. 
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Indicates the array data (for the loss compensation table) of 1 + Num 
(number of set data items)X2. Where n is an integer between 1 and 
Num. 

 

Data(0):The number of data items you want to set. Specify an integer 
between 0 to 100. When you set the number of data items to 0 (to clear 
the loss compensation table), you specify only Data(0) as the Data 
variable. 

Data(nX2-1):The frequency of the n-th data item (1 kHz to 500 GHz). 

Data(nX2):The loss of the n-th data item (-100 dB to 100 dB). 

The index of the array starts from 0. 

Return Data array 

Default None 

Menu Cal > Power Cal > Loss Compen Off > Power Loss Compensation 

Example :SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS:DATA 
2,2e9,3,5e9,-0.5 

:SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS:DATA? 

Return: 2,2e+09,3,5e+09,-0.5 

 

3.3.2 Port Extension 

3.3.2.1 Command List 

State of Port Extension :SENSe<cnum>:CORRection:EXTension[:STATe] 

Delay Time of Port 
Extension :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:TIME  

Delay Distance of Port 
Extension :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance  

Distance Unit of Port 
Extension 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTANCE:UNIT 

Velocity of Port Extension :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor 

State of Velocity Couple :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity 
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DC Loss of Port Extension :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC 

State of Loss Value and 
Frequency Value 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<type> 
[:STATe] 

Loss Value of Port 
Extension 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS 

Frequency 1 or 2 of Port 
Extension 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency 

Clear Port Extension Data :SENSe<cnum>:CORRection:EXTension:AUTO:RESet 

Calculate Method for 
Auto Port Extension 

:SENSe<cnum>:CORRection:EXTension:AUTO:CONFig 

State of the Loss 
Compensation 

:SENSe<cnum>:CORRection:EXTension:AUTO:LOSS 

Adjust for Mismatch State :SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset 

User Span Start 
Frequency 

:SENSe<cnum>:CORRection:EXTension:AUTO:STARt 

User Span Stop 
Frequency 

:SENSe<cnum>:CORRection:EXTension:AUTO:STOP 

Madia Type :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:MEDium 

Cuttoff Freq of 
Waveguide 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:WGCutoff 

Couple To System Media 
Definition 

:SENSe<cnum>:CORRection:EXTension:PORT:SYSMedia 

 

3.3.2.2 State of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension[:STATe] <bool> 

:SENSe<cnum>:CORRection:EXTension[:STATe]? 

Instruction This command turns ON/OFF or returns the status of the port 
extension, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Port Extension > Port Extension 

Example :SENSe1:CORRection:EXTension ON 

:SENSe1:CORRection:EXTension? 

Return: 1 

 

3.3.2.3 Delay Time of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:TIME 
<numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:TIME? 

Instruction This command sets or gets the value of the delay time for the port 
extension of ports 1 and 4, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<numeric>:represents the value of the delay time, and the parameter 
range: 0~10s. 

Return Float, unit s(second) 

Default 0 

Menu Cal > Port Extension > Time 

Example :SENSe1:CORRection:EXTension:PORT1:TIME 5 

:SENSe1:CORRection:EXTension:PORT1:TIME? 

Return: 5 

 

3.3.2.4 Delay Distance of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance 
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<numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTance? 

Instruction This command sets and returns the port extension delay in physical 
length (distance). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<numeric>:represents the port extension delay in physical length 
(distance). 

Return Float, unit m(meter), or ft(feet), or in(inches) 

Default 0 

Menu Cal > Port Extension > Distance 

Example :SENSe1:CORRection:EXTension:PORT1:DISTance 1 

:SENSe1:CORRection:EXTension:PORT1:DISTance? 

Return: 1 

 

3.3.2.5 Distance Unit of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTANCE:U
NIT <type> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:DISTANCE:U
NIT? 

Instruction This command Sets and returns the units for specifying port extension 
delay in physical length (distance). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<type>:={METers|FEET|INCHes} 

Return Enumeration 

Default METers 

Menu Cal > Port Extension > Port Extensions… > Delay > Distance Units 
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Example :SENSe1:CORRection:EXTension:PORT1:DISTANCE:UNIT INCHes 

:SENSe1:CORRection:EXTension:PORT1:DISTANCE:UNIT? 

Return: INCH 

 

3.3.2.6 Velocity of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor 
<numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:VELFactor? 

Instruction This command sets or gets the value of Velocity coefficient, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<numeric>:represents the value of Velocity coefficient, and the 
parameter range: 0 ~ 1. 

Return Float 

Default 1 

Menu Cal > Port Extension > Velocity 

Example :SENSe1:CORRection:EXTension:PORT1:VELFactor 0.66 

:SENSe1:CORRection:EXTension:PORT1:VELFactor? 

Return: 0.66 

 

3.3.2.7 State of Velocity Couple 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity 
<bool> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:SYSVelocity? 

Instruction This command sets or returns the state of coupling with the system 
Velocity Factor value. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Cal > Port Extension > Port Extensions… > Velocity > Couple to 
system Velocity Factor 

Example :SENSe1:CORRection:EXTension:PORT1:SYSVelocity 0 

:SENSe1:CORRection:EXTension:PORT1:SYSVelocity? 

Return: 0 

 

3.3.2.8 DC Loss of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC 
<numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LDC? 

Instruction This command sets/gets the DC loss value of the port 1 to 4, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<numeric>:represents the DC loss value, and the parameter range: -
90 ~ 90dB. 

Return Float, unit dB 

Default 0dB 

Menu Cal > Port Extension > DC Loss 

Example :SENSe1:CORRection:EXTension:PORT2:LDC 10 

:SENSe1:CORRection:EXTension:PORT2:LDC? 

Return: 10 
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3.3.2.9 State of Loss Value and Frequency Value 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<typ
e>[:STATe] <bool> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:INCLude<typ
e>[:STATe] 

Instruction This command turns ON/OFF the set of loss value and frequency value 
of include 1 and 2 of the port 1 to 4, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<type>:={[1]|2} 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Port Extension > Port Extensions… > Loss 

Example :SENSe1:CORRection:EXTension:PORT1:INCLude1 ON 

:SENSe1:CORRection:EXTension:PORT1:INCLude1? 

Return: 1 

 

3.3.2.10 Loss Value of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS<type> 
<numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:LOSS<type>? 

Instruction This command sets/gets the loss value of the loss 1 to 4 of the port 1 
to 4, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<type>:={[1]|2} 

<numeric>:represents the loss value, and the parameter range: -90 ~ 
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90dB. 

Return Float, unit dB 

Default 0dB 

Menu Cal > Port Extension > Port Extensions… > Loss > Loss1 or Loss2 

Example :SENSe1:CORRection:EXTension:PORT1:LOSS1 2 

:SENSe1:CORRection:EXTension:PORT1:LOSS1? 

Return: 2 

 

3.3.2.11 Frequency 1 or 2 of Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency<
type> <numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:FREQuency<
type>? 

Instruction This command sets/gets the frequency used for calculation of the loss 
value of the frequency 1 and 2 of the selected port, for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<type>:={[1]|2} 

<numeric>:represents the frequency. 

Return Double, unit: Hz 

Default 1GHz 

Menu Cal > Port Extension > Port Extensions… > Loss > Freq1 or Freq2 

Example :SENSe1:CORRection:EXTension:PORT2:FREQuency2 2e9 

:SENSe1:CORRection:EXTension:PORT2:FREQuency2? 

Return: 2000000000 
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3.3.2.12 Clear Port Extension Data 

Command Format :SENSe<cnum>:CORRection:EXTension:AUTO:RESet 

Instruction This command clears old port extension delay and loss data in 
preparation for acquiring new data. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu Cal > Port Extension > Port Extension… > Reset 

Example :SENSe1:CORRection:EXTension:AUTO:RESet 

 

3.3.2.13 Calculate Method for Auto Port Extension 

Command Format :SENSe<cnum>:CORRection:EXTension:AUTO:CONFig <type> 

:SENSe<cnum>:CORRection:EXTension:AUTO:CONFig? 

Instruction This command sets/gets the frequency point to calculate the auto port 
extension, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={CSPN|AMKR|USPN} 

Return Enumeration 

Default CSPN 

Menu Cal > Port Extension > Automatic Port Extension > Method 

Example :SENSe1:CORRection:EXTension:AUTO:CONFig USPN 

:SENSe1:CORRection:EXTension:AUTO:CONFig? 

Return: USPN 

 

3.3.2.14 State of the Loss Compensation 
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Command Format :SENSe<cnum>:CORRection:EXTension:AUTO:LOSS <bool> 

:SENSe<cnum>:CORRection:EXTension:AUTO:LOSS? 

Instruction This command turns ON/OFF or gets the status of the loss 
compensation for the results of the auto port extension, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Cal > Port Extension > Automatic Port Extension > Setting > Include 
Loss 

Example :SENSe1:CORRection:EXTension:AUTO:LOSS OFF 

:SENSe1:CORRection:EXTension:AUTO:LOSS? 

Return: 0 

 

3.3.2.15 Adjust for Mismatch State 

Command Format :SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset <bool> 

:SENSe<cnum>:CORRection:EXTension:AUTO:DCOFfset? 

Instruction This command enables/disables or gets the usage of DC Offset value 
for the results of the auto port extension, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Cal > Port Extension > Automatic Port Extension > Setting > Adjust for 
Mismatch 

Example :SENSe1:CORRection:EXTension:AUTO:DCOFfset 0 
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:SENSe1:CORRection:EXTension:AUTO:DCOFfset? 

Return: 0 

 

3.3.2.16 User Span Start Frequency 

Command Format :SENSe<cnum>:CORRection:EXTension:AUTO:STARt <numeric> 

:SENSe<cnum>:CORRection:EXTension:AUTO:STARt? 

Instruction This command gets/sets the start frequency within the frequency 
range of the user specified auto port extension, for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the start frequency. 

Return Float, unit: Hz 

Default 100 kHz 

Menu Cal > Port Extension > Automatic Port Extension > User Span > Start 

Example :SENSe1:CORRection:EXTension:AUTO:STARt 1e6 

:SENSe1:CORRection:EXTension:AUTO:STARt? 

Return: 1000000 

 

3.3.2.17 User Span Stop Frequency 

Command Format :SENSe<cnum>:CORRection:EXTension:AUTO:STOP <numeric> 

:SENSe<cnum>:CORRection:EXTension:AUTO:STOP? 

Instruction This command get/set the stop frequency within the frequency range 
of the user specified auto port extension, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the stop frequency. 

Return Float, unit:Hz 
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Default Maximum frequency of the analyzer 

Menu Cal > Port Extension > Automatic Port Extension > User Span > Stop 

Example :SENSe1:CORRection:EXTension:AUTO:STOP 1e9 

:SENSe1:CORRection:EXTension:AUTO:STOP? 

Return: 1000000000 

 

3.3.2.18 Madia Type 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT<pnum>:MEDium 
<type> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:MEDium? 

Instruction Sets and returns the media type of the added fixture or transmission 
line. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<type>:={COAX|WAVE}. 

Return String 

Default COAX 

Menu Cal > Port Extension > Port Extension… > Media 

Example :SENSe1:CORRection:EXTension:PORT1:MEDium WAVE 

:SENSe1:CORRection:EXTension:PORT1:MEDium? 

Return: WAVE 

 

3.3.2.19 Cuttoff Freq of Waveguide 

Command Format SENSe<cnum>:CORRection:EXTension:PORT<pnum>:WGCutoff 
<numeric> 

:SENSe<cnum>:CORRection:EXTension:PORT<pnum>:WGCutoff? 

Instruction Sets and returns the cuttoff (minimum) frequency of the added 
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waveguide fixture or transmission line. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

<numeric>:Cutoff frequency in Hz. 

Return Float, unit:Hz 

Default 45MHz 

Menu Cal > Port Extension > Port Extension… > Media > Port Cutoff Freq 

Example :SENSe1:CORRection:EXTension:PORT1:WGCutoff 100e3 

:SENSe1:CORRection:EXTension:PORT1:WGCutoff? 

Return: 100000 

 

3.3.2.20 Couple To System Media Definition 

Command Format :SENSe<cnum>:CORRection:EXTension:PORT:SYSMedia <bool> 

:SENSe<cnum>:CORRection:EXTension:PORT:SYSMedia? 

Instruction Sets and returns the state of coupling with the system Media type. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:=ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default 1 or ON 

Menu Cal > Port Extension > Port Extension… > Media > Couple To System 
Media Definition 

Example :SENSe1:CORRection:EXTension:PORT:SYSMedia OFF 

:SENSe1:CORRection:EXTension:PORT:SYSMedia? 

Return: 0 

 

3.3.3 Fixtures 
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3.3.3.1 Port Match 

3.3.3.1.1 Command List 

State of Fixture Simulator :CALCulate<cnum>:FSIMulator:STATe 

State of the Match Circuit 
Embedding Function 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:STATe 

Touchstone Filename for The 
Matching Circuit Model 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>: 

USER:FILename 

Type of the Matching Circuit :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum> 
[:TYPE] 

C Value of the Matching Circuit :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>: 

PARameters:C<type> 

L Value of the Matching Circuit :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>: 

PARameters:L<type> 

R Value of the Matching Circuit :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>: 

PARameters:R<type> 

G Value of the Matching Circuit :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>: 

PARameters:G<type> 

 

3.3.3.1.2 State of Fixture Simulator 

Command Format :CALCulate<cnum>:FSIMulator:STATe <bool> 

:CALCulate<cnum>:FSIMulator:STATe? 

Instruction This command turns ON/OFF the fixture simulator function of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Apply Fixtures 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    97 

Example :CALCulate1:FSIMulator:STATe ON 

:CALCulate1:FSIMulator:STATe? 

Return: 1 

 

3.3.3.1.3 State of the Match Circuit Embedding Function 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:STATe <bool> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:STATe? 

Instruction This command turns ON/OFF the matching circuit embedding function 
when the fixture simulator function is ON, for all the ports of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > Port Matching 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:STATe ON 

:CALCulate1:FSIMulator:SENDed:PMCircuit:STATe? 

Return: 1 

 

3.3.3.1.4 Touchstone Filename for The Matching Circuit Model 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:US
ER:FILename <string> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:US
ER:FILename? 

Instruction This command sets/gets the file in which the information on the user-
defined matching circuit is saved (2-port touchstone file), for the ports 
of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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<pnum>:={[1]-4}, specifies the measurement port number. 

<string>: represents the file in which the information on the user-
defined matching circuit is saved (2-port touchstone file). 

Return None 

Default None 

Menu Cal > Fixtures > Fixtures Setup > Port Matching > Match S2P File 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:USER:FILename 
"local/test.s2p" 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:USER:FILename? 

Return: local/test.s2p 

 

3.3.3.1.5 Type of the Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>[:T
YPE] <type> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>[:T
YPE]? 

Instruction This command sets/gets the type of the matching circuit, for the ports 
of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={NONE|SLPC|PCSL|PLSC|SCPL|PLPC|SCPC|PCSC|SLPL| 

PLSL|USER}. 

"NONE": Specifies no-circuit. 

"SLPC": Specifies the circuit that consists of series L and shunt C. 

"PCSL": Specifies the circuit that consists of shunt C and series L. 

"PLSC": Specifies the circuit that consists of shunt L and series C. 

"SCPL": Specifies the circuit that consists of series C and shunt L. 

"PLPC": Specifies the circuit that consists of shunt L and shunt C. 

"SCPC": Specifies the circuit that consists of series C and shunt C.  

"PCSC": Specifies the circuit that consists of shunt C and series C. 
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"SLPL": Specifies the circuit that consists of series L and shunt L. 

"PLSL": Specifies the circuit that consists of shunt L and series L. 

"USER": Specifies the user-defined circuit. 

Return Enumeration 

Default SLPC 

Menu Cal > Fixtures > Fixtures Setup > Port Matching > Circuit Model 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT PLSL 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1? 

Return: PLSL 

 

3.3.3.1.6 C Value of the Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:C<type> <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:C<type>? 

Instruction This command sets/gets the C value of the matching circuit, for the 
ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={[1]-2} 

<numeric>:represents the C value of the matching circuit. 

Return Float, unit F (farad) 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Port Matching > Circuit Model 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:C 
10e-9 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:C? 

Return: 1e-08 
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3.3.3.1.7 L Value of the Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:L<type> <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:L<type>? 

Instruction This command sets/gets the L value of the matching circuit, for the 
ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={[1]-2} 

<numeric>:represents the L value of the matching circuit. 

Return Float, unit H (henry) 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Port Matching > Circuit Model 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:L1 5 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:L1? 

Return: 5 

 

3.3.3.1.8 R Value of the Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:R<type> <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:R<type>? 

Instruction This command sets/gets the R value of the matching circuit, for the 
ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={[1]-2} 

<numeric>:represents the R value of the matching circuit. 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    101 

Return Float, unit ohm 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Port Matching > Circuit Model 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:R2 
25 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:R2? 

Return: 25 

 

3.3.3.1.9 G Value of the Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:G<type> <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:PMCircuit:PORT<pnum>:PA
Rameters:G<type>? 

Instruction This command sets/gets the G value of the matching circuit, for the 
ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={[1]-2} 

<numeric>:represents the G value of the matching circuit. 

Return Float, unit S (siemens) 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Port Matching > Circuit Model 

Example :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:G1 
10 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:G1? 

Return: 10 

 

3.3.3.2 Port Z… 
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3.3.3.2.1 Command List 

State of Port Z 
Conversion 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:STATe 

Impedance of 
Port Z 
Conversion 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:Z0[:R] 

Impedance 
(Real) of Port Z 
Conversion 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:REAL 

Impedance 
(Imaginary) of 
Port Z 
Conversion 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>:IMAGinary 

 

3.3.3.2.2 State of Port Z Conversion 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:STATe <bool> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:STATe? 

Instruction This command turns ON/OFF the port impedance conversion function 
when the fixture simulator function is ON, for all the ports of the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > Port Z Conversion 

Example :CALCulate1:FSIMulator:SENDed:ZCONversion:STATe ON 

:CALCulate1:FSIMulator:SENDed:ZCONversion:STATe? 

Return: 1 

 

3.3.3.2.3 Impedance of Port Z Conversion 
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Command Format :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>
:Z0[:R] <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>
:Z0[:R]? 

Instruction This command sets/gets the impedance value for the port impedance 
conversion function, for the ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the impedance value, and the parameter range: 
0.001 to 1E7. 

Return Float, unit: ohm 

Default 50 

Menu Cal > Fixtures > Fixtures Setup > Port Z Conversion > R 

Example :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:Z0 100 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:Z0? 

Return: 100 

 

3.3.3.2.4 Impedance (Real) of Port Z Conversion 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>
:REAL <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>
:REAL? 

Instruction This command sets/gets the impedance value (real part) for the port 
impedance conversion function, for the ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the impedance value (real part), and the 
parameter range: 0.001 to 1E7. 

Return Float, unit: ohm 
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Default 50 

Menu Cal > Fixtures > Fixtures Setup > Port Z Conversion > R 

Example :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:REAL 75 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:REAL? 

Return: 75 

 

3.3.3.2.5 Impedance (Imaginary) of Port Z Conversion 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>
:IMAGinary <numeric> 

:CALCulate<cnum>:FSIMulator:SENDed:ZCONversion:PORT<pnum>
:IMAGinary? 

Instruction This command sets/gets the impedance value (imaginary part) for the 
port impedance conversion function, for the ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the impedance value (imaginary part), and the 
parameter range: -1E+18 ~ 1E+18. 

Return Float, unit: ohm 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Port Z Conversion > jX 

Example :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:IMAGinary 
100 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:IMAGinary? 

Return: 100 

 

3.3.3.3 2-Port DeEmbed 

3.3.3.3.1 Command List 

State of the Network :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:STATe 
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De-embedding 
Function 

Type of the Network 
De-embedding 
Function 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>[:TYPE] 

Touchstone Filename 
for the Network De-
embedding Function 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:USER: 

FILename 

State of the Reverse 
Adapter Ports 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:SNP: 

REVerse 

 

3.3.3.3.2 State of the Network De-embedding Function 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:STATe <bool> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:STATe? 

Instruction This command turns ON/OFF the network de-embedding function 
when the fixture simulator function is ON, for all the ports of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > 2 Port De-embedding 

Example :CALCulate1:FSIMulator:SENDed:DEEMbed:STATe ON 

:CALCulate1:FSIMulator:SENDed:DEEMbed:STATe? 

Return: 1 

 

3.3.3.3.3 Type of the Network De-embedding Function 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>[:T
YPE] <type> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>[:T
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YPE]? 

Instruction This command sets/gets the type of the network de-embedding 
function, for the ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={NONE|USER} 

"NONE": Specifies no network de-embedding. 

"USER": Specifies the user-defined network de-embedding. 

Return Enumeration 

Default NONE 

Menu Cal > Fixtures > Fixtures Setup > 2 Port De-embedding > De-
embedding Type 

Example :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1 USER 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1? 

Return: USER 

 

3.3.3.3.4 Touchstone Filename for the Network De-embedding Function 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:US
ER:FILename <string> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:US
ER:FILename? 

Instruction This command sets/gets the file in which the information on the user-
defined network for the network de-embedding function is saved (2-
port touchstone file), for the ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<string>: represents the file in which the information on the user-
defined network for the network de-embedding function is saved (2-
port touchstone file). 

javascript:BSSCPopup('../../../Links/com_ref_network.htm',400,150);
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Return None 

Default None 

Menu Cal > Fixtures > Fixtures Setup > 2 Port De-embedding > Select De-
embedding 

Example :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:USER:FILename 
"local/test.s2p" 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:USER:FILename? 

Return: local/test.s2p 

 

3.3.3.3.5 State of the Reverse Adapter Ports 

Command Format :CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:SN
P:REVerse <bool> 

:CALCulate<cnum>:FSIMulator:SENDed:DEEMbed:PORT<pnum>:SN
P:REVerse? 

Instruction This command set and read whether or not to reverse ports on a 2-port 
fixture or adapter to be de-embedded. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > 2 Port De-embedding > Reverse 
Adapter Ports 

Example :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:SNP:REVerse ON 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:SNP:REVerse? 

Return: 1 

3.3.3.4 N- Port DeEmbed 

3.3.3.4.1 Command List 
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State of 4 Port Network 
Embedding/De-embedding 
Feature 

:CALCulate<cnum>:FSIMulator:EMBed:STATe 

Connection Mode of 4 Port 
Network Embedding/De-
embedding Feature 

:CALCulate<cnum>:FSIMulator:EMBed:TYPE 

Specifies Port Connections in 
Type A 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:A:PORTs 

Specifies Port Connections in 
Type B 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:B:PORTs 

Specifies Port Connections in 
Type C 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:C:PORTs 

Processing Type of Network :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:TYPE 

4 Port Touchstone Filename for 
the Network Embedding/De-
embedding Feature 

:CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:FILename 

 

3.3.3.4.2 State of 4 Port Network Embedding/De-embedding Feature 

Command Format :CALCulate<cnum>:FSIMulator:EMBed:STATe <bool> 

:CALCulate<cnum>:FSIMulator:EMBed:STATe? 

Instruction This command turns ON/OFF the 4-port network embedding/de-
embedding feature when the fixture simulator feature is ON, for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed 

Example :CALCulate1:FSIMulator:EMBed:STATe ON 

:CALCulate1:FSIMulator:EMBed:STATe? 

Return: 1 
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3.3.3.4.3 Connection Mode of 4 Port Network Embedding/De-embedding Feature 

Command Format :CALCulate<cnum>:FSIMulator:EMBed:TYPE <type> 

:CALCulate<cnum>:FSIMulator:EMBed:TYPE? 

Instruction This command selects a connection type (Topology), for the 4-port 
network embedding/de-embedding feature for channels. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={A|B|C} 

"A":Specifies connection type A. 

"B":Specifies connection type B. 

"C":Specifies connection type C. 

Return Enumeration 

Default A 

Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed > 
Topology 

Example :CALCulate1:FSIMulator:EMBed:TYPE B 

:CALCulate1:FSIMulator:EMBed:TYPE? 

Return: B 

 

3.3.3.4.4 Specifies Port Connections in Type A 

SNA NetWork1 DUT
1

2 4

3a

b

 

Command Format :CALCulate<cnum>:FSIMulator:EMBed:TOPology:A:PORTs 
<numeric1>,<numeric 2> 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:A:PORTs? 

Instruction This command sets/gets the test port assignment when the 
connection type (Topology) is set to A, for the 4-port network 
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embedding/de-embedding feature for selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric1>: VNA Port number assigned to a in above graphic. 

<numeric2>: VNA Port number assigned to b in above graphic. 

Return Data array 

Default 1,2 

Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed 

Example :CALCulate1:FSIMulator:EMBed:TOPology:A:PORTs 2,1 

:CALCulate1:FSIMulator:EMBed:TOPology:A:PORTs? 

Return: 2,1 

 

3.3.3.4.5 Specifies Port Connections in Type B 

SNA NetWork1 DUT
1

2 4

3a

b

SNA
c

 

Command Format :CALCulate<cnum>:FSIMulator:EMBed:TOPology:B:PORTs 
<numeric1>,<numeric2>,<numeric3> 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:B:PORTs? 

Instruction This command sets/gets test port assignment when the connection 
type (Topology) is set to B, for the 4-port network embedding/de-
embedding feature for selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric1>: VNA Port number assigned to a in above graphic. 

<numeric2>: VNA Port number assigned to b in above graphic. 

<numeric3>: VNA Port number assigned to c in above graphic. 

Return Data array 

Default 1,2,3 
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Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed 

Example :CALCulate1:FSIMulator:EMBed:TOPology:B:PORTs 2,1,3 

:CALCulate1:FSIMulator:EMBed:TOPology:B:PORTs? 

Return: 2,1,3 

 

3.3.3.4.6 Specifies Port Connections in Type C 

SNA NetWork1 DUT
1

2 4

3a

b

SNANetWork2
3

4 2

1 c

d

 

Command Format :CALCulate<cnum>:FSIMulator:EMBed:TOPology:C:PORTs 
<numeric1>,<numeric2>,<numeric3>,<numeric4> 

:CALCulate<cnum>:FSIMulator:EMBed:TOPology:C:PORTs? 

Instruction This command sets/gets test port assignment when the connection 
type (Topology) is set to C, for the 4-port network embedding/de-
embedding feature for selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric1>: VNA Port number assigned to a in above graphic. 

<numeric2>: VNA Port number assigned to b in above graphic. 

<numeric3>: VNA Port number assigned to c in above graphic. 

<numeric4>: VNA Port number assigned to d in above graphic. 

Return Data array 

Default 1,2,3,4 

Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed 

Example :CALCulate1:FSIMulator:EMBed:TOPology:C:PORTs 2,1,3,4 

:CALCulate1:FSIMulator:EMBed:TOPology:C:PORTs? 

Return: 2,1,3,4 

 

3.3.3.4.7 Processing Type of Network 
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Command Format :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:TYPE 
<type> 

:CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:TYPE? 

Instruction This command sets/gets the processing type for networks, for the 4-
port network embedding/de-embedding feature for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the network port number. 

<type>:={NONE|EMBed|DEEMbed} 

"NONE": Specifies no-processing. 

"EMBed": Specifies embedding. 

"DEEMbed": Specifies de-embedding. 

Return Enumeration 

Default NONE 

Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed 

Example :CALCulate1:FSIMulator:EMBed:NETWork1:TYPE DEEMbed 

:CALCulate1:FSIMulator:EMBed:NETWork1:TYPE? 

Return: DEEM 

 

3.3.3.4.8 4 Port Touchstone Filename for the Network Embedding/De-embedding Feature 

Command Format :CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:FILename 
<string> 

:CALCulate<cnum>:FSIMulator:EMBed:NETWork<pnum>:FILename? 

Instruction This command specifies a file in which the information of network 
(which you want to embed/de-embed using the 4-port network 
embedding/de-embedding feature) is saved for the selected channel. 
The file is saved as a 4-port touchstone file with the ".s4p" extension. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the network port number. 
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<string>: represents the file in which the information of network (which 
you want to embed/de-embed using the 4-port network 
embedding/de-embedding feature). 

Return None 

Default None 

Menu Cal > Fixtures > Fixtures Setup > 4/6/8-Port Embed/De-embed 

Example :CALCulate1:FSIMulator:EMBed:NETWork1:FILename "local/test.s4p" 

:CALCulate1:FSIMulator:EMBed:NETWork1:FILename? 

Return: local/test.s4p 

 

3.3.3.5 Differential Port Match 

3.3.3.5.1 Command List 

State of the Differential Port 
Matching Function 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:STATe 

Type of the Differential Port 
Matching Circuit 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>[
:TYPE] 

Touchstone Filename for the 
Differential Port Matching 
Circuit 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:
USER:FILename 

C Value of the Differential Port 
Matching Circuit 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:
PARameters:C 

L Value of the Differential Port 
Matching Circuit 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:P
ARameters:L 

R Value of the Differential Port 
Matching Circuit 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:P
ARameters:R 

G Value of the Differential Port 
Matching Circuit 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:P
ARameters:G 

 

3.3.3.5.2 State of the Differential Port Matching Function 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:STATe <bool> 
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:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:STATe? 

Instruction This command turns ON/OFF the differential port matching function 
when the fixture simulator function is ON, for all the logical ports of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Enable 
Differential Port Matching 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:STATe ON 

:CALCulate1:FSIMulator:BALun:DMCircuit:STATe? 

Return: 1 

 

3.3.3.5.3 Type of the Differential Port Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>[:TY
PE] <type> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>[:TY
PE]? 

Instruction This command sets/gets the type of the differential port matching 
circuit, for the logical ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<type>:={NONE|PLPC|USER} 

"NONE": Specifies no-circuit. 

"PLPC": Specifies the circuit that consists of shunt L and shunt C. 

"USER": Specifies the user-defined circuit. 

Return Enumeration 

Default NONE 
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Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Select 
Circuit 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1 PLPC 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1? 

Return: PLPC 

 

3.3.3.5.4 Touchstone Filename for the Differential Port Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:US
ER:FILename <string> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:US
ER:FILename? 

Instruction This command sets/gets the file in which the information on the user-
defined network for the differential port matching function is saved (2-
port touchstone file), for the logical ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<string>: represents the file in which the information on the user-
defined network for the differential port matching function is saved (2-
port touchstone file). 

Return String 

Default None 

Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Browse... 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:USER:FILename 
"local/test.s2p" 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:USER:FILename? 

Return: local/test.s2p 

 

3.3.3.5.5 C Value of the Differential Port Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
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Rameters:C <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
Rameters:C? 

Instruction This command sets/gets the C value of the differential port matching 
circuit, for the logical ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the C value of the differential port matching 
circuit. 

Return Float, unit F (farad) 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Shunt L 
- Shunt C 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:C  
1e-11 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:C? 

Return: 1e-11 

 

3.3.3.5.6 L Value of the Differential Port Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
Rameters:L <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
Rameters:L? 

Instruction This command sets/gets the L value of the differential port matching 
circuit, for the logical ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the L value of the differential port matching 
circuit. 

Return Float, unit H (henry) 
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Default 0 

Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Shunt L 
- Shunt C 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:L 
1e-8 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:L? 

Return: 1e-8 

 

3.3.3.5.7 R Value of the Differential Port Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
Rameters:R <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
Rameters:R? 

Instruction This command sets/gets the R value of the differential port matching 
circuit, for the logical ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the R value of the differential port matching 
circuit. 

Return Float, unit ohm 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Shunt L 
- Shunt C 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:R 25 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:R? 

Return: 25 

 

3.3.3.5.8 G Value of the Differential Port Matching Circuit 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
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Rameters:G <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DMCircuit:BPORt<pnum>:PA
Rameters:G? 

Instruction This command sets/gets the G value of the differential port matching 
circuit, for the logical ports of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the G value of the differential port matching 
circuit. 

Return Float, unit S (siemens) 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Differential Port Matching > Shunt L 
- Shunt C 

Example :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:G  
5e-2 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:G? 

Return: 5e-2 

 

3.3.3.6 Differential Z 

3.3.3.6.1 Command List 

State of the Differential Port Z 
Conversation Function 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:STATe 

Impedance of the Differential 
Port 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>: 

Z0[:R] 

Impedance (Real) of the 
Differential Port 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>: 

REAL 

Impedance (Imaginary) of the 
Differential Port 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>: 

IMAGinary 
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3.3.3.6.2 State of the Differential Port Z Conversation Function 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DZConversion:STATe <bool> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:STATe? 

Instruction This command turns ON/OFF the differential port impedance 
conversion function when the fixture simulator function is ON, for all 
the logical ports of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > Differential Z > Enable Differential Z 
Conversation 

Example :CALCulate1:FSIMulator:BALun:DZConversion:STATe ON 

:CALCulate1:FSIMulator:BALun:DZConversion:STATe? 

Return: 1 

 

3.3.3.6.3 Impedance of the Differential Port 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>
:Z0[:R] <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>
:Z0[:R]? 

Instruction Sets or get the impedance value for the differential port impedance 
conversion function. Set either this single value or set the real and 
imaginary parts separately. The imaginary part is set to 0.0 using this 
command. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the impedance value, and the parameter range: 
1E-3 ~ 1E7. 
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Return Float, unit: ohm 

Default 100 

Menu Cal > Fixtures > Fixtures Setup > Differential Z > R 

Example :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:Z0 100 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:Z0? 

Return: 100 

 

3.3.3.6.4 Impedance (Real) of the Differential Port 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>
:REAL <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>
:REAL? 

Instruction This command sets/gets the impedance value (real part) for the 
differential port impedance conversion function, for the logical ports of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the impedance value (real part), and the 
parameter range: 1E-3 ~ 1E7. 

Return Float, unit: ohm 

Default 100 

Menu Cal > Fixtures > Fixtures Setup > Differential Z > R 

Example :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:REAL 100 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:REAL? 

Return: 100 

 

3.3.3.6.5 Impedance (Imaginary) of the Differential Port 

Command Format :CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>
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:IMAGinary <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:DZConversion:BPORt<pnum>
:IMAGinary? 

Instruction This command sets/gets the impedance value (imaginary part) for the 
differential port impedance conversion function, for the logical ports of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the impedance value (imaginary part), and the 
parameter range: -1E+18 ~ 1E+18. 

Return Float, unit: ohm 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Differential Z > jX 

Example :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:IMAGinary 
100 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:IMAGinary? 

Return: 100 

 

3.3.3.7 Common Z 

3.3.3.7.1 Command List 

State of the Common 
Port Z Conversation 
Function 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:STATe 

Impedance of the 
Common Port 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>: 

Z0[:R] 

Impedance (Real) of the 
Common Port 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>: 

REAL 

Impedance (Imaginary) 
of the Common Port 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>: 

IMAGinary 
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3.3.3.7.2 State of the Common Port Z Conversation Function 

Command Format :CALCulate<cnum>:FSIMulator:BALun:CZConversion:STATe <bool> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:STATe? 

Instruction This command turns ON/OFF the common port impedance conversion 
function when the fixture simulator function is ON, for all the logical 
ports of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Cal > Fixtures > Fixtures Setup > Common Z > Enable Common Z 
Conversation 

Example :CALCulate1:FSIMulator:BALun:CZConversion:STATe ON 

:CALCulate1:FSIMulator:BALun:CZConversion:STATe? 

Return: 1 

 

3.3.3.7.3 Impedance of the Common Port 

Command Format :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>
:Z0[:R] <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>
:Z0[:R]? 

Instruction Sets /get the impedance value for the differential port impedance 
conversion function. Set either this single value or set the real and 
imaginary parts separately. The imaginary part is set to 0.0 using this 
command. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the impedance value, and the parameter range: 
1E-3 ~ 1E7. 
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Return Float, unit: ohm 

Default 25 

Menu Cal > Fixtures > Fixtures Setup > Common Z > R 

Example :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:Z0 100 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:Z0? 

Return: 100 

 

3.3.3.7.4 Impedance (Real) of the Common Port 

Command Format :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>
:REAL <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>
:REAL? 

Instruction This command sets/gets the impedance value (real part) for the 
common port impedance conversion function, for the logical ports of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the impedance value (real part), and the 
parameter range: 1E-3 ~ 1E7. 

Return Float, unit: ohm 

Default 25 

Menu Cal > Fixtures > Fixtures Setup > Common Z > R 

Example :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:REAL 100 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:REAL? 

Return: 100 

 

3.3.3.7.5 Impedance (Imaginary) of the Common Port 

Command Format :CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>
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:IMAGinary <numeric> 

:CALCulate<cnum>:FSIMulator:BALun:CZConversion:BPORt<pnum>
:IMAGinary? 

Instruction This command sets/gets the impedance value (imaginary part) for the 
common port impedance conversion function, for the logical ports of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-2},specifies the logical port number. 

<numeric>:represents the impedance value (imaginary part), and the 
parameter range: -1E+18 ~ 1E+18. 

Return Float, unit: ohm 

Default 0 

Menu Cal > Fixtures > Fixtures Setup > Common Z > jX 

Example :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:IMAGinary 
100 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:IMAGinary? 

Return: 100 

 

3.3.4 Ecal 

3.3.4.1 Command List 

Calibration Type :SENSe<cnum>:CORRection:COLLect:METHod:TYPE? 

ECal Execute 1 Port Calibration :SENSe{[1]-256}:CORRection:COLLect:ECal:SOLT1 

ECal Execute 2 Port Calibration :SENSe{[1]-256}:CORRection:COLLect:ECal:SOLT2 

ECal Execute 3 Port Calibration :SENSe{[1]-256}:CORRection:COLLect:ECal:SOLT3 

ECal Execute 4 Port Calibration :SENSe{[1]-256}:CORRection:COLLect:ECal:SOLT4 

ECal Execute Response 
Calibration 

:SENSe<cnum>:CORRection:COLLect:ECal:THRU 

ECal Execute Enhanced 
Response Calibration 

:SENSe<cnum>:CORRection:COLLect:ECal:ERESponse 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    125 

ECal Unknown Thru State :SENSe<cnum>:CORRection:COLLect:ECal:UTHRU[:STATe] 

ECal Confidence Check :SENSe<cnum>:CORRection:COLLect:ECal:CCHeck[:ACQuire] 

ECal Orientation :SENSe<cnum>:CORRection:COLLect:ECal:IORIentation[:STATe] 

ECal Characterization 
Information 

:SENSe:CORRection:COLLect:ECal:INFormation? 

 

3.3.4.2 Calibration Type 

Command Format :SENSe<cnum>:CORRection:COLLect:METHod:TYPE? 

Instruction This command gets the calibration type selected by the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu None 

Example :SENSe1:CORRection:COLLect:METHod:TRL4 1,2,3,4 

:SENSe1:CORRection:COLLect:METHod:TYPE? 

Return: TRL4 

 

3.3.4.3 ECal Execute 1 Port Calibration 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:SOLT1 <pnum> 

Instruction This command executes 1-port calibration of the specified port of 
selected channel using the ECal  module. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={1|2|3|4}, specifies the measurement port number. 

Return None 

Default None 
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Menu Cal > ECal > ECal… > Cal Type 

Example :SENSe1:CORRection:COLLect:ECal:SOLT1 1 

 

3.3.4.4 ECal Execute 2 Port Calibration 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:SOLT2  
<pnum1>,<pnum2> 

Instruction This command executes full 2-port calibration between the specified 2 
ports of selected channel using the ECal module. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies a port for full 2-port calibration. 

<pnum2>:={1|2|3|4}, specifies a port for full 2-port calibration. 

If you specify the same port number to 2 port numbers, an error occurs 
when executed. The order of the 2 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > ECal > ECal… > Cal Type 

Example :SENSe1:CORRection:COLLect:ECal:SOLT2 1,2 

 

3.3.4.5 ECal Execute 3 Port Calibration 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:SOLT3  
<pnum1>,<pnum2>,<pnum3> 

Instruction This command executes full 3-port calibration between the specified 3 
ports of selected channel using the ECal module. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies a port for full 3-port calibration. 

<pnum2>:={1|2|3|4}, specifies a port for full 3-port calibration. 
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<pnum3>:={1|2|3|4}, specifies a port for full 3-port calibration. 

If you specify the same port number to 3 port numbers, an error occurs 
when executed. the order of the 3 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > ECal > ECal… > Cal Type 

Example :SENSe1:CORRection:COLLect:ECal:SOLT3 1,2,3 

 

3.3.4.6 ECal Execute 4 Port Calibration 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:SOLT4  
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

Instruction This command executes full 4-port calibration between the specified 4 
ports of selected channel using the ECal module. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies a port for full 4-port calibration. 

<pnum2>:={1|2|3|4}, specifies a port for full 4-port calibration. 

<pnum3>:={1|2|3|4}, specifies a port for full 4-port calibration. 

<pnum4>:={1|2|3|4}, specifies a port for full 4-port calibration. 

If you specify the same port number to 4 port numbers, an error occurs 
when executed. the order of the 4 port numbers to be specified is 
arbitrary. 

Return None 

Default None 

Menu Cal > ECal > ECal… > Cal Type 

Example :SENSe1:CORRection:COLLect:ECal:SOLT4 1,2,3,4 

 

3.3.4.7 ECal Execute Response Calibration 
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Command Format :SENSe<cnum>:CORRection:COLLect:ECal:THRU  
<pnum1>,<pnum2> 

Instruction This command executes response calibration between the two 
specified ports of selected channel using the ECal module. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

Return None 

Default None 

Menu Cal > ECal > ECal… > Cal Type 

Example :SENSe1:CORRection:COLLect:ECal:THRU 1,2 

 

3.3.4.8 ECal Execute Enhanced Response Calibration 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:ERESponse  
<pnum1>,<pnum2> 

Instruction This command executes enhanced response calibration between the 
two specified ports of selected channel using the ECal module. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum1>:={1|2|3|4}, specifies the response port number. 

<pnum2>:={1|2|3|4}, specifies the stimulus port number. 

Return None 

Default None 

Menu Cal > ECal > ECal… > Cal Type 

Example :SENSe1:CORRection:COLLect:ECal:ERESponse 1,2 

 

3.3.4.9 ECal Unknown Thru State 
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Command Format :SENSe<cnum>:CORRection:COLLect:ECal:UTHRU[:STATe] <bool> 

:SENSe<cnum>:CORRection:COLLect:ECal:UTHRU[:STATe]? 

Instruction This command sets/gets Unknown Thru On/Off for ECal. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default 0 

Menu Cal > ECal > ECal… > Cal Type >Unknown Thru  

Example :SENSe1:CORRection:COLLect:ECal:UTHRU 1 

:SENSe1:CORRection:COLLect:ECal:UTHRU? 

Return:1 

 

3.3.4.10 ECal Confidence Check 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:CCHeck[:ACQuire] 

Instruction Reads the 'confidence data' associated with the specified ECal module 
and puts it into memory. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu Cal > ECal > Confidence Check… 

Example :SENSe1:CORRection:COLLect:ECal:CCHeck 

 

3.3.4.11 ECal Orientation 

Command Format :SENSe<cnum>:CORRection:COLLect:ECal:IORIentation[:STATe] 
<bool> 
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:SENSe<cnum>:CORRection:COLLect:ECal:IORIentation[:STATe]? 

Instruction Specifies whether or not the VNA should perform orientation of the 
ECal module during calibration.  Orientation is a technique by which 
the VNA automatically determines which ports of the module are 
connected to which ports of the VNA.  Orientation begins to fail at very 
low power levels or if there is much attenuation in the path between 
the VNA and the ECal module.  

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default 1 

Menu Cal > ECal > Orientation 

Example :SENSe1:CORRection:COLLect:ECal:ORIentation 1 

:SENSe1:CORRection:COLLect:ECal:ORIentation? 

Return:1 

 

3.3.4.12 ECal Characterization Information 

Command Format :SENSe:CORRection:COLLect:ECal:INFormation? 

Instruction Reads the identification and characterization information from the 
specified ECal module. 

Parameter Type None 

Return None 

Default None 

Menu Cal > ECal > Characterization… 

Example :SENSe:CORRection:COLLect:ECal:INFormation? 

 

3.4 Display Commands 
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3.4.1 Trace Setup 

3.4.1.1 Command List 

Get all Trace list :DISPlay:TRACe:LIST? 

Set Active trace :DISPlay:TRACe<tnum>:ACTivate 

Set or get active trace :DISPlay:WINDow<wnum>:TRACe<tnum>:SELect 

The title of the trace :DISPlay:TRACe<tnum>:TITLe:DATA 

Enable the trace title :DISPlay:TRACe<tnum>:TITLe[:STATe] 

Add New Trace :DISPlay:ADD:FUNCtion:EXECute TRC 

Add New Trace +Channel :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

Add New Trace +Window :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

Add New Trace+Channel+Window :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

Trace Display State :DISPlay:WINDow<wnum>:TRACe<tnum> 

Move Trace to Window :DISPlay:MEASure<tnum>:MOVE 

Trace Hold Type :CALCulate<cnum>:TRACe<tnum>:HOLD[:TYPE] 

Reset Trace :CALCulate<cnum>:TRACe<tnum>:HOLD:CLEar 

Active Trace Maximization :DISPlay:WINDow<wnum>:MAXimize 

 

3.4.1.2 Get all Trace list 

Command Format :DISPlay:TRACe:LIST? 

Instruction Get the list of all channel. 

Parameter Type None 

Return Integer 

Default 1 

Menu Display > Trace Setup > Select 

Example :DISPlay:TRACe:LIST? 

Return:1,2,3,4,5 
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3.4.1.3 Set Active trace 

Command Format :DISPlay:TRACe<tnum>:ACTivate 

Instruction This command specifies selected trace as the active trace. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default 1 

Menu Display > Trace Setup > Select 

Example :DISPlay:TRACe2:ACTivate 

 

3.4.1.4 Set or get active trace 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:SELect 

:DISPlay:WINDow:TRACe:SELect? 

:DISPlay:TRACe<tnum>:SELect 

:DISPlay:TRACe:SELect? 

Instruction This command sets/gets the active trace number. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Integer 

Default 1 

Menu Display > Trace Setup > Select 

Example :DISPlay:WINDow2:TRACe3:SELect 

:DISPlay:WINDow2:TRACe3:SELect? 

Return: 2 

 

:DISPlay:TRACe2:SELect 
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:DISPlay:TRACe:SELect? 

Return:2 

 

3.4.1.5 The title of the trace 

Command Format :DISPlay:TRACe<tnum>:TITLe:DATA <string> 

:DISPlay:TRACe<tnum>:TITLe:DATA? 

Instruction Sets or gets the title for the specified trace 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<string>: represents the title for the specified trace , and the 
parameter range: 255 characters or less. 

Return String  

Default 1 

Menu Display > Trace Setup > Trace Title 

Example :DISPlay:TRACe 1:TITLe:DATA siglent 

:DISPlay:TRACe1:TITLe:DATA? 

Return :"siglent" 

 

3.4.1.6 Enable the trace title 

Command Format :DISPlay:TRACe<tnum>:TITLe[:STATe] <bool> 

:DISPlay:TRACe<tnum>:TITLe[:STATe]? 

Instruction Turns ON or OFF the trace title. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default 0 

Menu Display > Trace Setup > Trace Title > Enabled 
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Example :DISPlay:TRACe1:TITLe:STATe 1 

:DISPlay:TRACe1:TITLe:STATe? 

Return :1 

 

3.4.1.7 Add New Trace 

Command Format :DISPlay:ADD:FUNCtion:EXECute TRC 

Instruction Adds a new trace to the current working window and channel. 

Parameter Type None 

Return None 

Default None 

Menu Display > Trace Setup > Add Trace > New Trace 

Example :DISPlay:ADD:FUNCtion:EXECute TRC 

 

3.4.1.8 Add New Trace +Channel 

Command Format :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

Instruction Add a new channel and trace in the current working window. 

Parameter Type None  

Return None 

Default None 

Menu Display > Trace Setup > Add Trace > New Trace +Channel 

Example :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

 

3.4.1.9 Add New Trace +Window 

Command Format :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

Instruction Add a new window and trace in the current working channel. 
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Parameter Type None  

Return None 

Default None 

Menu Display > Trace Setup > Add Trace > New Trace +Window 

Example :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

 

3.4.1.10 Add New Trace+Channel+Window 

Command Format :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

Instruction Add a new trace and new channel in a new window. 

Parameter Type None  

Return None 

Default None 

Menu Display > Trace Setup > Add Trace > New Trace+Channel+Window 

Example :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

 

3.4.1.11 Trace Display State 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum> <bool> 

:DISPlay:WINDow<wnum>:TRACe<tnum>? 

Instruction This command turns ON/OFF the trace display, for the selected trace 
of selected channel. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default None 
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Menu Display > Trace Setup > Add Trace / Delete Trace 

Example :DISPlay:WINDow1:TRACe5 1 

:DISPlay:WINDow1:TRACe5? 

Return: 1 

 

3.4.1.12 Move Trace to Window 

Command Format DISPlay:MEASure<tnum>:MOVE <numeric> 

Instruction Moves a trace associated with measurement number to the specified 
window. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the number to the specified window, and the 
parameter range: 1~200. 

Return None 

Default None 

Menu Display > Trace Setup > Move Trace 

Example :DISPlay:ADD:FUNCtion:EXECute TRC 

:DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

DISPlay:MEASure2:MOVE 2 

 

3.4.1.13 Trace Hold Type 

Command Format :CALCulate<cnum>:TRACe<tnum>:HOLD[:TYPE] <type> 

:CALCulate<cnum>:TRACe<tnum>:HOLD[:TYPE]? 

Instruction This command sets/gets maximum/minimum trace hold function to 
hold the active trace at the maximum or minimum point. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
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specified, <tnum> defaults to 1. 

<type>:={OFF|MAXimum|MINimum} 

Return Enumeration 

Default OFF 

Menu Display > Trace Setup > Trace Hold 

Example :CALCulate1:TRACe1:HOLD MAXimum 

:CALCulate1:TRACe1:HOLD? 

Return: MAX 

 

3.4.1.14 Reset Trace 

Command Format :CALCulate<cnum>:TRACe<tnum>:HOLD:CLEar 

Instruction This command clears/resets the trace hold function that holds the 
active trace at either the maximum or minimum point. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu Display > Trace Setup > Trace Hold > Restart 

Example :CALCulate1:TRACe1:HOLD:CLEar 

 

3.4.1.15 Active Trace Maximization 

Command Format :DISPlay:WINDow<wnum>:MAXimize <bool> 

:DISPlay:WINDow<wnum>:MAXimize? 

Instruction This command turns ON/OFF the maximization of the active trace of 
selected channel. 



VNA Series Programming Guide 

138                                                                                                                                                                                    int.siglent.com 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default None 

Menu Display > Trace Setup > Trace Maximize 

Example :DISPlay:WINDow1:MAXimize 1 

:DISPlay:WINDow1:MAXimize? 

Return: 1 

 

3.4.2 Channel Setup 

3.4.2.1 Command List 

Get all channel list :DISPlay:CHANnel:LIST? 

Set Active channel :DISPlay:CHANnel<cnum>ACTivate 

Set or get active channel :DISPlay:CHANnel<cnum>SELect 

The trace list of a channel :DISPlay:CHANnel<cnum>TRACe:LIST? 

The title of the channel :DISPlay:CHANnel<cnum>TITLe:DATA 

Enable the channel title :DISPlay:CHANnel<cnum>TITLe[:STATe] 

 

3.4.2.2 Get all channel list 

Command Format :DISPlay:CHANnel:LIST? 

Instruction Get the list of all channel. 

Parameter Type None 

Return Integer 

Default 1 

Menu Display > Channel Setup > Select 
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Example :DISPlay:CHANnel:LIST? 

Return:1,2,3,4 

 

3.4.2.3 Set Active channel 

Command Format :DISPlay:CHANnel<cnum>ACTivate 

Instruction This command specifies selected channel as the active channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default 1 

Menu Display > Channel Setup > Select 

Example :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

:DISPlay:CHANnel1:ACTivate 

 

3.4.2.4 Set or get active channel 

Command Format :DISPlay:CHANnel<cnum>SELect 

:DISPlay:CHANnel:SELect? 

Instruction This command sets/gets the active channel number. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Integer 

Default 1 

Menu Display > Channel Setup > Select 

Example :DISPlay:CHANnel2:SELect 

:DISPlay:CHANnel:SELect? 

Return: 2 
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3.4.2.5 The trace list of a channel 

Command Format :DISPlay:CHANnel<cnum>TRACe:LIST? 

Instruction Get the trace list of a specified channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Integer 

Default 1 

Menu Display > Channel Setup > Select 

Example There are Tr1 ,Tr2 and Tr4 in channel1, query the trace list in chhanel1: 

:DISPlay:CHANnel1:TRACe:LIST? 

Return:1,2,4 

 

3.4.2.6 The title of the channel 

Command Format :DISPlay:CHANnel<cnum>TITLe:DATA <string> 

:DISPlay:CHANnel<cnum>TITLe:DATA? 

Instruction Sets or gets the title for the specified channel 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<string>: represents the title for the specified channel, and the 
parameter range: 255 characters or less. 

Return String  

Default 1 

Menu Display > Channel Setup > Channel Title 

Example :DISPlay:CHANnel1:TITLe:DATA siglent 

:DISPlay:CHANnel1:TITLe:DATA? 

Return :"siglent" 
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3.4.2.7 Enable the channel title 

Command Format :DISPlay: CHANnel<cnum>TITLe[:STATe] <bool> 

:DISPlay:CHANnel<cnum>TITLe[:STATe]? 

Instruction Turns ON or OFF the channel title. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default 0 

Menu Display > Channel Setup > Channel Title > Enabled 

Example :DISPlay:CHANnel1:TITLe:STATe 1 

:DISPlay:CHANnel1:TITLe:STATe? 

Return :1 

 

3.4.3 Window Setup 

3.4.3.1 Command List 

Get all window list :DISPlay:WINDow:LIST? 

Window State :DISPlay:WINDow<wnum>:STATe 

Set Active window :DISPlay:WINDow<wnum>:ACTivate 

Set or get active window :DISPlay:WINDow<wnum>:SELect 

The trace list of a window :DISPlay:WINDow<wnum>:TRACe:LIST? 

The channel list of a window :DISPlay:WINDow<wnum>:CHANnel:LIST? 

The title of the window :DISPlay:WINDow<wnum>:TITLe:DATA 

Enable the window title :DISPlay:WINDow<wnum>:TITLe[:STATe] 

Set Window Layout :DISPlay:ARRange 

Active Window Maximization :DISPlay:MAXimize 

Clear Error Message :DISPlay:CCLear 
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3.4.3.2 Get all window list 

Command Format :DISPlay:WINDow:LIST? 

Instruction Get the list of all Windows. 

Parameter Type None 

Return Integer 

Default 1 

Menu Display > Window Setup > Select 

Example :DISPlay:WINDow:LIST? 

Return:1,2,3 

 

3.4.3.3 Window State 

Command Format :DISPlay:WINDow<wnum>:STATe <bool> 

:DISPlay:WINDow<wnum>:STATe? 

Instruction This command sets/gets the display state of selected window. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default None 

Menu None 

Example :DISPlay:WINDow2:STATe 1 

:DISPlay:WINDow2:STATe? 

Return: 1 

 

3.4.3.4 Set Active window 

Command Format :DISPlay:WINDow<wnum>:ACTivate 
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Instruction This command specifies selected window as the active window.(Write 
only). 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

Return None 

Default 1 

Menu Display > Window Setup > Select 

Example :DISPlay:WINDow2:ACTivate 

 

3.4.3.5 Set or get active window 

Command Format :DISPlay:WINDow<wnum>:SELect 

:DISPlay:WINDow:SELect? 

Instruction This command sets/gets the active window number. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

Return Integer 

Default 1 

Menu Display > Window Setup > Select 

Example :DISPlay:WINDow2:SELect 

:DISPlay:WINDow:SELect? 

Return: 2 

 

3.4.3.6 The trace list of a window 

Command Format :DISPlay:WINDow<wnum>:TRACe:LIST? 

Instruction Get the trace list of a specified window. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 
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Return Integer 

Default 1 

Menu Display > Trace Setup > Select 

Example There are Tr1 ,Tr2 and Tr4 in window1, query the trace list in window1: 

 

:DISPlay:WINDow1:TRACe:LIST? 

Return:1,2,4 

 

3.4.3.7 The channel list of a window 

Command Format :DISPlay:WINDow<wnum>:CHANnel:LIST? 

Instruction Get the channel list of a specified window. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

Return Integer 

Default 1 

Menu Display > Channel Setup > Select 

Example There are CH1 and CH3 in window1, query the channel list in window 
1: 

:DISPlay:WINDow1:CHANnel:LIST? 

Return:1,3 

 

3.4.3.8 The title of the window 

Command Format :DISPlay:WINDow<wnum>:TITLe:DATA <string> 

:DISPlay:WINDow<wnum>:TITLe:DATA? 

Instruction Sets or gets the title for the specified window 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<string>: represents the title for the specified window, and the 
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parameter range: 255 characters or less. 

Return String  

Default 1 

Menu Display > Window Setup > Window Title 

Example :DISPlay:WINDow1:TITLe:DATA siglent 

:DISPlay:WINDow1:TITLe:DATA? 

Return : "siglent" 

 

3.4.3.9 Enable the window title 

Command Format :DISPlay:WINDow<wnum>:TITLe[:STATe] <bool> 

:DISPlay:WINDow<wnum>:TITLe[:STATe]? 

Instruction Turns ON or OFF the window title. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean  

Default 0 

Menu Display > Window Setup > Window Title > Enabled 

Example :DISPlay:WINDow1:TITLe:STATe 1 

:DISPlay:WINDow1:TITLe:STATe? 

Return :1 

 

3.4.3.10 Set Window Layout 

Command Format :DISPlay:ARRange <type> 

Instruction Sets the layout of the windows on the LCD display. 

Parameter Type <type>:={TILE|OVERlay|STACk|SPLIt|QUAD|MEASure|CHANnel} 

Return Enumeration 
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Default OVERlat 

Menu Display > Window Setup > Window Layout 

Example :DISPlay:ARRange TILE 

 

3.4.3.11 Active Window Maximization 

Command Format :DISPlay:MAXimize <bool> 

:DISPlay:MAXimize? 

Instruction This command turns ON/OFF the window maximization of the active 
channel. If the maximization is set to ON, only the window of the active 
channel is maximized on the LCD display and the windows of the other 
channels are not displayed. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default 1 

Menu Display > Window Setup > Window Max 

Example :DISPlay:MAXimize ON 

:DISPlay:MAXimize? 

Return: 1 

 

3.4.3.12 Clear Error Message 

Command Format :DISPlay:CCLear 

Instruction This command clears the error message displayed in the status bar (at 
the bottom of the LCD display). 

Parameter Type None 

Return None 

Default None 

Menu None 
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Example :DISPlay:CCLear 

 

3.4.4 RefLine Setup 

3.4.4.1 Command List 

Activation HLine :DISPlay:WINDow<wnum>:HLINe<lnum>:ACTivate 

Delete HLine :DISPlay:WINDow<wnum>:HLINe<lnum>:DELete 

HLine State :DISPlay:WINDow<wnum>:HLINe<lnum>[:STATe] 

Set HLine name :DISPlay:WINDow<wnum>:HLINe<lnum>:NAME 

HLine value type :DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:TYPE 

HLine value absolute :DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:ABSolute 

HLine value relative :DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:RELative 

Set HLine colour :DISPlay:WINDow<wnum>:HLINe<lnum>:COLor 

Activation VLine :DISPlay:WINDow<wnum>:VLINe<lnum>:ACTivate 

Delete VLine :DISPlay:WINDow<wnum>:VLINe<lnum>:DELete 

VLine State :DISPlay:WINDow<wnum>:VLINe<lnum>[:STATe] 

Set VLine name :DISPlay:WINDow<wnum>:VLINe<lnum>:NAME 

VLine value type :DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:TYPE 

VLine value absolute :DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:ABSolute 

VLine value relative :DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:RELative 

Set VLine colour :DISPlay:WINDow<wnum>:VLINe<lnum>:COLor 

Set Refline all off :DISPlay:WINDow<wnum>:REFLine:AOFF 

Refline table type :DISPlay:WINDow<wnum>:REFLine:TABLe:TYPE 

 

3.4.4.2 Activation HLine 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:ACTivate 

Instruction Activate the Horizontal line. It will be displayed automatically after 
activation. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
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not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

Return None 

Default None  

Menu Display > RefLine Setup > HLine Select 

Example :DISP:WIND1:HLIN1:ACT 

 

3.4.4.3 Delete HLine 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:DELete 

Instruction Delete the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

Return None  

Default None  

Menu Display > RefLine Setup > Line Table > HLine >State>Delete 

Example :DISP:WIND1:HLIN1:DEL 

 

3.4.4.4 HLine State 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>[:STATe] <bool> 

:DISPlay:WINDow<wnum>:HLINe<lnum>[:STATe]? 

Instruction Set or get the state of the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 
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<bool>:= ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default 1 

Menu Display > RefLine Setup > Line Table > HLine >State 

Example :DISP:WIND1:HLIN1 1 

:DISP:WIND1:HLIN1? 

Return: 1 

 

3.4.4.5 Set HLine name 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:NAME <string> 

:DISPlay:WINDow<wnum>:HLINe<lnum>:NAME? 

Instruction Set or get the name of the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

<string>: Horizontal  line name 

Return string 

Default HL*(“*” stands for horizontal line number ) 

Menu Display > RefLine Setup > Line Table > HLine >name 

Example :DISP:WIND1:HLIN1:NAME hLine1 

:DISP:WIND1:HLIN1:NAME? 

Return: "hLine1" 

 

3.4.4.6 HLine value type 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:TYPE <type> 

:DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:TYPE? 
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Instruction Set or get the vlaule type of the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

<type>:={ABS|REL} 

Return Enumeration 

Default ABS 

Menu Display > RefLine Setup > Line Table >Hline >Value Type 

Example :DISP:WIND1:HLIN1:VAL:TYPE ABS 

:DISP:WIND1:HLIN1:VAL:TYPE? 

Return: ABS 

 

3.4.4.7 HLine value absolute 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:ABSolute <numeric> 

:DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:ABSolute? 

Instruction Set or get the absolute value of the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

<numeric>: the absolute value of the Horizontal line. 

Return Float  

Default Measurement of the median vertical range 

Menu Display > RefLine Setup > Line Table > HLine >Abs Value 

Example :DISP:WIND1:HLIN1:VAL:ABS -10 

:DISP:WIND1:HLIN1:VAL:ABS? 

Return: -10 
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3.4.4.8 HLine value relative 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:RELative <numeric> 

:DISPlay:WINDow<wnum>:HLINe<lnum>:VALue:RELative? 

Instruction Set or get the relative value of the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

<numeric>: the relative value of the Horizontal line,and range is 0 to 
100. 

Return Float  

Default 50 

Menu Display > RefLine Setup > Line Table > HLine > Rel Value 

Example :DISP:WIND1:HLIN1:VAL:REL 60 

:DISP:WIND1:HLIN1:VAL:REL? 

Return: 60 

 

3.4.4.9 Set HLine colour 

Command Format :DISPlay:WINDow<wnum>:HLINe<lnum>:COLor <string> 

:DISPlay:WINDow<wnum>:HLINe<lnum>:COLor? 

Instruction Set or get the color of the Horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Horizontal line number. If not 
specified, <lnum> defaults to 1. 

<string>: A color represented as an RGBA string, ranging from 
00000000 to ffffffff 

Return RGBA string 

Default None  
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Menu Display > RefLine Setup > Line Table > HLine > Color 

Example :DISP:WIND1:HLIN1:COL fffff500 

:DISP:WIND1:HLIN1:COL? 

Return: "fffff500" 

 

3.4.4.10 Activation VLine 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:ACTivate 

Instruction Activate the Vertical line. It will be displayed automatically after 
activation. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertical line number. If not specified, 
<lnum> defaults to 1. 

Return None 

Default None  

Menu Display > RefLine Setup > VLine Select 

Example :DISP:WIND1:VLIN1:ACT 

 

3.4.4.11 Delete VLine 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:DELete 

Instruction Delete the Vertical line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertical line number. If not specified, 
<lnum> defaults to 1. 

Return None  

Default None  
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Menu Display > RefLine Setup > Line Table >VLine >State>Delete 

Example :DISP:WIND1:VLIN1:DEL 

 

3.4.4.12 VLine State 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>[:STATe] <bool> 

:DISPlay:WINDow<wnum>:VLINe<lnum>[:STATe]? 

Instruction Set or get the state of the Vertical line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertical line number. If not specified, 
<lnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default 1 

Menu Display > RefLine Setup > Line Table >VLine >State 

Example :DISP:WIND1:VLIN1 1 

:DISP:WIND1:VLIN1? 

Return: 1 

 

3.4.4.13 Set VLine name 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:NAME <string> 

:DISPlay:WINDow<wnum>:VLINe<lnum>:NAME? 

Instruction Set or get the name of the horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertical line number. If not specified, 
<lnum> defaults to 1. 

<string>: Vertical line name 
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Return string 

Default HL*(“*” stands for Vertical line number ) 

Menu Display > RefLine Setup > Line Table >VLline >name 

Example :DISP:WIND1:VLIN1:NAME hLine1 

:DISP:WIND1:VLIN1:NAME? 

Return: "vLine1" 

 

3.4.4.14 VLine value type 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:TYPE <type> 

:DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:TYPE? 

Instruction Set or get the vlaule type of the horizontal line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertical line number. If not specified, 
<lnum> defaults to 1. 

<type>:={ABS|REL} 

Return Enumeration 

Default ABS 

Menu Display > RefLine Setup > Line Table >VLine >Value Type 

Example :DISP:WIND1:VLIN1:VAL:TYPE ABS 

:DISP:WIND1:VLIN1:VAL:TYPE? 

Return: ABS 

 

3.4.4.15 VLine value absolute 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:ABSolute <numeric> 

:DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:ABSolute? 

Instruction Set or get the absolute value of the Vertical line. 
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Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertical line number. If not specified, 
<lnum> defaults to 1. 

<numeric>: the absolute value of the Vertical line. 

Return Float  

Default Measurement of the median horizontal range 

Menu Display > RefLine Setup > Line Table >VLine >Abs Value 

Example :DISP:WIND1:VLIN1:VAL:ABS -10 

:DISP:WIND1:VLIN1:VAL:ABS? 

Return: -10 

 

3.4.4.16 VLine value relative 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:RELative <numeric> 

:DISPlay:WINDow<wnum>:VLINe<lnum>:VALue:RELative? 

Instruction Set or get the relative value of the Vertica line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertica line number. If not specified, 
<lnum> defaults to 1. 

<numeric>: the relative value of the Vertical line,and range is 0 to 100. 

Return Float  

Default 50 

Menu Display > RefLine Setup > Line Table >VLine > Rel Value 

Example :DISP:WIND1:VLIN1:VAL:REL 60 

:DISP:WIND1:VLIN1:VAL:REL? 

Return: 60 
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3.4.4.17 Set VLine colour 

Command Format :DISPlay:WINDow<wnum>:VLINe<lnum>:COLor <string> 

:DISPlay:WINDow<wnum>:VLINe<lnum>:COLor? 

Instruction Set or get the color of the Vertica line. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<lnum>:={[1]-8}, represents the Vertica line number. If not specified, 
<lnum> defaults to 1. 

<string>: A color represented as an RGBA string, ranging from 
00000000 to ffffffff 

Return RGBA string 

Default None  

Menu Display > RefLine Setup > Line Table >VLine > Color 

Example :DISP:WIND1:VLIN1:COL fffff500 

:DISP:WIND1:VLIN1:COL? 

Return: "fffff500" 

 

3.4.4.18 Set Refline all off 

Command Format :DISPlay:WINDow<wnum>:REFLine:AOFF 

Instruction Hide all reference lines. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

Return None  

Default None  

Menu Display > RefLine Setup > All Off 

Example :DISP:WIND1:REFL:AOFF 
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3.4.4.19 Refline table type 

Command Format :DISPlay:WINDow<wnum>:REFLine:TABLe:TYPE <type> 

:DISPlay:WINDow<wnum>:REFLine:TABLe:TYPE? 

Instruction Set or get the type of Line Table 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <wnum> defaults to 1. 

<type>:={OFF|HLine|VLine} 

Return Enumeration 

Default OFF 

Menu Display > RefLine Setup > Line Table 

Example :DISP:WIND1:REFL:TABL:TYPE HLine 

:DISP:WIND1:REFL:TABL:TYPE? 

Return: HLine 

 

3.5 Format Commands 

3.5.1 Format 

3.5.1.1 Command List 

Data transfer 
format 

:FORMat:DATA 

Trace Format :CALCulate<cnum>:TRACe<tnum>:FORMat 

 

3.5.1.2 Data transfer format 

Command Format :FORMat:DATA <type> 

:FORMat:DATA? 

Instruction Set/get the transfer format of data 

Parameter Type <type> ={ASCii|REAL|REAL32} 
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ASCii: Specifies the ASCII transfer format. 

REAL: Specifies the IEEE 64-bit floating point binary transfer format. 

REAL32: Specifies the IEEE 32-bit floating point binary transfer format. 

Return Enumeration 

Default ASCii 

Menu None 

Example :FORMat:DATA REAL 

:FORMat:DATA? 

Return: REAL 

 

3.5.1.3 Trace Format 

Command Format :CALCulate<cnum>[:SELected]:FORMat <type> 

:CALCulate<cnum>[:SELected]:FORMat? 

:CALCulate<cnum>:TRACe<tnum>:FORMat <type> 

:CALCulate<cnum>:TRACe<tnum>:FORMat? 

Instruction This command sets/gets the data format of the active trace of selected 
channel. 

This command sets/gets the data format of selected trace for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>=:{MLOGarithmic|PHASe|GDELay| 
SLINear|SLOGarithmic|SCOMplex|SMITh|SADMittance|PLINear|PLOGa
rithmic|POLar|MLINear|SWR|REAL| IMAGinary|UPHase|PPHase} 

Return Enumeration 

Default MLOGarithmic 

Menu Format > Format1 or Format2 

Example :CALCulate1:FORMat PHASe 
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:CALCulate1:FORMat? 

Return: PHAS 

:CALCulate1:TRACe1:FORMat GDELay 

:CALCulate1:TRACe1:FORMat? 

Return: GDEL 

 

3.5.2 Trace data 

3.5.2.1 Command List 

Formatted Data Array :CALCulate<cnum>:TRACe<tnum>:DATA:FDATa 

Corrected Data Array :CALCulate<cnum>:TRACe<tnum>:DATA:SDATa 

Frequency of All Measurement Points :SENSe<cnum>:FREQuency:DATA? 

X Axis Data :CALCulate<cnum>:TRACe<tnum>:DATA:XAXis? 

Gets the formatted data of multiple 
traces 

:CALCulate<cnum>:DATA:MFData <numeric>? 

Gets the correction data of multiple 
traces 

:CALCulate<cnum>:DATA:MSData <numeric>? 

Get the SNP data :CALCulate<cnum>:DATA:SNP? 

Get Corrected Data Array :SENSe<cnum>:DATA:CORRdata? S<XY> 

Get Raw Data Array :SENSe<cnum>:DATA:RAWData? S<XY> 

 

3.5.2.2 Formatted Data Array 

Command Format :CALCulate<cnum>[:SELected]:DATA:FDATa 
<numeric1>,… ,<numeric NOP*2> 

:CALCulate<cnum>[:SELected]:DATA:FDATa? 

:CALCulate<cnum>:TRACe<tnum>:DATA:FDATa 
<numeric1>,… ,<numeric NOP*2> 

:CALCulate<cnum>:TRACe<tnum>:DATA:FDATa? 

Instruction This command sets/gets the formatted data array, for the active trace 
of selected channel. 
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This command sets/gets the formatted data array of selected trace for 
the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric1>,… ,<numeric NOP*2>:Indicates the array data (formatted 
data array) of NOP (number of measurement points)×2. Where n is an 
integer between 1 and NOP. 

Data(n×2-2) :Data (primary value) at the n-th measurement point. 

Data(n×2-1) :Data (secondary value) at the n-th measurement point. 
Always 0 when the data format is not the Smith chart format or the 
polar format. 

The index of the array starts from 0. 

Return Array 

Default None 

Menu None 

Example :CALCulate1:DATA:FDATa a1,b1,……,an,bn 

:CALCulate1:DATA:FDATa? 

:CALCulate1:TRACe1:DATA:FDATa a1,b1,……,an,bn 

:CALCulate1:TRACe1:DATA:FDATa? 

 

3.5.2.3 Corrected Data Array 

Command Format :CALCulate<cnum>[:SELected]:DATA:SDATa 
<numeric1>,… ,<numeric NOP*2> 

:CALCulate<cnum>[:SELected]:DATA:SDATa? 

:CALCulate<cnum>:TRACe<tnum>:DATA:SDATa 
<numeric1>,… ,<numeric NOP*2> 

:CALCulate<cnum>:TRACe<tnum>:DATA:SDATa? 

Instruction This command sets/gets the corrected data array, for the active trace 
of selected channel. 

This command sets/gets the corrected data array of selected trace for 
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the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric1>,… ,<numeric NOP*2>:Indicates the array data (correcte 
DATA:XAXis? d data array) of NOP (number of measurement points)×2. 
Where n is an integer between 1 and NOP. 

Data(n×2-2) :Real part of the data (complex number) at the n-th 
measurement point. 

Data(n×2-1) :Imaginary part of the data (complex number) at the n-th 
measurement point. 

The index of the array starts from 0. 

Return Array 

Default None 

Menu None 

Example :CALCulate1:DATA:SDATa a1,b1,……,an,bn 

:CALCulate1:DATA:SDATa? 

:CALCulate1:TRACe1:DATA:SDATa a1,b1,……,an,bn 

:CALCulate1:TRACe1:DATA:SDATa? 

 

3.5.2.4 Frequency of All Measurement Points 

Command Format :SENSe<cnum>:FREQuency:DATA? 

Instruction This command reads the frequencies at all measurement points of 
channels 1 to 200. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Data array 

Default None 

Menu None 
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Example :SENSe1:FREQuency:DATA? 

 

3.5.2.5 X Axis Data 

Command Format :CALCulate<cnum>[:SELected]:DATA:XAXis? 

:CALCulate<cnum>:TRACe<tnum>:DATA:XAXis? 

Instruction This command reads the data of measurement points of X axis, for the 
active trace of selected channel. 

This command reads the data of measurement points of X axis of 
selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Data array(Unit depend on sweep type) 

Default None 

Menu None 

Example :CALCulate1:DATA:XAXis? 

:CALCulate1:TRACe1:DATA:XAXis? 

 

3.5.2.6 Gets the formatted data of multiple traces 

Command Format :CALCulate<cnum>:DATA:MFData <numeric>? 

Instruction gets the formatted data array of multiple traces (traces-n, m, .... to l) of 
the selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the trace number. 

"n, m, l, ..."  

where n, m, l are 1 to the maximum trace number. 

Use comma for separator of trace number. 
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Return Array 

Default None  

Menu None  

Example :CALC:DATA:MFData? "1,2,3" 

Return: 8.457302793195e-02,0.000000000000e+00, 
-1.426901425958e-01,0.000000000000e+00, 
-2.635991012650e-01,0.000000000000e+00, 
-2.839929320553e-01,0.000000000000e+00, 
-3.315815592045e-01,0.000000000000e+00, 
-3.528884698654e-01,0.000000000000e+00, 
-3.937646932011e-01,0.000000000000e+00, 
-4.517490965595e-01… 

 

3.5.2.7 Gets the correction data of multiple traces 

Command Format :CALCulate<cnum>:DATA:MSData <numeric>? 

Instruction gets the correction data array of multiple traces (traces-n, m, .... to l) of 
the selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the trace number. 

"n, m, l, ..."  

where n, m, l are 1 to the maximum trace number. 

Use comma for separator of trace number. 

Return Array 

Default None  

Menu None  

Example :CALC:DATA:MSData? "1,2,3" 

Return: 1.010376816410e+00,-8.191833528689e-03, 
-6.960549382249e-01,-6.946841837980e-01, 
6.925621007541e-03,9.700560127871e-01, 
6.967893184358e-01,-6.718442699877e-01, 
-9.629746082335e-01, -1.534994428298e-02, 
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6.515030755121e-01, 7.056409245766e-01, 
4.932709557852e-02,-9.543263693213e-01, 
-7.007103025244e-01,… 

 

3.5.2.8 Get the SNP data 

Command Format :CALCulate<cnum>:DATA:SNP? <numeric> 

Instruction This command returns SNP data without header information, and in 
columns, not in rows as .SnP files. This means that the data returned 
from this command sends all frequency data, then all Sx1 magnitude 
or real data, then all Sx1 phase or imaginary data, and so forth. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the number of SNP files "N", ranging from 1 to 4 

Return String(The actual returned data will be affected by the data 
transmission format set, including ASCII/REAL32/REAL64, and the 
default is ASCII code) 

Default None 

Menu None 

Example :CALC:DATA:SNP? 1 

Return : 
1.000000000000e+05,4.259950000000e+07,8.509900000000e+07, 
1.275985000000e+08,1.700980000000e+08,2.125975000000e+08, 

2.550970000000e+08,2.975965000000e+08,3.400960000000e+08, 

3.825955000000e+08, 

 

3.5.2.9 Get Corrected Data Array 

Command Format :SENSe<cnum>:DATA:CORRdata? S<XY> 

Instruction This command gets S-Parameter data of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 
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"S<XY>": 

Where 

X: 1 to 4 

Y: 1 to 4 

Return Indicates the array data of NOP (number of measurement points)×2. 
Where n is an integer between 1 and NOP. 

Data(n×2-2): Real part of the data (complex number) at the n-th 
measurement point. 

Data(n×2-1): Imaginary part of the data (complex number) at the n-th 
measurement point. 

The index of the array starts from 0. 

Default None 

Menu None 

Example :SENSe1:DATA:CORRdata? S11 

 

3.5.2.10 Get Raw Data Array 

Command Format :SENSe<cnum>:DATA:RAWData? S<XY> 

Instruction This command gets the raw data of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

" S<XY>": 

Where 

X: 1 to 4 

Y: 1 to 4 

Return Indicates the array data of NOP (number of measurement points)×2. 
Where n is an integer between 1 and NOP. 

 

Data(n×2-2): Real part of the data (complex number) at the n-th 
measurement point. 

Data(n×2-1): Imaginary part of the data (complex number) at the n-th 
measurement point. 
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The index of the array starts from 0. 

Default None 

Menu None 

Example :SENSe1:DATA:RAWData? S11 

 

3.6 Frequency Commands 

3.6.1 Frequency setup 

3.6.1.1 Command List 

Start Frequency :SENSe<cnum>:FREQuency:STARt 

Stop Frequency :SENSe<cnum>:FREQuency:STOP 

Center Frequency :SENSe<cnum>:FREQuency:CENTer 

Frequency Span :SENSe<cnum>:FREQuency:SPAN 

CW Frequency :SENSe<cnum>:FREQuency:CW 

 

3.6.1.2 Start Frequency 

Command Format :SENSe<cnum>:FREQuency:STARt <numeric> 

:SENSe<cnum>:FREQuency:STARt? 

Instruction This command sets/gets the start value of the sweep range of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the start frequency. 

Return Float, unit: Hz 

Default 9 kHz 

Menu Freq > Start 
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Example :SENSe1:FREQuency:STARt 100e3 

:SENSe1:FREQuency:STARt? 

Return: 100000 

 

3.6.1.3 Stop Frequency 

Command Format :SENSe<cnum>:FREQuency:STOP <numeric> 

:SENSe<cnum>:FREQuency:STOP? 

Instruction This command sets/gets the stop value of the sweep range of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the stop frequency. 

Return Float, unit: Hz 

Default Maximum frequency of the analyzer 

Menu Freq > Stop 

Example :SENSe1:FREQuency:STOP 1e9 

:SENSe1:FREQuency:STOP? 

Return: 1000000000 

 

3.6.1.4 Center Frequency 

Command Format :SENSe<cnum>:FREQuency:CENTer <numeric> 

:SENSe<cnum>:FREQuency:CENTer? 

Instruction This command sets/gets the center value of the sweep range of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the center frequency. 

Return Float, unit: Hz 
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Default The central value of the frequency range of the analyzer 

Menu Freq > Center 

Example :SENSe1:FREQuency:CENTer 1e9 

:SENSe1:FREQuency:CENTer? 

Return: 1000000000 

 

3.6.1.5 Frequency Span 

Command Format :SENSe<cnum>:FREQuency:SPAN <numeric> 

:SENSe<cnum>:FREQuency:SPAN? 

Instruction This command sets/gets the span value of the sweep range of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the frequency span. 

Return Float, unit: Hz 

Default 8.4999 GHz 

Menu Freq > Span 

Example :SENSe1:FREQuency:SPAN 1e6 

:SENSe1:FREQuency:SPAN? 

Return: 1000000 

 

3.6.1.6 CW Frequency 

Command Format :SENSe<cnum>:FREQuency:CW <numeric> 

:SENSe<cnum>:FREQuency:CW? 

 

:SENSe<cnum>:FREQuency:FIXed <numeric> 

:SENSe<cnum>:FREQuency:FIXed? 

Instruction This command sets/gets the fixed frequency (CW frequency) for the 
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power sweep for channels 1 to 200. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the fixed frequency (CW frequency). 

Return Float, unit: Hz 

Default 1 GHz 

Menu Freq > CW 

Example :SENSe1:FREQuency:CW 2e9 

:SENSe1:FREQuency:CW? 

Return: 2000000000 

 

:SENSe1:FREQuency:FIXed 3e9 

:SENSe1:FREQuency:FIXed? 

Return: 3000000000 

 

3.6.2 Freq Offset 

3.6.2.1 Command List 

Channel FOM State :SENSe<cnum>:FOM[:STATe] 

FOM Range Number :SENSe<cnum>:FOM:COUNt? 

FOM Range Name 
List 

:SENSe<cnum>:FOM:CATalog? 

FOM Range Index :SENSe<cnum>:FOM:RNUM? 

FOM Range Name :SENSe<cnum>:FOM:RANGe<rnum>:NAME? 

FOM X-Axis Range 
Name 

:SENSe<cnum>:FOM:DISPlay:SELect 

FOM Range Sweep 
Type 

:SENSe{chnum}:FOM:RANGe<rnum>:SWEep:TYPE 

FOM Range Start 
Frequency 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STARt 

FOM Range Stop :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STOP 
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Frequency 

FOM Range CW 
Frequency 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:CW 

Add a Segment in 
FOM Range 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:ADD 

Delete a Segment in 
FOM Range 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:DELete 

Segment Number of 
FOM Range 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:COUNt? 

Clear Segment Table 
of FOM Range 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:DELete:ALL 

Segment Enable 
State 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>[:STATe] 

Segment Start 
Frequency 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STARt 

Segment Stop 
Frequency 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:STOP 

Segment Center 
Frequency 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:CENTer 

Segment Frequency 
Span 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuency:SPAN 

Segment Sweep 
Point 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:POINts 

Individual Power 
Level State Control 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:POWer[:LEVel]:CONTrol 

Individual Power 
Level 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:POWer[:LEVel] 

Individual Sweep 
Time State Control 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:TIME:CONTrol 

Individual Sweep 
Time 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:TIME 

Individual Sweep 
Delay State Control 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:DELay:CONTrol 

Individual Sweep 
Delay 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:DELay 

Individual IFBW :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:BWIDth[:RESolution]:CONTrol 
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State Control 

Individual IFBW :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:BWIDth[:RESolution] 

FOM Range Couple 
State 

:SENSe<cnum>:FOM:RANGe<rnum>:COUPled 

FOM Range 
Multiplier 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:MULTiplier 

FOM Range Divisor :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:DIVisor 

FOM Range Offset :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:OFFSet 

 

3.6.2.2 Channel FOM State 

Command Format :SENSe<cnum>:FOM[:STATe] <bool> 

:SENSe<cnum>:FOM[:STATe]? 

Instruction This command sets/gets Frequency Offset Measurement Function 
enable state. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Freq > Freq Offset… > Freq Offset Enable 

Example :SENS:FOM ON 

:SENS:FOM? 

Return: 1 

 

3.6.2.3 FOM Range Number 

Command Format :SENSe<cnum>:FOM:COUNt? 

Instruction This command gets the number of valid FOM ranges in the VNA. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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Return Integer 

Default None 

Menu None 

Example :SENS:FOM:COUN? 

Return: 3 

 

3.6.2.4 FOM Range Name List 

Command Format :SENSe<cnum>:FOM:CATalog? 

Instruction This command gets a comma-separated list of available range names 
in the VNA. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return String 

Default None 

Menu Freq > Freq Offset… > Annotation 

Example :SENS:FOM:CAT? 

Return: “Primary,Source,Receivers” 

 

3.6.2.5 FOM Range Index 

Command Format :SENSe<cnum>:FOM:RNUM? <string> 

Instruction This command gets the range Index of specified FOM range name. 

The FOM range items are typically numbered as follows: 

1.Primary 

2.Source 

3.Receivers 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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<string>: represents the valid FOM range name. 

Return Integer 

Default None 

Menu None 

Example :SENS:FOM:RNUM? "Source" 

Return: 2 

 

3.6.2.6 FOM Range Name 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:NAME? 

Instruction This command gets the range name of specified FOM range index. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

Return String 

Default None 

Menu Freq > Freq Offset… > Annotation 

Example :SENS:FOM:RANG:NAME? 

Return: "Primary" 

 

3.6.2.7 FOM X-Axis Range Name 

Command Format :SENSe<cnum>:FOM:DISPlay:SELect <string> 

:SENSe<cnum>:FOM:DISPlay:SELect? 

Instruction This command sets/gets the FOM range to be displayed on the SNA x-
axis. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<string>: represents the valid FOM range name. 
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Use"SENSe:FOM:CAT? to see a list of available frequency range names. 

Return String 

Default "Source" 

Menu Freq > Freq Offset… > Annotation 

Example :SENS:FOM:DISP:SEL "Source" 

:SENS:FOM:DISP:SEL? 

Return: "Source" 

 

3.6.2.8 FOM Range Sweep Type 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SWEep:TYPE <type> 

:SENSe<cnum>:FOM:RANGe<rnum>:SWEep:TYPE? 

Instruction This command sets/gets the sweep type to be used with the specified 
range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<type>:= {LINear|LOGarithmic|SEGMent|POWer|CW} 

Return Enumeration 

Default LINear 

Menu Freq > Freq Offset… > Sweep Type 

Example :SENS:FOM:RANG2:SWE:TYPE CW 

:SENS:FOM:RANG2:SWE:TYPE? 

Return: CW 

 

3.6.2.9 FOM Range Start Frequency 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STARt <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STARt? 

https://ena.support.keysight.com/e5080a/manuals/webhelp/scn/programming/gp-ib_command_finder/sense/fom.htm#cat


VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    175 

Instruction This command sets/gets the start value of frequency range.. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<numeric>:represents the start frequency. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Settings > Start Freq 

Example :SENS:FOM:RANG2:FREQ:STAR 1E9 

:SENS:FOM:RANG2:FREQ:STAR? 

Return: 1000000000 

 

3.6.2.10 FOM Range Stop Frequency 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STOP <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:STOP? 

Instruction This command sets/gets stop value of frequency range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<numeric>:represents the stop frequency. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Settings > Stop Freq 

Example :SENS:FOM:RANG2:FREQ:STOP 1E9 

:SENS:FOM:RANG2:FREQ:STOP? 

Return: 1000000000 
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3.6.2.11 FOM Range CW Frequency 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:CW <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:CW? 

Instruction This command sets/gets CW Frequency of frequency range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<numeric>:represents the CW frequency. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > CW Freq 

Example :SENS:FOM:RANG2:FREQ:CW 1E9 

:SENS:FOM:RANG2:FREQ:CW? 

Return: 1000000000 

 

3.6.2.12 Add a Segment in FOM Range 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:ADD 

Instruction This command adds a segment into the segment table of frequency 
range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. Segment numbers must be 
sequential. If a new number is added where one currently exists, the 
existing segment and those following are incremented by one. 

Return None 

Default None 
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Menu Freq > Freq Offset… > Sweep Type > Segment > Add Segment 

Example :SENS:FOM:RANG:SEGM:ADD 

 

3.6.2.13 Delete a Segment in FOM Range 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:DELete 

Instruction This command deletes a segment in the segment table of frequency 
range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

Return None 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Delete Segment 

Example :SENS:FOM:RANG:SEGM:DEL 

 

3.6.2.14 Segment Number of FOM Range 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:COUNt? 

Instruction This command gets the number of segments that exist for the 
specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

Return Integer 

Default 1 



VNA Series Programming Guide 

178                                                                                                                                                                                    int.siglent.com 

Menu None 

Example :SENS:FOM:RANG:SEGM:COUN? 

 

3.6.2.15 Clear Segment Table of FOM Range 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:DELete:ALL 

Instruction This command clears the segment table of frequency range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

Return None 

Default None 

Menu Sweep > Segment Table > Delete All Segment 

Example :SENS:FOM:RANG:SEGM:DEL:ALL 

 

3.6.2.16 Segment Enable State 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>[:STATe] 
<bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>[:STATe]? 

Instruction This command sets/gets enable state of the specified segment in the 
specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<bool>:= ON|OFF|1|0 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    179 

Return Boolean 

Default OFF 

Menu Freq > Freq Offset… > Sweep Type > Segment 

Example :SENS:FOM:RANG:SEGM OFF 

:SENS:FOM:RANG:SEGM? 

Return: 0 

 

3.6.2.17 Segment Start Frequency 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:STARt <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:STARt? 

Instruction This command sets/gets the start frequency for the specified sweep 
segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the start frequency. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Segment Table > 
start 

Example :SENS:FOM:RANG:SEGM:FREQ:STAR 1E9 

:SENS:FOM:RANG:SEGM:FREQ:STAR? 

Return: 1000000000 
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3.6.2.18 Segment Stop Frequency 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:STOP <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:STOP? 

Instruction This command sets/gets the stop frequency for the specified sweep 
segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the stop frequency. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Segment Table > stop 

Example :SENS:FOM:RANG:SEGM:FREQ:STOP 1E9 

:SENS:FOM:RANG:SEGM:FREQ:STOP? 

Return: 1000000000 

 

3.6.2.19 Segment Center Frequency 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:CENTer <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:CENTer? 

Instruction This command sets/gets the center frequency for the specified sweep 
segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
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not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the center frequency. 

Return Float 

Default None 

Menu None 

Example :SENS:FOM:RANG:SEGM:FREQ:CENT 1E9 

:SENS:FOM:RANG:SEGM:FREQ:CENT? 

Return: 1000000000 

 

3.6.2.20 Segment Frequency Span 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:SPAN <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:FREQuenc
y:SPAN? 

Instruction This command sets/gets the frequency span for the specified sweep 
segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the frequency span. 

Return Float 

Default None 

Menu None 

Example :SENS:FOM:RANG:SEGM:FREQ:SPAN 1E9 

:SENS:FOM:RANG:SEGM:FREQ:SPAN? 
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Return: 1000000000 

 

3.6.2.21 Segment Sweep Point 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:P
OINts <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:P
OINts? 

Instruction This command sets/gets the number of data points for the specified 
sweep segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the number of points in the segment. The total 
number of points in all segments cannot exceed 20001. A segment can 
have as few as 2 points. 

Return Integer 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Segment Table > 
Points 

Example :SENS:FOM:RANG:SEGM:SWE:POIN 300 

:SENS:FOM:RANG:SEGM:SWE:POIN? 

Return: 300 

 

3.6.2.22 Individual Power Level State Control 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:POWer[:LEVel]:CONT
rol <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:POWer[:LEVel]:CONT
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rol? 

Instruction This command sets/gets the power level can be set independently for 
each sweep segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent Power Levels 

Example :SENS:FOM:RANG:SEGM:POW:CONT ON 

:SENS:FOM:RANG:SEGM:POW:CONT? 

Return: 1 

 

3.6.2.23 Individual Power Level 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:POWer[:L
EVel] <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:POWer[:L
EVel]? 

Instruction This command sets/gets the power level for the specified segment in 
the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the power level in dBm,the range is -55dBm to 
20dBm. 
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Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent Power Levels > Power Level 

Example :SENS:FOM:RANG:SEGM:POW -10 

:SENS:FOM:RANG:SEGM:POW? 

Return: -10 

 

3.6.2.24 Individual Sweep Time State Control 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:TIME:CONTr
ol <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:TIME:CONTr
ol? 

Instruction This command sets/gets the sweep time can be set independently for 
each sweep segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent Sweep Time 

Example :SENS:FOM:RANG:SEGM:SWE:TIME:CONT ON 

:SENS:FOM:RANG:SEGM:SWE:TIME:CONT? 

Return: 1 

 

3.6.2.25 Individual Sweep Time 
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Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:TI
ME <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:TI
ME? 

Instruction This command sets/gets the time the VNA takes to sweep the 
specified segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the sweep time. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent Sweep Time > Sweep Time 

Example :SENS:FOM:RANG:SEGM:SWE:TIME 5 

:SENS:FOM:RANG:SEGM:SWE:TIME? 

Return: 5 

 

3.6.2.26 Individual Sweep Delay State Control 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:DELay:CONT
rol <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:SWEep:DELay:CONT
rol? 

Instruction This command sets/gets the sweep delay can be set independently for 
each sweep segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
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not specified, <rnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent Sweep Delay 

Example :SENS:FOM:RANG:SEGM:SWE:DEL:CONT ON 

:SENS:FOM:RANG:SEGM:SWE:DEL:CONT? 

Return: 1 

3.6.2.27 Individual Sweep Delay 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:DE
Lay <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:SWEep:DE
Lay? 

Instruction This command sets/gets the time the VNA waits before sweeping the 
specified segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:represents the sweep delay time. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent Sweep Delay > Delay 

Example :SENS:FOM:RANG:SEGM:SWE:DEL 5 

:SENS:FOM:RANG:SEGM:SWE:DEL? 

Return: 5 
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3.6.2.28 Individual IFBW State Control 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:BWIDth[:RESolution]:
CONTrol <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent:BWIDth[:RESolution]:
CONTrol? 

Instruction This command sets/gets the IF Bandwidth resolution can be set 
independently for each sweep segment in the specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent IF Bandwidth 

Example :SENS:FOM:RANG:SEGM:BWID:CONT ON 

:SENS:FOM:RANG:SEGM:BWID:CONT? 

Return: 1 

 

3.6.2.29 Individual IFBW 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:BWIDth[:R
ESolution] <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:SEGMent<segnum>:BWIDth[:R
ESolution]? 

Instruction This command sets/gets IF Bandwidth for the specified segment in the 
specified range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 
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<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:={1|2|3|4|5|6|7|10|15|20|30|40|50|70|100|150|200|300|400|
500|700|1E3|1.5E3|2E3|3E3|4E3|5E3|7E3|10E3|15E3|20E3|30E3|40E3|
50E3|70E3|100E3|150E3|200E3|300E3|400E3|500E3|700E3|1E6|1.5E
6|2E6|3E6|4E6|5E6|7E6|10E6} ,unit: Hz. 

Return Float 

Default None 

Menu Freq > Freq Offset… > Sweep Type > Segment > Sweep Properties > 
Independent IF Bandwidth > IF Bandwidth 

Example :SENS:FOM:RANG:SEGM:BWID 1E4 

:SENS:FOM:RANG:SEGM:BWID? 

Return: 10000 

 

3.6.2.30 FOM Range Couple State 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:COUPled <bool> 

:SENSe<cnum>:FOM:RANGe<rnum>:COUPled? 

Instruction This command gets the state of coupling of the specified range to the 
primary range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Freq > Freq Offset… > Mode > Coupled 

Example :SENS:FOM:RANG2:COUP OFF 

:SENS:FOM:RANG2:COUP? 

Return: 0 
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3.6.2.31 FOM Range Multiplier 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:MULTiplier 
<numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:MULTiplier? 

Instruction This command sets/gets the multiplier value to be used when coupling 
this range to the primary range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<numeric>:represents the multiplier value, and the range is 1 to100. 

Return Integer 

Default 1 

Menu Freq > Freq Offset… > Couped > Multiplier 

Example :SENS:FOM:RANG2:FREQ:MULT 2 

:SENS:FOM:RANG2:FREQ:MULT? 

Return: 2 

 

3.6.2.32 FOM Range Divisor 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:DIVisor <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:DIVisor? 

Instruction This command sets/gets the divisor value to be used when coupling 
this range to the primary range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<numeric>:represents the divisor value, and the range is 1 to100. 
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Return Integer 

Default 1 

Menu Freq > Freq Offset… > Couped > Divisor 

Example :SENS:FOM:RANG2:FREQ:DIV 2 

:SENS:FOM:RANG2:FREQ:DIV? 

Return: 2 

 

3.6.2.33 FOM Range Offset 

Command Format :SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:OFFSet <numeric> 

:SENSe<cnum>:FOM:RANGe<rnum>:FREQuency:OFFSet? 

Instruction This command sets/gets the offset value to be used when coupling this 
range to the primary range. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<rnum>: represents the available frequency offset device number. If 
not specified, <rnum> defaults to 1. 

<numeric>:represents the offset value. 

Return Float 

Default 0 

Menu Freq > Freq Offset… > Couped > Offset 

Example :SENS:FOM:RANG2:FREQ:OFFS 1E9 

:SENS:FOM:RANG2:FREQ:OFFS? 

Return: 1000000000 

 

3.7 Math Commands 

3.7.1 Memory 

3.7.1.1 Command List 
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Data to Memory :CALCulate<cnum>:TRACe<tnum>:MATH:MEMorize 

NORMalize :CALCulate<cnum>:TRACe<tnum>:MATH:NORMalize 

Math Method :CALCulate<cnum>:TRACe<tnum>:MATH:FUNCtion 

Data Trace Display State :DISPlay:WINDow<wnum>:TRACe<tnum>:STATe 

Memory Trace Display State :DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe] 

 

3.7.1.2 Data to Memory 

Command Format :CALCulate<cnum>[:SELected]:MATH:MEMorize 

:CALCulate<cnum>:TRACe<tnum>:MATH:MEMorize 

Instruction This command puts the active data trace into memory. You can store 
one memory trace for every displayed trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default None 

Menu Math > Memory > Data → Memory 

Example :CALCulate1:MATH:MEMorize 

:CALCulate1:TRACe1:MATH:MEMorize 

 

3.7.1.3 NORMalize 

Command Format :CALCulate<cnum>[:SELected]:MATH:NORMalize 

:CALCulate<cnum>:TRACe<tnum>:MATH:NORMalize 

Instruction This command performs the same function as Data->Memory, then 
Data / Memory.  

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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Return None 

Default None 

Menu Math > Memory > Normalize 

Example :CALCulate1:MATH:NORMalize 

:CALCulate1:TRACe1:MATH:NORMalize 

 

3.7.1.4 Math Method 

Command Format :CALCulate<cnum>[:SELected]:MATH:FUNCtion <type> 

:CALCulate<cnum>[:SELected]:MATH:FUNCtion? 

:CALCulate<cnum>:TRACe<tnum>:MATH:FUNCtion <type> 

:CALCulate<cnum>:TRACe<tnum>:MATH:FUNCtion? 

Instruction This command sets/gets the data trace display method (math 
method between measurement data and memory trace data), for the 
active trace of selected channel (Ch). 

This command sets/gets the data trace display method (math 
method between measurement data and memory trace data), for the 
selected trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={NORMal|SUBTract|DIVide|ADD|MULTiply} 

Return Enumeration 

Default NORMal 

Menu Math > Memory > Math 

Example :CALCulate1:MATH:MEMorize 

:CALCulate1:MATH:FUNCtion SUBTract 

:CALCulate1:MATH:FUNCtion? 

Return: SUBT 

:CALCulate1:TRACe1:MATH:FUNCtion DIVide 
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:CALCulate1:TRACe1:MATH:FUNCtion? 

Return: DIV 

 

3.7.1.5 Data Trace Display State 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:STATe <bool> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:STATe? 

Instruction This command turns ON/OFF the data trace display, for the selected 
trace of selected channel. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default None 

Menu Math > Memory > Display > Data (when the memory trace display is 
OFF) 

Math > Memory > Display > Data & Mem (when the memory trace 
display is ON) 

Example :DISPlay:WINDow1:TRACe5:STATe 0 

:DISPlay:WINDow1:TRACe5:STATe? 

Return: 0 

 

3.7.1.6 Memory Trace Display State 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe] <bool> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:MEMory[:STATe]? 

Instruction This command turns ON/OFF the memory trace display, for the 
selected trace of selected channel. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
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not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default None 

Menu Math > Memory > Display > Mem (when the data trace display is OFF) 

Math > Memory > Display > Data & Mem (when the data trace display 
is ON) 

Example :DISPlay:WINDow1:TRACe5:MEMory ON 

:DISPlay:WINDow1:TRACe5:MEMory? 

Return: 1 

 

3.7.2 Analysis 

3.7.2.1 Command List 

Parameter Conversion State :CALCulate<cnum>:TRACe<tnum>:CONVersion[:STATe] 

Parameter Conversion :CALCulate<cnum>:TRACe<tnum>:CONVersion:FUNCtion 

Equation Text :CALCulate<cnum>:TRACe<tnum>:EQUation:TEXT 

Equation Valid :CALCulate<cnum>:TRACe<tnum>:EQUation:VALID? 

Equation State :CALCulate<cnum>:TRACe<tnum>:EQUation:STATE 

Trace Statistics State :CALCulate<cnum>:TRACe<tnum>:MSTatistics[:STATe] 

Statistics Type :CALCulate<cnum>:MEASure<tnum>:FUNCtion:TYPE 

Get Statistics Data :CALCulate<cnum>:TRACe<tnum>:MSTatistics:DATA? 

Statistics Range User Span State :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STATe 

User Span Statistics Range Start 
Frequency 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STARt 

User Span Statistics Range Stop 
Frequency 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STOP 

Limit Test State :CALCulate<cnum>:TRACe<tnum>:LIMit[:STATe] 
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Limit Line State :CALCulate<cnum>:TRACe<tnum>:LIMit:DISPlay[:STATe] 

Limit Sound State :CALCulate<cnum>:MEASure<tnum>:LIMit:SOUNd[:STATe] 

Display of limit test failure points SYSTem:PREFerences:ITEM:RTOF 

Globle Fail Sign :DISPlay:FSIGn 

Get Limit Test Result :CALCulate<cnum>:TRACe<tnum>:LIMit:FAIL? 

Limit Table :CALCulate<cnum>:TRACe<tnum>:LIMit:DATA 

Get Limit All Report :CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:ALL? 

Get Limit Failed Points :CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:POINts? 

Get Limit Failed Data :CALCulate<cnum>:TRACe<tnum>:LIMit:REPort[:DATA] 

Table Display Type :DISPlay:WINDow<wnum>:TABLe 

Load Limit Table :MMEMory:LOAD:LIMit 

Store Limit Table :MMEMory:STORE:LIMit 

Point Limit Test State :CALCulate<cnum>:TRACe<tnum>:PLIMit[:STATe] 

Point Limit Line State :CALCulate<cnum>:TRACe<tnum>:PLIMit:DISPlay:LINE 

Point Limit Test Sound State :CALCulate<cnum>:MEASure<tnum>:PLIMit:SOUNd 

Point Limit Test Result :CALCulate<cnum>:TRACe<tnum>:PLIMit:FAIL? 

Get Point Limit test report :CALCulate<cnum>[:SELected]:PLIMit:REPort[:DATA]? 

Point Limit Data :CALCulate<cnum>[:SELected]:PLIMit:DATA 

Load Point Limit Table :MMEMory:LOAD:PLIMit 

Store Point Limit Table :MMEMory:STORE:PLIMit 

Ripple Limit Test State :CALCulate<cnum>:TRACe<tnum>:RLIMit[:STATe] 

Ripple Limit Line State :CALCulate<cnum>:TRACe<tnum>:RLIMit:DISPlay:LINE 

Ripple Limit Test Sound State :CALCulate<cnum>:MEASure<tnum>:RLIMit:SOUNd 

Ripple Limit Test Result :CALCulate<cnum>:TRACe<tnum>:RLIMit:FAIL? 

Ripple Limit Data :CALCulate<cnum>:TRACe<tnum>:RLIMit:DATA 

Get Ripple Result :CALCulate<cnum>:TRACe<tnum>:RLIMit:REPort[:DATA]? 

Load Ripple Limit Table :MMEMory:LOAD:RLIMit 

Store Ripple Limit Table :MMEMory:STORE:RLIMit 

Bandwidth Test State :CALCulate<cnum>:TRACe<tnum>:BLIMit[:STATe] 

Bandwidth Test Value State :CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:VALue 
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Bandwidth Test Marker State :CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:MARKer 

Bandwidth Test Threshold :CALCulate<cnum>:TRACe<tnum>:BLIMit:DB 

Bandwidth Test MiNimum :CALCulate<cnum>:TRACe<tnum>:BLIMit:MINimum 

Bandwidth Test Maximum :CALCulate<cnum>:TRACe<tnum>:BLIMit:MAXimum 

Get Bandwidth Test Fail Result :CALCulate<cnum>:TRACe<tnum>:BLIMit:FAIL? 

Bandwidth Test Report Data :CALCulate<cnum>:TRACe<tnum>:BLIMit:REPort[:DATA]? 

 

3.7.2.2 Parameter Conversion State 

Command Format :CALCulate<cnum>[:SELected]:CONVersion[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:CONVersion[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:CONVersion[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:CONVersion[:STATe]? 

Instruction This command sets/gets the parameter conversion state for the active 
trace of selected channel. 

This command sets/gets the parameter conversion state for the 
selected trace and selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Conversion 

Example :CALCulate1:CONVersion:STATe 1 

:CALCulate1:CONVersion:STATe? 

Return: 1 

 

:CALCulate1:TRACe1:CONVersion:STATe 1 

:CALCulate1:TRACe1:CONVersion:STATe? 
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Return: 1 

 

3.7.2.3 Parameter Conversion 

Command Format :CALCulate<cnum>[:SELected]:CONVersion:FUNCtion <type> 

:CALCulate<cnum>[:SELected]:CONVersion:FUNCtion? 

 

:CALCulate<cnum>:TRACe<tnum>:CONVersion:FUNCtion <type> 

:CALCulate<cnum>:TRACe<tnum>:CONVersion:FUNCtion? 

Instruction This command sets/gets the parameter after conversion using the 
parameter conversion function, for the active trace of selected channel. 

This command sets/gets the parameter after conversion using the 
parameter conversion function for the selected trace and selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={ZREFlection|ZTRansmit|YREFlection|YTRansmit|INVersion|Z
TSHunt|YTSHunt|CONJugation} 

Return Enumeration 

Default ZREFlection 

Menu Math > Analysis > Conversion 

Example :CALCulate1:CONVersion:STATe 1 

:CALCulate1:CONVersion:FUNCtion ZTSHunt 

:CALCulate1:CONVersion:FUNCtion? 

Return: ZTSH 

 

:CALCulate1:TRACe1:CONVersion:STATe 1 

:CALCulate1:TRACe1:CONVersion:FUNCtion YREFlection 

:CALCulate1:TRACe1:CONVersion:FUNCtion? 

Return: YREF 
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3.7.2.4 Equation Text 

Command Format :CALCulate<cnum>[:SELected]:EQUation:TEXT <string> 

:CALCulate<cnum>[:SELected]:EQUation:TEXT? 

:CALCulate<cnum>:TRACe<tnum>:EQUation:TEXT <string> 

:CALCulate<cnum>:TRACe<tnum>:EQUation:TEXT? 

Instruction This command sets/gets the equation in the Equation Editor. For valid 
parameters that can be used in this equation, refer to the Equation 
Editor. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<string>: represents the equation in the Equation Editor. 

Return String 

Default None 

Menu Math > Analysis > Equation editor 

Example :CALCulate1:EQUation:TEXT "S11/S22" 

:CALCulate1:EQUation:TEXT? 

Return: S11/S22 

:CALCulate1:TRACe1:EQUation:TEXT "S11/S22" 

:CALCulate1:TRACe1:EQUation:TEXT? 

Return: S11/S22 

 

3.7.2.5 Equation Valid 

Command Format :CALCulate<cnum>[:SELected]:EQUation:VALID? 

:CALCulate<cnum>:TRACe<tnum>:EQUation:VALID? 

Instruction This command returns False when the equation expression and label 
are correct but the required S-parameter data is not measured or if it 
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refers the invalid corrected memory array. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Boolean 

1: Valid 

0: Invalid 

Default None 

Menu Math > Analysis > Equation editor 

Example :CALCulate1:EQUation:VALID? 

:CALCulate1:TRACe1:EQUation:VALID? 

3.7.2.6 Equation State 

Command Format :CALCulate<cnum> [:SELected]:EQUation:STATE <bool> 

:CALCulate<cnum> [:SELected]:EQUation:STATE? 

:CALCulate<cnum>:TRACe<tnum>:EQUation:STATE <bool> 

:CALCulate<cnum>:TRACe<tnum>:EQUation:STATE? 

Instruction This command enables/disables the Equation Editor of the active 
trace of selected channel. 

This command enables/disables the Equation Editor of selected trace 
for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Equation editor 

Example :CALCulate1:EQUation:TEXT ‘S11/S22’ 
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:CALCulate1:EQUation:STATE ON 

:CALCulate1:EQUation:STATE? 

Return: 1 

:CALCulate1:TRACe1:EQUation:STATE OFF 

:CALCulate1:TRACe1:EQUation:STATE? 

Return: 0 

 

3.7.2.7 Trace Statistics State 

Command Format :CALCulate<cnum>[:SELected]:MSTatistics[:STATe] <bool>  

:CALCulate<cnum>[:SELected]:MSTatistics[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MSTatistics[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MSTatistics[:STATe]? 

Instruction This command displays and hides the trace statistics (peak-to-peak, 
mean, standard deviation) on the screen. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Statistics 

Example :CALCulate1:MSTatistics:STATe 1 

:CALCulate1:MSTatistics:STATe? 

Return: 1 

:CALCulate1:TRACe1:MSTatistics:STATe 0 

:CALCulate1:TRACe1:MSTatistics:STATe? 

Return: 0 
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3.7.2.8 Statistics Type 

Command Format :CALCulate<cnum>:MEASure<tnum>:FUNCtion:TYPE <type> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:TYPE? 

Instruction This command sets statistic type of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={PTPeak|STDEV|MEAN} 

Return Enumeration 

Default PTPeak 

Menu None 

Example :CALCulate1:MEASure1:FUNCtion:TYPE MEAN 

:CALCulate1:MEASure1:FUNCtion:TYPE? 

Return: MEAN 

 

3.7.2.9 Get Statistics Data 

Command Format :CALCulate<cnum>[:SELected]:MSTatistics:DATA? 

:CALCulate<cnum>:TRACe<tnum>:MSTatistics:DATA? 

Instruction Returns the trace statistic data for the selected statistic type for the 
specified channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu None 
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Example :CALCulate1:TRACe1:MSTatistics:STATe 1 

:CALCulate1:MEASure1:FUNCtion:TYPE MEAN 

:CALCulate1:TRACe1:MSTatistics:DATA? 

:CALCulate1:MSTatistics:DATA? 

 

3.7.2.10 Statistics Range User Span State 

Command Format :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STATe 
<bool> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STATe
? 

Instruction This command sets/gets whether the statistical range is set by the 
user. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Statistics Range > User Span 

Example :CALCulate1:MEASure1:FUNCtion:USER:RANGe:STATe 1 

:CALCulate1:MEASure1:FUNCtion:USER:RANGe:STATe? 

Return: 1 

 

3.7.2.11 User Span Statistics Range Start Frequency 

Command Format :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STARt 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STARt
? 
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Instruction This command sets/gets the start frequency of the user-defined 
statistical span in the statistics range. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the start frequency. 

Return Float, unit Hz 

Default Minimum frequency of the analyzer 

Menu Math > Analysis > Statistics Range > User Span > Start  

Example :CALCulate1:MEASure1:FUNCtion:USER:RANGe:STARt 10000 

:CALCulate1:MEASure1:FUNCtion:USER:RANGe:STARt? 

Return: 10000 

 

3.7.2.12 User Span Statistics Range Stop Frequency 

Command Format :CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STOP 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:FUNCtion:USER:RANGe:STOP
? 

Instruction This command sets/gets the stop frequency of the user-defined 
statistical span in the statistics range. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the stop frequency. 

Return Float, unit Hz 

Default Maximum frequency span of the analyzer 

Menu Math > Analysis > Statistics Range > User Span > Stop 

Example :CALCulate1:MEASure1:FUNCtion:USER:RANGe:STOP 10000 
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:CALCulate1:MEASure1:FUNCtion:USER:RANGe:STOP? 

Return: 10000 

 

3.7.2.13 Limit Test State 

Command Format :CALCulate<cnum>[:SELected]:LIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:LIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:LIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:LIMit[:STATe]? 

Instruction This command turns ON/OFF the limit test function, for the active trace 
of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Limit Test ON 

Example :CALCulate1:LIMit ON 

:CALCulate1:LIMit? 

Return: 1 

:CALCulate1:TRACe1:LIMit OFF 

:CALCulate1:TRACe1:LIMit? 

Return: 0 

3.7.2.14 Limit Line State 

Command Format :CALCulate<cnum>[:SELected]:LIMit:DISPlay[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:LIMit:DISPlay[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DISPlay[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DISPlay[:STATe]? 
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Instruction This command turns ON/OFF the limit line display, for the active trace 
of selected channel. 

This command turns ON/OFF the limit line display of selected trace for 
the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Limit Line ON 

Example :CALCulate1:LIMit:DISPlay ON 

:CALCulate1:LIMit:DISPlay? 

Return: 1 

:CALCulate1:TRACe1:LIMit:DISPlay OFF 

:CALCulate1:TRACe1:LIMit:DISPlay? 

Return: 0 

 

3.7.2.15 Limit Sound State 

Command Format :CALCulate<cnum>:TRACe<tnum>:LIMit:SOUNd[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:LIMit:SOUNd[:STATe]? 

Instruction This command turns ON/OFF the limit testing fail sound of selected 
trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 
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Default OFF 

Menu Math > Analysis > Limit… > Test Sound ON 

Example :CALCulate1:MEASure:LIMit:SOUNd ON 

:CALCulate1:MEASure:LIMit:SOUNd? 

Return: 1 

 

3.7.2.16 Display of limit test failure points 

Command 

Format 

SYSTem:PREFerences:ITEM:RTOF <bool> 

SYSTem:PREFerences:ITEM:RTOF? 

Instruction Set and return whether to display limit line failures as red trace 
segments or red data points (dots). 

Parameter Type <bool>:= ON|OFF|1|0 

ON (1)  Display failures as red trace segments. (Red Trace On Fail). 

OFF (0) Display failures as red data points (dots). 

Return Boolean  

Default 1 

Menu Math > Analysis > Limit… > Display 

Example SYSTem:PREFerences:ITEM:RTOF 0 

SYSTem:PREFerences:ITEM:RTOF? 

Return :0 

 

3.7.2.17 Globle Fail Sign 

Command Format :DISPlay:FSIGn <bool> 

:DISPlay:FSIGn? 

Instruction Shows or hides the window which displays global pass/fail results. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 
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Default OFF 

Menu Math > Analysis > Limit… > Global Pass/Fail ON 

Example :DISPlay:FSIGn 1 

:DISPlay:FSIGn? 

Return: 1 

 

3.7.2.18 Get Limit Test Result 

Command Format :CALCulate<cnum>[:SELected]:LIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:FAIL? 

Instruction This command reads the limit test result, for the active trace of selected 
channel. 

This command reads the limit test result of selected trace for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Boolean  

1: Fail 

0: Pass 

Default None 

Menu None 

Example :CALCulate1:LIMit:FAIL? 

:CALCulate1:TRACe1:LIMit:FAIL? 

 

3.7.2.19 Limit Table 

Command Format :CALCulate<cnum>[:SELected]:LIMit:DATA <numeric 
1>, ... ,<numeric 1+(N*5)> 
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:CALCulate<cnum>[:SELected]:LIMit:DATA? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DATA <numeric 
1>, ... ,<numeric 1+(N*5)> 

:CALCulate<cnum>:TRACe<tnum>:LIMit:DATA? 

Instruction This command sets/gets the limit table for the limit test, for the active 
trace of selected channel 

This command sets/gets the limit table for the limit test of selected 
trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric 1>, ... ,<numeric 1+(N*5)>:Indicates the array data (for limit 
line) of 1 + Num (number of limit lines)*5. Where n is an integer 
between 1 and Num. 

Data(0) :The number of limit lines you want to set. Specify an integer 
ranging 0 to 100. When the number of limit lines is set to 0 (clears the 
limit table), the variable Data is only required with Data(0). 

Data(n*5-4) :The type of the n-th line. 

Specify an integer 0 to 2 as follows. 

0:OFF 

1:Upper limit line 

2:Lower limit line 

 

Data(n*5-3) :The value on the horizontal axis (frequency/power/time) 
of the start point of the n-th line. 

Data(n*5-2) :The value on the horizontal axis (frequency/power/time) 
of the end point of the n-th line. 

Data(n*5-1) :The value on the vertical axis of the start point of the n-
th line. 

Data(n*5) :The value on the vertical axis of the end point of the n-th 
line. 

The index of the array starts from 0. 

Return Data Array 
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Default None 

Menu Math > Analysis > Limit Table 

Example :CALCulate1:LIMit:DATA 2,1,1E9,3E9,0,0,2,1E9,3E9,-3,-3 

:CALCulate1:LIMit:DATA? 

Return: 
2,1,1000000000,3000000000,0,0,2,1000000000,3000000000,-3,-3 

:CALCulate1:TRACe1:LIMit:DATA 2,2,2E9,3E9,-3,0,1,2E9,3E9,-5,-3 

:CALCulate1:TRACe1:LIMit:DATA? 

Return: 2,2,2000000000,3000000000,-3,0,1,2000000000, 
3000000000,-5,-3  

 

3.7.2.20 Get Limit All Report 

Command Format :CALCulate<cnum>[:SELected]:LIMit:REPort:ALL? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:ALL? 

Instruction This command reads the bandwidth test results (stimulus value, limit 
test result, upper limit value and lower limit value of all measurement 
points), for the active trace of selected channel 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Data array 

Indicates the array data (for limit line) of NOP (number of 
measurement points)x4. Where n is an integer between 1 and NOP. 

Data(nx4-3) The stimulus value for the measurement point. 

Data(nx4-2) The limit test result. Specify an integer -1 to 1 as follows. 
-1:No limit 
0:Fail 
1:Pass 

Data(nx4-1) The upper limit value at the measurement point. (If there 
is no limit at this point, reads out the 0.) 

Data(nx4) The lower limit value at the measurement point. (If there is 
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no limit at this point, reads out the 0.) 

The index of the array starts from 0. 

Default None 

Menu None 

Example :CALCulate1:LIMit:REPort:ALL? 

:CALCulate1:TRACe1:LIMit:REPort:ALL? 

 

3.7.2.21 Get Limit Failed Points 

Command Format :CALCulate<cnum>[:SELected]:LIMit:REPort:POINts? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:REPort:POINts? 

Instruction This command reads the number of the measurement points that 
failed the limit test, for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Integer 

Default None 

Menu None 

Example :CALCulate1:LIMit:REPort:POINts? 

:CALCulate1:TRACe1:LIMit:REPort:POINts? 

 

3.7.2.22 Get Limit Failed Data 

Command Format :CALCulate<cnum>[:SELected]:LIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:LIMit:REPort[:DATA]? 

Instruction This command reads the stimulus values (frequency, power level or 
time) at all the measurement points that failed the limit test, for the 
active trace of selected channel. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Data array 

Indicates the array data for failed measurement points. 

Default None 

Menu None 

Example :CALCulate1:LIMit:REPort? 

:CALCulate1:TRACe1:LIMit:REPort? 

 

3.7.2.23 Table Display Type 

Command Format :DISPlay:WINDow<wnum>:TABLe <type> 

:DISPlay:WINDow<wnum>:TABLe? 

Instruction This command selects the type of the window that appears in the lower 
part of the window display, for the selected window. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<type>:={MARKer|LIMit|SEGMent|RLIMit|PLIMit|OFF} 

Return Enumeration 

Default OFF 

Menu Marker > Marker Setup > Marker Table 

Math > Analysis > Limit Table > Limit 

Math > Analysis > Limit Table > Ripple 

Math > Analysis > Limit Table > Point Limit 

Sweep > Segment Table > Show Table 

Example :DISPlay:WINDow2:TABLe RLIMit 

:DISPlay:WINDow2:TABLe? 

Return: RLIM 
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3.7.2.24 Load Limit Table 

Command Format :MMEMory:LOAD:LIMit <string> 

Instruction This command recalls the specified limit table file, from the limit table 
for the active trace of the active channel. 

Parameter Type <string>: represents the specified limit table file, and the parameter 
range: 255 characters or less. 

Return None 

Default None 

Menu Math > Analysis > Limit… > Load Table 

Example :MMEMory:LOAD:LIMit "local/test.csv" 

 

3.7.2.25 Store Limit Table 

Command Format :MMEMory:STORE:LIMit <string> 

Instruction This command saves the limit table of the active trace of the active 
channel into a file in the CSV format (extension ".csv").If a file with the 
same name as the specified file name exists, its contents are 
overwritten. 

Parameter Type <string>: represents the specified limit table file, and the parameter 
range: 255 characters or less. 

Return None 

Default None 

Menu Math > Analysis > Limit… > Save Table 

Example :MMEMory:STORE:LIMit "local/test.csv" 

 

3.7.2.26 Point Limit Test State 
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Command Format :CALCulate<cnum>[:SELected]:PLIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:PLIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:PLIMit[:STATe]? 

Instruction This command turns ON/OFF the point limit test function for the active 
trace of selected channel. 

This command turns ON/OFF the point limit test function for the 
selected trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Point Limit 

Example :CALCulate1:PLIMit ON 

:CALCulate1:PLIMit? 

Return: 1 

:CALCulate1:TRACe1:PLIMit OFF 

:CALCulate1:TRACe1:PLIMit? 

Return: 0 

 

3.7.2.27 Point Limit Line State 

Command Format :CALCulate<cnum>[:SELected]:PLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>[:SELected]:PLIMit:DISPlay:LINE? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DISPlay:LINE? 

Instruction This command turns ON/OFF the point limit line display, for the active 
trac of selected channel (Ch). 

javascript:BSSCPopup('../link/Val_Ch.htm');
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This command turns ON/OFF the point limit line display, for the 
selected trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Point Limit 

Example :CALCulate1:PLIMit:DISPlay:LINE ON 

:CALCulate1:PLIMit:DISPlay:LINE? 

Return: 1 

:CALCulate1:TRACe1:PLIMit:DISPlay:LINE OFF 

:CALCulate1:TRACe1:PLIMit:DISPlay:LINE? 

Return: 0 

 

3.7.2.28 Point Limit Test Sound State 

Command Format :CALCulate<cnum>:MEASure<tnum>:PLIMit:SOUNd <bool> 

:CALCulate<cnum>:MEASure<tnum>:PLIMit:SOUNd? 

Instruction This command gets/sets Point limit testing fail sound state. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Point Limit 

javascript:BSSCPopup('../link/Val_Ch.htm');
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Example :CALCulate1:MEASure1:PLIMit:SOUNd ON 

:CALCulate1:MEASure1:PLIMit:SOUNd? 

Return: 1 

 

3.7.2.29 Point Limit Test Result 

Command Format :CALCulate<cnum>[:SELected]:PLIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:FAIL? 

Instruction This command reads the point test result for the active trace of 
selected channel (Ch). 

This command reads the point test result for the selected trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Boolean 

1: Fail 

0: Pass 

Default None 

Menu None 

Example :CALCulate1:PLIMit:FAIL? 

:CALCulate1:TRACe1:PLIMit:FAIL? 

 

3.7.2.30 Get Point Limit test report 

Command Format :CALCulate<cnum>[:SELected]:PLIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:REPort[:DATA]? 

Instruction This command reads all test results with indexes of active point limits 
for the active trace of selected channel (Ch). 

This command reads all test results with indexes of active point limits 
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for the selected trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Indicates the array data of 1 + Num (active number of point limits)*2. 
The head value is number of active limits, first of 2 is limit index, and 
second is fail state. 

Returns the below result for each measurement point: 

({Number of active limit}, 1 , Result (pass=0 , fail=1), 2,  Result (pass=0 , 
fail=1), ,,, {point no}, results 

Default 0 

Menu Math > Analysis > Limit… > Point Limit 

Example :CALCulate1:PLIMit:REPort? 

:CALCulate1:TRACe1:PLIMit:REPort? 

 

3.7.2.31 Point Limit Data 

Command Format :CALCulate<cnum>[:SELected]:PLIMit:DATA <string> 

:CALCulate<cnum>[:SELected]:PLIMit:DATA? 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DATA <string> 

:CALCulate<cnum>:TRACe<tnum>:PLIMit:DATA? 

Instruction This command sets/gets the list of point limit test for the active trace 
of selected channel (Ch). 

This command sets/gets the list of point limit test for the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<string>: the list of point limit test for the active trace. 

Returns the below result for each point:  
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{Number of Limit}, {State for point 1(On=1, Off=0)}, {Stimulus for point 
1},  {Lower Limit for point 1}, {Uppder Limit for point 1} ,,,, {State for 
point n(On=1, Off=0)}, {Stimulus for point n},  {Lower Limit for point n}, 
{Uppder Limit for point n} 

Return Data array 

Default None 

Menu Math > Analysis > Limit… > Point Limit 

Example :CALC1:PLIM:DATA 2,1,1E9,-2,3,1,4E9,2,5 

:CALC1:PLIM:DATA? 

Return: 2,1,1000000000,-2,3,1,4000000000,2,5 

:CALCulate1:TRACe1:PLIMit:DATA 2,1,1E9,-2,3,0,4E9,-5,-3 

:CALCulate1:TRACe1:PLIMit:DATA? 

Return: 2,1,1000000000,-2,3,0,4000000000,-5,-3 

 

3.7.2.32 Load Point Limit Table 

Command Format :MMEMory:LOAD:PLIMit <string> 

Instruction This command recalls the specified point limit table file, from the point 
limit table for the active trace of the active channel. 

Parameter Type <string>: represents the specified point limit table file, and the 
parameter range: 255 characters or less. 

Return None 

Default None 

Menu Math > Analysis > Limit… > Point Limit > Load Table 

Example :MMEMory:LOAD:PLIMit "local/test.csv" 

 

3.7.2.33 Store Point Limit Table 

Command Format :MMEMory:STORE:RLIMit <string> 

Instruction This command saves the point limit table of the active trace of the 
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active channel into a file in the CSV format (extension ".csv").If a file 
with the same name as the specified file name exists, its contents are 
overwritten. 

Parameter Type <string>: represents the specified point limit table file, and the 
parameter range: 255 characters or less. 

Return None 

Default None 

Menu Math > Analysis > Limit… > Point Limit > Save Table 

Example :MMEMory:STORE:PLIMit "local/test.csv" 

 

3.7.2.34 Ripple Limit Test State 

Command Format :CALCulate<cnum>[:SELected]:RLIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:RLIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:RLIMit[:STATe]? 

Instruction This command turns ON/OFF the ripple test function for the active 
trace of selected channel. 

This command turns ON/OFF the ripple test function for the selected 
trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Ripple 

Example :CALCulate1:RLIMit ON 

:CALCulate1:RLIMit? 

Return: 1 
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:CALCulate1:TRACe1:RLIMit OFF 

:CALCulate1:TRACe1:RLIMit? 

Return: 0 

 

3.7.2.35 Ripple Limit Line State 

Command Format :CALCulate<cnum>[:SELected]:RLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>[:SELected]:RLIMit:DISPlay:LINE? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DISPlay:LINE <bool> 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DISPlay:LINE? 

Instruction This command turns ON/OFF the ripple limit line display, for the active 
trac of selected channel (Ch). 

This command turns ON/OFF the ripple limit line display, for the 
selected trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Ripple 

Example :CALCulate1:RLIMit:DISPlay:LINE ON 

:CALCulate1:RLIMit:DISPlay:LINE? 

Return: 1 

:CALCulate1:TRACe1:RLIMit:DISPlay:LINE OFF 

:CALCulate1:TRACe1:RLIMit:DISPlay:LINE? 

Return: 0 

 

3.7.2.36 Ripple Limit Test Sound State 
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Command Format :CALCulate<cnum>:MEASure<tnum>:RLIMit:SOUNd <bool> 

:CALCulate<cnum>:MEASure<tnum>:RLIMit:SOUNd? 

Instruction This command gets/sets Ripple limit testing fail sound state. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Ripple 

Example :CALCulate1:MEASure1:RLIMit:SOUNd ON 

:CALCulate1:MEASure1:RLIMit:SOUNd? 

Return: 1 

 

3.7.2.37 Ripple Limit Test Result 

Command Format :CALCulate<cnum>[:SELected]:RLIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:FAIL? 

Instruction This command reads the ripple test result for the active trace of 
selected channel (Ch). 

This command reads the ripple test result for the selected trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Boolean 

1: Fail 

0: Pass 

Default None 
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Menu None 

Example :CALCulate1:RLIMit:FAIL? 

:CALCulate1:TRACe1:RLIMit:FAIL? 

 

3.7.2.38 Ripple Limit Data 

Command Format :CALCulate<cnum>[:SELected]:RLIMit:DATA <string> 

:CALCulate<cnum>[:SELected]:RLIMit:DATA? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DATA <string> 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:DATA? 

Instruction This command sets/gets the ripple limit table for the active trace of 
selected channel (Ch). 

This command sets/gets the ripple limit table for the selected trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<string>:Indicates the array data (for ripple line) of 1 + Num (number 
of limit lines)\4. Where n is an integer between 1 and Num. 

Data(0) :The number of limit lines you want to set. Specify an integer 
ranging 0 to 12. When the number of limit lines is set to 0 (clears the 
limit table), the variable Data is only required with Data(0). 

Data(nx4-3) :The type of the n-th line. 
Specify an integer 0 to 1 as follows. 
0:UNUSED 
1:ON 

2:OFF 

Data(nx4-2) :The value on the horizontal axis (frequency/power/time) 
of the start point of the n-th line. 

Data(nx4-1) :The value on the horizontal axis (frequency/power/time) 
of the end point of the n-th line. 

Data(nx4) :The ripple line value (dB) of the n-th line. 

The index of the array starts from 0. 
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Return Data array 

Default None 

Menu Math > Analysis > Limit… > Ripple 

Example :CALC1:RLIM:DATA 2,1,1E9,3E9,3,1,5E9,7E9,3 

:CALC1:RLIM:DATA? 

Return: 2,1,1000000000,3000000000,3,1,5000000000,7000000000,3 

:CALCulate1:TRACe1:RLIMit:DATA 2,1,1E9,2E9,3,0,5E9,6E9,-3 

:CALCulate1:TRACe1:RLIMit:DATA? 

Return: 2,1,1000000000,2000000000,3,0,5000000000,6000000000,-
3 

 

3.7.2.39 Get Ripple Result 

Command Format :CALCulate<cnum>[:SELected]:RLIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:RLIMit:REPort[:DATA]? 

Instruction This command reads the ripple value of the ripple test for the active 
trace of selected channel (Ch). 

This command reads the ripple value of the ripple test for the selected 
trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Indicates the array data (for ripple line) of 1 + Num (number of limit 
lines)*3. Where n is an integer between 1 and 12. 

Data(0): Number of ripple limit line. 

Data(nx3-2): Number of ripple limit bands. 

Data(nx3-1): Ripple value. 

Data(nx3): Results of ripple test. 

Select from the following. 

0: PASS 

1: FAIL. 
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The index of the array starts from 0. 

Default 0 

Menu Math > Analysis > Limit… > Ripple 

Example :CALCulate1:RLIMit:REPort? 

:CALCulate1:TRACe1:RLIMit:REPort? 

 

3.7.2.40 Load Ripple Limit Table 

Command Format :MMEMory:LOAD:RLIMit <string> 

Instruction This command recalls the specified ripple limit table file, from the ripple 
limit table for the active trace of the active channel. 

Parameter Type <string>: represents the specified ripple limit table file, and the 
parameter range: 255 characters or less. 

Return None 

Default None 

Menu Math > Analysis > Limit… > Ripple > Load Table 

Example :MMEMory:LOAD:RLIMit "local/test.csv" 

 

3.7.2.41 Store Ripple Limit Table 

Command Format :MMEMory:STORE:RLIMit <string> 

Instruction This command saves the ripple limit table of the active trace of the 
active channel into a file in the CSV format (extension ".csv").If a file with 
the same name as the specified file name exists, its contents are 
overwritten. 

Parameter Type <string>: represents the specified ripple limit table file, and the 
parameter range: 255 characters or less. 

Return None 

Default None 
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Menu Math > Analysis > Limit… > Ripple > Save Table 

Example :MMEMory:STORE:RLIMit "local/test.csv" 

 

3.7.2.42 Bandwidth Test State 

Command Format :CALCulate<cnum>[:SELected]:BLIMit[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:BLIMit[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit[:STATe] <bool> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit[:STATe]? 

Instruction This command turns ON/OFF the bandwidth test function, for the 
active trace of selected channel. 

This command turns ON/OFF the bandwidth test function of the 
selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Bandwidth 

Example :CALCulate1:BLIMit ON 

:CALCulate1:BLIMit? 

Return: 1 

:CALCulate1:TRACe1:BLIMit OFF 

:CALCulate1:TRACe1:BLIMit? 

Return: 0 

 

3.7.2.43 Bandwidth Test Value State 
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Command Format :CALCulate<cnum>[:SELected]:BLIMit:DISPlay:VALue <bool> 

:CALCulate<cnum>[:SELected]:BLIMit:DISPlay:VALue? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:VALue <bool> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:VALue? 

Instruction This command turns ON/OFF the bandwidth value display of the 
bandwidth test, for the active trace of selected channel. 

This command turns ON/OFF the bandwidth value display of the 
bandwidth test of selected trace for the selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu None 

Example :CALCulate1:BLIMit:DISPlay:VALue ON 

:CALCulate1:BLIMit:DISPlay:VALue? 

Return: 1 

:CALCulate1:TRACe1:BLIMit:DISPlay:VALue OFF 

:CALCulate1:TRACe1:BLIMit:DISPlay:VALue? 

Return: 0 

 

3.7.2.44 Bandwidth Test Marker State 

Command Format :CALCulate<cnum>[:SELected]:BLIMit:DISPlay:MARKer <bool> 

:CALCulate<cnum>[:SELected]:BLIMit:DISPlay:MARKer? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:MARKer <bool> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DISPlay:MARKer? 

Instruction This command turns ON/OFF the marker display of the bandwidth test, 
for the active trace of selected channel. 
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This command turns ON/OFF the marker display of the bandwidth test 
of selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Analysis > Limit… > Bandwidth > Bandwidth Marker On 

Example :CALCulate1:BLIMit:DISPlay:MARKer ON 

:CALCulate1:BLIMit:DISPlay:MARKer? 

Return: 1 

:CALCulate1:TRACe1:BLIMit:DISPlay:MARKer OFF 

:CALCulate1:TRACe1:BLIMit:DISPlay:MARKer? 

Return: 0 

 

3.7.2.45 Bandwidth Test Threshold 

Command Format :CALCulate<cnum>[:SELected]:BLIMit:DB <numeric> 

:CALCulate<cnum>[:SELected]:BLIMit:DB?  

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DB <numeric> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:DB? 

Instruction This command sets/gets the bandwidth threshold value (attenuation 
from the peak) of the bandwidth test, for the selected channel. 

This command sets/gets the bandwidth threshold value (attenuation 
from the peak) of the bandwidth test of selected trace for the selected 
channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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<numeric>:represents the bandwidth threshold value (attenuation 
from the peak) of the bandwidth test, and the parameter range: 0-
500MdB. 

Return Float, unit: dB 

Default 3 

Menu Math > Analysis > Limit… > Bandwidth > N dB Points 

Example :CALCulate1:BLIMit:DB 3.5 

:CALCulate1:BLIMit:DB? 

Return: 3.5 

:CALCulate1:TRACe1:BLIMit:DB 4 

:CALCulate1:TRACe1:BLIMit:DB? 

Return: 4 

 

3.7.2.46 Bandwidth Test MiNimum 

Command Format :CALCulate<cnum>[:SELected]:BLIMit:MiNimum <numeric> 

:CALCulate<cnum>[:SELected]:BLIMit:MiNimum?  

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MiNimum <numeric> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MiNimum? 

Instruction This command sets/gets the lower limit value of the bandwidth test, for 
the selected channel. 

This command sets/gets the lower limit value of the bandwidth test of 
selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the lower limit value. 

Return Float 

Default 10kHz 

Menu Math > Analysis > Limit… > Bandwidth > Min Bandwidth 
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Example :CALCulate1:BLIMit:MiNimum 2000000 

:CALCulate1:BLIMit:MiNimum? 

Return: 2000000 

:CALCulate1:TRACe1:BLIMit:MiNimum 5000000 

:CALCulate1:TRACe1:BLIMit:MiNimum? 

Return: 5000000 

 

3.7.2.47 Bandwidth Test Maximum 

Command Format :CALCulate<cnum>[:SELected]:BLIMit:MAXimum <numeric> 

:CALCulate<cnum>[:SELected]:BLIMit:MAXimum?  

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MAXimum <numeric> 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:MAXimum? 

Instruction This command sets/gets the upper limit value of the bandwidth test, 
for the selected channel. 

This command sets/gets the upper limit value of the bandwidth test of 
selected trace for the selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the upper limit value. 

Return Float 

Default 300kHz 

Menu Math > Analysis > Limit… > Bandwidth > Max Bandwidth 

Example :CALCulate1:BLIMit:MAXimum 3500000 

:CALCulate1:BLIMit:MAXimum? 

Return: 3500000 

:CALCulate1:TRACe1:BLIMit:MAXimum 4000000 

:CALCulate1:TRACe1:BLIMit:MAXimum? 

Return: 4000000 
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3.7.2.48 Get Bandwidth Test Fail Result 

Command Format :CALCulate<cnum>[:SELected]:BLIMit:FAIL? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:FAIL? 

Instruction This command gets the bandwidth limit test results, for the active trace 
of selected channel. 

This command gets the bandwidth limit test results, for the selected 
trace of selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Boolean 

1: Pass 

0: Fail 

Default None 

Menu None 

Example :CALCulate1:BLIMit:FAIL? 

:CALCulate1:TRACe1:BLIMit:FAIL? 

 

3.7.2.49 Bandwidth Test Report Data 

Command Format :CALCulate<cnum>[:SELected]:BLIMit:REPort[:DATA]? 

:CALCulate<cnum>:TRACe<tnum>:BLIMit:REPort[:DATA]? 

Instruction This command reads the bandwidth value of the bandwidth test, for 
the active trace of selected channel. 

This command reads the bandwidth value of the bandwidth test of 
selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 
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<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float 

Default None 

Menu None 

Example :CALCulate1:BLIMit:REPort? 

:CALCulate1:TRACe1:BLIMit:REPort? 

 

3.7.3 Time Domain 

3.7.3.1 Command List 

Transform State :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STATe 

Transform Start :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STARt 

Transform Stop :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STOP 

Transform Center :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:CENTer 

Transform Span :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:SPAN 

Transform Mode :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME[:TYPE] 

Transform Stimulus :CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STIMulus 

Transform Set Low Pass 
Frequencies 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:LPFRequency 

Transform Auto 
Extrapolate 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCS
Param:AUTO 

Transform manual 
Extrapolate value 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCS
Param 

Set Auto Extrapolate to 
manual value 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCS
Param:EXTRapolate 

 

3.7.3.2 Transform State 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:STATe <bool> 
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:CALCulate<cnum>[:SELected]:TRANsform:TIME:STATe? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STATe <bool> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STATe? 

Instruction This command turns ON/OFF the transformation function of the time 
domain function, for the active trace of selected channel. 

This command turns ON/OFF the transformation function of the time 
domain function of selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Time Domain > Transform 

Example :CALCulate1:TRANsform:TIME:STATe ON 

:CALCulate1:TRANsform:TIME:STATe? 

Return: 1 

:CALCulate1:TRACe1:TRANsform:TIME:STATe OFF 

:CALCulate1:TRACe1:TRANsform:TIME:STATe? 

Return: 0 

 

3.7.3.3 Transform Start 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:STARt <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STARt? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STARt 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STARt? 

Instruction This command sets/gets the start value of the transformation used for 
the transformation function of the time domain function, for the active 
trace of selected channel. 
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This command sets/gets the start value of the transformation used for 
the transformation function of the time domain function of selected 
trace for the selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the start time. 

Return Float, unit s(second) 

Default None 

Menu Math > Time Domain > Start Time 

Example :CALCulate1:TRANsform:TIME:STARt -1e-9 

:CALCulate1:TRANsform:TIME:STARt? 

Return: -1e-09 

:CALCulate1:TRACe1:TRANsform:TIME:STARt 1e-9 

:CALCulate1:TRACe1:TRANsform:TIME:STARt? 

Return: 1e-09 

 

3.7.3.4 Transform Stop 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:STOP <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STOP? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STOP 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STOP? 

Instruction This command sets/gets the stop value of the transformation used for 
the transformation function of the time domain function, for the active 
trace of selected channel. 

This command sets/gets the stop value of the transformation used for 
the transformation function of the time domain function of selected 
trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the stop time. 

Return Float, unit s(second) 

Default None 

Menu Math > Time Domain > Stop Time 

Example :CALCulate1:TRANsform:TIME:STOP 20e-9 

:CALCulate1:TRANsform:TIME:STOP? 

Return: 2e-08 

:CALCulate1:TRACe1:TRANsform:TIME:STOP 15e-9 

:CALCulate1:TRACe1:TRANsform:TIME:STOP? 

Return: 1.5e-08 

 

3.7.3.5 Transform Center 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:CENTer <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:CENTer? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:CENTer 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:CENTer? 

Instruction This command sets/gets the center value of the transformation used 
for the transformation function of the time domain function, for the 
active trace of selected channel 

This command sets/gets the center value of the transformation used 
for the transformation function of the time domain function of selected 
trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the center time. 
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Return Float, unit s(second) 

Default None 

Menu Math > Time Domain > Center Time 

Example :CALCulate1:TRANsform:TIME:CENTer 12e-9 

:CALCulate1:TRANsform:TIME:CENTer? 

Return: 1.2e-08 

:CALCulate1:TRACe1:TRANsform:TIME:CENTer 15e-9 

:CALCulate1:TRACe1:TRANsform:TIME:CENTer? 

Return: 1.5e-08 

 

3.7.3.6 Transform Span 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:SPAN <numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:SPAN? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:SPAN 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:SPAN? 

Instruction This command sets/gets the span value of the transformation used for 
the transformation function of the time domain function, for the active 
trace of selected channel. 

This command sets/gets the span value of the transformation used for 
the transformation function of the time domain function of selected 
trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the span time. 

Return Float, unit s(second) 

Default None 

Menu Math > Time Domain > Span Time 
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Example :CALCulate1:TRANsform:TIME:SPAN 10e-9 

:CALCulate1:TRANsform:TIME:SPAN? 

Return: 1e-08 

:CALCulate1:TRACe1:TRANsform:TIME:SPAN 15e-9 

:CALCulate1:TRACe1:TRANsform:TIME:SPAN? 

Return: 1.5e-08 

 

3.7.3.7 Transform Mode 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME[:TYPE] <type> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME[:TYPE]? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME[:TYPE] <type> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME[:TYPE]? 

Instruction This command sets/gets the transformation type used for the 
transformation function of the time domain function, for the active 
trace of selected channel. 

This command sets/gets the transformation type used for the 
transformation function of the time domain function, for the selected 
trace and selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={BPASs|LPASs} 

Return Enumeration 

Default BPASs 

Menu Math > Time Domain > TD Mode 

Example :CALCulate1:TRANsform:TIME LPASs 

:CALCulate1:TRANsform:TIME? 

Return: LPAS 

:CALCulate1:TRACe1:TRANsform:TIME BPASs 

:CALCulate1:TRACe1:TRANsform:TIME? 
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Return: BPAS 

 

3.7.3.8 Transform Stimulus 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:STIMulus <type> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:STIMulus? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STIMulus 
<type> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:STIMulus? 

Instruction This command sets/gets the stimulus type used for the transformation 
function of the time domain function, for the active trace of selected 
channel. 

This command sets/gets the stimulus type used for the transformation 
function of the time domain function of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={IMPulse|STEP} 

Return Enumeration 

Default IMPulse 

Menu Math > Time Domain > TD Mode 

Example :CALCulate1:TRANsform:TIME LPASs 

:CALCulate1:TRANsform:TIME:STIMulus STEP 

:CALCulate1:TRANsform:TIME:STIMulus? 

Return: STEP 

:CALCulate1:TRACe1:TRANsform:TIME LPASs 

:CALCulate1:TRACe1:TRANsform:TIME:STIMulus IMPulse 

:CALCulate1:TRACe1:TRANsform:TIME:STIMulus? 

Return: IMP 
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3.7.3.9 Transform Set Low Pass Frequencies 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:LPFRequency 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:LPFRequency 

Instruction Sets the start frequencies in LowPass Mode, for the active trace. 
Sets the start frequencies in LowPass Mode, for the selected channel 
and the trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu Math > Time Domain > Time Domain Setup… > Transform > Set Low 
Pass Frequencies 

Example :CALCulate1:TRANsform:TIME:LPFRequency 

:CALCulate1:TRACe1:TRANsform:TIME:LPFRequency 

3.7.3.10 Transform Auto Extrapolate 

Command Format :CALCulate<cnum> 
[:SELected]:TRANsform:TIME:LPASs:DCSParam:AUTO <bool> 

:CALCulate<cnum> 
[:SELected]:TRANsform:TIME:LPASs:DCSParam:AUTO? 

 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSPar
am:AUTO <bool> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSPar
am:AUTO? 

Instruction sets/gets the active trace low-pass mode time domain conversion 
automatic DC extrapolation mode, for the active trace of selected 
channel. 

sets/gets the time domain conversion automatic DC extrapolation 
mode of the low-pass mode of selected trace for the selected channel. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default On 

Menu Math > Time Domain > Time Domain Setup… > Advance > Auto 
Extrapolate 

Example :CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam:AUTO 
OFF 

:CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam:AUTO? 

Return:0 

 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam:AUTO ON 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam:AUTO? 

Return:1 

 

3.7.3.11 Transform manual Extrapolate value 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:LPASs:DCSParam 
<numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:LPASs:DCSParam? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSPar
am <numeric> 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSPara
m? 

Instruction sets/gets the time domain conversion DC extrapolation mode to 
manual of the low-pass mode of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
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specified, <tnum> defaults to 1. 

<numeric>:represents the DC extrapolation value, and the parameter 
range: -1E15~1E15. 

Return Float 

Default 1 

Menu Math > Time Domain > Time Domain Setup… > Advance > Manual 
Entry 

Example :CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam 9 

:CALCulate1:SELected1:TRANsform:TIME:LPASs:DCSParam? 

Return:9 

 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam 11 

:CALCulate1:TRACe1:TRANsform:TIME:LPASs:DCSParam? 

Return:11 

 

3.7.3.12 Set Auto Extrapolate to manual value 

Command 
Format 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:LPASs:DCSParam:EXT
Rapolate 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:LPASs:DCSParam:
EXTRapolate 

Instruction Sets the time domain conversion automatic DC extrapolation value to 
manual value of the low-pass mode of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If not 
specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None  

Default None  

Menu Math > Time Domain > Time Domain Setup… > Advance > Extrapolate 
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Example :CALCulate1:SELected:TRANsform:TIME:LPASs:DCSParam:EXTRapolate 

 

3.7.4 Time Gating 

3.7.4.1 Command List 

Gating State :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STATe 

Gating Start :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STARt 

Gating Stop :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STOP 

Gating Center :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:CENTer 

Gating Span :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SPAN 

Gating Type :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:TYPE 

Gating Shape :CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SHAPE 

Time Domain Window 
Impulse Width 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:IMPulse:WIDTh 

Time Domain Window 
Kaiser Beta 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:KBESsel 

 

3.7.4.2 Gating State 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STATe <bool> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STATe? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STATe 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STATe? 

Instruction This command turns ON/OFF the gating function of the time domain 
function, for the active trace of selected channel. 

This command turns ON/OFF the gating function of the time domain 
function of selected trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > Time Gating > Gating 

Example :CALCulate1:FILTer:TIME:STATe ON 

:CALCulate1:FILTer:TIME:STATe? 

Return: 1 

:CALCulate1:TRACe1:FILTer:TIME:STATe OFF 

:CALCulate1:TRACe1:FILTer:TIME:STATe? 

Return: 0 

 

3.7.4.3 Gating Start 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STARt 
<numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STARt? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STARt 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STARt? 

Instruction This command sets/gets the start value of the gate used for the gating 
function of the time domain function, for the active trace of selected 
channel. 

This command sets/gets the start value of the gate used for the gating 
function of the time domain function of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the gating start time, and the parameter range: 
-250e-9, 250e-9. 

Return float, unit s(second) 
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Default -250e-9 

Menu Math > Time Gating > Gate Start 

Example :CALCulate1:FILTer:TIME:STARt -1e-9 

:CALCulate1:FILTer:TIME:STARt? 

Return: -1e-09 

:CALCulate1:TRACe1:FILTer:TIME:STARt -2e-9 

:CALCulate1:TRACe1:FILTer:TIME:STARt? 

Return: -2e-09 

 

3.7.4.4 Gating Stop 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STOP <numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:STOP? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STOP 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:STOP? 

Instruction This command sets/gets the stop value of the gate used for the gating 
function of the time domain function, for the active trace of selected 
channel. 

This command sets/gets the stop value of the gate used for the gating 
function of the time domain function of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the gating stop time, and the parameter range: 
-250e-9, 250e-9. 

Return float, unit s(second) 

Default 250e-9 

Menu Math > Time Gating > Gate Stop 

Example :CALCulate1:FILTer:TIME:STOP 10e-9 
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:CALCulate1:FILTer:TIME:STOP? 

Return: 1e-08 

:CALCulate1:TRACe1:FILTer:TIME:STOP 15e-9 

:CALCulate1:TRACe1:FILTer:TIME:STOP? 

Return: 1.5e-08 

 

3.7.4.5 Gating Center 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:CENTer 
<numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:CENTer? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:CENTer 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:CENTer? 

Instruction This command sets/gets the center value of the gate used for the 
gating function of the time domain function, for the active trace of 
selected channel. 

This command sets/gets the center value of the gate used for the 
gating function of the time domain function of selected trace for the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the gating center time. 

Return float, unit s(second) 

Default 0 

Menu Math > Time Gating > Gate Center 

Example :CALCulate1:FILTer:TIME:CENTer 10e-9 

:CALCulate1:FILTer:TIME:CENTer? 

Return: 1e-08 

:CALCulate1:TRACe1:FILTer:TIME:CENTer 12e-9 
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:CALCulate1:TRACe1:FILTer:TIME:CENTer? 

Return: 1.2e-08 

 

3.7.4.6 Gating Span 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SPAN <numeric> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SPAN? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SPAN 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SPAN? 

Instruction This command sets/gets the span value of the gate used for the gating 
function of the time domain function, for the active trace of selected 
channel. 

This command sets/gets the span value of the gate used for the gating 
function of the time domain function of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the gating span time. 

Return float, unit s(second) 

Default 500e-9 

Menu Math > Time Gating > Gate Span 

Example :CALCulate1:FILTer:TIME:SPAN 10e-9 

:CALCulate1:FILTer:TIME:SPAN? 

Return: 1e-08 

:CALCulate1:TRACe1:FILTer:TIME:SPAN 15e-9 

:CALCulate1:TRACe1:FILTer:TIME:SPAN? 

Return: 1.5e-08 
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3.7.4.7 Gating Type 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:TYPE <type> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:TYPE? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:TYPE <type> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:TYPE? 

Instruction This command sets/gets the type of the gate used for the gating 
function of the time domain function, for the active trace of selected 
channel. 

This command sets/gets the type of the gate used for the gating 
function of the time domain function of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={BPASs| NOTCh} 

Return Enumeration 

Default BPASs 

Menu Math > Time Gating > Gate Type 

Example :CALCulate1:FILTer:TIME:TYPE NOTCh 

:CALCulate1:FILTer:TIME:TYPE? 

Return: NOTC 

:CALCulate1:TRACe1:FILTer:TIME:TYPE BPASs 

:CALCulate1:TRACe1:FILTer:TIME:TYPE? 

Return: BPAS 

 

3.7.4.8 Gating Shape 

Command Format :CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SHAPe <type> 

:CALCulate<cnum>[:SELected]:FILTer[:GATE]:TIME:SHAPe? 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SHAPE 
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<type> 

:CALCulate<cnum>:TRACe<tnum>:FILTer[:GATE]:TIME:SHAPE? 

Instruction This command sets/gets the shape of the gate used for the gating 
function of the time domain function, for the active trace of selected 
channel. 

This command sets/gets the shape of the gate used for the gating 
function of the time domain function of selected trace for the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={MAXimum|WIDE|NORMal|MINimum} 

Return Enumeration 

Default NORMal 

Menu Math > Time Gating > Gate Shape 

Example :CALCulate1:FILTer:TIME:SHAPe MINimum 

:CALCulate1:FILTer:TIME:SHAPe? 

Return: MIN 

:CALCulate1:TRACe1:FILTer:TIME:SHAPe WIDE 

:CALCulate1:TRACe1:FILTer:TIME:SHAPe? 

Return: WIDE 

 

3.7.4.9 Time Domain Window Impulse Width 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:IMPulse:WIDTh 
<numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:IMPulse:WIDTh? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:IMPulse:WIDTh 
<numeric> 
:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:IMPulse: 
WIDTh? 
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Instruction This command sets/gets the pulse width of the activation trace time 
domain window. 

This command sets/gets the pulse width of the time domain window 
for selecting channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the pulse width, and the parameter range: 
141.965927ps~326.518527ps. 

Return Float, unit s(second) 

Default 229.934230ps 

Menu Math > Time Domain > Time Domain Setup… > Window > Impulse 
Width 

Example :CALCulate1:TRANsform:TIME:IMPulse:WIDTh 1.77344558e-10 

:CALCulate1:TRANsform:TIME:IMPulse:WIDTh? 

Return: 1.77344558e-10 

 

:CALCulate1:TRACe1:TRANsform:TIME:IMPulse:WIDTh  
1.77344558e-10 

:CALCulate1:TRACe1:TRANsform:TIME:IMPulse:WIDTh? 
Return: 1.77344558e-10 

 

3.7.4.10 Time Domain Window Kaiser Beta 

Command Format :CALCulate<cnum>[:SELected]:TRANsform:TIME:KBESsel 
<numeric> 

:CALCulate<cnum>[:SELected]:TRANsform:TIME:KBESsel? 

:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:KBESsel 
<numeric> 
:CALCulate<cnum>:TRACe<tnum>:TRANsform:TIME:KBESsel? 

Instruction This command sets/gets the Kaiser Beta value of the activation trace 
time domain window. 
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This command sets/gets the Kaiser Beta value of the time domain 
window for selecting channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the Kaiser Beta value, and the parameter range: 
0~13. 

Return Float 

Default 6 

Menu Math > Time Domain > Time Domain Setup… > Window > Kaiser Beta 

Example :CALCulate1:TRANsform:TIME:KBESsel 3.4 

:CALCulate1:TRANsform:TIME:KBESsel? 

Return: 3.4 

 

:CALCulate1:TRACe1:TRANsform:TIME:KBESsel 3.4 

:CALCulate1:TRACe1:TRANsform:TIME:KBESsel? 
Return: 3.4 

 

3.8 Marker Commands 

3.8.1 Marker 

3.8.1.1 Command List 

Active Marker :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:ACTivate 

Marker State :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>[:STATe] 

Marker X Value :CALCulate<cnum>:TRACe<tnum>:MARKer:X 

Get Response and 
Stimulus Data of Marker 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DATA? 

Get Marker Y Value :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:Y? 

Reference Marker State :CALCulate<cnum>:TRACe<tnum>:MARKer:REFerence[:STATe] 

All Marker Off :CALCulate<cnum>:MEASure<tnum>:MARKer:AOFF 
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3.8.1.2 Active Marker 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:ACTivate 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:ACTivate 

Instruction This command sets the marker 1 to 9 (Mk) and reference marker 
(Mk:10) to the active marker. The marker on a trace that can be 
repositioned either by front panel controls or by programming 
commands, for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 1 to 10 (10 is for the reference marker) 

Default None 

Menu Marker > Marker > Select 

Example :CALCulate1:MARKer3:ACTivate 

:CALCulate1:TRACe1:MARKer3:ACTivate 

 

3.8.1.3 Marker State 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>[:STATe]? 

 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>[:STATe] 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>[:STATe]? 

 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>[:STATe] 
<bool> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum> [:STATe]? 

javascript:BSSCPopup('../link/Val_Mk.htm');
javascript:TextPopup(this)
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Instruction This command turns ON/OFF the display of marker 1 to 9 and 
reference marker (Mk:10), for the active trace of selected channel; 

This command turns ON/OFF the display of marker 1 to 9 and 
reference marker (Mk:10), for the selected trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu None 

Example :CALCulate1:MARKer2 ON 

:CALCulate1:MARKer2? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer2 OFF 

:CALCulate1:TRACe1:MARKer2? 

Return: 0 

 

:CALCulate1:MEASure1:MARKer5 ON 

:CALCulate1:MEASure1:MARKer5? 

Return: 1 

 

3.8.1.4 Marker X Value 

Command Format :CALCulate<cnum>[:SELected]:MARKer:X <numeric> 

:CALCulate<cnum>[:SELected]:MARKer:X? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:X <numeric>  

:CALCulate<cnum>:TRACe<tnum>:MARKer:X? 
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Instruction This command set the stimulus value for marker 1 to 9 (Mk) and 
reference marker (Ch:10), for the active trace of selected channel. 

This command set the stimulus value for marker 1 to 9 (Mk) and 
reference marker (Ch:10), for the a selected ctive trace of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the stimulus value. 

Return float 

Default None 

Menu Marker > Marker > Marker x(x: 1-9 and R) 

Example :CALCulate1:MARKer1:X 1e9 

:CALCulate1:MARKer1:X? 

Return: 1000000000 

 

:CALCulate1:TRACe1:MARKer:X 2e9 

:CALCulate1:TRACe1:MARKer:X? 

Return: 2000000000 

 

3.8.1.5 Get Response and Stimulus Data of Marker 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:DATA? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DATA? 

Instruction This command reads the response and stimulus value of marker 1 to 9 
(Mk) and reference marker (Mk:10), for the active trace of selected 
channel. 

This command reads the response and stimulus value of marker 1 to 9 
(Mk) and reference marker (Mk:10), for the selected trace of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

Return Data array 

Indicates 3-element array data (response and stimulus of marker). 

Data(0) :Response value (primary value) at the marker position. 

Data(1) :Response value (secondary value) at the marker position. 
Always 0 when the data format is not the Smith chart format or the 
polar format. 

Data(2) :Stimulus value at the marker position. 

The index of the array starts from 0. 

Default None 

Menu None 

Example :CALCulate1:MARKer3:DATA? 

:CALCulate1:TRACe1:MARKer3:DATA? 

 

3.8.1.6 Get Marker Y Value 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:Y? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:Y? 

Instruction Reads the marker's Y-axis value. The format of the value depends on 
the marker setup. If the marker is set as delta, the data is relative to 
the reference marker. The query always returns two numbers. 

Smith and Polar formats - (Real, Imaginary) 

All other formats - (Value,0) 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 
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Return Numeric 

Default None 

Menu None 

Example  Smith formats: 

:CALCulate1:MARKer1:Y? 

:CALCulate1:TRACe1:MARKer1:Y? 

Retrun : 39.3147784266,12.8101028317 

 

 Not Smith or Polar formats: 

:CALCulate1:MARKer1:Y? 

:CALCulate1:TRACe1:MARKer1:Y? 

Return: -14.6367454451,0 

 

3.8.1.7 Reference Marker State 

Command Format :CALCulate<cnum>[:SELected]:MARKer:REFerence[:STATe] <bool> 

:CALCulate<cnum>[:SELected]:MARKer:REFerence[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:REFerence[:STATe] 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:REFerence[:STATe]? 

Instruction This command turns ON/OFF the reference marker for the active 
trace of selected channel; 

This command turns ON/OFF the reference marker for the selected 
trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 
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Menu Marker > Marker > Reference Marker 

Example :CALCulate1:MARKer:REFerence ON 

:CALCulate1:MARKer:REFerence? 

Return: 1 

:CALCulate1:TRACe1:MARKer:REFerence OFF 

:CALCulate1:TRACe1:MARKer:REFerence? 

Return: 0 

 

3.8.1.8 All Marker Off 

Command Format :CALCulate<cnum>:MEASure<tnum>:MARKer:AOFF 

Instruction This command turns OFF all markers for the selected trace of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Boolean 

Default None 

Menu Marker > Marker > All Off 

Example :CALCulate1:TRACe1:MARKer3 ON 

:CALCulate1:MEASure1:MARKer:AOFF 

 

3.8.2 Marker Setup 

3.8.2.1 Commands List 

Marker Delta :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:DELTa 

Marker Discrete :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DISCrete 

Marker Type :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:TYPE 
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Marker Format :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FORMAT 

Marker Couple :CALCulate:MARKer:COUPle 

 

3.8.2.2 Marker Delta 

Command Format :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:DELTa 
<bool> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:DELTa? 

Instruction This command turns ON/OFF the delta marker state, for the selected 
trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-9},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Marker > Marker Setup > Delta 

Example :CALCulate1:MEASure:MARKer3:DELTa ON 

:CALCulate1:MEASure:MARKer3:DELTa? 

Return: 1 

 

3.8.2.3 Marker Discrete 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:DISCrete <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:DISCrete? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DISCrete 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:DISCrete? 
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Instruction This command turns ON/OFF the discrete mode (mode in which the 
marker moves only at the measurement points) with marker 1 to 9 (Mk) 
and reference marker (Mk:10), for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Marker > Marker Setup > Discrete 

Example :CALCulate1:MARKer2:DISCrete ON 

:CALCulate1:MARKer2:DISCrete? 

Return: 1 

 

:CALCulate1:TRACe1:MARKer3:DISCrete OFF 

:CALCulate1:TRACe1:MARKer3:DISCrete? 

Return: 0 

 

3.8.2.4 Marker Type 

Command Format :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:TYPE 
<type> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:TYPE? 

Instruction This command sets the type of marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the selected trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={NORMal|FIXed} 

Return Enumeration 

Default NORM 

Menu Marker > Marker Setup > Type 

Example :CALCulate1:MEASure:MARKer3:TYPE FIXed 

:CALCulate1:MEASure:MARKer3:TYPE? 

Return: FIX 

 

3.8.2.5 Marker Format 

Command Format :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FORMAT 
<type> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FORMAT? 

Instruction This command sets the measure format with marker 1 to 9 and 
reference marker (Mk:10), for the selected trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={DEFault|MLINear|MLOGarithmic|IMPedance|ADMittance|PH
ASe|IMAGinary|REAL|POLar|GDELay|LINPhase|LOGPhase|SWR} 

Return Enumeration 

Default DEF 

Menu Marker > Marker Setup > Format 

Example :CALCulate1:MEASure1:MARKer3:FORMAT MLINear 

:CALCulate1:MEASure1:MARKer3:FORMAT? 

Return: MLIN 
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3.8.2.6 Marker Couple 

Command Format :CALCulate:MARKer:COUPle <type> 

:CALCulate:MARKer:COUPle? 

Instruction This command sets the marker coupling state. 

Parameter Type <type>:={ALL|CHANnel|OFF} 

Return ALL|CHAN|OFF 

Default OFF 

Menu Marker > Marker Setup > Coupled 

Example :CALCulate:MARKer:COUPle ALL 

:CALCulate:MARKer:COUPle? 

Return: ALL 

 

3.8.3 Marker Display 

3.8.3.1 Command list  

Marker readout state :DISPlay:WINDow<wnum>:ANNotation:MARKer:ALIGn[:STATe] 

Only show the Active Trc 
Marker readout 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe] 

Single trace marker readout 
of X-axis position 

:DISPlay:CHANnel<cnum>TRACe<tnum>:ANNotation:MARKer:POSition:X 

Single trace marker readout 
of Y-axis position 

:DISPlay:CHANnel<cnum>TRACe<tnum>:ANNotation:MARKer:POSition:Y 

X-axis position of marker 
readout 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:X 

Y-axis position of marker 
readout 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:Y 

Marker value accuracy 
mode 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:DECimal:PLACes:AUTO 
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Stimulus value decimal 
places of marker 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:STIMulus:DECimal:PLACes 

Response value decimal 
places of marker 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:RESPonse:DECimal:PLACes 

 

3.8.3.2 Marker readout state 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:ALIGn[:STATe] 
<bool> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:ALIGn[:STATe]? 

Instruction Specifies whether to show or hide the Marker readout (when markers 
are ON) on the selected window. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean  

Default 1 

Menu Marker > Marker Display > Show Readout 

Example :DISPlay:WINDow1:ANNotation:MARKer:ALIGn:STAT 0? 

:DISPlay:WINDow1:ANNotation:MARKer:ALIGn:STAT? 

Return :0 

 

3.8.3.3 Only show the Active Trc Marker readout 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe] 
<bool> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:SINGle[:STATe]? 

Instruction Set only shows the active trace marker readout. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 
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Return Boolean  

Default 0 

Menu Marker > Marker Display > Active Trc Only 

Example :DISPlay:WINDow1:ANNotation:MARKer:SINGle:STAT 1? 

:DISPlay:WINDow1:ANNotation:MARKer:SINGle:STAT? 

Return :1 

 

3.8.3.4 Single trace marker readout of X-axis position 

Command Format :DISPlay:CHANnel<cnum>TRACe<tnum>:ANNotation:MARKer:POSit
ion:X <numeric> 

:DISPlay:CHANnel<cnum>TRACe<tnum>:ANNotation:MARKer:POSit
ion:X? 

Instruction Sets or gets the X - axis position of the marker readout for a single trace 
in the window. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1.  

<numeric>:represents the X - axis position, and the parameter range: 
1-10. 

Return Float  

Default 10 

Menu Marker > Marker Display > Show Readout > X Div 

Example :DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:X 5 

:DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:X? 

Return: 5 

 

3.8.3.5 Single trace marker readout of Y-axis position 
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Command Format :DISPlay:CHANnel<cnum>TRACe<tnum>:ANNotation:MARKer:POSit
ion:Y <numeric> 

:DISPlay:CHANnel<cnum>TRACe<tnum>:ANNotation:MARKer:POSit
ion:Y? 

Instruction Sets or gets the Y - axis position of the marker readout for a single trace 
in the window. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the Y - axis position, and the parameter range: 
1-10. 

Return Float  

Default 10 

Menu Marker > Marker Display > Show Readout > Y Div 

Example :DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:Y 7 

:DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:Y? 

Return: 7 

 

3.8.3.6 X-axis position of marker readout 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:X 
<numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:X? 

Instruction Sets or gets the window's overall marker readout at the X axis position. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the X - axis position, and the parameter range: 
1-10. 

Return Float  

Default 10 
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Menu Marker > Marker Display > Show Readout > X Div 

Example :DISPlay:WINDow1:ANNotation:MARKer:POSition:X 6 

:DISPlay:WINDow1:ANNotation:MARKer:POSition:X? 

Return: 6 

 

3.8.3.7 Y-axis position of marker readout 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:Y 
<numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:POSition:Y? 

Instruction Sets or gets the window's overall marker readout at the Y axis position. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the Y - axis position, and the parameter range: 
1-10. 

Return Float  

Default 10 

Menu Marker > Marker Display > Show Readout > Y Div 

Example :DISPlay:WINDow1:ANNotation:MARKer:POSition:Y 8 

:DISPlay:WINDow1:ANNotation:MARKer:POSition:Y? 

Return: 6 

 

3.8.3.8 Marker value accuracy mode 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:DECimal:PLACes:AU
TO <bool> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:DECimal:PLACes:AU
TO? 

Instruction Set or get the auto decimal state of the marker readout 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
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not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default On 

Menu Marker > Marker Display > Decimal Places… > Auto Decimal Places 

Example :DISPlay:WINDow1:ANNotation:MARKer:DECimal:PLACes:AUTO OFF 

:DISPlay:WINDow1:ANNotation:MARKer:DECimal:PLACes:AUTO? 

 

Retuen:0 

 

3.8.3.9 Stimulus value decimal places of marker 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:STIMulus:DECimal:P
LACes <numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:STIMulus:DECimal:PL
ACes? 

Instruction Set or get the stimulus value decimal places of marker readout. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the stimulus value decimal places, and the 
parameter range: 2-9. 

Return Float 

Default 6 

Menu Marker > Marker Display > Decimal Places… > Marker Decimal Places 
Setting > Stimulus 

Example :DISPlay:WINDow1:ANNotation:MARKer:STIMulus:DECimal:PLACes 3 

:DISPlay:WINDow1:ANNotation:MARKer:STIMulus:DECimal:PLACes? 

 

Retuen:3 

 



VNA Series Programming Guide 

264                                                                                                                                                                                    int.siglent.com 

3.8.3.10 Response value decimal places of marker 

Command Format :DISPlay:WINDow<wnum>:ANNotation:MARKer:RESPonse:DECimal:P
LACes <numeric> 

:DISPlay:WINDow<wnum>:ANNotation:MARKer:RESPonse:DECimal:P
LACes? 

Instruction Set or get the response value decimal places of marker readout. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1.  

<numeric>:represents the response value decimal places, and the 
parameter range: 2-6. 

Return Float 

Default 6 

Menu Marker > Marker Display > Decimal Places… > Marker Decimal Places 
Setting > Response 

Example :DISPlay:WINDow1:ANNotation:MARKer:RESPonse:DECimal:PLACes 
5 

:DISPlay:WINDow1:ANNotation:MARKer:RESPonse:DECimal:PLACes 
5 

 

Retuen:5 

 

3.8.4 Marker Function 

3.8.4.1 Command List 

Marker →

Function 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:SET 

Noise Marker 
State 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NOISe:STATe 

N dB BW State :CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:STATe 

N dB BW 
reference value 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:THReshold 

Get N dB BW :CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:BWIDth? 
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result 

 

3.8.4.2 Marker →Function 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:SET <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:SET <type> 

Instruction This command sets the value at the position of marker 1 to 9 (Mk) and 
reference marker (Mk:10) to the value of the instrument setting item 
(Param), for the active trace of selected channel. 

This command sets the value at the position of marker 1 to 9 (Mk) and 
reference marker (Mk:10) to the value of the instrument setting item 
(Param), for the selected trace of selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={STARt|STOP|CENTer|RLEVel|DELay|RMARker|SPAN|SA} 

Return None 

Default None 

Menu Marker > Marker → Function 

Example :CALCulate1:MARKer1:SET RLEVel 

:CALCulate1:TRACe1:MARKer1:SET STARt 

3.8.4.3 Noise Marker State 

Command 
Format 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NOISe:STATe <bool> 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NOISe:STATe? 

 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NOISe:STATe 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NOISe:STATe? 
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Instruction This command turns ON/OFF the Noise Marker function for the active trace 
of selected channel. 

This command turns ON/OFF the Noise Marker function of selected trace 
for the selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If not 
specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified,defaults 
to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Marker > Marker Function>Noise Marker 

Example :CALCulate1:SELected:SA:MARKer1:NOISe:STATe 1 

:CALCulate1:SELected:SA:MARKer1:NOISe:STATe? 

Return 1 

 

:CALCulate1:TRACe1:SA:MARKer1:NOISe:STATe OFF 

:CALCulate1:TRACe1:SA:MARKer1:NOISe:STATe? 

Return 0 

 

3.8.4.4 N dB BW State 

Command Format :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:STATe <bool> 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:STATe? 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:STATe 
<bool> 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:STATe? 

Instruction This command turns ON/OFF the N dB Bandwidth function for the active 
trace of selected channel. 

This command turns ON/OFF the N dB Bandwidth function of selected 
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trace for the selected channel. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number. If not 
specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Marker > Marker Function>N dB BW 

Example :CALCulate1:SELected:SA:MARKer1:NDB:STATe 1 

:CALCulate1:SELected:SA:MARKer1:NDB:STATe? 

Return 1 

 

:CALCulate1:TRACe1:SA:MARKer1:NDB:STATe 0 

:CALCulate1:TRACe1:SA:MARKer1:NDB:STATe? 

Return 0 

 

3.8.4.5 N dB BW reference value 

Command Format :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:THReshold 
<val> 

:CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:THReshold? 

 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:THReshol
d <val> 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:THReshol
d? 

Instruction Set or get the N dB bandwidth reference value. 

Parameter Type 
<cnum>:={[1] -256}, represents the measurement channel number, If not 
specified, defaults to 1. 
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<tnum>:={[1]-256},represents the measurement trace number. If not 
specified, defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
defaults to 1. 

<val>:= float number in the range of -500dB to 500dB. 

Return Float  

Default -3 

Menu Marker > Marker Function>N dB 

Example :CALCulate1:SELected:SA:MARKer1:NDB:THReshold -5 

:CALCulate1:SELected:SA:MARKer1:NDB:THReshold? 

Return -5 

 

:CALCulate1:TRACe1:SA:MARKer1:NDB:THReshold -2 

:CALCulate1:TRACe1:SA:MARKer1:NDB:THReshold? 

Return -2 

 

3.8.4.6 Get N dB BW result 

Command Format :CALCulate<cnum>:SELected:SA:MARKer<mnum>:NDB:BWIDth? 

:CALCulate<cnum>:TRACe<tnum>:SA:MARKer<mnum>:NDB:BWIDth? 

Instruction Get the result of N dB bandwidth. 

Parameter Type 

<cnum>:={[1] -256}, represents the measurement channel number, If not 
specified, defaults to 1. 

<tnum>:={[1]-256},represents the measurement trace number. If not 
specified, defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
defaults to 1. 

Return Float ,Unit Hz 

Default None  

Menu Marker > Marker Function>N dB BW 

Example :CALCulate1:TRACe1:SA:MARKer1:NDB:STATe 1 
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:CALCulate1:SELected:SA:MARKer1:NDB:BWIDth? 

Return 2778220.80323839 

 

3.9 Meas Commands 

3.9.1 Command List 

Measurement Mode :CALCulate<cnum>:INSTrument 

Measurement parameter :CALCulate<cnum>:PARameter<tnum>:DEFine 

Balance Measurement 
Topology 

:CALCulate<cnum>:DTOPology 

 

3.9.2 Measurement Mode 

Command Format :CALCulate<cnum>:INSTrument <type> 

:CALCulate<cnum>:INSTrument? 

Instruction This command sets and gets the measurement mode of the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={VNA|SA|SMM|MT|CAT} 

VNA: Vector Network Analyzers mode 

SA: Spectrum Analyzer mode 

SMM: Scalar Mixer Measurement mode 

MT: Material Measurement mode 

Return Enumeration 

Default VNA 

Menu Meas > S-Params > Mode 

Example :CALCulate1:INSTrument SMM 

:CALCulate1:INSTrument? 

Return :SMM 
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3.9.3 Measurement parameter 

Command Format :CALCulate<cnum>:PARameter<tnum>:DEFine <string> 

:CALCulate<cnum>:PARameter<tnum>:DEFine? 

Instruction This command sets and gets the measurement parameter of the 
selected trace, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<string>:={S11|S21|S31|S41|S12|S22|S32|S42|S13|S23|S33|S43|S14|S2
4|S34|S44|A|B|C|D|R1|R2|R3|R4} 

The <string>parameter ranges as follows: 

 For S-parameters: <meas>="S<XY>", X=1 to 4,Y=1 to 4; 

 For ratioed measurements: <meas>="𝑏𝑁/𝑎𝑁,N" or <meas>="𝑏𝑁/
𝑎𝑁_N",N=1 to 4;For example: b1/a1,1 (this means B,1/R1,1) 

 For non-ratioed measurements: <meas>= Any receiver followed 
by a comma and the port number. For example: A,1 

 For Balanced Measurements: <meas>="𝑆𝑎𝑏𝑥𝑦" 

single port balance measurement: 
"𝑆𝑎𝑏𝑥𝑦"=Sdd11|Scd11|Sdc11|Scc11 

 

single-ended - balanced measurement: 

"𝑆𝑎𝑏𝑥𝑦"=Sdd11|Scd11|Sdc11|Scc11|Ssd21|Ssc21|Sds12|Scs12|Sss2
2|ImBal|Sds21/Scs21|Ssd12/Ssc12 

 

balance - balance measurement: 

"𝑆𝑎𝑏𝑥𝑦"=Sdd11|Sdd21|Sdd12|Sdd22|Scd11|Scd21|Scd12|Scd22|Sd
c11|Sdc21|Sdc12|Sdc22|Scc11|Scc21|Scc12|Scc22|ImBal1|ImBal2|Sdd2
1/Scc21 

 

Single-single-balance measurement 

"𝑆𝑎𝑏𝑥𝑦"=Sss11|Sss21|Sss12|Sss22|Sds31|Scs31|Sds32|Scs32|Ssd13
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|Ssd23|Ssc13|Ssc23|Sdd33|Scd33|Sdc33|Scc33|ImBal1|ImBal2|ImBal3|I
mBal|Sds31/Scs31|Sds32/Scs32 

Return String 

Default S11 

Menu Meas > S-Params/Balanced/Receiver/Wave/Ratio 

Example Set S measurement 

:CALCulate1:PARameter1:DEFine S12 

Set balance measurement 

:CALCulate1:PARameter1:DEFine Sdd11 

Set receiver measurement 

:CALCulate1:PARameter1:DEFine "A,1" 

:CALCulate1:PARameter1:DEFine "R1,1" 

Set wave measurement 

:CALCulate1:PARameter1:DEFine "a1,2" 

Set Ratio measurement 

:CALCulate1:PARameter1:DEFine "b2/a1,1" 

 

Query measurement 

:CALCulate1:PARameter1:DEFine? 

Return: S12 

 

3.9.4 Balance Measurement Topology 

Command Format :CALCulate<cnum>:DTOPology 
<TopologyType>,<PortTopologyList> 

:CALCulate<cnum>:DTOPology? 

Instruction This command sets and gets the device type for the balanced 
measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<TopologyType>: 

B:        Balance (2 Ports) 
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SB:      Single – Balance (3 Ports) 

SSB:    Single – Single – Balance (4 Ports) 

BB:      Balance – Balance (4 Ports) 

<PortTopologyList>: 

Integers represent the ports as the port numbers, expressing the ports 
in the device topology in order. 

Return String 

Default B,1,2 

Menu Meas > Balanced > Topology... 

Example :CALCulate1:DTOPology SB,1,2,3 

:CALCulate1:DTOPology? 

Return: SB,1,2,3 

 

3.10 Power Commands 

3.10.1 Power 

3.10.1.1 Commands List 

RF Output State :OUTPut[:STATe] 

Power Level :SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude] 

Power Start :SOURce<cnum>:POWer:STARt 

Power Stop :SOURce<cnum>:POWer:STOP 

 

3.10.1.2 RF Output State 

Command Format :OUTPut[:STATe] <bool> 

:OUTPut[:STATe]? 

Instruction This command turns on/off the stimulus signal output. Measurement 
cannot be made until the stimulus signal output is turned ON. 

Parameter Type <bool>:= ON|OFF|1|0 
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Return Boolean 

Default ON 

Menu Power > RF Power 

Example :OUTPut 0 

:OUTPut? 

Return: 0 

 

3.10.1.3 Power Level 

Command Format :SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude] 
<numeric> 

:SOURce<cnum>:POWer[:LEVel][:IMMediate][:AMPLitude]? 

Instruction This command sets/gets the power level of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the power level. 

Return Float, unit: dBm 

Default 0 

Menu Power > Power > Power Level 

Example :SOURce1:POWer -5 

:SOURce1:POWer? 

Return: -5 

 

3.10.1.4 Power Start 

Command Format :SOURce<cnum>:POWer:STARt <numeric> 

:SOURce<cnum>:POWer:STARt? 

Instruction This command sets/gets the start value of the sweep range for the 
power sweep for channels 1 to 200. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the start power level. 

Return Float, unit: dBm 

Default -10 

Menu Power > Port Power > Start Power 

Example :SOURce1:POWer:STARt 5 

:SOURce1:POWer:STARt? 

Return: 5 

 

3.10.1.5 Power Stop 

Command Format :SOURce<cnum>:POWer:STOP <numeric> 

:SOURce<cnum>:POWer:STOP? 

Instruction This command sets/gets the stop value of the sweep range for the 
power sweep for channels 1 to 200. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the stop power level. 

Return Float, unit: dBm 

Default 0 

Menu Power > Port Power > Stop Power 

Example :SOURce1:POWer:STOP -5 

:SOURce1:POWer:STOP? 

Return: -5 

 

3.10.2 Port Power 

3.10.2.1 Command List 
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Power Level Couple 
State 

:SOURce<cnum>:POWer:PORT:COUPle 

Power Level of  :SOURce<cnum>:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLitude] 

 

 

3.10.2.2 Power Level Couple State 

Command Format :SOURce<cnum>:POWer:PORT:COUPle <bool> 

:SOURce<cnum>:POWer:PORT:COUPle? 

Instruction This command sets/gets whether to output the same power level for 
each port of channels 1 to 200. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Power > Port Power > Coupling 

Example :SOURce1:POWer:PORT:COUPle OFF 

:SOURce1:POWer:PORT:COUPle? 

Return: 0 

 

3.10.2.3 Power Level of Port 

Command Format :SOURce<cnum>:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLit
ude] <numeric> 

 

:SOURce<cnum>:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLit
ude]? 

Instruction This command sets/gets the power level value of the selected channel 
and port. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the power level value. 

Return Data array 

Default 0 

Menu Power > Port Power > Power Level 

Example :SOURce1:POWer:PORT1 -5 

:SOURce1:POWer:PORT1? 

Return: -5 

 

3.10.3 Leveling & Offsets 

3.10.3.1 Command List 

Power Slope State :SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe 

Power Slope :SOURce<cnum>:POWer[:LEVel]:SLOPe[:DATA] 

State of Power Limit :SYSTem:POWer<pnum>:LIMit:STATe 

Power Limit Value :SYSTem:POWer<pnum>:LIMit 

 

3.10.3.2 Power Slope State 

Command Format :SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe <bool> 

:SOURce<cnum>:POWer[:LEVel]:SLOPe:STATe? 

Instruction This command turns ON/OFF or gets the status of the power slope 
feature, for the selected channel. This command corrects the 
attenuation of simple power level proportional to the frequency 
(attenuation due to cables etc). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 
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Return Boolean 

Default OFF 

Menu Power > Leveling&Offsets > Slope Enable 

Example :SOURce1:POWer:SLOPe:STATe ON 

:SOURce1:POWer:SLOPe:STATe? 

Return: 1 

 

3.10.3.3 Power Slope 

Command Format :SOURce<cnum>:POWer[:LEVel]:SLOPe[:DATA] <numeric> 

:SOURce<cnum>:POWer[:LEVel]:SLOPe[:DATA]? 

Instruction This command sets/gets the correction value of the power slope 
feature of channels 1 to 200. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the correction value, and the parameter range: 
-2dB~2dB. 

Return Float, unit: dB 

Default 0 

Menu Power > Leveling&Offsets > Slope 

Example :SOURce1:POWer:SLOPe -1 

:SOURce1:POWer:SLOPe? 

Return: -1 

 

3.10.3.4 State of Power Limit 

Command Format :SYSTem:POWer<pnum>:LIMit:STATe <bool> 

:SYSTem:POWer<pnum>:LIMit:STATe? 

Instruction This command enables or disables the power limit for the specified 
port. 
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Parameter Type <pnum>:={[1]-4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Power > Leveling&Offsets > Limit Enable 

Example :SYSTem:POWer1:LIMit:STATe ON 

:SYSTem:POWer1:LIMit:STATe? 

Return: 1 

 

3.10.3.5 Power Limit Value 

Command Format :SYSTem:POWer<pnum>:LIMit <numeric> 

:SYSTem:POWer<pnum>:LIMit? 

Instruction This command sets and gets the power limit value for the specified 
port. 

Parameter Type <pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the power limit value, and the parameter range: 
-1000~1000dB. 

Return Float, unit: dB 

Default 0 

Menu Power > Leveling&Offsets > Limit 

Example :SYSTem:POWer1:LIMit 10 

:SYSTem:POWer1:LIMit? 

Return: 10 

 

3.11 SaveRecall Commands 

3.11.1 Recall  
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3.11.1.1 Command List 

Recall the .cal file :MMEMory:LOAD:CORRection 

Recall the .csa file :MMEMory:LOAD:CSARchive 

Recall the specified file :MMEMory:LOAD[:STATe] 

 

3.11.1.2 Recall the .cal file 

Command Format :MMEMory:LOAD:CORRection <string> 

Instruction Recall the specified calibration file 

Parameter Type <string>: represents the specified calibration file, and the parameter 
range: less than 255 characters. 

Return None  

Default None  

Menu Save Recall > Recall > Recall Cal… 

Example :MMEMory:LOAD:CORRection "local/test.cal" 

 

3.11.1.3 Recall the .csa file 

Command Format :MMEMory:LOAD:CSARchive <string> 

Instruction Recall the specified state and calibration file. 

Parameter Type <string>: represents the specified state and calibration file, and the 
parameter range: less than 255 characters. 

Return None  

Default None  

Menu Save Recall > Recall > Recall State+Cal… 

Example :MMEMory:LOAD "local/test.csa" 

 

3.11.1.4 Recall the specified file 
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Command Format :MMEMory:LOAD[:STATe] <string> 

Instruction Recall the specified file. 

Parameter Type <string>: represents the specified file, and the parameter range: less 
than 255 characters. 

Return None  

Default None  

Menu Save Recall > Recall > File Browser… 

Example :MMEMory:LOAD "local/test.sta" 

:MMEMory:LOAD "local/test.csa" 

:MMEMory:LOAD "local/test.cal" 

 

3.11.2 Save State 

3.11.2.1 Command List 

Save the .csa file :MMEMory:STORe:CSARchive 

Save the specified file :MMEMory:STORE[:STATe] 

 

3.11.2.2 Save the .csa file 

Command Format :MMEMory:STORe:CSARchive <string> 

Instruction Stores the instrument state and calibration data(.csa) 

Parameter Type <string>: represents the instrument state and calibration data(.csa), 
and the parameter range: less than 255 characters. 

Return None 

Default None 

Menu Save Recall > Save State > Save State As… 

Example :MMEMory:STORe:CSARchive "local/test.csa" 
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3.11.2.3 Save the specified file 

Command Format :MMEMory:STORE[:STATe] <string> 

Instruction Stores the specified file (.sta, .cal,.csa). 

Parameter Type <string>: represents the specified file (.sta, .cal,.csa), and the 
parameter range: less than 255 characters. 

Return None 

Default None 

Menu Save Recall > Save Other > Savel Cal… 

Save Recall > Save State > Save State As… 

Example :MMEMory:STORE "local/test.cal" 

:MMEMory:STORE "local/test.csa" 

:MMEMory:STORE "local/test.sta" 

 

3.11.3 Recall Data 

3.11.3.1 Command List 

Recall data using CSV file :MMEMory:LOAD:CSV <string> 

Recall data using SNP file :MMEMory:LOAD:SNP <string> 

Recall CSV files onto specific trace :MMEMory:LOAD:CSV:TRACe<tnum> <string> 

Recall SNP files onto specific trace :MMEMory:LOAD:SNP:TRACe<tnum> <string> 

Interpolation state :MMEMory:LOAD:DATA:INTerpolate[:STATe] 

 

3.11.3.2 Recall data using CSV file 

Command Format :MMEMory:LOAD:CSV <string> 

Instruction Recall CSV file into the current channel. 

Parameter Type <string>represents the file name. 

Return None 
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Default None 

Menu Save Recall > Recall Data > Recall Data 

Example :MMEMory:LOAD:CSV "local/ trace3.csv" 

 

3.11.3.3 Recall data using SNP file 

Command Format :MMEMory:LOAD:SNP <string> 

Instruction Recall SNP file into the current channel. 

Parameter Type <string>represents the file name. 

Return None 

Default None 

Menu Save Recall > Recall Data > Recall Data 

Example :MMEMory:LOAD:SNP "local/01.s2p" 

 

3.11.3.4 Recall CSV files onto specific trace 

Command Format :MMEMory:LOAD:CSV:TRACe<tnum> <string> 

Instruction Recall CSV file to specific trace lines. 

Parameter Type <tnum>indicates the selected trace. 

<string>represents the file name. 

Return None 

Default None 

Menu Save Recall > Recall Data > Recall Data 

Example :MMEMory:LOAD:CSV:TRACe2 "local/trace3.csv" 
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3.11.3.5 Recall SNP files onto specific trace 

Command Format :MMEMory:LOAD:SNP:TRACe<tnum> <string> 

Instruction Recall SNP file to specific trace lines. 

Parameter Type <tnum>indicates the selected trace. 

<string>represents the file name. 

Return None 

Default None 

Menu Save Recall > Recall Data > Recall Data 

Example :MMEMory:LOAD:SNP:TRACe2 "local/01.s2p" 

 

3.11.3.6 Interpolation state 

Command Format :MMEMory:LOAD:DATA:INTerpolate[:STATe] <bool> 

:MMEMory:LOAD:DATA:INTerpolate[:STATe]? 

Instruction Set whether the file call function performs interpolation. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default ON 

Menu Save Recall > Recall Data > Interpolation 

Example :MMEMory:LOAD:DATA:INTerpolate OFF 

:MMEMory:LOAD:DATA:INTerpolate:STATe? 

Return 0 

 

 

3.11.4 Save Data 

3.11.4.1 Command List 
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Set or get CSV format :MMEMory:STORe:CSV:FORMat 

Save the selected trace data :MMEMory:STORe:CSV [:DATA] 

Save data based on trace number :MMEMory:STORe:CSV:TRACes[:DATA] 

Query SNP data :CALCulate<cnum>[:MEASure]:DATA:SNP?<num> 

Query SNP data for S-parameter :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs 

Save SNP data :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs:SAVE 

 

3.11.4.2 Set or get CSV format 

Command Format :MMEMory:STORe:CSV:FORMat <type> 

:MMEMory:STORe:CSV:FORMat? 

Instruction This command is used to set/retrieve the data format and save the 
measurement data of the working channel to a CSV format file. 

Note that the corresponding SNP command changes MA to linear 
amplitude and DB to logarithmic amplitude. 

Parameter Type <type>:={AUTO|MA|DB|RI|DISPlayed} 

"AUTO": Automatically specifies the data format based on the display 
"format of the activity trace. 

"MA": Specify the data format "linear amplitude>angle". 

"DB": Specify the data format "Logarithmic amplitude>Angle". 

"RI": Specify the data format "real part>imaginary part". 

"DISPlayed": Save data according to the current data format. 

Return String 

Default AUTO 

Menu Save Recall > Save Data > CSV Format 

Example :MMEMory:STORe:CSV:FORMat MA 

:MMEMory:STORe:CSV:FORMat? 

Return: MA 

 

3.11.4.3 Save the selected trace data 
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Command Format :MMEMory:STORe:CSV [:DATA] <string> 

Instruction Save the selected trace data. 

Parameter Type <string>represents the file name. 

Return None 

Default None 

Menu Save Recall > Save Data > Save Trc Data… 

Example :MMEMory:STORe:CSV "local/tmp.csv" 

 

3.11.4.4 Save data based on trace number 

Command Format :MMEMory:STORe:CSV:TRACes[:DATA] <string1>,<string2> 

Instruction Save data based on trace number. 

Parameter Type <string1>represents a list of trace numbers 

<string2>represents the file path 

Return None 

Default None 

Menu Save Recall > Save Data > Save Multi Trc… 

Example :MMEMory:STORe:CSV:TRACes "2,3","local/tmp.csv" 

 

3.11.4.5 Query SNP data 

Command Format :CALCulate<cnum>[:MEASure]:DATA:SNP?<num> 

Instruction Query SNP data 

Parameter Type <cnum>Channel Number 

<num>, parameter range is 1-4 

Return String(The actual returned data will be affected by the data 
transmission format set, including ASCII/REAL32/REAL64, and the 
default is ASCII code) 
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Default None 

Menu None 

Example :CALCulate1:MEASure:DATA:SNP? 1 

Return:1.000000000000e+05,8.500000000000e+09,-
2.517962752291e-01,-8.413169797246e+00,-
1.795121308191e+02,-1.373235865870e+02 

 

3.11.4.6 Query SNP data for S-parameter 

Command Format :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs?<string> 

Instruction Query SNP data. This command is only used for measuring S 
parameters. 

Parameter Type <cnum>, channel number 

<string>, port number 

Return String 

Default None 

Menu None 

Example :CALCulate1:MEASure:DATA:SNP:PORTs? "1" 

Return:1.000000000000e+05,8.500000000000e+09,-
2.245324021131e-01,-8.419927767910e+00,-
1.795215338430e+02,-1.376447999678e+02 

 

3.11.4.7 Save SNP data 

Command Format :CALCulate<cnum>[:MEASure]:DATA:SNP:PORTs:SAVE<string1>,<strin
g2>{,type} 

Instruction Save SNP data. 

Parameter Type <cnum>Channel Number 

<string1>, port number 

<string2>, save file name 
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<type>:={AUTO|MA|DB|RI} 

"AUTO": Automatically specifies the data format based on the display 
format of the activity trace. 

"MA": Specify the data format "linear amplitude>angle". 

"DB": Specify the data format "Logarithmic amplitude>Angle". 

"RI": Specify the data format "real part>imaginary part". 

Return None 

Default None 

Menu Save Recall > Save Data > Save SnP 

Example :CALCulate1:DATA:SNP:PORTs:SAVE "1","local/sdh.s1p",DB 

 

 

3.11.5 Save Other 

3.11.5.1 Command list 

Save the screen Image :MMEMory:STORe:IMAGe 

Save the .cal file :MMEMory:STORe:CORRection 

Save Fdata :MMEMory:STORe:FDATa 

Read/write file data :MMEMory:TRANsfer 

Format of SNP File :MMEMory:STORe:SNP:FORMat 

Save SNP File :MMEMory:STORe:SNP[:DATA] 

Port Saved in S1P File :MMEMory:STORe:SNP:TYPE:S1P 

Ports Saved in S2P File :MMEMory:STORe:SNP:TYPE:S2P 

Ports Saved in S3P File :MMEMory:STORe:SNP:TYPE:S3P 

Ports Saved in S4P File :MMEMory:STORe:SNP:TYPE:S4P 

 

3.11.5.2 Save the screen Image 

Command Format :MMEMory:STORe:IMAGe <string> 
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Instruction This command saves the display image on the LCD display at the 
execution of the object into a file in the bitmap (extension ".bmp") or 
portable network graphics format (extension ".png") or JPEG file 
interchange format (extension ".jpg"). 

Parameter Type <string>: represents the image format file, and the parameter range: 
255 characters or less. 

Return None 

Default None 

Menu Save Recall > Save Other > Screenshot… 

Example :MMEMory:STORe:IMAGe "local/test.bmp" 

 

3.11.5.3 Save the .cal file 

Command Format :MMEMory:STORe:CORRection <string> 

Instruction Stores the calibration data(.cal) 

Parameter Type <string>: represents the calibration data(.cal), and the parameter 
range: less than 255 characters. 

Return None 

Default None 

Menu Save Recall > Save Other > Savel Cal… 

Example :MMEMory:STORe:CORRection "local/test.cal" 

 

3.11.5.4 Save Fdata 

Command Format :MMEMory:STORe:FDATa <string> 

Instruction This command saves the formatted data array into a file in the CSV 
format (extension ".csv"), for the active trace of the active channel. If a 
file with the same name as the specified file name exists, its contents 
are overwritten. 

Parameter Type <string>: represents the formatted data file(extension ".csv"), and the 
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parameter range: 255 characters or less. 

Return None 

Default None 

Menu Save Recall > Save Other > Save Trc Data… 

Example :MMEMory:STORe:FDATa "local/test.csv" 

 

3.11.5.5 Read/write file data 

Command Format :MMEMory:TRANsfer <string>,<block> 

:MMEMory:TRANsfer? 

Instruction Data written on/read out from the file 

Parameter Type <string>: represents the file name on the built-in storage device. 

<block>: represents the contents of the file.(Block data format 
example: #212ABCDEF123456, the data starts with #, the following 2 
specifies the number of bytes is two digits, 12 specifies the number of 
bytes of the following data, ABCDEF123456 represents 12-bit data.) 

Return Return the data from the specified file location 

Default None 

Menu None 

Example :MMEMory:TRANsfer? "local/test.csv" 

Return: #592939"# Channel\s1" "#\sTrace 2" Frequency,Formatted 
Data,Formatted Data 1.000000000000e+05, 

-7.710605710955e-02,2.403043541994e-01 2.912437500000e+06, 

 

3.11.5.6 Format of SNP File 

Command Format :MMEMory:STORe:SNP:FORMat <type> 

:MMEMory:STORe:SNP:FORMat? 

Instruction This command sets/gets the data format for saving measurement data 
for the active channel into a file in the touchstone format. 
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Parameter Type <type>:={AUTO|MA|DB|RI} 

"AUTO":Specifies data format automatically according to the display 
format of the active trace. 

"MA":Specifies data format "log magnitude > angle". 

"DB":Specifies data format "linear magnitude > angle". 

"RI":Specifies data format "real part > imaginary part". 

Return String 

Default AUTO 

Menu Save Recall > Save Other > SnP Format 

Example :MMEMory:STORe:SNP:FORMat MA 

:MMEMory:STORe:SNP:FORMat? 

Return: MA 

 

3.11.5.7 Save SNP File 

Command Format :MMEMory:STORe:SNP[:DATA] <string> 

Instruction Saves the measurement data for the active channel into a file in the 
touchstone format. You need to specify a file format and file type 
before saving a file. The extension differs depending on file types. 

.s1p:When specifying one port 

.s2p:When specifying two port 

.s3p:When specifying three port 

.s4p:When specifying four port 

Parameter Type <string>: represents the SNP file, and the parameter range: 255 
characters or less. 

Return None 

Default None 

Menu Save Recall > Save Other > Save SnP 

Example :MMEMory:STORe:SNP:TYPE:S2P 2,3 

:MMEMory:STORe:SNP "local/test.s2p" 
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3.11.5.8 Port Saved in S1P File 

Command Format :MMEMory:STORe:SNP:TYPE:S1P <pnum> 

:MMEMory:STORe:SNP:TYPE:S1P? 

Instruction This command sets/gets the specified port to the file type (1 port) 
when saving measurement data for the active channel into a file in the 
touchstone format. 

Parameter Type <pnum>:={1~4},specifies the measurement port number. 

Return Integer 

Default 1 

Menu None 

Example :MMEMory:STORe:SNP:TYPE:S1P 2 

:MMEMory:STORe:SNP:TYPE:S1P? 

Return: 2 

 

3.11.5.9 Ports Saved in S2P File 

Command Format :MMEMory:STORe:SNP:TYPE:S2P <pnum1>,<pnum2> 

:MMEMory:STORe:SNP:TYPE:S2P? 

Instruction This command sets/gets the specified port to the file type (2 port) 
when saving measurement data for the active channel into a file in the 
touchstone format. 

Parameter Type <pnum1>:={1~4}, specifies the measurement port number. 

<pnum2>:={1~4}, specifies another port number. 

Return Data array 

Default 1,2 

Menu None 

Example :MMEMory:STORe:SNP:TYPE:S2P 2,3 

:MMEMory:STORe:SNP:TYPE:S2P? 
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Return: 2,3 

 

3.11.5.10 Ports Saved in S3P File 

Command Format :MMEMory:STORe:SNP:TYPE:S3P <pnum1>,<pnum2>,<pnum3> 

:MMEMory:STORe:SNP:TYPE:S3P? 

Instruction This command sets/gets the specified port to the file type (3 port) 
when saving measurement data for the active channel into a file in the 
touchstone format. 

Parameter Type <pnum1>:={1~4}, specifies the measurement port number. 

<pnum2>:={1~4}, specifies the measurement port number. 

<pnum3>:={1~4}, specifies the measurement port number. 

Ports cannot be duplicated. 

Return Data array 

Default 1,2,3 

Menu None 

Example :MMEMory:STORe:SNP:TYPE:S3P 2,3,4 

:MMEMory:STORe:SNP:TYPE:S3P? 

Return: 2,3,4 

 

3.11.5.11 Ports Saved in S4P File 

Command Format :MMEMory:STORe:SNP:TYPE:S4P 
<pnum1>,<pnum2>,<pnum3>,<pnum4> 

:MMEMory:STORe:SNP:TYPE:S4P? 

Instruction This command sets/gets the specified port to the file type (4 port) 
when saving measurement data for the active channel into a file in the 
touchstone format. 

Parameter Type <pnum1>:={1~4}, specifies the measurement port number. 

<pnum2>:={1~4}, specifies the measurement port number. 

<pnum3>:={1~4}, specifies the measurement port number. 
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<pnum4>:={1~4}, specifies the measurement port number. 

Ports cannot be duplicated. 

Return Data array 

Default 1,2,3,4 

Menu None 

Example :MMEMory:STORe:SNP:TYPE:S4P 1,2,3,4 

:MMEMory:STORe:SNP:TYPE:S4P? 

Return: 1,2,3,4 

 

3.11.6 File Browser 

3.11.6.1 Command List 

Enter a folder directory :MMEMory:CDIRectory 

Makes a folder :MMEMory:MDIRectory 

Delete a folder :MMEMory:RDIRectory 

Rename a file :MMEMory:MOVE 

Query the directory file list :MMEMory:CATalog[:<type>]? [<string>] 

Copy File :MMEMory:COPY 

Delete File :MMEMory:DELete 

The save date of a File :MMEMory:DATE? 

The save time of a File :MMEMory:TIME? 

 

3.11.6.2 Enter a folder directory 

Command Format :MMEMory:CDIRectory <string> 

:MMEMory:CDIRectory? 

Instruction Toggle or query the current working directory. The default directory 
is "/", and the common working directory is "/local". If the new folder 
is at a different level than the default, use a slash (/) before the folder 
name and enclose in quotes., such as "/local/NewFolder" 
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Parameter Type <string>: represents the current working directory, and the 
parameter range: 255 characters or less. 

Return String  

Default "/" 

Menu Save Recall > File Browser 

Example 1. If no external USB flash drive is inserted, only the common /local 
directory is available. The following is an example to enter a folder in 
the local directory: 

:MMEMory:CDIRectory "/local/NewFolder" 

:MMEMory:CDIRectory? 

Return: "/local/NewFolder" 

2. When an external USB flash drive is inserted, the working directory 
contains "/local" and "/U-disk0". The following is an example of going 
to a folder in the USB flash drive directory: 

:MMEMory:CDIRectory "/U-disk0/NewFolder" 

:MMEMory:CDIRectory? 

Return :"/ U-disk0/NewFolder" 

 

3.11.6.3 Makes a folder 

Command Format :MMEMory:MDIRectory <string> 

Instruction Make a folder. 

Parameter Type <string>: represents the file directory, and the parameter range: 255 
characters or less. 

Return None  

Default None  

Menu Save Recall > File Browser 

Example 1. In the local directory, create a folder named "123". 

MMEMory:MDIRectory "/local/123" 

2. When inserting a U disk, create a folder named "456" in the U disk 
directory. 
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MMEMory:MDIRectory "/U-disk0/456" 

 

3.11.6.4 Delete a folder 

Command Format :MMEMory:RDIRectory <string> 

Instruction Delete the specified folder 

Parameter Type <string>: represents the file directory, and the parameter range: 255 
characters or less. 

Return None  

Default None  

Menu Save Recall > File Browser 

Example 1. In the local directory, delete a folder named "123". 

:MMEMory: RDIRectory "/local/123" 

2. When inserting a U disk, delete a folder named "456" in the U disk 
directory. 

:MMEMory:RDIRectory "/U-disk0/456". 

 

3.11.6.5 Rename a file 

Command Format :MMEMory:MOVE <string1>,<string2> 

Instruction Renames <string1> to <string2>. File extensions must be specified. 

Parameter Type <string1>,<string2>: represents the file name, and the parameter 
range: 255 characters or less. 

Return None  

Default None  

Menu Save Recall > File Browser > Rename 

Example 1. In the local directory, rename the "12.csv" file to "34.csv". 

:MMEMory:MOVE "/local/123.csv",/local/789.csv" 

2. When inserting an U disk, rename the "11.csv" file to "22.csv" in the 
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directory of the U disk. 

:MMEMory:MOVE "/U-disk0/11.csv",/local/22.csv" 

 

3.11.6.6 Query the directory file list 

Command Format :MMEMory:CATalog[:<type>]? [<string>] 

Instruction Query the files in the specified directory. If the file type and folder name 
are not specified, all files in the current directory are queried. 

Parameter Type <type>: string, the type of files to list.Choose from: 

STATe|STA - Instrument states (.sta) 

CORRection|CAL- Calibration Data (.cal) 

CSARchive|CSA - Instrument state and calibration data (.csa) 

CSV - Instrument state (.csv) 

DIRectory – Instrument foler list. 

<string>: String - Any existing folder name. The parameter range: 255 
characters or less. 

Return String  

Default None  

Menu Save Recall > File Browser 

Example 1. Query all files in the local root directory. 

:MMEMory:CATalog? "/local" 

2. Query all files in the root directory of a U disk. 

:MMEMory:CATalog? "/U-disk0" 

3. Query all ".CSV" files in the "Test" folder of the local directory 

:MMEMory:CATalog:CSV? "/local/Test" 

 

3.11.6.7 Copy File 

Command Format :MMEMory:COPY <string1>,<string2> 

Instruction This command copies a file. If the specified copy source file does not 
exist, an error occurs when executed and the object is ignored. Notice 
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that, if a file with the same name as the specified copy destination file 
name exists, its contents are overwritten. The source file and copy 
destination file is seperated by comma. 

Parameter Type <string1>,<string2>: represents the file name, and the parameter 
range: 255 characters or less. 

Return None 

Default None 

Menu None 

Example :MMEMory:COPY "local/test1.csv","local/test2.csv" 

 

3.11.6.8 Delete File 

Command Format :MMEMory:DELete <string> 

Instruction This command deletes an existing file or directory (folder). If the 
specified file or directory does not exist, an error occurs when executed 
and the object is ignored. 

Parameter Type <string>: represents the file name, and the parameter range: 255 
characters or less. 

Return None 

Default None 

Menu None 

Example :MMEMory:DELete "local/test1.csv" 

 

3.11.6.9 The save date of a File 

Command Format :MMEMory:DATE? <string> 

Instruction Returns the (year, month, day) that the specified file was last saved. 

Parameter Type <string>: represents the specified file, and the parameter range: 255 
characters or less. 

Return Integer 
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Default None  

Menu Save Recall > File Browser 

Example Query the save date of the file "123.csv" in the local directory. 

:MMEM:DATE? "/local/123.csv" 

Return : 2022,11,5 

 

3.11.6.10 The save time of a File 

Command Format :MMEMory:TIME? <string> 

Instruction Returns the (hour, minute,second) that the specified file was last saved. 

Parameter Type <string>: represents the specified file, and the parameter range: 255 
characters or less. 

Return Integer 

Default None  

Menu Save Recall > File Browser 

Example Query the save time of the file "123.csv" in the local directory. 

:MMEM:TIME? "/local/123.csv" 

Return : 15,55,34 

 

3.12 Scale Commands 

3.12.1 Scale 

3.12.1.1 Command List 

Auto Scale :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:AUTO 

Auto Scale All :DISPlay:WINDow<wnum>:Y:AUTO 

Scale Per Division :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision 

Scale Reference Level :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel 

Scale Reference :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition 
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Position 

 

3.12.1.2 Auto Scale 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:AUTO 

Instruction This command executes the auto scale function, for the selected trace 
(Tr) of selected channel (Ch). The Auto Scale function automatically 
adjusts the value of the reference division line and the scale per 
division to display the trace appropriately. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu Scale > Auto Scale 

Example :DISPlay:WINDow1:TRACe2:Y:AUTO 

3.12.1.3 Auto Scale All 

Command Format :DISPlay:WINDow<wnum>:Y:AUTO 

Instruction Scales all of the traces to fit in the same window. This is equivalent to 
"Auto Scale All" from the front panel. 

Auto scale behaves differently when scale coupling is enabled. How it 
behaves depends on the scale coupling method. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu Scale > Auto Scale All 

Example :DISPlay:WINDow1:Y:AUTO 
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3.12.1.4 Scale Per Division 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision 
<numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:PDIVision? 

Instruction For the selected trace of selected channel, when the data format is 
not the Smith chart format or the polar format, sets the scale per 
division. When the data format is the Smith chart format or the polar 
format, sets the full scale value (the value of the outermost 
circumference). 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>: represents the scale per division, float, unit varies 
depending on the data format. 

Log magnitude: dB (decibel) 

Phase, Expanded phase or Positive phase:    (degree) 

Group delay: s (second) 

Others: No unit 

Return Float 

Default Varies depending the data format. 

Log magnitude: 10 

Phase, Expanded phase or Positive phase: 90 

Group delay: 1E-8 

Smith chart or Polar or SWR: 1 

Linear magnitude: 0.1 

Real or Imaginary: 0.2 

Menu Scale > Scale 

Example :DISPlay:WINDow1:TRACe1:Y:PDIVision 10 

:DISPlay:WINDow1:TRACe1:Y:PDIVision? 

Return: 10 
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3.12.1.5 Scale Reference Level 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel 
<numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RLEVel? 

Instruction This command sets/gets the value of the reference division line, for the 
selected trace of selected channel. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>: represents the scale reference level, float, unit varies 
depending on the data format. 

Log magnitude: dB (decibel) 

Phase, Expanded phase or Positive phase:    (degree) 

Group delay: s (second) 

Others: No unit 

Return Float 

Default 0 

Menu Scale > Reference Level 

Example :DISPlay:WINDow1:TRACe1:Y:RLEVel 5 

:DISPlay:WINDow1:TRACe1:Y:RLEVel? 

Return: 5 

 

3.12.1.6 Scale Reference Position 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition 
<numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:RPOSition? 

Instruction This command specifies the position of a reference division line with its 
number (an integer assigned starting from 0 from the lowest division), 
for the selected trace of selected channel. 
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Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>: represents the scale reference position, and the parameter 
range: 0 to the number of divisions. 

Return Integer 

Default 5 

Menu Scale > Reference Position 

Example :DISPlay:WINDow1:TRACe1:Y:RPOSition 6 

:DISPlay:WINDow1:TRACe1:Y:RPOSition? 

Return: 6 

 

3.12.2 Electrical Delay 

3.12.2.1 Command List 

Electrical Delay Time :CALCulate<cnum>:TRACe<tnum>:CORRection:EDELay:TIME 

Electrical Delay Distance :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:DISTance 

Electrical Delay Distance Units :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:UNIT 

Velocity Factor :SENSe<cnum>:CORRection:RVELocity:COAX 

Madia :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:MEDium 

Cuttoff Freq of Waveguide :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:WGCutoff 

 

3.12.2.2 Electrical Delay Time 

Command Format :CALCulate<cnum>[:SELected]:CORRection:EDELay:TIME 
<numeric> 

:CALCulate<cnum>[:SELected]:CORRection:EDELay:TIME? 

:CALCulate<cnum>:TRACe<tnum>:CORRection:EDELay:TIME 
<numeric> 
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:CALCulate<cnum>:TRACe<tnum>:CORRection:EDELay:TIME? 

Instruction This command sets/gets the electrical delay time of the active trace of 
channels 1 to 200. 

This command sets/gets the electrical delay time of selected trace for 
the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the electrical delay time, and the parameter 
range: -10~10. 

Return Float, unit s(second) 

Default 0 

Menu Scale > Electrical Delay > Delay Time 

Example :CALCulate1:CORRection:EDELay:TIME 1 

:CALCulate1:CORRection:EDELay:TIME? 

Return: 1 

:CALCulate1:TRACe1:CORRection:EDELay:TIME 2 

:CALCulate1:TRACe1:CORRection:EDELay:TIME? 

Return: 2 

 

3.12.2.3 Electrical Delay Distance 

Command Format :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:DISTance 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:DISTance
? 

Instruction This command sets/gets the electrical delay distance of selected trace 
for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
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specified, <tnum> defaults to 1. 

<numeric>:represents the electrical delay distance. 

Return Float, unit meter, feet or inch 

Default 0 

Menu Scale > Electrical Delay > Delay Distance 

Example :CALCulate1:MEASure1:CORRection:EDELay:DISTance 1 

:CALCulate1:MEASure1:CORRection:EDELay:DISTance? 

Return: 1 

 

3.12.2.4 Electrical Delay Distance Units 

Command Format :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:UNIT 
<type> 

:CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:UNIT? 

Instruction This command sets/gets the electrical delay distance units of selected 
trace for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>: {METer|FEET|INCH} 

Return METer|FEET|INCH 

Default METer 

Menu Scale > Electrical Delay > Distance Units 

Example :CALCulate1:MEASure1:CORRection:EDELay:UNIT FEET 

:CALCulate1:MEASure1:CORRection:EDELay:UNIT? 

Return: FEET 

 

3.12.2.5 Velocity Factor 
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Command Format :SENSe<cnum>:CORRection:RVELocity:COAX <numeric> 

:SENSe<cnum>:CORRection:RVELocity:COAX? 

Instruction This command sets/gets the velocity factor, for selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the velocity factor e, and the parameter range: 
0~1. 

Return Float 

Default 1 

Menu Scale > Electrical Delay > Velocity Factor 

Example :SENSe1:CORRection:RVELocity:COAX 0.5 

:SENSe1:CORRection:RVELocity:COAX? 

Return: 0.5 

 

3.12.2.6 Madia 

Command Format :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:MEDium 
<type> 

:CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:MEDium
? 

Instruction Sets the media used when calculating the electrical delay.  

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={COAX|WAVE}. 

Return String 

Default COAX 

Menu Scale > Electrical Delay > Media 

Example :CALCulate1:MEASure1:CORRection:EDELay:MEDium WAVE 
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:CALCulate1:MEASure1:CORRection:EDELay:MEDium? 

Return: WAVE 

 

3.12.2.7 Cuttoff Freq of Waveguide 

Command Format :CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:WGCutoff 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:CORRection:EDELay:WGCutoff
? 

Instruction Sets the waveguide cutoff frequency used when the electrical delay 
media is set to WAVEguide. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:Waveguide cutoff frequency used with the electrical delay 
calculation. 

Return Float, unit:Hz 

Default 45MHz 

Menu Scale > Electrical Delay > Wavegd Cutoff  

Example :CALCulate1:MEASure1:CORRection:EDELay:WGCutoff 100e3 

:CALCulate1:MEASure1:CORRection:EDELay:WGCutoff? 

Return: 100000 

 

3.12.3 Constants 

3.12.3.1 Command list  

System Impedance :SENSe:CORRection:IMPedance[:INPut][:MAGNitude] 

Phase Offset :CALCulate<cnum>:TRACe<tnum>:CORRection:OFFSet:PHASe 

Magnitude Offset :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude 
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Magnitude Slope :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude:SLOPe 

 

3.12.3.2 System Impedance 

Command Format :SENSe:CORRection:IMPedance[:INPut][:MAGNitude] <numeric> 

:SENSe:CORRection:IMPedance[:INPut][:MAGNitude]? 

Instruction This command sets/gets the system characteristic impedance (Z0) 
value. 

Parameter Type <numeric>:represents the system characteristic impedance (Z0) value, 
and the parameter range: 0~1000. 

Return Float 

Default 50 

Menu Scale > Constants > System Z0 

Example :SENSe:CORRection:IMPedance 75 

:SENSe:CORRection:IMPedance? 

Return: 75 

 

3.12.3.3 Phase Offset 

Command Format :CALCulate<cnum>[:SELected]:CORRection:OFFSet:PHASe 
<numeric> 

:CALCulate<cnum>[:SELected]:CORRection:OFFSet:PHASe? 

:CALCulate<cnum>:TRACe<tnum>:CORRection:OFFSet:PHASe 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:CORRection:OFFSet:PHASe? 

Instruction This command sets/gets the phase offset of the active trace of selected 
channel 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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<numeric>:represents the phase offset, and the parameter range: -
360 ~ 360. 

Return Float unit (radian) 

Default 0 

Menu Scale > Constants > Phase offset 

Example :CALCulate1:CORRection:OFFSet:PHASe 25 

:CALCulate1:CORRection:OFFSet:PHASe? 

Return: 25 

 

:CALCulate1:TRACe1:CORRection:OFFSet:PHASe 90 

:CALCulate1:TRACe1:CORRection:OFFSet:PHASe? 

Return: 90 

 

3.12.3.4 Magnitude Offset 

Command Format :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude <numeric> 

:CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude? 

Instruction This command sets/gets the magnitude offset of the active trace of 
selected channel 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the magnitude offset, and the parameter range: 
-1000 ~ 1000 

Return Float unit dB 

Default 0 

Menu Scale > Constants > Mag offset 

Example :CALCulate1:MEASure1:OFFSet:MAGNitude 90 

:CALCulate1:MEASure1:OFFSet:MAGNitude? 

Return: 90 
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3.12.3.5 Magnitude Slope 

Command Format :CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude:SLOPe 
<numeric> 

:CALCulate<cnum>:MEASure<tnum>:OFFSet:MAGNitude:SLOPe? 

Instruction This command sets/gets the magnitude slope of the active trace of 
selected channel 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the magnitude slope, and the parameter range: 
-1000 ~ 1000. 

Return Float unit dB/GHz 

Default 0 

Menu Scale > Constants > Mag Slope 

Example :CALCulate1:MEASure1:OFFSet:MAGNitude:SLOPe 10 

:CALCulate1:MEASure1:OFFSet:MAGNitude:SLOPe? 

Return: 10 

 

3.12.4 Advanced 

3.12.4.1 Command List 

Scale Divisions :DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions 

Scale Type :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:TYPE 

Logarithmic scale Y-
axis maximum value 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MAXimize 

Logarithmic scale Y-
axis minimum value 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MINimize 
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3.12.4.2 Scale Divisions 

Command Format :DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions <numeric> 

:DISPlay:WINDow<wnum>:Y[:SCALe]:DIVisions? 

Instruction This command sets/gets the number of division on the Y-axis. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the number of division on the Y-axis, and the 
parameter range: an even number from 4 to 30. 

Return Integer 

Default 10 

Menu Scale > Advanced > Divisions 

Example :DISPlay:WINDow1:Y:DIVisions 4 

:DISPlay:WINDow1:Y:DIVisions? 

Return: 4 

 

3.12.4.3 Scale Type 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:TYPE <type> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:TYPE? 

Instruction This command sets/gets the type of scale display. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={LINear|LOG} 

LINear: Linear scale mode. 

LOG: Logarithmic scale mode. 

Return Enumeration 

Default LINear 

Menu Scale > Advanced > Scale Type 
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Example :DISPlay:WINDow1:TRACe1:Y:TYPE LOG 

:DISPlay:WINDow1:TRACe1:Y:TYPE? 

Return: LOG 

 

3.12.4.4 Logarithmic scale Y-axis maximum value 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MAXimize 
<numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MAXimize
? 

Instruction This command sets/gets the Y-axis maximum value on a logarithmic 
scale. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the Y-axis maximum value on a logarithmic 
scale, and the parameter range: integer powers of 10. 

Return Float 

Default 10000 

Menu Scale > Advanced > Max Value 

Example :DISPlay:WINDow1:TRACe1:Y:LOG:MAXimize 1000 

:DISPlay:WINDow1:TRACe1:Y:LOG:MAXimize? 

Return: 1000 

 

3.12.4.5 Logarithmic scale Y-axis minimum value 

Command Format :DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MINimize 
<numeric> 

:DISPlay:WINDow<wnum>:TRACe<tnum>:Y[:SCALe]:LOG:MINimize? 

Instruction This command sets/gets the Y-axis minimum value on a logarithmic 
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scale.. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the Y-axis minimum value on a logarithmic 
scale, and the parameter range: integer powers of 10. 

Return Float 

Default 0.01 

Menu Scale > Advanced > Min Value 

Example :DISPlay:WINDow1:TRACe1:Y:LOG:MINimize 0.1 

:DISPlay:WINDow1:TRACe1:Y:LOG:MINimize? 

Return: 0.1 

 

3.13 Search Commands 

3.13.1 Search 

3.13.1.1 Command List 

Marker Search Type :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TYPE 

Execute Search :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:EXECute 

Add Search Domain :CALCulate<cnum> [:SELected]:MARKer:FUNCtion:DOMain:ADD 

Delete Search 
Domain 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain:DELete 

Select Search Range 
Number 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:DOMain:NUMber 

Search Domain 
Start 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STARt 

Search Domain Stop :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnum>:STOP 

Tracking State :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TRACking 

3.13.1.2 Marker Search Type 
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Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TYPE 
<type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TYPE? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TYP
E <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TYP
E? 

Instruction This command selects the search type for marker 1 to 9 (Mk) and 
reference marker (Mk:10), for the active trace of selected channel 
(Ch). 

This command selects the search type for marker 1 to 9 (Mk) and 
reference marker (Mk:10), for the selected trace of selected channel 
(Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={MAXimum|MINimum|PEAK|LPEak|RPEak|TARGet|LTARget|
RTARget} 

Return Enumeration 

Default None 

Menu Search > Max Search/Min Search 

Search > Peak Search/Peak Right Search/Peak Left Search 

Search > Target Search/Target Right Search/Target Left Search 

Example :CALCulate1:MARKer1:FUNCtion:TYPE RTARget 

:CALCulate1:MARKer1:FUNCtion:TYPE? 

Return: RTAR 

:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE PEAK 

:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE? 

Return: PEAK 

 



VNA Series Programming Guide 

314                                                                                                                                                                                    int.siglent.com 

3.13.1.3 Execute Search 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:EXECute 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:EXE
Cute 

Instruction This command immediately executes the specified search function of 
the active trace for the selected channel. 

This command immediately executes the specified search function of 
the selected trace, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

Return None 

Default None 

Menu Search > Max Search/Min Search 

Search > Peak Search/Peak Right Search/Peak Left Search 

Search > Target Search/Target Right Search/Target Left Search 

Example :CALCulate1:MARKer1:FUNCtion:TYPE MAXimum 

:CALCulate1:MARKer1:FUNCtion:EXECute 

:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE MINimum 

:CALCulate1:TRACe1:MARKer1:FUNCtion:EXECute 

 

3.13.1.4 Add Search Domain 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain:ADD 

Instruction This command adds search range of search analysis for the selected 
marker, for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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Return None 

Default None 

Menu Search > Domain > Add 

Example :CALCulate1:MARKer:FUNCtion:DOMain:ADD 

 

3.13.1.5 Delete Search Domain 

Command Format :CALCulate<cnum> [:SELected]:MARKer:FUNCtion:DOMain:DELete 
<numeric> 

Instruction This command deletes search range of search analysis for the selected 
marker, for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the search range of marker, and the parameter 
range: 1 ~ 16. 

Return None 

Default None 

Menu Search > Domain > Delete 

Example :CALCulate1:MARKer:FUNCtion:DOMain:DELete 1 

 

3.13.1.6 Select Search Range Number 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:DOMain:
NUMber <numeric> 

:CALCulate<cnum> 
[:SELected]:MARKer<mnum>:FUNCtion:DOMain:NUMber? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:DO
Main:NUMber <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:DO
Main:NUMber? 

Instruction This command selects or gets search range number of search analysis 
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for the selected marker, for the active trace of selected channel. 

This command selects or gets search range number of search analysis 
for the selected marker, for the selected trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<numeric>:represents the search range of marker, and the parameter 
range: 1 ~ 16. 

Return Integer 

Default None 

Menu Search > Domain  

Example :CALCulate1:TRACe1:MARKer1:FUNCtion:DOMain:NUMber 3 

:CALCulate1:TRACe1:MARKer1:FUNCtion:DOMain:NUMber? 

Return: 3 

:CALCulate1:MARKer:FUNCtion:DOMain:NUMber 2 

:CALCulate1:MARKer:FUNCtion:DOMain:NUMber? 

Return: 2 

 

3.13.1.7 Search Domain Start 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:
STARt <numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:
STARt? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnu
m>:STARt <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnu
m>:STARt? 

Instruction This command sets/gets the start value of the marker search range, for 
the selected channel. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<dnum>:={[1]-16}, represents the number of the marker search range. 

<numeric>:represents the start value of the marker search range. 

Return Float 

Default None 

Menu Search > Start 

Example :CALCulate1:MARKer:FUNCtion:DOMain2:STARt 1e9 

:CALCulate1:MARKer:FUNCtion:DOMain2:STARt? 

Return: 1000000000 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STARt 2e9 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STARt? 

Return: 2000000000 

 

3.13.1.8 Search Domain Stop 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:
STOP <numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:DOMain<dnum>:
STOP? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnu
m>:STOP <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:DOMain<dnu
m>:STOP? 

Instruction This command sets/gets the stop value of the marker search range, for 
the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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<dnum>:={[1]-16}, represents the number of the marker search range. 

<numeric>:represents the stop value of the marker search range. 

Return Float 

Default None 

Menu Search > Stop 

Example :CALCulate1:MARKer:FUNCtion:DOMain2:STOP 3e9 

:CALCulate1:MARKer:FUNCtion:DOMain2:STOP? 

Return: 3000000000 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STOP 4e9 

:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STOP? 

Return: 4000000000 

 

3.13.1.9 Tracking State 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TRACkin
g <bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TRACkin
g? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TRA
Cking <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TRA
Cking? 

Instruction This command turns ON or OFF the tracking search capability for the 
specified marker of the active trace for the selected channel. 

This command turns ON or OFF the tracking search capability for the 
specified marker of the selected trace, for the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<bool>:= ON|OFF|1|0 
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Return Boolean 

Default OFF 

Menu Search > Tracking 

Example :CALCulate1:MARKer2:FUNCtion:TRACking ON 

:CALCulate1:MARKer2:FUNCtion:TRACking? 

Return: 1 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TRACking OFF 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TRACking? 

Return: 0 

 

3.13.2 Peak 

3.13.2.1 Command List 

Peak Search 
THReshold 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FUNCtion:PEAK:THReshold 

Peak Search 
Excursion 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PEXCursion 

Peak Search 
POLarity 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PPOLarity 

 

3.13.2.2 Peak Search THReshold 

Command Format :CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FUNCtion:P
EAK:THReshold <numeric> 

:CALCulate<cnum>:MEASure<tnum>:MARKer<mnum>:FUNCtion:P
EAK:THReshold? 

Instruction This comamnd set/get the threshold of the peak search with marker 1 
to 9 (Mk) and reference marker (Mk:10), for the selected trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<numeric>:represents the threshold of the peak search, and the 
parameter range: -500dB~500dB. 

Return Float 

Default -100dB 

Menu Search > Peak > Threshold 

Example :CALCulate1:MEASure1:MARKer2:FUNCtion:PEAK:THReshold -20 

:CALCulate1:MEASure1:MARKer2:FUNCtion:PEAK:THReshold? 

Return: -20 

 

3.13.2.3 Peak Search Excursion 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PEXCurs
ion <numeric> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PEXCur
sion? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PEX
Cursion <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PEX
Cursion? 

Instruction This command sets/gets the lower limit of peak excursion value when 
executing the peak search with marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the active trace of selected channel (Ch). Peak 
excursion value is the minimum value of the difference relative to the 
right and left adjacent measurement points. 

This command sets/gets the lower limit of peak excursion value when 
executing the peak search with marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the selected trace of selected channel (Ch). Peak 
excursion value is the minimum value of the difference relative to the 
right and left adjacent measurement points. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<numeric>:represents the lower limit of peak excursion value, and the 
parameter range: -500dB~500dB. 

Return Float 

Default 3dB 

Menu Search > Peak > Excursion 

Example :CALCulate1:MARKer2:FUNCtion:PEXCursion 2 

:CALCulate1:MARKer2:FUNCtion:PEXCursion? 

Return: 2 

 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PEXCursion 6 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PEXCursion? 

Return: 6 

 

3.13.2.4 Peak Search POLarity 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PPOLarit
y <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:PPOLarit
y? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PPO
Larity <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:PPO
Larity? 

Instruction This comamnd set/get the polarity of the peak search with marker 1 to 
9 (Mk) and reference marker (Mk:10), for the active trace of selected 
channel (Ch). 

This comamnd set/get the polarity of the peak search with marker 1 to 
9 (Mk) and reference marker (Mk:10), for the selected trace of selected 
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channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={POSitive|NEGative|BOTH} 

Return Enumeration 

Default POSitive 

Menu Search > Peak > Peak Polarity 

Example :CALCulate1:MARKer2:FUNCtion:PPOLarity NEGative 

:CALCulate1:MARKer2:FUNCtion:PPOLarity? 

Return: NEG 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PPOLarity BOTH 

:CALCulate1:TRACe1:MARKer2:FUNCtion:PPOLarity? 

Return: BOTH 

 

3.13.3 Target 

3.13.3.1 Command List 

Target Search 
Value 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TARGet 

Transition Type 
of Target Search 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TTRansition 

 

3.13.3.2 Target Search Value 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TARGet 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TARGet? 
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:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TAR
Get <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TAR
Get? 

Instruction This command sets/gets the target value to be searched with marker 
1 to 9 (Mk) and reference marker (Mk:10), for the active trace of 
selected channel (Ch). 

This command sets/gets the target value to be searched with marker 
1 to 9 (Mk) and reference marker (Mk:10), for the selected trace of 
selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<numeric>:represents the target value, and the parameter range: -
500dB~500dB. 

Return Float 

Default 0 dB 

Menu Search > Target > Target Value 

Example :CALCulate1:MARKer2:FUNCtion:TARGet 1 

:CALCulate1:MARKer2:FUNCtion:TARGet? 

Return: 1 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TARGet -3 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TARGet? 

Return: -3 

 

3.13.3.3 Transition Type of Target Search 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TTRansit
ion <type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:FUNCtion:TTRansit
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ion? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TTR
ansition <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:FUNCtion:TTR
ansition? 

Instruction This command selects the transition type of the target search, for 
marker 1 to 9 (Mk) and reference marker (Mk:10) of the active trace of 
selected channel (Ch). 

This command selects the transition type of the target search, for 
marker 1 to 9 (Mk) and reference marker (Mk:10) of the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={POSitive|NEGative|BOTH} 

Return Enumeration 

Default POSitive 

Menu Search > Target > Transition 

Example :CALCulate1:MARKer2:FUNCtion:TTRansition NEGative 

:CALCulate1:MARKer2:FUNCtion:TTRansition? 

Return: NEG 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TTRansition POSitive 

:CALCulate1:TRACe1:MARKer2:FUNCtion:TTRansition? 

Return: POS 

 

3.13.4 Multi Peak & Target 

3.13.4.1 Command List 

Search Type of Multi :CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TYPE 
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Peak&Target Search 

Multi Peak Search 
THReshold 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:THReshol
d 

Multi Peak Search 
Pexcurion 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PEXCursi
on 

Multi Peak Search 
POLarity 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PPOLarity 

Multi Target Search 
Value 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TARGet 

Transition Type of 
Multi Target Search 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TTRansiti
on 

 

3.13.4.2 Search Type of Multi Peak&Target Search 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TYPE 
<type> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TYPE? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TYPE 
<type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TYPE? 

Instruction This command sets/gets the search type of the multi search of the 
active trace of selected channel (Ch). 

This command sets/gets the search type of the multi search of the 
selected trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={PEAK|TARGet|OFF} 

Return Enumeration 

Default None 

Menu None 

Example :CALCulate1:MARKer:FUNCtion:MULTi:TYPE PEAK 
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:CALCulate1:MARKer:FUNCtion:MULTi:TYPE? 

Return: PEAK 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TYPE TARGet 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TYPE? 

Return: TARG 

 

3.13.4.3 Multi Peak Search THReshold 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:THReshold 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:THReshold
? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:THRes
hold <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:THRes
hold? 

Instruction This comamnd set/get the threshold of the multi peak search with 
marker 1 to 9 (Mk) and reference marker (Mk:10), for the selected trace 
of active channel (Ch). 

This comamnd set/get the threshold of the multi peak search with 
marker 1 to 9 (Mk) and reference marker (Mk:10), for the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the threshold of the multi peak search, and the 
parameter range: -500dB~500dB. 

Return Float 

Default -100 dB 

Menu Search > Multi Peak&Target > Peak Threshold 

Example :CALCulate1:MARKer:FUNCtion:MULTi:THReshold -20 

:CALCulate1:MARKer:FUNCtion:MULTi:THReshold? 
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Return: -20 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold -30 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold? 

Return: -30 

 

3.13.4.4 Multi Peak Search Pexcurion 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursio
n <numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursio
n? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PEXCu
rsion <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PEXCu
rsion? 

Instruction This command sets/gets the lower limit of multi peak excursion value 
when executing the peak search with marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the active trace of selected channel (Ch). Peak 
excursion value is the minimum value of the difference relative to the 
right and left adjacent measurement points. 

This command sets/gets the lower limit of multi peak excursion value 
when executing the peak search with marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the selected trace of selected channel (Ch). Peak 
excursion value is the minimum value of the difference relative to the 
right and left adjacent measurement points. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the lower limit of multi peak excursion value, 
and the parameter range: -500dB~500dB. 

Return Float 

Default 3 dB 

Menu Search > Multi Peak&Target > Peak Excursion 
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Example :CALCulate1:MARKer:FUNCtion:MULTi:PEXCursion 2 

:CALCulate1:MARKer:FUNCtion:MULTi:PEXCursion? 

Return: 2 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PEXCursion 6 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PEXCursion? 

Return: 6 

 

3.13.4.5 Multi Peak Search POLarity 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity 
<type> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity
? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PPOLa
rity <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:PPOLa
rity? 

Instruction This comamnd set/get the polarity of the multi peak search with 
marker 1 to 9 (Mk) and reference marker (Mk:10), for the active trace 
of selected channel (Ch). 

This comamnd set/get the polarity of the multi peak search with 
marker 1 to 9 (Mk) and reference marker (Mk:10), for the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={POSitive|NEGative|BOTH} 

Return Enumeration 

Default POSitive 

Menu Search > Multi Peak&Target > Peak Polarity 

Example :CALCulate1:MARKer:FUNCtion:MULTi:PPOLarity BOTH 

:CALCulate1:MARKer:FUNCtion:MULTi:PPOLarity? 
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Return: BOTH 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PPOLarity NEGative 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PPOLarity? 

Return: NEG 

 

3.13.4.6 Multi Target Search Value 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TARGet 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TARGet? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TARG
et <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TARG
et? 

Instruction This command sets/gets the multi target value to be searched with 
marker 1 to 9 (Mk) and reference marker (Mk:10), for the active trace 
of selected channel (Ch). 

This command sets/gets the multi target value to be searched with 
marker 1 to 9 (Mk) and reference marker (Mk:10), for the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the target value, and the parameter range: -
500dB~500dB. 

Return Float 

Default 0 dB 

Menu Search > Multi Peak&Target > Target Value 

Example :CALCulate1:MARKer:FUNCtion:MULTi:TARGet -10 

:CALCulate1:MARKer:FUNCtion:MULTi:TARGet? 

Return: -10 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TARGet -5 
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:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TARGet? 

Return: -5 

 

3.13.4.7 Transition Type of Multi Target Search 

Command Format :CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TTRansitio
n <type> 

:CALCulate<cnum>[:SELected]:MARKer:FUNCtion:MULTi:TTRansitio
n ? 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TTRan
sition <type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer:FUNCtion:MULTi:TTRan
sition ? 

Instruction This command selects the transition type of the multi target search, for 
marker 1 to 9 (Mk) and reference marker (Mk:10) of the active trace of 
selected channel (Ch). 

This command selects the transition type of the multi target search, for 
marker 1 to 9 (Mk) and reference marker (Mk:10) of the selected trace 
of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={POSitive|NEGative|BOTH} 

Return Enumeration 

Default POSitive 

Menu Search > Multi Peak&Target > Transition 

Example :CALCulate1:MARKer:FUNCtion:MULTi:TTRansition NEGative 

:CALCulate1:MARKer:FUNCtion:MULTi:TTRansition? 

Return: NEG 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TTRansition POSitive 

:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TTRansition? 

Return: POS 
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3.13.5 Bandwidth 

3.13.5.1 Command List 

Bandwidth Search 
Result State of 
Marker 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth[:STATe] 

Bandwidth Search 
BW Ref To 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:REF 

Bandwidth 
Threshold of Marker 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:THReshold 

Bandwidth Search 
Result of Marker 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:DATA? 

 

3.13.5.2 Bandwidth Search Result State of Marker 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth[:STATe] 
<bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth[:STAT
e] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth[:STAT
e]? 

Instruction This command turns ON/OFF the bandwidth search result display, for 
the active trace of selected channel; 

This command turns ON/OFF the bandwidth search result display, for 
the selected trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 



VNA Series Programming Guide 

332                                                                                                                                                                                    int.siglent.com 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Search > Bandwidth > Bandwidth Search  

Example :CALCulate1:TRACe1:MARKer1 ON 

:CALCulate1:MARKer1:BWIDth ON 

:CALCulate1:MARKer1:BWIDth? 

Return: 1 

:CALCulate1:TRACe1:MARKer:BWIDth OFF 

:CALCulate1:TRACe1:MARKer:BWIDth? 

Return: 0 

 

3.13.5.3 Bandwidth Search BW Ref To 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:REF 
<type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:REF? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:REF 
<type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:REF? 

Instruction Sets or gets the bandwidth reference type for the bandwidth search of 
the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={MARKer|PEAK} 

Return Enumeration 

Default PEAK 
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Menu Search > Bandwidth > BW Ref To 

Example :CALCulate1:SELected:MARKer1:BWIDth:REF MARKer 

:CALCulate1:SELected:MARKer1:BWIDth:REF? 

Return :MARK 

:CALCulate1:TRACe1:MARKer1:BWIDth:REF PEAK 

:CALCulate1:TRACe1:MARKer1:BWIDth:REF? 

Return :PEAK 

 

3.13.5.4 Bandwidth Threshold of Marker 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:THReshold 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:THReshold
? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:THRes
hold <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:THRes
hold? 

Instruction This command sets/gets the bandwidth definition value (the value to 
define the pass-band of the filter) of marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<numeric>:represents the bandwidth definition value, and the 
parameter range: -500~500. 

Return Float 

Default -3 

Menu Search > Bandwidth > BW Level 
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Example :CALCulate1:MARKer1:BWIDth:THReshold -3.5 

:CALCulate1:MARKer1:BWIDth:THReshold? 

Return: -3.5 

:CALCulate1:TRACe1:MARKer1:BWIDth:THReshold -6 

:CALCulate1:TRACe1:MARKer1:BWIDth:THReshold? 

Return: -6 

 

3.13.5.5 Bandwidth Search Result of Marker 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:BWIDth:DATA? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:BWIDth:DATA
? 

Instruction This command reads the bandwidth search result of marker 1 to 9 (Mk) 
and reference marker (Mk:10), for the active trace of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

Return Indicates 4-element array data (bandwidth search result). 

Data(0) :The bandwidth. 

Data(1) :Center point frequency of the 2 cutoff frequency points. 

Data(2) :The Q value. 

Data(3) :Insertion loss 

The index of the array starts from 0.  

The bandwidth search enable switch must to be turned on before query 
the search result. 

Default None 

Menu None 

Example :CALCulate1:MEASure1:MARKer3 ON 

:CALCulate1:MARKer:BWIDth ON 
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:CALCulate1:MARKer3:BWIDth:DATA? 

:CALCulate1:TRACe1:MARKer3:BWIDth:DATA? 

Return: 254357919.225087,4162270498.174748,16.363833, 
-13.946911 

 

3.13.6 Notch 

3.13.6.1 Command List 

Notch Search State :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh[:STATe] 

Notch Search Notch Ref 
To 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCH:REF 

Notch Search Level :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:THReshold 

Get Notch Search Data :CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:DATA? 

 

3.13.6.2 Notch Search State 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh[:STATe] 
<bool> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh[:STATe]? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh[:STAT
e] <bool> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh[:STAT
e]? 

Instruction This command turns ON/OFF the notch search result display, for the 
active trace of selected channel (Ch). 

This command turns ON/OFF the notch search result display, for the 
selected trace of selected channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 
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<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Search > Notch > Notch Search 

Example :CALCulate1:MARKer2:NOTCh ON 

:CALCulate1:MARKer2:NOTCh? 

Return: 1 

:CALCulate1:TRACe1:MARKer2:NOTCh OFF 

:CALCulate1:TRACe1:MARKer2:NOTCh? 

Return: 0 

 

3.13.6.3 Notch Search Notch Ref To 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCH:REF 
<type> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCH:REF? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCH:REF 
<type> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCH:REF? 

Instruction Sets or gets the notch reference type for the selected channel and trace 
notch search. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<type>:={MARKer|PEAK} 

Return Enumeration 

Default PEAK 

Menu Search > Notch > Notch Ref To 
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Example :CALCulate1:SELected:MARKer1:NOTCH:REF MARKer 

:CALCulate1:SELected:MARKer1:NOTCH:REF? 

Return :MARK 

:CALCulate1:TRACe1:MARKer1:NOTCH:REF PEAK 

:CALCulate1:TRACe1:MARKer1:NOTCH:REF? 

Return :PEAK 

 

3.13.6.4 Notch Search Level 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh:THReshold 
<numeric> 

:CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh:THReshold
? 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:THRes
hold <numeric> 

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:THRes
hold? 

Instruction This command sets/gets the notch definition value of marker 1 to 9 
(Mk) and reference marker (Mk:10), for the active trace of selected 
channel (Ch). 

This command sets/gets the notch definition value of marker 1 to 9 
(Mk) and reference marker (Mk:10), for the selected trace of selected 
channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<numeric>:represents the notch definition value, and the parameter 
range: -500dB~500dB. 

Return Float 

Default -3 dB 
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Menu Search > Notch > Notch Level 

Example :CALCulate1:MARKer2:NOTCh:THReshold -6 

:CALCulate1:MARKer2:NOTCh:THReshold? 

Return: -6 

:CALCulate1:TRACe1:MARKer2:NOTCh:THReshold -3 

:CALCulate1:TRACe1:MARKer2:NOTCh:THReshold? 

Return: -3 

 

3.13.6.5 Get Notch Search Data 

Command Format :CALCulate<cnum>[:SELected]:MARKer<mnum>:NOTCh:DATA?  

:CALCulate<cnum>:TRACe<tnum>:MARKer<mnum>:NOTCh:DATA? 

Instruction This command reads the notch search result of marker 1 to 9 (Mk) 
and reference marker (Mk:10), for the active trace of selected channel 
(Ch). 

This command reads the notch search result of marker 1 to 9 (Mk) 
and reference marker (Mk:10), for the selected trace of selected 
channel (Ch). 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

Return Indicates 4-element array data (notch bandwidth search result). 

Data(0) :The bandwidth. 

Data(1) :Center point frequency of the 2 cutoff frequency points. 

Data(2) :The Q value. 

Data(3) :Insertion loss 

The index of the array starts from 0. 

Default None 

Menu None 
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Example :CALCulate1:MARKer2:NOTCh:DATA? 

:CALCulate1:TRACe1:MARKer2:NOTCh:DATA? 

 

3.14 Service Commands 

3.14.1 Command List 

Get Active Trace :SERVice:CHANnel<cnum>:TRACe:ACTive? 

Get Active Channel :SERVice:CHANnel:ACTive? 

Get Upper Limit of Numbers of Channels :SERVice:CHANnel:COUNt? 

Get Upper Limit of Numbers of Traces :SERVice:CHANnel:TRACe:COUNt? 

Get Upper Limit of Numbers of Ports :SERVice:PORT:COUNt? 

Maximum Frequency :SERVice:SWEep:FREQency:MAXimum? 

Minimum Frequency :SERVice:SWEep:FREQency:MINimum? 

Get Upper Limit of Numbers of Sweep Points :SERVice:SWEep:POINts? 

Clear Log Data :SERVice:LOGGing:CLEar 

System error information :SYSTem:ERRor? 

10MHz Reference Oscillator :SENSe:ROSCillator:SOURce? 

 

3.14.2 Get Active Trace 

Command Format :SERVice:CHANnel<cnum>:TRACe:ACTive? 

Instruction This command reads the active trace number of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return Integer 

Default 1 

Menu None 

Example :SERVice:CHANnel1:TRACe:ACTive? 
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3.14.3 Get Active Channel 

Command Format :SERVice:CHANnel:ACTive? 

Instruction This command reads the active channel number. 

Parameter Type None 

Return Integer 

Default 1 

Menu None 

Example :DISPlay:WINDow2:ACTivate 

:SERVice:CHANnel:ACTive? 

Return: 2 

 

3.14.4 Get Upper Limit of Numbers of Channels 

Command Format :SERVice:CHANnel:COUNt? 

Instruction This reads the upper limit of the number of channels. 

Parameter Type None 

Return Integer 

Default None 

Menu None 

Example :SERVice:CHANnel:COUNt? 

Return: 256 

 

3.14.5 Get Upper Limit of Numbers of Traces 

Command Format :SERVice:CHANnel:TRACe:COUNt? 

Instruction This reads the upper limit of the number of traces. 

Parameter Type None 

Return Integer 
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Default None 

Menu None 

Example :SERVice:CHANnel:TRACe:COUNt? 

Return: 256 

 

3.14.6 Get Upper Limit of Numbers of Ports 

Command Format :SERVice:PORT:COUNt? 

Instruction This reads the upper limit of the number of ports. 

Parameter Type None 

Return Integer 

Default None 

Menu None 

Example :SERVice:PORT:COUNt? 

 

3.14.7 Maximum Frequency 

Command Format :SERVice:SWEep:FREQency:MAXimum? 

Instruction This reads the upper limit of measurement frequency. 

Parameter Type None 

Return Float, unit: Hz 

Default Maximum frequency of the analyzer 

Menu None 

Example :SERVice:SWEep:FREQency:MAXimum? 

 

3.14.8 Minimum Frequency 

Command Format :SERVice:SWEep:FREQency:MINimum? 
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Instruction This reads the lower limit of measurement frequency. 

Parameter Type None 

Return Float, unit: Hz 

Default 9 kHz 

Menu None 

Example :SERVice:SWEep:FREQency:MINimum? 

 

3.14.9 Get Upper Limit of Numbers of Sweep Points 

Command Format :SERVice:SWEep:POINts? 

Instruction This reads the upper limit of the number of sweep points. 

Parameter Type None 

Return Integer 

Default 20001 

Menu None 

Example :SERVice:SWEep:POINts? 

 

3.14.10 Clear Log Data 

Command Format :SERVice:LOGGing:CLEar 

Instruction This command clears the log data of the instrument. 

Parameter Type None 

Return None 

Default None 

Menu None 

Example :SERVice:LOGGing:CLEar 
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3.14.11 System error information 

Command Format :SYSTem:ERRor? 

Instruction Query the system error information,and return the Error number and 
the Error message(a character string with double quotation marks(")) 

Parameter Type None 

Return array 

Default None  

Menu None  

Example :SYSTem:ERRor? 

Return: -101, "Invalid character" 

 

3.14.12 10MHz Reference Oscillator 

Command Format :SENSe:ROSCillator:SOURce? 

Instruction This command gets whether apply 10 MHz signal to the Reference 
Oscillato connector. 

Parameter Type None 

Return String 

Default None 

"EXT":10 MHz signal already applied to the reference oscillator 
connector. 

"INT":10 MHz signal not applied to the reference oscillator connector. 

Menu The ninth parameter at the bottom of the screen. 

Example :SENSe1:ROSCillator:SOURce? 

Return: INT 

 

3.15 Sweep Commands 

3.15.1 Command List 
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Sweep Point :SENSe<cnum>:SWEep:POINts 

Sweep Type :SENSe<cnum>:SWEep:TYPE 

Auto Sweep :SENSe<cnum>:SWEep:TIME:AUTO 

Sweep Time :SENSe<cnum>:SWEep:TIME[:DATA] 

Sweep Delay :SENSe<cnum>:SWEep:DELay 

Individual 
Segment State 
Control 

:SENSe<cnum>:SEGMent:LIST:CONTrol:STATe 

Display Type of 
the Graph 
Horizontal Axis 

:DISPlay:WINDow<wnum>:X:SPACing 

Save Segment 
Sweep Table 

:MMEMory:STORE:SEGMent 

Load Segment 
Sweep Table 

:MMEMory:LOAD:SEGMent 

IF Bandwidth 
Per Port 

:SENSe<cnum>:SEGMent:LIST:BWIDth:PORT:STATe 

IFBW of Each 
Segment 

:SENSe<cnum>:SEGMent:LIST:BWIDth:PORT<pnum>[:RESolution] 

State of Each 
Segment 

:SENSe<cnum>:SEGMent:LIST:CONTrol:DATA 

Individual 
Power Control 

:SENSe<cnum>:SEGMent:LIST:POWer:PORT:STATe 

Power Level of 
Each Segment 

:SENSe<cnum>:SEGMent:LIST:POWer:PORT<pnum>[:LEVel][:IMMediate][:AMPLitude] 

Total Sweep 
Points of 
Segment 
Sweep 

:SENSe<cnum>:SEGMent:SWEep:POINts? 

Total Sweep 
Time of 
Segment 
Sweep 

:SENSe<cnum>:SEGMent:SWEep:TIME[:DATA]? 

Segment 
Sweep Table 

:SENSe<cnum>:SEGMent:DATA <Data> 
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3.15.2 Sweep Point 

Command Format :SENSe<cnum>:SWEep:POINts <numeric> 

:SENSe<cnum>:SWEep:POINts? 

Instruction This command sets/gets the number of measurement points of 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the sweep points. 

Return Integer 

Default 201 

Menu Sweep > Sweep Points 

Example :SENSe1:SWEep:POINts 251 

:SENSe1:SWEep:POINts? 

Return: 251 

 

3.15.3 Sweep Type 

Command Format :SENSe<cnum>:SWEep:TYPE <type> 

:SENSe<cnum>:SWEep:TYPE? 

Instruction This command sets/gets the sweep type of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={LINear|LOGarithmic|SEGMent|POWer|CW} 

"LINear":Sets the sweep type to the linear sweep. 

"LOGarithmic":Sets the sweep type to the log sweep. 

"SEGMent":Sets the sweep type to the segment sweep. 

"POWer":Sets the sweep type to the power sweep 

"CW":Sets the sweep type to the constant power sweep 

Return Enumeration 

Default LINear 
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Menu Sweep > Sweep Type 

Example :SENSe1:SWEep:TYPE SEGMent 

:SENSe1:SWEep:TYPE? 

Return: SEGM 

 

3.15.4 Auto Sweep 

Command Format :SENSe<cnum>:SWEep:TIME:AUTO <bool> 

:SENSe<cnum>:SWEep:TIME:AUTO? 

Instruction This command sets/gets whether to automatically set the sweep time 
of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Sweep > Sweep Mode 

Example :SENSe1:SWEep:TIME:AUTO 0 

:SENSe1:SWEep:TIME:AUTO? 

Return: 0 

 

3.15.5 Sweep Time 

Command Format :SENSe<cnum>:SWEep:TIME[:DATA] <numeric> 

:SENSe<cnum>:SWEep:TIME[:DATA]? 

Instruction This command sets/gets the sweep time of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the sweep time. 

Return Float, unit: s (second) 
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Default None 

Menu Sweep > Sweep Time 

Example :SENSe1:SWEep:TIME 2 

:SENSe1:SWEep:TIME? 

Return: 2 

 

3.15.6 Sweep Delay 

Command Format :SENSe<cnum>:SWEep:DELay <numeric> 

:SENSe<cnum>:SWEep:DELay? 

Instruction This command sets/gets the sweep delay time of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the sweep delay time. 

Return Float, unit: s (second) 

Default 0 

Menu Sweep > Sweep Delay 

Example :SENSe1:SWEep:DELay 1 

:SENSe1:SWEep:DELay? 

Return: 1 

 

3.15.7 Individual Segment State Control 

Command Format :SENSe<cnum>:SEGMent:LIST:CONTrol:STATe <bool> 

:SENSe<cnum>:SEGMent:LIST:CONTrol:STATe? 

Instruction This command turns ON/OFF or gets the individual segment state 
control in the segment sweep table. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 



VNA Series Programming Guide 

348                                                                                                                                                                                    int.siglent.com 

Return Boolean 

Default 1 

Menu None 

Example :SENSe1:SEGMent:LIST:CONTrol:STATe 0 

:SENSe1:SEGMent:LIST:CONTrol:STATe? 

Return: 0 

 

3.15.8 Display Type of the Graph Horizontal Axis 

Command Format :DISPlay:WINDow<wnum>:X:SPACing <type> 

:DISPlay:WINDow<wnum>:X:SPACing? 

Instruction This command selects the display type of the graph horizontal axis of 
selected channel for segment sweep. 

Parameter Type <wnum>:={[1]-36}, represents the measurement window number. If 
not specified, <cnum> defaults to 1. 

<type>:={LINear|OBASe} 

"LINear":Specifies the frequency base (linear frequency axis with the 
minimum frequency at the left edge and the maximum frequency at 
the right edge). 

"OBASe" :Specifies the order base (axis in which the measurement 
point numbers are positioned evenly in the order of measurement). 

Return Enumeration 

Default LINear 

Menu Sweep > Segment Table  > Segment Table… > X-Axis Point Spacing 

Example :DISPlay:WINDow1:X:SPACing OBASe 

:DISPlay:WINDow1:X:SPACing? 

Return: OBAS 

 

3.15.9 Save Segment Sweep Table 
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Command Format :MMEMory:STORE:SEGMent <string> 

Instruction This command saves the segment sweep table of the active channel 
into a file in the CSV format (extension ".csv").If a file with the same 
name as the specified file name exists, its contents are overwritten. 

Parameter Type <string>: represents the CSV file, and the parameter range: 255 
characters or less. 

Return None 

Default None 

Menu Sweep > Segment Table > Segment Table… > Save Table 

Example :MMEMory:STORE:SEGMent "local/test.csv" 

 

3.15.10 Load Segment Sweep Table 

Command Format :MMEMory:LOAD:SEGMent <string> 

Instruction This command recalls the specified segment sweep table file, as the 
segment sweep table of the active channel. 

Parameter Type <string>: represents the CSV file, and the parameter range: 255 
characters or less. 

Return None 

Default None 

Menu Sweep > Segment Table > Segment Table… > Load Table 

Example :MMEMory:LOAD:SEGMent "local/test.csv" 

 

3.15.11 IF Bandwidth Per Port 

Command Format :SENSe<cnum>:SEGMent:LIST:BWIDth:PORT:STATe <bool> 

:SENSe<cnum>:SEGMent:LIST:BWIDth:PORT:STATe? 

Instruction This command turns ON/OFF or gets the status of IFBW Per Port 
control in the segment sweep table. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > Segment Table > Segment Table Setting > IF Bandwidth Per 
Port 

Example :SENSe1:SEGMent:LIST:BWIDth:PORT:STATe 1 

:SENSe1:SEGMent:LIST:BWIDth:PORT:STATe? 

Return: 1 

 

3.15.12 IFBW of Each Segment 

Command Format :SENSe<cnum>:SEGMent:LIST:BWIDth:PORT<pnum>[:RESolution] 
<value1>,<value2>,...,<valueN> 

:SENSe<cnum>:SEGMent:LIST:BWIDth:PORT<pnum>[:RESolution]? 

Instruction This command sets/gets the IFBW of each segment for the selected 
port and channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<value1>,<value2>,...,<valueN>: represents the array data of NOP 
(number of total segment numbers). Where n is an integer between 1 
and NOP. 

Return Data array 

Default 10 kHz 

Menu Sweep > Segment Table > Segment Table Setting 

Example :SENSe1:SEGMent:LIST:BWIDth:PORT1:RESolution 10e3,20e3,30e3 

:SENSe1:SEGMent:LIST:BWIDth:PORT1? 

Return: 
1.000000000000e+04,2.000000000000e+04,3.000000000000e+04 
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3.15.13 State of Each Segment 

Command Format :SENSe<cnum>:SEGMent:LIST:CONTrol:DATA 
<value1>,<value2>,...,<valueN> 

:SENSe<cnum>:SEGMent:LIST:CONTrol:DATA? 

Instruction This command sets/gets the state of each segment in the segment 
sweep table of selected channel.  

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<value1>,<value2>,...,<valueN>: represents t the array data of NOP 
(number of total segment numbers). Where n is an integer between 1 
and NOP. 

Return Data array 

Default None 

Menu Sweep > Segment Table > Segment Table Setting 

Example :SENSe1:SEGMent:LIST:CONTrol:DATA 1,1,0 

:SENSe1:SEGMent:LIST:CONTrol:DATA? 

Return: 1,1,0 

 

3.15.14 Individual Power Control 

Command Format :SENSe<cnum>:SEGMent:LIST:POWer:PORT:STATe <bool> 

:SENSe<cnum>:SEGMent:LIST:POWer:PORT:STATe? 

Instruction This command turns ON/OFF the individual power control in the 
segment sweep table. This command overrides the coupled port 
power control. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 
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Default 0 

Menu Sweep > Segment Table > Segment Table Setting > Power Level 

Example :SENSe1:SEGMent:LIST:POWer:PORT:STATe 1 

:SENSe1:SEGMent:LIST:POWer:PORT:STATe? 

Return: 1 

 

3.15.15 Power Level of Each Segment 

Command Format :SENSe<cnum>:SEGMent:LIST:POWer:PORT<pnum>[:LEVel][:IMMed
iate][:AMPLitude] <value1>,<value2>,...,<valueN> 

:SENSe<cnum>:SEGMent:LIST:POWer:PORT<pnum>[:LEVel][:IMMed
iate][:AMPLitude]? 

Instruction This command sets/gets the power level of each segment for the 
selected port and channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<value1>,<value2>,...,<valueN>:represents the array data of NOP 
(number of total segment numbers). Where n is an integer between 1 
and NOP, and the parameter range: -55~20dB. 

Return Data array 

Default 0 

Menu Sweep > Segment Table > Segment Table Setting 

Example :SOURce1:POWer:PORT:COUPle 1 

:SENSe1:SEGMent:DATA 5,0,0,1,0,0,3,9000,1e+06,21, 
-5,1e+09,2e+09,61,1,3e+09,4e+09,101,-5 

:SENSe1:SEGMent:LIST:POWer:PORT1 -10,-20,-15 

:SENSe1:SEGMent:LIST:POWer:PORT1? 

Return: -1.000000000000e+01,-2.000000000000e+01, 
-1.500000000000e+01 

 

:SOURce1:POWer:PORT:COUPle 0 
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:SENSe1:SEGMent:LIST:POWer:PORT2? 

Return: -5.000000000000e+00,1.000000000000e+00,-
5.000000000000e+00 

 

3.15.16 Total Sweep Points of Segment Sweep 

Command Format :SENSe<cnum>:SEGMent:SWEep:POINts? 

Instruction This command reads the total number of the measurement points of 
all segments, for the segment sweep table of selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return Integer 

Default 21 

Menu Sweep > Segment Table > Segment Table Setting 

Example :SENSe1:SEGMent:DATA 
5,0,0,0,0,0,3,9000,1e+06,21,1e+09,2e+09,61,3e+09,4e+09,101 

:SENSe1:SEGMent:SWEep:POINts? 

Return: 183 

 

3.15.17 Total Sweep Time of Segment Sweep 

Command Format :SENSe<cnum>:SEGMent:SWEep:TIME[:DATA]? 

Instruction This command reads the total sweep time (including sweep delay time) 
of all segments, for the segment sweep table of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return Float, unit: s (second) 

Default None 

Menu Sweep > Segment Table > Segment Table Setting 

Example :SENSe1:SEGMent:DATA 
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5,0,0,0,0,1,3,9000,1e+06,21,1,1e+09,2e+09,61,5,3e+09,4e+09,101,10 

:SENSe1:SEGMent:SWEep:TIME? 

Return: 16 

 

3.15.18 Segment Sweep Table 

Command Format :SENSe<cnum>:SEGMent:DATA <Data> 

:SENSe<cnum>:SEGMent:DATA? 

Instruction This command creates/gets the segment sweep table of selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<Data>: represents the array data arranged in the following order (for 
the segment sweep table); where N is the number of segments 
(specified with <segm>) and n is an integer between 1 and N. 

 

Data = {<buf>,<stim>,<ifbw>,<pow>,<del>,<swp>,<time>,<segm>, 
<star 1>,<stop 1>,<nop 1>,<ifbw 1>,<pow 1>,<del 1>,<swp 1>,<time 
1>,...  , <star n>,<stop n>,<nop n>,<ifbw n>,<pow n>,<del n>,<swp 
n>,<time n>,.... , <star N>,<stop N>,<nop N>,<ifbw N>,<pow N>,<del 
N>,<swp N>,<time N>} 

 

Each parameter in the above array data is detailed below: 

 

<buf>:Always specify 5. 

<stim>:Stimulus setting mode 

 0:Specifies with start/stop values 

 1:Specifies with center/span values 

<ifbw>:ON/OFF of the IF bandwidth setting for each segment 

0:OFF, 1:ON 

<pow>:ON/OFF of the power setting for each segment 

 0:OFF, 1:ON 

<del>:ON/OFF of the sweep delay time setting for each segment 
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 0:OFF, 1:ON 

<time>:ON/OFF of the sweep time setting for each segment 

 0:OFF, 1:ON 

<segm>:Number of segments 

Specify an integer ranging 1 to 201. 

<star n>:Start value/center value of the n-th segment 

<stop n>:Stop value/span value of the n-th segment 

<nop n>:Number of measurement points of the n-th segment 

<ifbw n>:IF bandwidth of the n-th segment Not necessary when the IF 
bandwidth setting for each segment is OFF (<ifbw>:0). 

<pow n>:Power of the n-th segment Not necessary when the power 
setting for each segment is OFF (<pow>:0). 

<del n>:Sweep delay time of the n-th segment Not necessary when the 
sweep delay time setting for each segment is OFF (<del>:0). 

<time n> Sweep time of the n-th segment Not necessary when the 
sweep time setting for each segment is OFF (<time>:0). 

Return Data array 

Default 5,0,0,0,0,0,1,100000,1e6,21 

Menu Sweep > Segment Table > Segment Table Setting 

Example :SENSe1:SEGMent:DATA 
5,0,0,0,0,0,2,9000,1e+06,21,1e+09,2e+09,61 

:SENSe1:SEGMent:DATA? 

Return: 
5.000000000000e+00,0.000000000000e+00,0.000000000000e+00,0
.000000000000e+00,0.000000000000e+00,0.000000000000e+00,2.
000000000000e+00,9.000000000000e+03,1.000000000000e+06,2.1
00000000000e+01,1.000000000000e+09,2.000000000000e+09,6.10
0000000000e+01 

 

3.16 System Commands 

3.16.1 System  
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3.16.1.1 Command List 

Display System Date and Time :DISPlay:CLOCk 

System Date :SYSTem:DATE 

System Time :SYSTem:TIME 

Set the graphic format :HCOPy:SDUMp:DATA:FORMat 

The print color for output :HCOPy:IMAGe 

Set the area of screenshot :HCOPy:AREA 

Saves the screen image to a file :HCOPy:FILE 

Get the arbitrary block of image :HCOPy:SDUMp:DATA[:IMMediate]? 

Reboot the VNA :SYSTem:REBoot 

Shut down the VNA :SYSTem:SHUTdown 

 

3.16.1.2 Display System Date and Time 

Command Format :DISPlay:CLOCk <bool> 

:DISPlay:CLOCk? 

Instruction This command turns ON/OFF the clock display in the instrument status 
bar (at the right bottom of the LCD display). 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default 1 

Menu System > Date&Time > Display Date Time 

Example :DISPlay:CLOCk OFF 

:DISPlay:CLOCk? 

Return: 0 

 

3.16.1.3 System Date 

Command Format :SYSTem:DATE <string> 

:SYSTem:DATE? 
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Instruction This command sets/gets the date of the clock built in the VNA 
instrument. 

Parameter Type <string>: represents 3-element array data (date of the built-in clock). 

Data(0) Sets year(1980~2099). 

Data(1) Sets month(1~12). 

Data(2) Sets day(1~31). 

The index of the array starts from 0. 

Return Data array 

Default None 

Menu System > Date & Time 

Example :SYSTem:DATE 2020,1,1 

:SYSTem:DATE? 

Return: 2020,01,01 

 

3.16.1.4 System Time 

Command Format :SYSTem:TIME <string> 

:SYSTem:TIME? 

Instruction This command sets/gets the time of the clock built in the VNA 
instrument. 

Parameter Type <string>: represents 3-element array data (date of the built-in clock). 

Data(0) Sets hour(0~23). 

Data(1) Sets minute(0~59). 

Data(2) Sets second(0~59). 

The index of the array starts from 0. 

Return Data array 

Default None 

Menu System > Date & Time 

Example :SYSTem:TIME 10,30,40 

:SYSTem:TIME? 
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Return: 10,30,40 

 

3.16.1.5 Set the graphic format 

Command Format :HCOPy:SDUMp:DATA:FORMat <type> 

:HCOPy:SDUMp:DATA:FORMat? 

Instruction Sets the graphic format for screenshot. 

Parameter Type <type>:={JPG|BMP|PNG} 

Return enumerate 

Default PNG 

Menu None 

Example :HCOPy:SDUMp:DATA:FORMat BMP 

:HCOPy:SDUMp:DATA:FORMat? 

Return :BMP 

 

3.16.1.6 The print color for output 

Command Format :HCOPy:IMAGe <type> 

:HCOPy:IMAGe? 

Instruction sets/gets the print color for output (to the printer). 

Parameter Type <type>:={NORMal|INVert} 

"NORMal": Specifies printing in close color to the display color. 

"INVert": Specifies printing in the inverted color of the display color. 

Return enumerate 

Default NORMal 

Menu System > System > Screenshot Settings… 

Example :HCOPy:IMAGe INVert 

:HCOPy:IMAGe? 

Return :INV  
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3.16.1.7 Set the area of screenshot 

Command Format :HCOPy:AREA <type> 

:HCOPy:AREA? 

Instruction Set or get the area of the screenshot. 

Parameter Type <type>:={ALL|WINDow} 

ALL: Capture the entire screen. 

WINDow: Only capture waveform window area (excluding toolbar, 
status bar and menu bar) 

Return enumerate 

Default WINDow 

Menu System > System > Screenshot Settings… 

Example :HCOPy:AREA ALL 

:HCOPy:AREA? 

Return :ALL 

 

3.16.1.8 Saves the screen image to a file 

Command Format :HCOPy:FILE <string> 

:HCOPy:FILE? 

Instruction Save the screen display as a local file or an external storage device file. 
The file name must specify an extension. 

Parameter Type <string>: represents the file name, and the parameter range: less than 
256 characters. 

Use one of the following suffixes: 

.bmp - not recommended due to large file size 

.jpg - not recommended due to poor quality 

.png - recommended 

Return None 



VNA Series Programming Guide 

360                                                                                                                                                                                    int.siglent.com 

Default None 

Menu None 

Example 1.Save the screen display to the local local as a ".jpg" file. 

:HCOPy:FILE "/local/myfile.jpg" 

Save the screen display to an external USB flash drive as a.png file. 

:HCOPy:FILE "/U-disk0/myfile.png" 

 

3.16.1.9 Get the arbitrary block of image 

Command Format :HCOPy:SDUMp:DATA[:IMMediate]? 

Instruction Returns the display image in a definite-length arbitrary binary block. 
The format of the data is PNG by default. 

Parameter Type None 

Return A definite-length arbitrary binary block 

Default None 

Menu None 

Example :HCOPy:SDUMp:DATA:IMMediate? 

Return: 
#73072054BM6\E0.\00\00\00\00\006\00\00\00(\00\00\00\00\05\0
0\00\s\03\00\00\01\00\18\00\00\00\00\00\00\E0.\00\FE\11\00\00
\EB\10\00\00\00\00\00\00\00\00\00\00\E8\E9\E9\E8\E9\E9\E8\E
9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\
E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9
\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\... 

 

3.16.1.10 Reboot the VNA 

Command Format :SYSTem:REBoot 

Instruction Restart the VNA. 

Parameter Type None  
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Return None  

Default None  

Menu System > Power >Reboot 

Example :SYSTem:REBoot 

 

3.16.1.11 Shut down the VNA 

Command Format :SYSTem:SHUTdown 

Instruction Shut down the VNA. 

Parameter Type None  

Return None  

Default None  

Menu System > Power >Shut down 

Example :SYSTem:SHUTdown 

 

3.16.2 I/O Setting 

3.16.2.1 Command List 

State of DHCP :SYSTem:COMMunicate:LAN:TYPE 

IP Address :SYSTem:COMMunicate:LAN:IPADdress 

Subnet Mask :SYSTem:COMMunicate:LAN:SMASk 

Gateway :SYSTem:COMMunicate:LAN:GATeway 

GPIB Address :SYSTem:COMMunicate:GPIB:ADDRess 

 

3.16.2.2 State of DHCP 

Command Format :SYSTem:COMMunicate:LAN:TYPE <type> 

:SYSTem:COMMunicate:LAN:TYPE? 
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Instruction Toggles the IP assignment setting between static (manual) and DHCP 
(dynamic assignment) mode. 

Gets IP config. 

Parameter Type <type>:={STATIC|DHCP} 

Return Enumeration 

Default STATIC 

Menu System > I/O Setting > LAN Status > DHCP 

Example :SYSTem:COMMunicate:LAN:TYPE DHCP 

:SYSTem:COMMunicate:LAN:TYPE? 

Return: DHCP 

 

3.16.2.3 IP Address 

Command Format :SYSTem:COMMunicate:LAN:IPADdress <string> 

:SYSTem:COMMunicate:LAN:IPADdress? 

Instruction Sets a host name for the analyzer in network. 

Gets IP address. 

Parameter Type <string> is a string with double quotation marks and the format is 
"xxx.xxx.xxx.xxx". Conform to the IP Sets standard (0-255:0-255:0-
255:0-255). 

Return String 

Default None 

Menu System > I/O Setting > LAN Status > IP Address 

Example :SYSTem:COMMunicate:LAN:IPADdress "10.11.13.100" 

:SYSTem:COMMunicate:LAN:IPADdress? 

Return: "10.11.13.100" 

 

3.16.2.4 Subnet Mask 
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Command Format :SYSTem:COMMunicate:LAN:SMASk <string> 

:SYSTem:COMMunicate:LAN:SMASk? 

Instruction Sets the subnet mask according to the PC network Settings. The 
subnet mask will be set automatically if the IP assignment is set to 
DHCP. 

Parameter Type <string> is a string with double quotation marks and the format is 
"xxx.xxx.xxx.xxx". Conform to the IP Sets standard (0-255:0-255:0-
255:0-255). 

Return String 

Default None 

Menu System > I/O Setting > LAN Status > SUB Mask 

Example :SYSTem:COMMunicate:LAN:SMASk "255.255.255.0" 

:SYSTem:COMMunicate:LAN:SMASk? 

Return: "255.255.255.0" 

 

3.16.2.5 Gateway 

Command Format :SYSTem:COMMunicate:LAN:GATeway <string> 

:SYSTem:COMMunicate:LAN:GATeway? 

Instruction Sets the gateway for the analyzer in the network. The gateway will be 
fetched automatically if the IP assignment is set to DHCP. 

Gets gateway. 

Parameter Type <string> is a string with double quotation marks and the format is 
"xxx.xxx.xxx.xxx". Conform to the IP Sets standard (0-255:0-255:0-
255:0-255). 

Return String 

Default None 

Menu System > I/O Setting > LAN Status > Gateway 

Example :SYSTem:COMMunicate:LAN:GATeway "10.11.13.1" 

:SYSTem:COMMunicate:LAN:GATeway? 
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Return: "10.11.13.1" 

 

3.16.2.6 GPIB Address 

Command Format :SYSTem:COMMunicate:GPIB:ADDRess <numeric> 

:SYSTem:COMMunicate:GPIB:ADDRess? 

Instruction Sets/gets the gpib address for the network analyzer.  

Parameter Type <numeric>:represents the gpib address, and the parameter range: 
1~30. 

Return Integer 

Default 18 

Menu System > I/O Setting > GPIB 

Example :SYSTem:COMMunicate:GPIB:ADDRess 7 

:SYSTem:COMMunicate:GPIB:ADDRess? 

Return: 7 

 

3.16.3 Preset 

3.16.3.1 Command List 

Default Preset :SYSTem:PRESet 

Preset Option :SYSTem:PRESet:TYPE 

User Preset :SYSTem:UPReset 

Load User Preset File SYSTem:UPReset:LOAD[:FILE] 

Last Preset :SYSTem:LPReset 

Power On Option :SYSTem:PON:TYPE 

Power On Line State :SYSTem:PONLine[:STATe] 

Factory Reset :SYSTem:FDEFault 

 

3.16.3.2 Default Preset 
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Command Format :SYSTem:PRESet 

Instruction This command presets the setting state of the VNA to the original 
factory setting. 

Parameter Type None 

Return None 

Default None 

Menu System > Preset > Preset Option is "Default", and at the same time 
execute 

System > Preset > Preset 

Example :SYSTem:PRESet 

 

3.16.3.3 Preset Option 

Command Format :SYSTem:PRESet:TYPE <type> 

Instruction This command sets/gets the system preset type. 

Parameter Type <type>:={DEFault|LAST|USER} 

Return Enumeration 

Default None 

Menu Preset > Preset > Preset Option 

Example :SYSTem:PRESET:TYPE USER 

:SYSTem:PRESET:TYPE? 

Return: USER 

 

3.16.3.4 User Preset 

Command Format :SYSTem:UPReset 

Instruction This command presets the VNA with the user settings. The command 
is executed regardless of the operation mode in preset state. If you try 
to specify a file for a preset (local:/user_preset.sta) that does not exist, 
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an error will occur and this command will be ignored. 

Parameter Type None 

Return None 

Default None 

Menu System > Preset > Preset Option is "User", and at the same time 
execute 

System > Preset > Preset 

Example :SYSTem:UPReset 

 

3.16.3.5 Load User Preset File 

Command Format :SYSTem:UPReset:LOAD[:FILE] <string> 

Instruction This command loads an existing instrument state file (.sta or .csa) to be 
used for User Preset. 

Parameter Type <string>: represents the file name. 

Return None 

Default None 

Menu None 

Example SYSTem:UPReset:LOAD "local/user_preset.sta" 

 

3.16.3.6 Last Preset 

Command Format :SYSTem:LPReset 

Instruction This command presets the setting state of VNA to the settings before 
the last software shutdown. 

Parameter Type None 

Return None 

Default None 
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Menu System > Preset > Preset Option is "Last", and at the same time 
execute 

System > Preset > Preset 

Example :SYSTem:LPReset 

 

3.16.3.7 Power On Option 

Command Format :SYSTem:PON:TYPE <type> 

:SYSTem:PON:TYPE? 

Instruction This command sets/gets the system start type after power on. 

Parameter Type <type>:={DEFault|LAST|USER} 

Return Enumeration 

Default DEFault 

Menu Preset > Preset > Power On Option 

Example :SYSTem:PON:TYPE USER 

:SYSTem:PON:TYPE? 

Return: USER 

 

3.16.3.8 Power On Line State 

Command Format :SYSTem:PONLine[:STATe] <bool> 

:SYSTem:PONLine[:STATe]? 

Instruction This command turns ON/OFF or returns the status of the system power 
on line state. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Preset > Preset > Power On Line 

Example :SYSTem:PONLine ON 
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:SYSTem:PONLine? 

Return: 1 

 

3.16.3.9 Factory Reset 

Command Format :SYSTem:FDEFault 

Instruction This command reset the system status return to factory state. 

Parameter Type None 

Return None 

Default None 

Menu Preset > Preset > Factory Reset 

Example :SYSTem:FDEFault 

 

3.16.4 Help  

3.16.4.1 Command List 

Enable Message Display :DISPlay:MESSage:STATe 

Enable Power Unlevel Detection :DISPlay:MESSage:POWer:UNLevel 

State of Backlight :SYSTem:BACKlight 

Information About Power Meter :SYSTem:COMMunicate:USB:PMETer:CATalog? 

 

3.16.4.2 Enable Message Display 

Command Format :DISPlay:MESSage:STATe <bool> 

:DISPlay:MESSage:STATe? 

Instruction This command sets/gets the state of the enable message display. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 
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Default ON  

Menu Help > Messages Setting… > Enable Messages Display 

Example :DISP:MESS:STAT 0 

:DISP:MESS:STAT? 

Return: 0 

 

3.16.4.3 Enable Power Unlevel Detection 

Command Format :DISPlay:MESSage:POWer:UNLevel <bool> 

:DISPlay:MESSage:POWer:UNLevel? 

Instruction This command sets/gets the state of the enable power unlevel 
detection. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default ON  

Menu Help > Messages Setting… > Enable Power Unlevel Detection 

Example :DISPl:MESS:POW:UNL 0 

:DISPl:MESS:POW:UNL? 

Return: 0 

 

3.16.4.4 State of Backlight 

Command Format :SYSTem:BACKlight <bool> 

:SYSTem:BACKlight? 

Instruction This command turns ON/OFF or returns the status of the backlight of 
the LCD display. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default 1 
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Menu None 

Example :SYSTem:BACKlight OFF 

:SYSTem:BACKlight? 

Return: 0 

 

3.16.4.5 Information About Power Meter 

Command Format :SYSTem:COMMunicate:USB:PMETer:CATalog? 

Instruction This command reads the identification information string of power 
meters. 

Parameter Type None 

Return Returns identification information about connected power meters. 

Default None 

Menu None 

Example :SYSTem:COMMunicate:USB:PMETer:CATalog? 

 

3.16.5 Buzzer 

3.16.5.1 Command List 

Complete Buzzer :SYSTem:BEEPer:COMPlete:IMMediate 

Complete Buzzer State :SYSTem:BEEPer:COMPlete:STATe 

Warning Buzzer :SYSTem:BEEPer:WARNing:IMMediate 

Warning Buzzer State :SYSTem:BEEPer:WARNing:STATe 

 

3.16.5.2 Complete Buzzer 

Command Format :SYSTem:BEEPer:COMPlete:IMMediate 

Instruction This command generates a beep for the notification of the completion 
of an operation. 
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Parameter Type None 

Return None 

Default None 

Menu System > Buzzer > Complete Test 

Example :SYSTem:BEEPer:COMPlete:IMMediate 

 

3.16.5.3 Complete Buzzer State 

Command Format :SYSTem:BEEPer:COMPlete:STATe <bool> 

:SYSTem:BEEPer:COMPlete:STATe? 

Instruction This command turns ON/OFF or returns the status of the beeper for the 
notification of the completion of the operation. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu System > Buzzer > Complete Buzzer 

Example :SYSTem:BEEPer:COMPlete:STATe OFF 

:SYSTem:BEEPer:COMPlete:STATe? 

Return: 0 

 

3.16.5.4 Warning Buzzer 

Command Format :SYSTem:BEEPer:WARNing:IMMediate 

Instruction This command generates a beep for the notification of warning/limit 
test results. 

Parameter Type None 

Return None 

Default None 
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Menu System > Buzzer > Warning Test 

Example :SYSTem:BEEPer:WARNing:IMMediate 

 

3.16.5.5 Warning Buzzer State 

Command Format :SYSTem:BEEPer:WARNing:STATe <bool> 

:SYSTem:BEEPer:WARNing:STATe? 

Instruction This command turns ON/OFF or returns the status of the beeper for the 
notification of warning/limit test results. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu System > Buzzer > Warning Buzzer 

Example :SYSTem:BEEPer:WARNing:STATe ON 

:SYSTem:BEEPer:WARNing:STATe? 

Return: 1 

 

3.16.6 FIFO function 

FIFO Overview 

In a Vector Network Analyzer (VNA), FIFO (First-In-First-Out) is a data buffer. When the FIFO 

function is enabled, the VNA maintains a fixed-size storage area to hold data for rapid read/write 

access by users. FIFO data flow is controlled using SCPI commands related to the FIFO buffer. The 

data stored in the FIFO consists of raw data after averaging and scaling calculations, and has not 

undergone calibration, formatting, or data analysis processing. 

FIFO Features: 

• Users can write data into, and simultaneously read from the FIFO buffer. 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    373 

• REAL/IMAGINARY pairs is the only supported format for the FIFO buffer. 

• A maximum of 100,000 data points can be read for  per query. 

• When more than one measurement is present, data from each measurement is stored in 

the FIFO buffer in the following order as the table showned.These measurements are 

divided into multiple rows for easier access. S-parameters are converted into ratio 

measurements to determine their storage order in the FIFO. For example: S21 is placed 

into the FIFO in the same manner as B/R1. 

4-port models 

R、A、B、C、D、 

R/R、A/R、B/R、C/R、D/R、 

R/A、A/A、B/A、C/A、D/A、 

R/B、A/B、B/B、C/B、D/B、 

R/C、A/C、B/C、C/C、D/C、 

R/D、A/D、B/D、C/D、D/D 

2-port models 

R1、R2、A、B、 

R1/R1、R2/R1、A/R1、B/R1 

R1/R2、R2/R2、A/R2、B/R2 

R1/A、R2/A、A/A、B/A 

R1/B、R2/B、A/B、B/B 

 

 

3.16.6.1 Command List 

FIFO state :SYSTem:FIFO[:STATe] 

Clear the data from FIFO buffer :SYSTem:FIFO:DATA:CLEar 

Get total number of data points in the FIFO :SYSTem:FIFO:DATA:COUNt? 

Get number of bytes in the FIFO :SYSTem:FIFO:DATA:BYTe:COUNt? 

reads specific number of bytes :SYSTem:FIFO:DATA:BYTe? 

reads specified number of data points :SYSTem:FIFO:DATA? 

 

3.16.6.2 FIFO state 

Command Format :SYSTem:FIFO[:STATe] <bool> 

:SYSTem:FIFO[:STATe]? 
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Instruction Sets and returns the state of data storage to the FIFO buffer. 
Syst:Preset or an instrument state recall also ends storage to the FIFO 
buffer.  The FIFO buffer is cleared when set to OFF 

Parameter Type <bool>:=ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu None 

Example :SYSTem:FIFO ON 

:SYSTem:FIFO? 

Return:1 

 

3.16.6.3 Clear the data from FIFO buffer 

Command Format :SYSTem:FIFO:DATA:CLEar 

Instruction Clears the data from the FIFO buffer 

Parameter Type None  

Return None  

Default None  

Menu None  

Example :SYSTem:FIFO:DATA:CLEar 

 

3.16.6.4 Get total number of data points in the FIFO 

Command Format :SYSTem:FIFO:DATA:COUNt? 

Instruction Returns the total number of data points in the FIFO buffer 

Parameter Type None  

Return Integer 

Default 0 
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Menu None  

Example :SYSTem:FIFO:DATA:COUNt? 

Return:0 

 

3.16.6.5 Get number of bytes in the FIFO 

Command Format :SYSTem:FIFO:DATA:BYTe:COUNt? 

Instruction Returns a specific number of bytes in the FIFO 

Parameter Type None  

Return Integer 

Default 0 

Menu None  

Example :SYSTem:FIFO:DATA:BYTe:COUNt? 

Return:0 

 

3.16.6.6 reads specific number of bytes 

Command Format :SYSTem:FIFO:DATA:BYTe? <numeric> 

Instruction Returns a specific number of bytes to read 

Parameter Type <numeric>:represents the number of bytes, and the parameter range: 
1~1600000. 

Return A byte array representing Numbers of byte (NOB). n is an integer between 
1 and NOB.Element n-1: the NTH byte in the byte array.The array index 
starts at 0. 

Default None  

Menu None  

Example :SYSTem:FIFO:DATA:BYTe? 1000 
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3.16.6.7 reads specified number of data points 

Command Format :SYSTem:FIFO:DATA? <numeric> 

Instruction Reads a  specified number of data points from the FIFO buffer. Each 
data point is returned as a real/imaginary pair. 

Parameter Type <numeric>:represents the number of data points, and the parameter 
range: 1~100000. 

Return Numbers of point (NOP) *2 array data. n is an integer between 1 and 
NOP. 

Data (n*2-2) : the NTH stored data (real part). 

Data (n*2-1) : the NTH stored data (imaginary part). 

The array index starts at 0. 

Default None  

Menu None  

Example :SYSTem:FIFO:DATA? 1000 

 

3.16.7 External Ports 

3.16.7.1 Characterize 

3.16.7.1.1 Command List 

Initialize 
Characterization 

:SYSTem:EXTPort:SMATrix:CHAR:INIT 

Query Characterization 
Task Item Count 

:SYSTem:EXTPort:SMATrix:CHAR:STEP:COUNt? 

Query Characterization 
Task Item Description 

:SYSTem:EXTPort:SMATrix:CHAR:STEP<numeric>:DESC? 

Execute 
Characterization Tasks 

:SYSTem:EXTPort:SMATrix:CHAR:STEP<numeric>:ACQ 

Save Characterization 
Data 

:SYSTem:EXTPort:SMATrix:CHAR:SAVE 

Termination :SYSTem:EXTPort:SMATrix:CHAR:ABORt 
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Characterization 

 

3.16.7.1.2 Initialize Characterization 

Command Format :SYSTem:EXTPort:SMATrix:CHAR:INIT 

Instruction Initialize the characterization, use the current channel for 
characterizing, and generate task items for the switch matrix 
characterization. 

Parameter Type None 

Return None 

Default None 

Menu System > External Ports > Characterize 

Example :SYSTem:EXTPort:SMATrix:CHAR:INIT 

 

3.16.7.1.3 Query Characterization Task Item Count 

Command Format :SYSTem:EXTPort:SMATrix:CHAR:STEP:COUNt? 

Instruction To obtain the number of characterization tasks through a query, one 
must complete all task items, which constitutes the completion of the 
characterization. 

Parameter Type None 

Return Integer 

Default None 

Menu System > External Ports > Characterize 

Example :SYSTem:EXTPort:SMATrix:CHAR:STEP:COUNt? 

Return: 7 

 

3.16.7.1.4 Query Characterization Task Item Description 

Command Format :SYSTem:EXTPort:SMATrix:CHAR:STEP<numeric>:DESC? 
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Instruction Query the operation description for the specified task item. 

Parameter Type <numeric>:Which numbered task item. 

Return String 

Default None 

Menu System > External Ports > Characterize 

Example :SYSTem:EXTPort:SMATrix:CHAR:STEP1:DESC? 

Return: Cal Port1,2 

 

3.16.7.1.5 Execute Characterization Tasks 

Command Format :SYSTem:EXTPort:SMATrix:CHAR:STEP<numeric>:ACQ 

Instruction Execute specified tasks. 

Parameter Type <numeric>:Which numbered task item. 

Return None 

Default None 

Menu System > External Ports > Characterize > Measure 

Example :SYSTem:EXTPort:SMATrix:CHAR:STEP1:ACQ 

 

3.16.7.1.6 Save Characterization Data 

Command Format :SYSTem:EXTPort:SMATrix:CHAR:SAVE <string> 

Instruction Save characterization data. 

Parameter Type <string>:The path and name of the characterization switch matrix 
(.csm) file. 

Return None 

Default None 

Menu System > External Ports > Characterize > Finish 

Example :SYSTem:EXTPort:SMATrix:CHAR:SAVE "local/test.csm" 
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3.16.7.1.7 Termination Characterization 

Command Format :SYSTem:EXTPort:SMATrix:CHAR:ABORt 

Instruction Termination characterization. 

Parameter Type None 

Return None 

Default None 

Menu System > External Ports > Characterize > Cancel 

Example :SYSTem:EXTPort:SMATrix:CHAR:ABORt 

 

3.16.7.2 De-embed 

3.16.7.2.1 Command List 

Previous De-
embedding Parameters 

:SYSTem:EXTPort:SMATrix:DEEMbed:DISCard 

Apply De-embedding 
Parameters 

:SYSTem:EXTPort:SMATrix:DEEMbed:APPLy 

Characterize Switch 
Matrix Data 

:SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:NAME 

Use Characterization 
Sweep Parameters  

:SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:STIMulus:STATe 

De-embedding Port :SYSTem:EXTPort:SMATrix:DEEMbed:PORTs 

De-embedding 
Calibration Type 

:SYSTem:EXTPort:SMATrix:DEEMbed:METHod 

De-embedding Channel :SYSTem:EXTPort:SMATrix:DEEMbed:CHANnel 

 

3.16.7.2.2 Previous De-embedding Parameters 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:DISCard 
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Instruction Discard unapplied de-embedding parameters and restore to the 
previously saved state. 

Parameter Type None 

Return None 

Default None 

Menu System > External Ports > De-embed > Cancel 

Example :SYSTem:EXTPort:SMATrix:DEEMbed:DISCard 

 

3.16.7.2.3 Apply De-embedding Parameters 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:APPLy 

Instruction Apply de-embedding parameters. 

Parameter Type None 

Return None 

Default None 

Menu System > External Ports > De-embed > Apply 

Example :SYSTem:EXTPort:SMATrix:DEEMbed:APPLy 

 

3.16.7.2.4 Characterize Switch Matrix Data 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:NAME <string> 

:SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:NAME? 

Instruction This command sets/gets the characterization data of the switch matrix 
for de-embedding. 

Parameter Type <string>:The path and name of the characterization switch matrix 
(.csm) file. 

Return String 

Default None 

Menu System > External Ports > De-embed > Characterize Switch Matrix file 
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Example :SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:NAME "local/test.csm" 

:SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:NAME? 

Return: local/test.csm 

 

3.16.7.2.5 Use Characterization Sweep Parameters 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:STIMulus:STATe 
<bool> 

:SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:STIMulus:STATe? 

Instruction This command sets/gets the sweep parameters for determining 
whether to use a characterization switch matrix when de-embedding. 

Parameter Type <bool>:=ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default 0 or OFF 

Menu System > External Ports > De-embed > Change the channel's stimulus 
to the Cal Set 

Example :SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:STIMulus:STATe 1 

:SYSTem:EXTPort:SMATrix:DEEMbed:CALSet:STIMulus:STATe? 

Return: 1 

 

3.16.7.2.6 De-embedding Port 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:PORTs <pnum> 

:SYSTem:EXTPort:SMATrix:DEEMbed:PORTs? 

Instruction This command sets/gets the port to be de-embedded. 

Parameter Type <pnum>:De-embedded Port Set. 

Return String 

Default None 

Menu System > External Ports > De-embed > Ports 

Example :SYSTem:EXTPort:SMATrix:DEEMbed:PORTs 1,2 
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:SYSTem:EXTPort:SMATrix:DEEMbed:PORTs? 

Return: 1,2 

 

3.16.7.2.7 De-embedding Calibration Type 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:METHod <type> 

:SYSTem:EXTPort:SMATrix:DEEMbed:METHod? 

Instruction This command sets/gets the de-embedding calibration type. 

Parameter Type <type>:={OSL|SOLT} 

"OSL": Single-Port Calibration. 

"SOLT": Multi-Port Calibration. 

Return Enumeration 

Default None 

Menu System > External Ports > De-embed > Type 

Example :SYSTem:EXTPort:SMATrix:DEEMbed:METHod SOLT 

:SYSTem:EXTPort:SMATrix:DEEMbed:METHod? 

Return: SOLT 

 

3.16.7.2.8 De-embedding Channel 

Command Format :SYSTem:EXTPort:SMATrix:DEEMbed:CHANnel <cnum> 

Instruction Set the channel to be de-embedded; if not specified, de-embed the 
current channel. 

Parameter Type <cnum>:De-embed Channel Set. 

Return String 

Default Channel 1 

Menu System > External Ports > De-embed > Channel 

Example :SYSTem:EXTPort:SMATrix:DEEMbed:CHANnel 1,2 
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3.17 Trigger Commands  

3.17.1 Command List 

Channel trigger mode :SENSe<cnum>:SWEep:MODE 

Trigger Restart :ABORt 

Continuous Initiation Mode :INITiate<cnum>:CONTinuous 

Single Trigger Mode :INITiate<cnum>[:IMMediate] 

Trigger Source :TRIGger[:SEQuence]:SOURce 

Trigger Command :TRIGger[:SEQuence]:SINGle 

Trigger Command :TRIGger[:SEQuence][:IMMediate] 

Trigger Scope :TRIGger[:SEQuence]:SCOPe 

Trigger Event :TRIGger[:SEQuence]:POINt 

Polarity of the External Trigger Input Port :TRIGger:SEQuence:EXTernal:SLOPe 

Delay of the External Trigger Source :TRIGger[:SEQuence]:EXTernal:DELay 

External Trigger Output Port State :TRIGger:OUTPut:STATe 

Polarity of the Pulse :TRIGger:OUTPut:POLarity 

Position of the Pulse :TRIGger:OUTPut:POSition 

 

3.17.2 Channel trigger mode 

Command Format :SENSe<cnum>:SWEep:MODE <type> 

:SENSe<cnum>:SWEep:MODE? 

Instruction Set how many triggers will each channel accept before going into hold. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={HOLD|SINGLe|CONTinuous} 

 HOLD - channel will not trigger. 

 CONTinuous - channel triggers indefinitely. 

 SINGle - channel accepts one trigger, then goes to HOLD. 
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Return String 

Default CONTinuous 

Menu Trigger > Trigger 

Example :SENSe:SWEep:MODE HOLD 

:SENSe:SWEep:MODE? 

 

Return:HOLD 

3.17.3 Trigger Restart 

Command Format :ABORt 

Instruction This command stops the current sweeps and immediately sends a 
trigger. Then, after measurement is executed once, it goes back to the 
idle state. 

Parameter Type None 

Return None 

Default None 

Menu Trigger > Restart 

Example :ABORt 

 

3.17.4 Continuous Initiation Mode 

Command Format :INITiate<cnum>:CONTinuous <bool> 

:INITiate<cnum>:CONTinuous? 

Instruction This command turns ON/OFF the continuous initiation mode of 
selected channel in the trigger system. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

True or ON:Turns ON the continuous initiation mode. 

False or OFF:Turns OFF the continuous initiation mode. 
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Return Boolean 

Default 0 

Menu Trigger > Continuous/Hold 

Example :INITiate1:CONTinuous 1 

:INITiate1:CONTinuous? 

Return: 1 

 

3.17.5 Single Trigger Mode 

Command Format :INITiate<cnum>[:IMMediate] 

Instruction This command changes the state of each channel of selected channel 
to the initiation state in the trigger system. 

When this object is executed for a channel in the hold state, it goes into 
the single state immediately. Then, after measurement is executed 
once, it goes back to the hold state. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

Return None 

Default None 

Menu Trigger > Single 

Example :INITiate1 

 

3.17.6 Trigger Source 

Command Format :TRIGger[:SEQuence]:SOURce <type> 

:TRIGger[:SEQuence]:SOURce? 

Instruction This command sets/gets the trigger source from the following 4 
types: 

Internal Trigger 
Uses the internal trigger to generate continuous triggers 
automatically. 
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External Trigger 
Generates a trigger when the trigger signal is inputted externally via 
the Ext Trig connector or the handler interface. 

Manual Trigger 
Generates a trigger when the key operation of Trigger > Trigger is 
executed from the front panel. 

Bus Trigger 
Generates a trigger when the SCPI.IEEE4882.TRG object is executed. 

Parameter Type <type>:={INTernal|EXTernal|MANual|BUS} 

Return Enumeration 

Default INTernal 

Menu Trigger > Trigger Source 

Example :TRIGger:SOURce EXTernal 

:TRIGger:SOURce? 

Return: EXT 

 

3.17.7 Trigger Command 

Command Format :TRIGger[:SEQuence]:SINGle 

:TRIG:SING 

Instruction The trigger system is in a trigger wait state (i.e. the trigger mode is 
Single or Continuous, and the trigger source is Bus or Manual), and 
sending the command will immediately generates the trigger and 
performs the measurement. If the command is followed by *OPC? 
Make inquiries until the trigger and measurement are complete *OPC? 
return 1. For specific examples, see "Waiting for Trigger State (OPC?)" 
in Chapter 4. 

Parameter Type None 

Return None 

Default None 

Menu None 

Example :TRIGger:SEQuence:SOURce BUS 

mk:@MSITStore:C:/Users/Administrator/Desktop/常用手册/E5071_EN.chm::/Programming/Command_Reference/IEEE/SCPI_IEEE4882_TRG.htm
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:TRIGger:SEQuence:SINGle 

*OPC? 

Return：1       # Only wait until the trigger and the sweep measurement 
are complete the *OPC? return 1. 

 

3.17.8 Trigger Command 

Command Format :TRIGger[:SEQuence][:IMMediate] 

Instruction The trigger system is in a trigger wait state (i.e. the trigger mode is 
Single or Continuous, and the trigger source is Bus or Manual), and 
sending the command immediately generates the trigger and 
performs the measurement. If the command is followed by *OPC? 
Make inquiries, *OPC? 1 is returned immediately, indicating that this 
instruction has been executed. 

Parameter Type None 

Return None 

Default None 

Menu None 

Example :TRIGger:SEQuence:SOURce BUS 

:TRIGger:SEQuence:IMMediate 

*OPC? 

Return:1    #1 is returned immediately. 

 

3.17.9 Trigger Scope 

Command Format :TRIGger[:SEQuence]:SCOPe <type> 

:TRIGger[:SEQuence]:SCOPe? 

Instruction This command sets/gets the effective scope of triggering. When this 
function is enabled with a value of "ACTive", only active channel is 
triggered. When this function is enabled with a value of "ALL", all 
channels are triggered. 

Parameter Type <type>:={ALL|ACTive} 
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Return Enumeration 

Default ALL 

Menu Trigger > Trigger Scope 

Example :TRIGger:SCOPe ACTive 

:TRIGger:SCOPe? 

Return: ACT 

 

3.17.10 Trigger Event 

Command Format :TRIGger[:SEQuence]:POINt <bool> 

:TRIGger[:SEQuence]:POINt? 

Instruction This command turns ON/OFF or returns the status of the point trigger 
feature. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Trigger > Trigger Setup > Trigger Event 

Example :TRIGger:POINt 1 

:TRIGger:POINt? 

Return: 1 

 

3.17.11 Polarity of the External Trigger Input Port 

Command Format :TRIGger:SEQuence:EXTernal:SLOPe <type> 

:TRIGger:SEQuence:EXTernal:SLOPe? 

Instruction This command sets/gets the polarity of the External Trigger Input Port. 

Parameter Type <type>:={POSitive|NEGative} 

Return Enumeration 

Default POSitive 

javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#5. External Trigger Input Connector (Ext Trig)');
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Menu Trigger > Trigger Setup > Ext Trig Input 

Example :TRIGger:SEQuence:EXTernal:SLOPe NEGative 

:TRIGger:SEQuence:EXTernal:SLOPe? 

Return: NEG 

 

3.17.12 Delay of the External Trigger Source 

Command Format :TRIGger[:SEQuence]:EXTernal:DELay <numeric> 

:TRIGger[:SEQuence]:EXTernal:DELay? 

Instruction This command sets/gets the time that it takes from receiving the 
trigger to starting measurement when the trigger source is external. 

Parameter Type <numeric>:represents the external trigger delay time. 

Return Float, unit: s (second) 

Default 0 

Menu Trigger > Trigger Setup > Trigger Delay 

Example :TRIGger:EXTernal:DELay 1 

:TRIGger:EXTernal:DELay? 

Return: 1 

 

3.17.13 External Trigger Output Port State 

Command Format :TRIGger:OUTPut:STATe <bool> 

:TRIGger:OUTPut:STATe? 

Instruction This command sets/gets the External Trigger Output Port state. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default 0 

Menu Trigger > Trigger Setup > Ext Trig output 

javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
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Example :TRIGger:OUTPut:STATe 1 

:TRIGger:OUTPut:STATe? 

Return: 1 

 

3.17.14 Polarity of the Pulse 

Command Format :TRIGger:OUTPut:POLarity <type> 

:TRIGger:OUTPut:POLarity? 

Instruction This command sets/gets the polarity of the pulse generated by the 
External Trigger Output Port. 

Parameter Type <type>:={POSitive|NEGative} 

Return Enumeration 

Default POSitive 

Menu Trigger > Trigger Setup > Polarity 

Example :TRIGger:OUTPut:POLarity NEGative 

:TRIGger:OUTPut:POLarity? 

Return: NEG 

 

3.17.15 Position of the Pulse 

Command Format :TRIGger:OUTPut:POSition <type> 

:TRIGger:OUTPut:POSition? 

Instruction This command sets/gets the position of the External Trigger Output 
Port. 

Parameter Type <type>:={AFTer|BEFore} 

Return Enumeration 

Default AFTer 

Menu Trigger > Trigger Setup > Position 

Example :TRIGger:OUTPut:POSition BEFore 

javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
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:TRIGger:OUTPut:POSition? 

Return: BEF 

 

3.18 Switch Matrix Commands 

3.18.1 Command list 

Ext Port Enabled :SYSTem:EXTPort[:STATe] 

Get  the numbers of the switch matrices :SYSTem:EXTPort:SMATrix:CATalog? 

Get the model of switch matrices :SYSTem:EXTPort:SMATrix<num>:MODel? 

Get the serial of switch matrices :SYSTem:EXTPort:SMATrix<num>:SERial? 

Starts a manual RF connection configuration :SYSTem:EXTPort:SMATrix:CONFigure:STARt 

Aborts a manual RF connection configuration :SYSTem:EXTPort:SMATrix:CONFigure:ABORt 

Ends a manual RF connection configuration :SYSTem:EXTPort:SMATrix:CONFigure:END 

Sets the RF connection between the switch 
matrix and VNA physical ports 

:SYSTem:EXTPort:SMATrix:CONFigure:TVNA 

Sets the RF connections between switch matrix 
and VNA 

:SYSTem:EXTPort:SMATrix<num>:CONFigure:MVNA 

Sets the matrix RF output port to VNA ports :SYSTem:EXTPort:SMATrix<num>:CONFigure:MTESt 

 

3.18.2 Ext Port Enabled 

Command Format :SYSTem:EXTPort[:STATe] <bool> 

:SYSTem:EXTPort[:STATe]? 

Instruction Set or get the state of the Ext Port function. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default None  

Menu System >External Ports > Ext Port Enabled 

Example :SYSTem:EXTPort:STATe 1 

:SYSTem:EXTPort:STATe? 
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Return 1 

 

3.18.3 Get  the numbers of the switch matrices 

Command Format :SYSTem:EXTPort:SMATrix:CATalog? 

Instruction Queries the numbers of the switch matrices currently part of the RF 
configuration. When connecting multiple switch matrices, The 
response is return a comma-separated list of switch matrix numbers. 

Parameter Type None  

Return string 

Default 1 

Menu None  

Example If  connecting 2 switch matrices, then: 

:SYSTem:EXTPort:SMATrix:CATalog? 

Return 1,2 

 

3.18.4 Get the model of switch matrices  

Command Format :SYSTem:EXTPort:SMATrix<num>:MODel? 

Instruction Get the model of the connected switch matrix. 

Parameter Type <num>: switch matrix number 

Return String  

Default None  

Menu None  

Example :SYSTem:EXTPort:SMATrix1:MODel? 

Return “SSM5124” 
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3.18.5 Get the serial of switch matrices 

Command Format :SYSTem:EXTPort:SMATrix<num>:SERial? 

Instruction Get the serial of the connected switch matrix. 

Parameter Type <num>: switch matrix number 

Return String  

Default None  

Menu None  

Example :SYSTem:EXTPort:SMATrix1:SERial? 

Return “SSM5AAAX7R0003” 

 

3.18.6 Starts a manual RF connection configuration 

Command Format :SYSTem:EXTPort:SMATrix:CONFigure:STARt 

Instruction Start a manual RF connection configuration, An RF connection 
configuration comprises the RF connections between the VNA, a set of 
switch matrices and the DUT test ports. This command with 
a":SYSTem:EXTPort:SMATrix:CONFigure:END" used in pairs, make a 
modified configuration to take effect. 

Parameter Type None 

Return None 

Default None 

Menu None 

Example #Enable the Ext Port function 

:SYSTem:EXTPort:STATe 1 

#Start a manual RF connection configuration 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

#Define non-default matrix-VNA port connections: matrix port 1 to 
VNA port 2, matrix port 2 to VNA port 4, matrix port 3 to VNA port 1 
and matrix port 4 to VNA port 3 

:SYSTem:EXTPort:SMATrix1:CONFigure:MVNA 1,2,2,4,3,1,4,3 
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#Configure 4 matrix test ports only: matrix test port 1 is test port 1, 
matrix test port 7 is test port 2, matrix test port 11 is test port 3 and 
matrix test port 22 is test port 4. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MTESt 1,1,7,2,11,3,22,4 

#Apply the manual RF connection configuration. 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

3.18.7 Aborts a manual RF connection configuration 

Command Format :SYSTem:EXTPort:SMATrix:CONFigure:ABORt 

Instruction Aborts a manual RF connection configuration and the new 
configuration is discarded. 

Parameter Type None 

Return None 

Default None 

Menu None 

Example :SYSTem:EXTPort:SMATrix:CONFigure:ABORt 

 

3.18.8 Ends a manual RF connection configuration 

Command Format :SYSTem:EXTPort:SMATrix:CONFigure:END 

Instruction Ends a manual RF connection configuration: if the configuration is valid, 
it will be activated ("commit"). Otherwise an error is returned and the 
new configuration is discarded, and the previous configuration remains 
active 

Parameter Type None 

Return None 

Default None 

Menu None 

Example :SYSTem:EXTPort:SMATrix:CONFigure:END 
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3.18.9 Sets the RF connection between the switch matrix and VNA physical ports 

Command Format :SYSTem:EXTPort:SMATrix:CONFigure:TVNA 
<testport1>,<VNAport1>[,<testport2>,<VNAport2> […]] 

Instruction Set the connection between the VNA physical port and the RF output 
port of the matrix switch, that is, the RF output port of the matrix switch 
is directly assigned to the VNA physical port. 

Parameter Type <testport1>:Number of the RF output port of the matrix switch. 

<VNAport1>:Number of the VNA physical port. 

Return None  

Default None  

Menu None  

Example Switch Matrix’s RF Ports 1,2,3,4are assigned to VNA ports 1,2,3,4 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

:SYSTem:EXTPort:SMATrix:CONFigure:TVNA 1,1,2,2,3,3,4,4 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

3.18.10 Sets the RF connections between switch matrix and VNA 

Command Format :SYSTem:EXTPort:SMATrix<num>:CONFigure:MVNA 
{<matrixVNAport>,<VNAPort>} 

Instruction Sets the RF connections between switch matrix and VNA as a comma-
separated list of port numbers. 

Parameter Type <num>: switch matrix number 

<matrixVNAport>: Number of the RF output port of the matrix switch. 

<VNAPort>: Number of the VNA physical port. 

Return None 

Default None 

Menu None 
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Example #Enable the Ext Port function 

:SYSTem:EXTPort:STATe 1 

#Start a manual RF connection configuration 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

#Define non-default matrix-VNA port connections: matrix port 1 to 
VNA port 2, matrix port 2 to VNA port 4, matrix port 3 to VNA port 1 
and matrix port 4 to VNA port 3 

:SYSTem:EXTPort:SMATrix1:CONFigure:MVNA 1,2,2,4,3,1,4,3 

#Configure 4 matrix test ports only: matrix test port 1 is test port 1, 
matrix test port 7 is test port 2, matrix test port 11 is test port 3 and 
matrix test port 22 is test port 4. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MTESt 1,1,7,2,11,3,22,4 

#Apply the manual RF connection configuration. 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

3.18.11 Sets the matrix RF output port to VNA ports 

Command Format :SYSTem:EXTPort:SMATrix<num>:CONFigure:MTESt  

{<MatrixTestPort>,<Testport>} 

Instruction Sets the matrix test port connections as a comma-separated list of port 
numbers 

Parameter Type <num>: switch matrix number 

<MatrixTestPort>: Number of the RF output port of the matrix switch. 

<Testport>: Number of the VNA physical port. 

Return None 

Default None 

Menu None 

Example #Enable the Ext Port function 

:SYSTem:EXTPort:STATe 1 

#Start a manual RF connection configuration 

:SYSTem:EXTPort:SMATrix:CONFigure:STARt 

#Define non-default matrix-VNA port connections: matrix port 1 to 
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VNA port 2, matrix port 2 to VNA port 4, matrix port 3 to VNA port 1 
and matrix port 4 to VNA port 3 

:SYSTem:EXTPort:SMATrix1:CONFigure:MVNA 1,2,2,4,3,1,4,3 

#Configure 4 matrix test ports only: matrix test port 1 is test port 1, 
matrix test port 7 is test port 2, matrix test port 11 is test port 3 and 
matrix test port 22 is test port 4. 

:SYSTem:EXTPort:SMATrix1:CONFigure:MTESt 1,1,7,2,11,3,22,4 

#Apply the manual RF connection configuration. 

:SYSTem:EXTPort:SMATrix:CONFigure:END 

 

 

 

3.19 Pulse Measurement Commands (Option, SHN900A series models 

do not support) 

3.19.1 Command List 

Pulse Measurement Mode :SENSe<cnum>:SWEep:PULSe:MODE 

Pulse Width :SENSe<cnum>:SWEep:PULSe:PRIMary:WIDth 

Pulse Period :SENSe<cnum>:SWEep:PULSe:PRIMary:PERiod 

Pulse Frequency :SENSe<cnum>:SWEep:PULSe:PRIMary:FREQuency 

Pulse Delay :SENSe<cnum>:SWEep:PULSe:PRIMary:DELay 

Gain Mode of All Receivers :SENSe<cnum>:SWEep:PULse:GAIN:MODE 

Gain Mode of Specified Receiver :SENSe<cnum>:SWEep:PULse:RECeiver:GAIN:MODE 

Receiver’s Pulse Delay :SENSe<cnum>:PULSe:MEASurement:DELay 

Auto select Profile Sweep Time State :SENSe<cnum>:SWEep:PULSe:CWTime:[AUTO] 

Auto select Width and Delay State :SENSe<cnum>:SWEep:PULSe:TIMing:[AUTO] 

 

3.19.2 Pulse Measurement Mode 

Command Format :SENSe<cnum>:SWEep:PULSe:MODE <type> 
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:SENSe<cnum>:SWEep:PULSe:MODE? 

Instruction This command sets/gets the pulse measurement mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={OFF|STD|PROFile}, represents the pulse measurement 
mode. 

Return Enumeration 

Default OFF 

Menu Sweep > Pulse Setup > Pulse Measurement 

Example :SENS:SWE:PULS:MODE STD 

:SENS:SWE:PULS:MODE? 

Return: STD 

 

3.19.3 Pulse Width 

Command Format :SENSe<cnum>:SWEep:PULSe:PRIMary:WIDth <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:WIDth? 

Instruction This command sets/gets the pulse width of the source pulse. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: represents Pulse width in Second. The range is 1us to 
1000s. 

Return Float, in Second. 

Default 200us 

Menu Sweep > Pulse Setup > Pulse Timing > Pulse Width 

Example :SENS:SWE:PULS:PRIM:WID 0.0005 

:SENS:SWE:PULS:PRIM:WID? 

Return: 0.0005 
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3.19.4 Pulse Period 

Command Format :SENSe<cnum>:SWEep:PULSe:PRIMary:PERiod <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:PERiod? 

Instruction This command sets/gets the pulse period of the source pulse. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: represents Pulse width in Second. The range is 1us to 
1000s. 

Return Float, in Second. 

Default 1ms 

Menu Sweep > Pulse Setup > Pulse Timing > Pulse Period 

Example :SENS:SWE:PULS:PRIM:PER 0.002 

:SENS:SWE:PULS:PRIM:PER? 

Return: 0.002 

 

3.19.5 Pulse Frequency 

Command Format :SENSe<cnum>:SWEep:PULSe:PRIMary:FREQuency <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:FREQuency? 

Instruction This command sets/gets the pulse frequency of the source pulse. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: represents Pulse frequency in Hz. The range is 1mHz to 
1MHz. 

Return Float, in Hz. 

Default 1kHz 

Menu Sweep > Pulse Setup > Pulse Timing > Pulse Frequency 

Example :SENS:SWE:PULS:PRIM:FREQ 100000 

:SENS:SWE:PULS:PRIM:FREQ? 
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Return: 100000 

 

3.19.6 Pulse Delay 

Command Format :SENSe<cnum>:SWEep:PULSe:PRIMary:DELay <numeric> 

:SENSe<cnum>:SWEep:PULSe:PRIMary:DELay? 

Instruction This command sets/gets the pulse delay of the source pulse. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: represents Pulse delay in Second. The range is 1us to 
1000s. 

Return Float, in Second. 

Default 200us 

Menu Sweep > Pulse Setup > Pulse Timing > Pulse Delay 

Example :SENS:SWE:PULS:PRIM:DEL 0.0004 

:SENS:SWE:PULS:PRIM:DEL? 

Return: 0.0004 

 

3.19.7 Gain Mode of All Receivers 

Command Format :SENSe<cnum>:SWEep:PULse:GAIN:MODE <type> 

Instruction This command sets the gain mode of all receivers. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={LOW|MEDIum|HIGH}, represents the gain mode of receivers. 

Return None 

Default None 

Menu Sweep > Pulse Setup > Properties > Setting… 

Example :SENS:SWE:PUL:GAIN:MODE HIGH 
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3.19.8 Gain Mode of Specified Receiver 

Command Format :SENSe<cnum>:SWEep:PULSe:RECeiver:GAIN:MODE 
<type1>,<type2> 

:SENSe<cnum>:SWEep:PULSe:RECeiver:GAIN:MODE? <type1> 

Instruction This command sets the gain mode of a specified receivers. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type1>:={A|B|C|D|R1|R2|R3|R4}, represents receiver. 

<type2>:={LOW|MEDIum|HIGH}, represents the gain mode of 
receivers. 

Return Enumeration 

Default LOW 

Menu Sweep > Pulse Setup > Properties > Setting… 

Example :SENS:SWEep:PULse:RECeiver:ATTen:MODE A,HIGH 

:SENS:SWEep:PULse:RECeiver:ATTen:MODE?  A 

Return: HIGH 

3.19.9 Receiver’s Pulse Delay 

Command Format :SENSe<cnum>:PULSe:MEASurement:DELay <numeric> 

:SENSe<cnum>:PULSe:MEASurement:DELay? 

Instruction This command sets/gets the pulse delay of the receiver. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents Receiver’s pulse delay in Second. The range is 
1us to 1000s. 

Return Float, in Second. 

Default 309us 

Menu Sweep > Pulse Setup > Measurement Timing > Measurement Delay 
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Example :SENS:PULSe:MEASurement:DELay 0.0004 

:SENS:PULSe:MEASurement:DELay? 

Return: 0.0004 

 

3.19.10 Auto select Profile Sweep Time State 

Command Format :SENSe<cnum>:SWEep:PULSe:CWTime:[AUTO] <bool> 

:SENSe<cnum>:SWEep:PULSe:CWTime:[AUTO]? 

Instruction This command sets/gets whether to check the autoselect profile 
sweep time option. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > Pulse Setup > Properties > Autoselect Profile Sweep Time 

Example :SENS:SWE:PULS:CWT 1 

:SENS:SWE:PULS:CWT? 

Return: 1 

 

3.19.11 Auto select Width and Delay State 

Command Format :SENSe<cnum>:SWEep:PULSe:TIMing:[AUTO] <bool> 

:SENSe<cnum>:SWEep:PULSe:TIMing:[AUTO]? 

Instruction This command sets/gets whether to check the autoselect width and 
delay option. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 
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Default OFF 

Menu Sweep > Pulse Setup > Measurement Timing > Autoselect Width and 
Delay 

Example :SENS:SWE:PULS:CWT 1 

:SENS:SWE:PULS:CWT? 

Return: 1 

 

3.20 Spectrum Analyzer Commands(Option) 

3.20.1 Swept SA 

3.20.1.1 Command List 

Active SA :CALCulate<cnum>:CUSTom:DEFine 

SA measure mode :CALCulate<cnum>:TRACe<tnum>:SA:MEASure 

Resolution Bandwidth :SENSe<cnum>:SA:BANDwidth[:RESolution] 

RBW Mode :SENSe<cnum>:SA:BANDwidth[:RESolution]:AUTO 

Video Bandwidth :SENSe<cnum>:SA:BANDwidth:VIDeo 

VBW Mode :SENSe<cnum>:SA:BANDwidth:VIDeo:AUTO 

RBW/VBW Ratio :SENSe<cnum>:SA:BANDwidth:VIDeo:RATio 

Span/RBW Ratio :SENSe<cnum>:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio 

Averaging Type :SENSe<cnum>:SA:BANDwidth:VIDeo:AVER:TYPE 

Image Reject Type :SENSe<cnum>:SA:IMAGe:REJect 

Detection type :SENSe<cnum>:TRACe<tnum>:SA:DETector[:FUNCtion] 

Auto detector mode :SENSe<cnum>:TRACe<tnum>:SA:DETector:AUTO 

SA trace type :SENSe<cnum>:TRACe<tnum>:SA:TYPE 

SA Trace display status :SENSe<cnum>:TRACe<tnum>:SA:DISPlay[:STATe] 

SA trace average count :SENSe<cnum>:TRACe<tnum>:SA:AVERage:COUNt 

SA trace calculate type :CALCulate<cnum> [:SELected]:SA:MATH:FUNCtion 

Input X trace calculate :CALCulate<cnum> [:SELected]:SA:MATH:X 

Input Y trace calculate :CALCulate<cnum> [:SELected]:SA:MATH:Y 
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Log offset of trace 
calculate 

:CALCulate<cnum> [:SELected]:SA:MATH:OFFSet 

Reference level for log 
subtract 

:CALCulate<cnum> [:SELected]:SA:MATH:REFerence 

Enable state for correction :SENSe<cnum> [:SELected]:SA:CORRections [:STATe] 

Enable state for sub 
correction 

:SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>.[:STATe] 

Add correction items :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:ADD<freq> 

Delete the correction item :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:POINt:DELete 

Delete all the correction 
items 

:SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:DELete 

 

3.20.1.2 Active SA 

Command Format :CALCulate<cnum>:CUSTom:DEFine <string> 

Instruction This command activate the SA function of selecting channel trace and 
its measurement item 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<string>:= "SA"|"spectrum analyzer" 

Return String 

Default "SA" 

Menu Meas > Mode > Spectrum Analyzer 

Example :CALCulate1:CUSTom:DEFine "SA" 

 

3.20.1.3 SA measure mode 

Command Format :CALCulate<cnum>[:SELected]:SA:MEASure <type> 

:CALCulate<cnum>[:SELected]:SA:MEASure? 

:CALCulate<cnum>:TRACe<tnum>:SA:MEASure <type> 

:CALCulate<cnum>:TRACe<tnum>:SA:MEASure? 
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Instruction Set or get SA measure mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={SA|CHPower|ACPR|OBW|TOI} 

SA:Spectrum Analyzer 

ACPR:ACPR 

CHPower:Channel Power 

OBW:Occupied BW 

TOI: Third-order Intercept Point 

Return Enumeration 

Default SA 

Menu Meas > Mode > SA > Meas 

Example :CALCulate1:SELected:SA:MEASure OBW 

:CALCulate1:SELected:SA:MEASure? 

Return:OBW 

 

:CALCulate1:TRACe1:SA:MEASure ACPR 

:CALCulate1:TRACe1:SA:MEASure? 

Return:ACPR 

 

3.20.1.4 Resolution Bandwidth 

Command Format :SENSe<cnum>:SA:BANDwidth[:RESolution] <numeric> 

:SENSe<cnum>:SA:BANDwidth[:RESolution]? 

Instruction This command set/reads the Resolution Bandwidth value. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the Resolution Bandwidth value, and the 
parameter range: 10~1000000. 
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Return Integer, unit: Hz 

Default 1MHz 

Menu Avg BW > BW > RBW 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:RESolution 3000 

:SENSe1:SA:BANDwidth:RESolution? 

Return: 3000 

 

3.20.1.5 RBW Mode 

Command Format :SENSe<cnum>:SA:BANDwidth[:RESolution]:AUTO <bool> 

:SENSe<cnum>:SA:BANDwidth[:RESolution]:AUTO? 

Instruction Sets / reads the mode of the resolution bandwidth. When ON, the 
resolution bandwidth is set based on Span/RBW ratio. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Avg BW > BW > RBW Mode 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:RESolution:AUTO 0 

:SENSe1:SA:BANDwidth:RESolution:AUTO? 

Return: 0 

 

3.20.1.6 Video Bandwidth 

Command Format :SENSe<cnum>:SA:BANDwidth:VIDeo <numeric> 

:SENSe<cnum>:SA:BANDwidth:VIDeo? 
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Instruction This command set/reads the Video Bandwidth value. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the Video Bandwidth value, and the parameter 
range: 10~1000000. 

Return Integer, unit: Hz 

Default 1MHz 

Menu Avg BW > BW > VBW 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo 10000 

:SENSe1:SA:BANDwidth:VIDeo? 

Return: 10000 

 

3.20.1.7 VBW Mode 

Command Format :SENSe<cnum>:SA:BANDwidth:VIDeo:AUTO <bool> 

:SENSe<cnum>:SA:BANDwidth:VIDeo:AUTO? 

Instruction Sets / reads the mode of the Video bandwidth. When ON, the 
resolution bandwidth is set based on RBW/VBW ratio. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Avg BW > BW > RBW Mode 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:AUTO 0 

:SENSe1:SA:BANDwidth:VIDeo:AUTO? 

Return: 0 
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3.20.1.8 RBW/VBW Ratio 

Command Format :SENSe<cnum>:SA:BANDwidth:VIDeo:RATio <numeric> 

:SENSe<cnum>:SA:BANDwidth:VIDeo:RATio? 

Instruction Sets / reads the RBW/VBW ratio. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the RBW/VBW ratio, and the parameter range: 
0.001~1000. 

Return Float 

Default 1 

Menu Avg BW > BW > RBW/VBW 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:RATio 0.3 

:SENSe1:SA:BANDwidth:VIDeo:RATio? 

Return: 0.3 

 

3.20.1.9 Span/RBW Ratio 

Command Format :SENSe<cnum>:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio 
<numeric> 

:SENSe<cnum>:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio? 

Instruction Sets / reads the Span/RBW ratio. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the Span/RBW ratio, and the parameter range: 
0.001~1000. 

Return Integer 

Default 1 

Menu Avg BW > BW > Span/RBW 

Example :CALCulate1:CUSTom:DEFine "SA" 
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:SENSe1:SA:BANDwidth:VIDeo:RATio 10 

:SENSe1:SA:BANDwidth:VIDeo:RATio? 

 

Return: 10 

 

3.20.1.10 Averaging Type 

Command Format :SENSe<cnum>:SA:BANDwidth:VIDeo:AVER:TYPE <type> 

:SENSe<cnum>:SA:BANDwidth:VIDeo:AVER:TYPE? 

Instruction Sets / reads the type of the Averaging. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={Log|Power|Voltage} 

Return Enumeration 

Default LOG 

Menu Avg BW > BW > Avg Type 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:BANDwidth:VIDeo:AVER:TYPE Voltage 

:SENSe1:SA:BANDwidth:VIDeo:AVER:TYPE? 

Return: VOLT 

 

3.20.1.11 Image Reject Type 

Command Format :SENSe<cnum>:SA:IMAGe:REJect <type> 

:SENSe<cnum>:SA:IMAGe:REJect? 

Instruction Sets / reads the type of the image reject. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={None|Min|Normal|Better|Max} 

Return Enumeration 
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Default Normal 

Menu Sweep > SA Setup… > Advanced > Image Reject 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:IMAGe:REJect Max 

:SENSe1:SA:IMAGe:REJect? 

Return: MAX 

 

3.20.1.12 Detection type 

Command Format :SENSe<cnum>[:SELected]:SA:DETector[:FUNCtion] <type> 

:SENSe<cnum>[:SELected]:SA:DETector[:FUNCtion]? 

:SENSe<cnum>:TRACe<tnum>:SA:DETector[:FUNCtion] <type> 

:SENSe<cnum>:TRACe<tnum>:SA:DETector[:FUNCtion]? 

Instruction Sets or gets the detection type of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={NEGative|POSitive|SAMPle|AVERage|NORMAL} 

Return Enumeration 

Default NORMAL 

Menu Math > Trace > Detector 

Example :SENSe1:SELected:SA:DETector:FUNCtion POS 

:SENSe1:SELected:SA:DETector:FUNCtion? 

Return :POS 

 

:SENSe:TRACe1:SA:DETector:FUNCtion AVER 

:SENSe1:TRACe1:SA:DETector:FUNCtion? 
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3.20.1.13 Auto detector mode 

Command Format :SENSe<cnum>[:SELected]:SA:DETector:AUTO <bool> 

:SENSe<cnum>[:SELected]:SA:DETector:AUTO? 

:SENSe<cnum>:TRACe<tnum>:SA:DETector:AUTO <bool> 

:SENSe<cnum>:TRACe<tnum>:SA:DETector:AUTO? 

Instruction Turn on or off the automatic detection mode of selected channels and 
traces, or read the switch status of the automatic detection mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Bool 

Default 1 

Menu Math > Trace > Auto Detector 

Example :SENSe1:SELected:SA:DETector:AUTO 1 

:SENSe1:SELected:SA:DETector:AUTO? 

Return :1 

:SENSe1:TRACe1:SA:DETector:AUTO 0 

:SENSe1:TRACe1:SA:DETector:AUTO? 

Return: 0 

 

3.20.1.14 SA trace type 

Command Format :SENSe<cnum>[:SELected]:SA:TYPE <type> 

:SENSe<cnum>[:SELected]:SA:TYPE? 

:SENSe<cnum>:TRACe<tnum>:SA:TYPE <type> 

:SENSe<cnum>:TRACe<tnum>:SA:TYPE? 

Instruction Sets or gets the display mode for the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={WRITe|MAXHold|MINHold|AVERage} 

WRITe :puts the trace in the normal mode, updating the data. 

MAXHold : displays the highest measured trace value for all the data 
that has been measured since the function was turned on. 

MINHold: displays the lowest measured trace value for all the data that 
has been measured since the function was turned on. 

AVERage: averages the trace for test period. 

Return Enumeration 

Default WRITe 

Menu Math > Trace > Trace Type 

Example :SENSe1:SELected:SA:TYPE MAXHold 

:SENSe1:SELected:SA:TYPE? 

Return :MAXH 

 

:SENSe1:TRACe1:SA:TYPE MINHold 

:SENSe1:TRACe1:SA:TYPE? 

Return : MINH 

 

3.20.1.15 SA Trace display status 

Command Format :SENSe<cnum>[:SELected]:SA:DISPlay[:STATe] <type> 

:SENSe<cnum>[:SELected]:SA:DISPlay[:STATe]? 

:SENSe<cnum>:TRACe<tnum>:SA:DISPlay[:STATe] <type> 

:SENSe<cnum>:TRACe<tnum>:SA:DISPlay[:STATe]? 

Instruction Sets or gets the display status of the selection channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1.  
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<type>:={ACTI|VIEW|BLAN|BACK} 

ACTI : Trace is normal mode, update data 

VIEW: turns on the trace data so that it can be viewed on the display. 

BLAN : turns off the trace data so that it is not viewed on the display. 

BACK: turns off the display of the trace data. 

Return Enumeration 

Default ACTI 

Menu Math > Trace > State 

Example :SENSe1:SELected:SA:DISPlay:STATe VIEW 

:SENSe1:SELected:SA:DISPlay:STATe? 

Return:VIEW 

 

:SENSe1:TRACe1:SA:DISPlay:STATe ACTI 

:SENSe1:TRACe1:SA:DISPlay:STATe? 

Return:ACTI 

 

3.20.1.16 SA trace average count 

Command Format :SENSe<cnum>[:SELected]:SA:AVERage:COUNt <numeric> 

:SENSe<cnum>[:SELected]:SA:AVERage:COUNt? 

:SENSe<cnum>:TRACe<tnum>:SA:AVERage:COUNt <numeric> 

:SENSe<cnum>:TRACe<tnum>:SA:AVERage:COUNt? 

Instruction Sets or gets the average number of select channels and traces. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the average number, and the parameter range: 
1~1000. 

Return Int  

Default 16 
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Menu Math > Trace > Average Count 

Example :SENSe1:SELected:SA:AVERage:COUNt 32 

:SENSe1:SELected:SA:AVERage:COUNt? 

Return :32 

 

:SENSe1TRACe1:SA:AVERage:COUNt 128 

:SENSe1:TRACe1:SA:AVERage:COUNt? 

Return :128 

 

3.20.1.17 SA trace calculate type 

Command Format :CALCulate<cnum> [:SELected]:SA:MATH:FUNCtion <math_type> 

:CALCulate<cnum> [:SELected]:SA:MATH:FUNCtion? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:FUNCtion <math type> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:FUNCtion 

Instruction Set the calculate type of trace in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<math type>:={OFF|PDIF|PSUM|LOFF|LDIF}. 

OFF: Turn Off 

PDIF: Power Subtract 

PSUM: Power SUM 

LDIF: Log Subtract 

LOFF: Log Offset 

Return Enum 

Default OFF 

Menu Math > Calculate > Math 

Example :CALCulate1:SELected:SA:MATH:FUNCtion LOFF 

:CALCulate1:SELected:SA:MATH:FUNCtion? 
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Return :LOFF 

 

:CALCulate1:TRACe1:SA:MATH:FUNCtion PSUM 

:CALCulate1:TRACe1:SA:MATH:FUNCtion? 

Return:PSUM 

 

3.20.1.18 Input X trace calculate 

Command Format :CALCulate<cnum> [:SELected]:SA:MATH:X <xnum> 

:CALCulate<cnum> [:SELected]:SA:MATH:X? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:X <xnum> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:X? 

Instruction Set the input X trace for trace calculate in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<xnum>:={[0]-256},represents the math calculate input X trace. 

Return Integer 

Default 0 

Menu Math > Calculate > Select X 

Example :CALCulate1:SELected:SA:MATH:X 3 

:CALCulate1:SELected:SA:MATH:X? 

Return :3 

 

:CALCulate1:TRACe1:SA:MATH:X 2 

:CALCulate1:TRACe1:SA:MATH:X? 

Return:2 
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3.20.1.19 Input Y trace calculate 

Command Format :CALCulate<cnum> [:SELected]:SA:MATH:Y <ynum> 

:CALCulate<cnum> [:SELected]:SA:MATH:Y? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:Y <ynum> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:Y? 

Instruction Set the input Y trace for trace calculate in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<xnum>:={[0]-256},represents the math calculate input Y trace. 

Return Integer 

Default 0 

Menu Math > Calculate > Select Y 

Example :CALCulate1:SELected:SA:MATH:Y 3 

:CALCulate1:SELected:SA:MATH:Y? 

Return :3 

 

:CALCulate1:TRACe1:SA:MATH:Y 2 

:CALCulate1:TRACe1:SA:MATH:Y? 

Return:2 

 

3.20.1.20 Log offset of trace calculate 

Command Format :CALCulate<cnum> [:SELected]:SA:MATH:OFFSet <offset> 

:CALCulate<cnum> [:SELected]:SA:MATH:OFFSet? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:OFFSet < offset > 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:OFFSet? 
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Instruction Set the log offset of trace calculate in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<offset>:=[-100,100],represents the trace log offset. 

Return Float 

Default 0 

Menu Math > Calculate > offset 

Example :CALCulate1:SELected:SA:MATH:OFFSet 50 

:CALCulate1:SELected:SA:MATH:OFFSet? 

Return :50 

 

:CALCulate1:TRACe1:SA:MATH:OFFSet 53.4 

:CALCulate1:TRACe1:SA:MATH:OFFSet? 

Return:53.4 

 

3.20.1.21 Reference level for log subtract 

Command Format :CALCulate<cnum> [:SELected]:SA:MATH:REFerence <ref> 

:CALCulate<cnum> [:SELected]:SA:MATH:REFerence? 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:REFerence < ref> 

:CALCulate<cnum>:TRACe<tnum>:SA:MATH:REFerence? 

Instruction Set the reference level for logarithmic subtraction of trace operations 
in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<offset>:=[-100,100],represents the reference level for log subtract. 

Return Float 
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Default 0 

Menu Math > Calculate > ref 

Example :CALCulate1:SELected:SA:MATH:REFerence 100 

:CALCulate1:SELected:SA:MATH:REFerence? 

Return :100 

 

:CALCulate1:TRACe1:SA:MATH:REFerence 20.5 

:CALCulate1:TRACe1:SA:MATH:REFerence? 

Return:20.5 

 

3.20.1.22 Enable state for correction 

Command Format :SENSe<cnum> [:SELected]:SA:CORRections [:STATe] <enable> 

:SENSe<cnum> [:SELected]:SA:CORRections [:STATe]? 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections [:STATe] < enable > 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections [:STATe]? 

Instruction Set enable state for correction function in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<enable>:= ON|OFF|1|0. 

Return Boolean (1=ON,0=OFF) 

Default 0 

Menu Scale > Corrections > Corrections Enable 

Example :SENSe1:SELected:SA:CORRections:STATe ON 

:SENSe1:SELected:SA:CORRections:STATe? 

Return :1 

 

:SENSe1:TRACe1:SA:CORRections:STATe OFF 
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:SENSe1:TRACe1:SA:CORRections:STATe? 

Return:0 

 

3.20.1.23 Enable state for sub correction 

Command Format :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>.[:STATe] <enable> 

:SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum> [:STATe]? 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum> [:STATe] <enable> 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum> [:STATe]? 

Instruction Set enable state for sub correction function in SA mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<rnum>:={[1]-6}, represents the selected sub correction. 

<enable>:= ON|OFF|1|0. 

Return Boolean (1=ON,0=OFF) 

Default 0 

Menu Scale > Corrections > Corr Enable 

Example :SENSe1:SELected:SA:CORRections:CSET1:STATe ON 

:SENSe1:SELected:SA:CORRections:CSET1:STATe? 

Return :1 

 

:SENSe1:TRACe1:SA:CORRections:CSET1:STATe OFF 

:SENSe1:TRACe1:SA:CORRections:CSET1:STATe? 

Return:0 
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3.20.1.24 Add correction items 

Command Format :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:ADD<freq> <value> 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum>:ADD<freq> <value> 

Instruction Add correction items to the sub correction table. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<rnum>:={[1]-6}, represents the selected sub correction. 

<freq>: set frequency value. 

<value>: set correction value. 

Return None. 

Default None. 

Menu Scale > Corrections > Edit Correction 

Example :SENSe1:SELected:SA:CORRections:CSET1:ADD 9000000,10 

:SENSe1:TRACe1:SA:CORRections:CSET1:ADD 90000,10 

 

3.20.1.25 Delete the correction item 

Command Format :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:POINt:DELete <point> 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum>:POINt:DELete <point> 

Instruction Delete the correction items in the sub correction. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<rnum>:={[1]-6}, represents the selected sub correction. 

<point>: represents the correction item, start from 0. 

Return None. 

Default None. 
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Menu Scale > Corrections > Edit Correction 

Example :SENSe1:SELected:SA:CORRections:CSET1:POINt:DELete 3 

:SENSe1:TRACe1:SA:CORRections:CSET1:POINt:DELete 2 

 

3.20.1.26 Delete all the correction items 

Command Format :SENSe<cnum> [:SELected]:SA:CORRections:CSET<rnum>:DELete 

:SENSe<cnum>:TRACe<tnum>:SA:CORRections:CSET<rnum>:DELete 

Instruction Delete all the correction items in the sub correction. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<rnum>:={[1]-6}, represents the selected sub correction. 

Return None. 

Default None. 

Menu Scale > Corrections > Edit Correction 

Example :SENSe1:SELected:SA:CORRections:CSET1:DELete 

:SENSe1:TRACe1:SA:CORRections:CSET1:DELete 

 

 

3.20.2 Channel Power 

3.20.2.1 Command List 

The integration BW :CALCulate<cnum>:TRACe<tnum>:SA:CHPower:BWIDth:INTegration 

The span power of the 
channel power 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:FREQuency:SPAN:POWer 

Main channel power and 
power density 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower? 
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Main channel power :CALCulate<cnum>:TRACe<tnum>:SA:CHPower:CHPower? 

Main channel power 
density 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:DENSity? 

 

3.20.2.2 The integration BW 

Command Format :CALCulate<cnum>[:SELected]:SA:CHPower:BWIDth:INTegration 
<numeric> 

:CALCulate<cnum>[:SELected]:SA:CHPower:BWIDth:INTegration? 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:BWIDth:INTegratio
n <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:BWIDth:INTegratio
n? 

Instruction Sets or gets the integral bandwidth of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the integral bandwidth, and the parameter 
range: 0 Hz to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 2MHz 

Menu Meas > Channel Power > Meas Setup > Integration BW 

Example :CALCulate1:SELected:SA:CHPower:BWIDth:INTegration 1e9 

:CALCulate1:SELected:SA:CHPower:BWIDth:INTegration? 

Return:1000000000 

 

:CALCulate1:TRACe1:SA:CHPower:BWIDth:INTegration 2e9 

:CALCulate1:TRACe1:SA:CHPower:BWIDth:INTegration? 

Return:2000000000 
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3.20.2.3 The span power of the channel power 

Command Format :CALCulate<cnum>[:SELected]:SA:CHPower:FREQuency:SPAN:POW
er 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:FREQuency:SPAN:
POWer 

Instruction Sets the analyzer span of the selected channel and trace for the channel 
power measurement. Be sure the span is set larger than the integration 
bandwidth. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu Meas > Channel Power > Meas Setup > Span Power 

Example :CALCulate1:SELected:SA:CHPower:FREQuency:SPAN:POWer 

 

:CALCulate1:TRACe1:SA:CHPower:FREQuency:SPAN:POWer 

 

3.20.2.4 Main channel power and power density 

Command Format :CALCulate<cnum>[:SELected]:SA:CHPower? 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower? 

Instruction Gets scalar results of main channel power and power density of the 
selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, Channel Power unit: dBm 

Float, Density unit: dBm/Hz 
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Default None 

Menu Meas > Channel Power 

Example :CALCulate1:SELected:SA:CHPower? 

Return: -32.3329235931259,-125.343223549766 

 

:CALCulate1:TRACe1:SA:CHPower? 

Return: -32.3329235931259,-125.343223549766 

 

3.20.2.5 Main channel power 

Command Format :CALCulate<cnum>[:SELected]:SA:CHPower:CHPower? 

:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:CHPower? 

Instruction Gets scalar results of main channel power of the selected channel and 
trace 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, Channel Power unit: dBm 

Default None 

Menu Meas > Channel Power 

Example :CALCulate1:SELected:SA:CHPower:CHPower? 

Return: -32.0712381021238 

 

:CALCulate1:TRACe1:SA:CHPower:CHPower? 

Return: -32.0712381021238 

 

3.20.2.6 Main channel power density 

Command Format :CALCulate<cnum>[:SELected]:SA:CHPower:DENSity? 
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:CALCulate<cnum>:TRACe<tnum>:SA:CHPower:DENSity? 

Instruction Gets scalar results of main channel power density of the selected 
channel and trace 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, Density unit: dBm/Hz 

Default None 

Menu Meas > Channel Power 

Example :CALCulate1:SELected:SA:CHPower:DENSity? 

Return: -125.096780027723 

 

:CALCulate1:TRACe1:SA:CHPower:DENSity? 

Return: -125.096780027723 

 

3.20.3 ACPR 

3.20.3.1 Command List 

ACPR main channel 
bandwidth 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:BWIDth:INTegration 

ACPR Adjacent channel 
bw 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet:BWIDth[:INTegration
] 

ACPR Adjacent channel 
space 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet[:FREQuency] 

ACPR main channel power :CALCulate<cnum>[:SELected]:SA:ACPRatio:MAIN? 

ACPR lower adjacent 
channel power ratio 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer? 

ACPR lower adjacent 
channel power 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer:POWer? 

ACPR upper adjacent 
channel power ratio 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer? 
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ACPR upper adjacent 
channel power 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer:POWer? 

 

3.20.3.2 ACPR main channel bandwidth 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:BWIDth:INTegration 
<numeric> 

:CALCulate<cnum>[:SELected]:SA:ACPRatio:BWIDth:INTegration? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:BWIDth:INTegratio
n <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:BWIDth:INTegratio
n? 

Instruction Sets or gets the main channel bandwidth measured by ACPR for the 
selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the main channel bandwidth, and the 
parameter range: 0 Hz to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 1MHz 

Menu Meas > ACPR > Meas Setup > Main Channel 

Example :CALCulate1:SELected:SA:ACPRatio:BWIDth:INTegration 1e9 

:CALCulate1:SELected:SA:ACPRatio:BWIDth:INTegration? 

Return: 1000000000 

 

:CALCulate1:TRACe1:SA:ACPRatio:BWIDth:INTegration 2e9 

:CALCulate1:TRACe1:SA:ACPRatio:BWIDth:INTegration? 

Return: 2000000000 
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3.20.3.3 ACPR Adjacent channel bw 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet:BWIDth[:INTegr
ation] <numeric> 

:CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet:BWIDth[:INTegr
ation]? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet:BWIDth[:IN
Tegration] <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet:BWIDth[:IN
Tegration]? 

Instruction Sets or gets the selected channel and trace's Adjacent channel 
bandwidth of ACPR measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the Adjacent channel bandwidth, and the 
parameter range: 0 Hz to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 1MHz 

Menu Meas > ACPR > Meas Setup > Adjacent Chn 

Example :CALCulate1:SELected:SA:ACPRatio:OFFSet:BWIDth:INTegration 5e6 

:CALCulate1:SELected:SA:ACPRatio:OFFSet:BWIDth:INTegration? 

Return :5000000 

 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:BWIDth:INTegration 3e6 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:BWIDth:INTegration? 

Return :3000000 

 

3.20.3.4 ACPR Adjacent channel space 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet[:FREQuency] 
<numeric> 
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:CALCulate<cnum>[:SELected]:SA:ACPRatio:OFFSet[:FREQuency] 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet[:FREQuenc
y] <numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:OFFSet[:FREQuenc
y]? 

Instruction Sets or gets the selected channel and trace's Adjacent channel space 
of ACPR measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the Adjacent channel space, and the parameter 
range: 0 Hz to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 3MHz 

Menu Meas > ACPR > Meas Setup > Adj Chn Space 

Example :CALCulate1:SELected:SA:ACPRatio:OFFSet:FREQuency 2e6 

:CALCulate1:SELected:SA:ACPRatio:OFFSet:FREQuency? 

Return: 2000000 

 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:FREQuency 1e6 

:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:FREQuency? 

Return: 1000000 

 

3.20.3.5 ACPR main channel power 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:MAIN? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:MAIN? 

Instruction Gets the selected channel and trace's main channel power of ACPR 
measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 
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<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: dBm 

Default None 

Menu Meas > ACPR 

Example :CALCulate1:SELected:SA:ACPRatio:MAIN? 

Return : -66.460503383216 

 

:CALCulate1:TRACe1:SA:ACPRatio:MAIN? 

Return : -64.8677896852216 

 

3.20.3.6 ACPR lower adjacent channel power ratio 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:LOWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer? 

Instruction Gets the selected channel and trace's lower adjacent channel power 
ratio of ACPR measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: dBc 

Default None  

Menu Meas > ACPR 

Example :CALCulate1:SELected:SA:ACPRatio:LOWer? 

Return : -20.6055355636683 

 

:CALCulate1:TRACe1:SA:ACPRatio:LOWer? 

Return : -21.1571905607897 
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3.20.3.7 ACPR lower adjacent channel power 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:LOWer:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:LOWer:POWer? 

Instruction Gets the selected channel and trace's lower adjacent channel power of 
ACPR measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: dBm 

Default None  

Menu Meas > ACPR 

Example :CALCulate1:SELected:SA:ACPRatio:LOWer:POWer? 

Return : -46.0127403678039 

:CALCulate1:TRACe1:SA:ACPRatio:LOWer:POWer? 

Return : -46.8181475071255 

 

3.20.3.8 ACPR upper adjacent channel power ratio 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:UPPer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer? 

Instruction Gets the selected channel and trace's upper adjacent channel power 
ratio of ACPR measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: dBc 

Default None  

Menu Meas > ACPR 
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Example :CALCulate1:SELected:SA:ACPRatio:UPPer? 

Return : -18.6108514488295 

:CALCulate1:TRACe1:SA:ACPRatio:UPPer? 

Return : -21.3324563909162 

 

3.20.3.9 ACPR upper adjacent channel power 

Command Format :CALCulate<cnum>[:SELected]:SA:ACPRatio:UPPer:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:ACPRatio:UPPer:POWer? 

Instruction Gets the selected channel and trace's upper adjacent channel power of 
ACPR measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: dBm 

Default None  

Menu Meas > ACPR 

Example :CALCulate1:SELected:SA:ACPRatio:UPPer:POWer? 

Return : -45.5211570718928 

 

:CALCulate1:TRACe1:SA:ACPRatio:UPPer:POWer? 

Return: -45.9642491121815 

 

3.20.4 Occupied BW 

3.20.4.1 Command List 

OBW percentage of signal 
power 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:PERCent 

OBW bandwidth and bandwidth :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth? 
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centroid 

OBW bandwidth :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:OBWidth? 

OBW bandwidth centroid :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:CENTroid? 

OBW Transmit Freq Error :CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:FERRor? 

 

3.20.4.2 OBW percentage of signal power 

Command Format :CALCulate<cnum>[:SELected]:SA:OBWidth:PERCent <numeric> 

:CALCulate<cnum>[:SELected]:SA:OBWidth:PERCent? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:PERCent 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:PERCent? 

Instruction Sets or gets the selected channel and trace's percentage of signal 
power of OBW measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the percentage of signal power, and the 
parameter range: 10~100. 

Return Float  

Default 99 

Menu Meas > Occupied BW > Meas Setup > Occ BW Percent 

Example :CALCulate1:SELected:SA:OBWidth:PERCent 60 

:CALCulate1:SELected:SA:OBWidth:PERCent? 

Return :60 

 

:CALCulate1:TRACe1:SA:OBWidth:PERCent 30 

:CALCulate1:TRACe1:SA:OBWidth:PERCent? 

Return :30 
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3.20.4.3 OBW bandwidth and bandwidth centroid 

Command Format :CALCulate<cnum>[:SELected]:SA:OBWidth? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth? 

Instruction Gets the selected channel and trace's occupied bandwidth and 
bandwidth centroid of OBW measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1.  

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: Hz 

Default None 

Menu Meas > Occupied BW 

Example :CALCulate1:SELected:SA:OBWidth? 

Return : 28580644.0096836,4249777822.00484 

 

:CALCulate1:TRACe1:SA:OBWidth? 

Return : 26997375.076252,4255988812.46187 

 

3.20.4.4 OBW bandwidth 

Command Format :CALCulate<cnum>[:SELected]:SA:OBWidth:OBWidth? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:OBWidth? 

Instruction Gets the selected channel and trace's occupied bandwidth of OBW 
measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: Hz 

Default None 
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Menu Meas > Occupied BW 

Example :CALCulate1:SELected:SA:OBWidth:OBWidth? 

Return : 26715503.1180305 

 

:CALCulate1:TRACe1:SA:OBWidth:OBWidth? 

Return : 26997375.076252 

 

3.20.4.5 OBW bandwidth centroid 

Command Format :CALCulate<cnum>[:SELected]:SA:OBWidth:CENTroid? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:CENTroid? 

Instruction Gets the selected channel and trace's occupied bandwidth centroid of 
OBW measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1.  

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: Hz 

Default None 

Menu Meas > Occupied BW 

Example :CALCulate1:SELected:SA:OBWidth:CENTroid? 

Return : 4241182953.86024 

 

:CALCulate1:TRACe1:SA:OBWidth:CENTroid? 

Return: 4252382501.60254 

 

3.20.4.6 OBW Transmit Freq Error 

Command Format :CALCulate<cnum>[:SELected]:SA:OBWidth:FERRor? 

:CALCulate<cnum>:TRACe<tnum>:SA:OBWidth:FERRor? 
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Instruction Gets the selected channel and trace's transmit frequency error of OBW 
measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: Hz 

Default None 

Menu Meas > Occupied BW 

Example :CALCulate1:SELected:SA:OBWidth:FERRor? 

Return : 4223880936.89468 

 

:CALCulate1:TRACe1:SA:OBWidth:FERRor? 

Return : -46483.4618330002 

 

3.20.5 TOI 

3.20.5.1 Command List 

Read the measurement results of TOI :CALCulate<cnum>:TRACe<tnum>:SA:TOI? 

Read the smaller value of TOI :CALCulate<tnum>:TRACe<tnum>:SA:TOI:IP3? 

 

3.20.5.2 Read the measurement results of TOI 

Command Format :CALCulate<cnum> [:SELected]:SA:TOI? 

:CALCulate<cnum>:TRACe<tnum>:SA:TOI? 

Instruction Read the measurement results of third-order intermodulation 
distortion 

Returns the following values separated by commas in scientific count 
form: 

Lower Tone frequency (Hz), amplitude, Upper Tone frequency (Hz), 
amplitude, 
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TOI(Lower 3rd) frequency (Hz), amplitude, third-order intermodulation 
cutoff 

(Intercept), High frequency TOI(Upper 3rd) frequency (Hz), amplitude, 
third-order 

intermodulation cut-off point (Intercept) 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float  

Default None 

Menu Meas > Meas >TOI 

Example :CALCulate1:TRACe1:SA:TOI? 

 

3.20.5.3 Read the smaller value of TOI 

Command Format :CALCulate<tnum>[:SELected]:SA:TOI:IP3? 

:CALCulate<tnum>:TRACe<tnum>:SA:TOI:IP3? 

Instruction Read the smaller value in the third-order intermodulation cutoff 
(Intercept) of low 

frequency TOI(Lower 3rd) and high frequency TOI(Upper 3rd) 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float  

Default None 

Menu Meas > Meas >TOI 

Example :CALCulate1:SELected:SA:TOI:IP3? 

Return -78.2445026767116 
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3.20.6 CNR 

3.20.6.1 Command List 

CNR Carrier 
BandWidth 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:BWIDth 

CNR Noise BandWidth :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:BWIDth 

CNR Frequence Offset :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:OFFSet[:FREQuency] 

CNR Carrier Power :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:POWer? 

CNR Noise Power :CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:POWer? 

CNR Carrier Noise 
Ratio 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio? 

 

3.20.6.2 CNR Carrier BandWidth 

Command 
Format 

:CALCulate<cnum>[:SELected]:SA:CNRatio:CARRier:BWIDth <freq> 

:CALCulate<cnum>[:SELected]:SA:CNRatio:CARRier:BWIDth? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:BWIDth 
<freq> 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:BWIDth? 

Instruction Sets or gets the CNR carrier bandwidth of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<freq> :represents the carrier bandwidth, and the parameter range: 0 Hz 
to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 2MHz 

Menu Meas > Meas > CNR > Meas Setup > Carrier BandWidth 

Example :CALCulate1:SELected:SA:CNRatio:CARRier:BWIDth 1e6 

:CALCulate1:SELected:SA:CNRatio:CARRier:BWIDth? 
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Return: 1000000 

 

:CALCulate1:TRACe1:SA:CNRatio:CARRier:BWIDth 2e6 

:CALCulate1:TRACe1:SA:CNRatio:CARRier:BWIDth? 

Return: 2000000 

 

3.20.6.3 CNR Noise BandWidth 

Command Format :CALCulate<cnum>[:SELected]:SA:CNRatio:NOISe:BWIDth <freq> 

:CALCulate<cnum>[:SELected]:SA:CNRatio:NOISe:BWIDth? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:BWIDth 
<freq> 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:BWIDth? 

Instruction Sets or gets the CNR noise bandwidth of the selected channel and 
trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<freq>:represents the noise bandwidth, and the parameter range: 0 Hz 
to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 2MHz 

Menu Meas > Meas > CNR > Meas Setup > Noise BandWidth 

Example :CALCulate1:SELected:SA:CNRatio:NOISe:BWIDth 1e6 

:CALCulate1:SELected:SA:CNRatio:NOISe:BWIDth? 

Return: 1000000 

 

:CALCulate1:TRACe1:SA:CNRatio:NOISe:BWIDth 2e6 

:CALCulate1:TRACe1:SA:CNRatio:NOISe:BWIDth? 

Return: 2000000 
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3.20.6.4 CNR Frequence Offset 

Command Format :CALCulate<cnum>[:SELected]:SA:CNRatio:OFFSet[:FREQuency] 
<freq> 

:CALCulate<cnum>[:SELected]:SA:CNRatio:OFFSet[:FREQuency]? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:OFFSet[:FREQuency] 
<freq> 

:CALCulate<cnum>:TRACe<tnum>SA:CNRatio:OFFSet[:FREQuency]? 

Instruction Sets or gets the CNR frequency offset of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<freq>:represents the frequency offset value, and the parameter range: 
0 Hz to maximum frequency of the analyzer. 

Return Float, unit: Hz 

Default 3MHz 

Menu Meas > Meas > CNR > Meas Setup > Frequence Offset 

Example :CALCulate1:SELected:SA:CNRatio:OFFSet:FREQuency 1e6 

:CALCulate1:SELected:SA:CNRatio:OFFSet:FREQuency? 

Return: 1000000 

 

:CALCulate1:TRACe1:SA:CNRatio:OFFSet:FREQuency 2e6 

:CALCulate1:TRACe1:SA:CNRatio:OFFSet:FREQuency? 

Return: 2000000 

 

3.20.6.5 CNR Carrier Power 

Command Format :CALCulate<cnum>[:SELected]:SA:CNRatio:CARRier:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:CARRier:POWer? 

Instruction Gets the CNR carrier power of the selected channel and trace. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float unit: dBm 

Default None  

Menu Meas > Meas > CNR > Carrier Power 

Example :CALCulate1:SELected:SA:CNRatio:CARRier:POWer? 

Return: -65.4299219695216 

 

3.20.6.6 CNR Noise Power 

Command Format :CALCulate<cnum>[:SELected]:SA:CNRatio:NOISe:POWer? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio:NOISe:POWer? 

Instruction Gets the CNR noise power of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float unit: dBm 

Default None  

Menu Meas > Meas > CNR > Noise Power 

Example :CALCulate1:SELected:SA:CNRatio:NOISe:POWer? 

Return: -65.321863719616 

 

:CALCulate1:TRACe1:SA:CNRatio:NOISe:POWer? 

Return: -65.1136055327616 

 

3.20.6.7 CNR Carrier Noise Ratio 
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Command Format :CALCulate<cnum>[:SELected]:SA:CNRatio? 

:CALCulate<cnum>:TRACe<tnum>:SA:CNRatio? 

Instruction Gets the CNR noise ratio of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float unit: dBm 

Default None  

Menu Meas > Meas > CNR > Carrier Noise Ratio 

Example :CALCulate1:SELected:SA:CNRatio? 

Return: 0.11582133533318 

 

:CALCulate1:TRACe1:SA:CNRatio? 

Return: -0.220832697601324 

 

3.20.7 Spectrum Monitor 

3.20.7.1 Command List 

Monitor Length :CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:SHOWlength 

Monitor Restart :CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:RESTart 

Spectrum Monitor 
state 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:PAUSe 

 

3.20.7.2 Monitor Length 

Command Format :CALCulate<cnum>[:SELected]:SA:SPECtrogram:SHOWlength 
<num> 

:CALCulate<cnum>[:SELected]:SA:SPECtrogram:SHOWlength? 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:SHOWlength 
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<num> 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:SHOWlength? 

Instruction Sets or gets the spectrum monitor length of the selected channel and 
trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<num>:=An integer in the range of [10,800]  

Return Integer 

Default 175 

Menu Meas > Meas > Spectrum Monitor > Meas Setup > Monitor Length 

Example :CALCulate1:SELected:SA:SPECtrogram:SHOWlength 200 

:CALCulate1:SELected:SA:SPECtrogram:SHOWlength? 

Return: 200 

 

:CALCulate1:TRACe1:SA:SPECtrogram:SHOWlength 300 

:CALCulate1:TRACe1:SA:SPECtrogram:SHOWlength? 

Return: 300 

 

3.20.7.3 Monitor Restart  

Command Format :CALCulate<cnum>[:SELected]:SA:SPECtrogram:RESTart 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:RESTart 

Instruction Sets the monitor restart of the selected channel and trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None  

Default None  
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Menu Meas > Meas > Spectrum Monitor > Meas Setup > Restart 

Example :CALCulate1:SELected:SA:SPECtrogram:RESTart 

:CALCulate1:TRACe1:SA:SPECtrogram:RESTart 

 

3.20.7.4 Spectrum Monitor state 

Command Format :CALCulate<cnum>[:SELected]:SA:SPECtrogram:PAUSe <bool> 

:CALCulate<cnum>[:SELected]:SA:SPECtrogram:PAUSe? 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:PAUSe <bool> 

:CALCulate<cnum>:TRACe<tnum>:SA:SPECtrogram:PAUSe? 

Instruction Sets or gets the spectrum monitor state of the selected channel and 
trace. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF  

Menu Meas > Meas > Spectrum Monitor > Meas Setup > Spectrum Monitor 

Example :CALCulate1:SELected:SA:SPECtrogram:PAUSe 1 

:CALCulate1:SELected:SA:SPECtrogram:PAUSe? 

Return: 1 

 

:CALCulate1:TRACe1:SA:SPECtrogram:PAUSe 0 

:CALCulate1:TRACe1:SA:SPECtrogram:PAUSe? 

Return: 0 

 

3.20.8 SA Source 



VNA Series Programming Guide 

444                                                                                                                                                                                    int.siglent.com 

3.20.8.1 Command List 

SA Source State :SENSe<cnum>:SA:SOURce<pnum>:STATe 

SA Source sweep type :SENSe<cnum>:SA:SOURce<pnum>:SWEep:TYPE 

SA Source CW frequency :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:CW 

SA Source start frequency :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STARt 

SA Source stop frequency :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STOP 

SA Source output power :SENSe<cnum>:SA:SOURce<pnum>:POWer:VALue 

SA Source start power :SENSe<cnum>:SA:SOURce<pnum>:POWer:STARt 

SA Source stop power :SENSe<cnum>:SA:SOURce<pnum>:POWer:STOP 

 

3.20.8.2 SA Source State 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:STATe <bool> 

:SENSe<cnum>:SA:SOURce<pnum>:STATe? 

Instruction Sets / reads the ON/OFF state of the source. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > SA Setup… > Source > State 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:STATe 1 

:SENSe1:SA:SOURce1:STATe? 

Return: 1 

 

3.20.8.3 SA Source sweep type 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:SWEep:TYPE <type> 
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:SENSe<cnum>:SA:SOURce<pnum>:SWEep:TYPE? 

Instruction Set and read the source sweep type. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<type>:={CW|LIN|POW|LFP} 

Return Enumeration 

Default CW 

Menu Sweep > SA Setup… > Source > Type > Sweep Type 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE LIN 

:SENSe1:SA:SOURce1:SWEep:TYPE? 

Return: LIN 

 

3.20.8.4 SA Source CW frequency 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:CW <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:FREQuency:CW? 

Instruction Set and read the source CW frequency. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the CW frequency. 

Return Float, unit is Hz  

Default 1000000000 

Menu Sweep > SA Setup… > Source > Frequency > CW Frequency 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:FREQuency:CW 500000 

:SENSe1:SA:SOURce1:FREQuency:CW? 

Return: 500000 
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3.20.8.5 SA Source start frequency 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STARt <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STARt? 

Instruction Set and read the source start frequency. This command applies to 
Linear Freq or LinFreq+Power sweep types. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the start frequency. 

Return Float, unit is Hz 

Default 500000000 

Menu Sweep > SA Setup… > Source > Frequency > Start Frequency 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE LIN 

:SENSe1:SA:SOURce1:FREQuency:STARt 600000 

:SENSe1:SA:SOURce1:FREQuency:STARt? 

Return: 600000 

 

3.20.8.6 SA Source stop frequency 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STOP <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:FREQuency:STOP? 

Instruction Set and read the source stop frequency. This command applies to 
Linear Freq or LinFreq+Power sweep types. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the stop frequency. 
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Return Float, unit is Hz 

Default 500000000 

Menu Sweep > SA Setup… > Source > Frequency > Stop Frequency 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE LIN 

:SENSe1:SA:SOURce1:FREQuency:STOP 900000 

:SENSe1:SA:SOURce1:FREQuency:STOP? 

Return: 900000 

 

3.20.8.7 SA Source output power 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:POWer:VALue <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:POWer:VALue? 

Instruction Set and read the source output power level. This command applies to 
CW or LINear sweep types. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the output power level, and the parameter 
range: -55~20 dBm. 

Return Float 

Default 0 

Menu Sweep > SA Setup… > Source > Power > Power Level 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE CW 

:SENSe1:SA:SOURce1:POWer:VALue -5 

:SENSe1:SA:SOURce1:POWer:VALue? 

Return: -5 
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3.20.8.8 SA Source start power 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:POWer:STARt <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:POWer:STARt? 

Instruction Set and read the source start power level. This command applies to 
Power or LFPower sweep types. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the start power level, and the parameter range: 
-55~20 dBm. 

Return Float  

Default -10 

Menu Sweep > SA Setup… > Source > Power > Start Power 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE POW 

:SENSe1:SA:SOURce1:POWer:STARt -7 

:SENSe1:SA:SOURce1:POWer:STARt? 

Return: -7 

 

3.20.8.9 SA Source stop power 

Command Format :SENSe<cnum>:SA:SOURce<pnum>:POWer:STOP <numeric> 

:SENSe<cnum>:SA:SOURce<pnum>:POWer:STOP? 

Instruction Set and read the source stop power level. This command applies to 
Power or LFPower sweep types. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<pnum>:={[1]-4}, specifies the measurement port number. 

<numeric>:represents the stop power level, and the parameter range: 
-55~20 dBm. 

Return Float  
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Default 0 

Menu Sweep > SA Setup… > Source > Power > Stop Power 

Example :CALCulate1:CUSTom:DEFine "SA" 

:SENSe1:SA:SOURce1:SWEep:TYPE POW 

:SENSe1:SA:SOURce1:POWer:STOP 2 

:SENSe1:SA:SOURce1:POWer:STOP? 

Return: 2 

 

3.21 MIXER Commands(Option, SHN900A series models do not support) 

3.21.1 Mixer measure sweep setup 

3.21.1.1 Command List 

Mixer Setup apply :SENSe<cnum>:MIXer:APPLy 

Mixer Frequency 
Calculates 

:SENSe<cnum>:MIXer:CALCulate 

Previously-saved 
Mixer Setup 

:SENSe<cnum>:MIXer:DISCard 

Load Mixer File :SENSe<cnum>:MIXer:LOAD 

Save Mixer Setting :SENSe<cnum>:MIXer:SAVE 

Noise suppression 
state 

:SENSe<cnum>:MIXer:AVOidspurs 

DUT Port Map :SENSe<cnum>:MIXer:PMAP 

DUT Input Port Query :SENSe<cnum>:MIXer:PMAP:INPut? 

DUT Output Port 
Query 

:SENSe<cnum>:MIXer:PMAP:OUTPut? 

Mixer Recalculate :SENSe<cnum>:MIXer:RECalculate 

X-axis display type :SENSe<cnum>:TRACe<tnum>:MIXer:XAXis <type> 

Add Segments to 
Mixer 

:SENSe<cnum>:MIXer:SEGMent<segnum>:ADD 

Segment State :SENSe<cnum>:MIXer:SEGMent<segnum>:STATe 

Segment Number of :SENSe<cnum>:MIXer:SEGMent:COUNt? 
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Mixer 

Delete Segments from 
Mixer 

:SENSe<cnum>:MIXer:SEGMent<segnum>:DELete 

Clear Segments Table 
of Mixer 

:SENSe<cnum>:MIXer:SEGMent:DELete:ALL 

Segment Frequency 
Calculates 

:SENSe<cnum>:MIXer:SEGMent<segnum>:CALCulate 

Segment Input Sweep 
Mode 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:MODE 

Segment Input Fixed 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:FIXed 

Segment Input Start 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STARt 

Segment Input Stop 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STOP 

Segment Input Power :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:POWer 

Segment LO Sweep 
Mode 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:MODE 

Mixer LO Fixed 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:FIXed 

Segment LO Start 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STARt 

Segment LO Stop 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STOP 

Segment LO 
Frequency State 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:ILTI 

Segment LO Power :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:POWer 

Segment Output 
Sweep Mode 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:MODE 

Segment Output Fixed 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:FIXed 

Segment Output Start 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STARt 

Segment Output Stop 
Frequency 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STOP 
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Segment Output 
Frequency Calculate 
Method 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:SIDeband 

Segment Output 
Power 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:POWer 

Segment Sweep Points 
Number 

:SENSe<cnum>:MIXer:SEGMent<segnum>:POINts 

Segment IF Bandwidth :SENSe<cnum>:MIXer:SEGMent<segnum>:BWIDth 

 

3.21.1.2 Mixer Setup apply 

Command Format :SENSe<cnum>:MIXer:APPLy 

Instruction This command applies the mixer setup settings and turns the channel 
ON. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Apply 

Example :SENS:MIX:APPL 

 

3.21.1.3 Mixer Frequency Calculates 

Command Format :SENSe<cnum>:MIXer:CALCulate <type> 

Instruction This command calculates the Input, IF, or Output frequencies of the 
mixer setup. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={INPut|OUTPut|LO}, represents Mixer port to be calculated. 

Return None 

Default None 
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Menu Sweep > Mixer Measure... > Mixer Frequency > Calc 

Example :SENS:MIX:CALC Output 

 

3.21.1.4 Previously-saved Mixer Setup 

Command Format :SENSe<cnum>:MIXer:DISCard 

Instruction This command cancels changes that have been made to the Converter 
setup and reverts to the previously-saved setup. Same as the Cancel 
button on the mixer setup dialog box. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Cancel 

Example :SENS:MIX:DISC 

 

3.21.1.5 Load Mixer File 

Command Format :SENSe<cnum>:MIXer:LOAD <string> 

Instruction This command loads a previously-configured mixer attributes file 
(.mxr) 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<string>: represents path and file name (including .mxr extension) to 
load. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Load… 

Example :SENS:MIXer:LOAD "local/file.mxr" 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Applications/MixerConverter_Setup.htm#Mixer_setup_help
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3.21.1.6 Save Mixer Setting 

Command Format :SENSe<cnum>:MIXer:SAVE <string> 

Instruction This command saves the settings for the mixer/converter test setup to 
a mixer attributes file. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<string>: represents path and file name (including .mxr extension) to 
save.. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Save… 

Example :SENS:MIXer:SAVE "local/file.mxr" 

 

3.21.1.7 Noise suppression state 

Command Format :SENSe<cnum>:MIXer:AVOidspurs <bool> 

:SENSe<cnum>:MIXer:AVOidspurs? 

Instruction Set or obtain the state of noise suppression. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean (1=ON,0=OFF) 

Default OFF 

Menu Cal > Mixer Cal > Avoid Spur 

Example :SENS:MIX:AVO ON 

:SENS:MIX:AVO? 

Return: 1 
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3.21.1.8 DUT Port Map 

Command Format :SENSe<cnum>:MIXer:PMAP <pnum1>,<pnum2> 

Instruction This command sets the VNA to DUT port map for FCA measurements. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<pnum1>:={1~2}, SNA port to connect to the DUT input. 

<pnum2>:={1~2}, SNA port to connect to the DUT output. 

Return None 

Default 1,2 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIX:PMAP 2,1 

3.21.1.9 DUT Input Port Query 

Command Format :SENSe<cnum>:MIXer:PMAP:INPut? 

Instruction This command gets the SNA port that is mapped to the DUT input. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Integer. Input port number. 

Default 1 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIXer:PMAP:INPut? 

Return: 1 

 

3.21.1.10 DUT Output Port Query 

Command Format :SENSe<cnum>:MIXer:PMAP:OUTPut? 

Instruction This command gets the SNA port that is mapped to the DUT output. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Integer. Output port number. 

Default 2 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIXer:PMAP:OUTPut? 

Return: 2 

 

3.21.1.11 Mixer Recalculate 

Command Format :SENSe<cnum>:MIXer:RECalculate 

Instruction This command repeats the last calculation that was performed. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default None 

Menu None 

Example :SENS:MIXer:RECalculate 

 

3.21.1.12 X-axis display type 

Command Format :SENSe<cnum>[:SELected]:MIXer:XAXis <type> 

:SENSe<cnum>[:SELected]:MIXer: XAXis? 

:SENSe<cnum>:TRACe<tnum>:MIXer:XAXis <type> 

:SENSe<cnum>:TRACe<tnum>:MIXer: XAXis? 

Instruction Set or obtain the X-axis display type when measuring the mixer, vector 
mixing is not allowed to be set. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
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specified, <tnum> defaults to 1. 

<type>:={INPUT|LO|OUTPUT}. 

INPut: Mixer Input port. 

LO:  Mixer LO port. 

OUTPut:  Mixer Output port. 

Return String 

Default INPut 

Menu Sweep > X-Axis Type 

Example :SENS:MIX:XAX INPut 

:SENSe:MIXer:XAXis? 

Return: INPUT 

 

3.21.1.13 Add Segments to Mixer 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:ADD <numeric> 

Instruction This command adds the specified number of segments to the scratch 
mixer beginning at the specified segment position. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. Segment numbers must be 
sequential. If a new number is added where one currently exists, the 
existing segment and those following are incremented by one. 

<numeric> :Number of segments to add. The number of added 
segments is less than the maximum number of segments. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Add 

Example :SENS:MIXer:SEGM:ADD 2 

 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/GP-IB_Command_Finder/Sense/MixerSegment.htm#Scratch
mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/GP-IB_Command_Finder/Sense/MixerSegment.htm#Scratch
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3.21.1.14 Segment State 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:STATe <bool> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:STATe? 

Instruction This command sets/gets the ON/OFF state for the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Segment Enable 

Example :SENS:MIX:SEGM:STATe ON 

:SENS:MIX:SEGM:STATe? 

Return: 1 

 

3.21.1.15 Segment Number of Mixer 

Command Format :SENSe<cnum>:MIXer:SEGMent:COUNt? 

Instruction This command gets the number of segments on the Applied mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Integer 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Segment 

Example :SENS:MIXer:SEGM:COUN? 

Return: 1 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/GP-IB_Command_Finder/Sense/MixerSegment.htm#Scratch
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3.21.1.16 Delete Segments from Mixer 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:DELete <numeric> 

Instruction This command removes the specified number of segments from the 
scratch mixer starting at the index position.  

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Number of segments to remove. The number of segments 
after deletion is not less than 0. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Delete 

Example :SENS:MIXer:SEGM:DEL 1 

 

3.21.1.17 Clear Segments Table of Mixer 

Command Format :SENSe<cnum>:MIXer:SEGMent:DELete:ALL 

Instruction This command removes all segments from the scratch mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return None 

Default None 

Menu None 

Example :SENS:MIX:SEGM:DEL:ALL 

 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/COM_Reference/Objects/Converter_Object.htm#Scratch
mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/COM_Reference/Objects/Converter_Object.htm#Scratch
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3.21.1.18 Segment Frequency Calculates 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:CALCulate <type> 

Instruction This command calculates the Input, IF, or Output frequencies of the 
mixer setup. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<type>:={INPut|OUTPut|LO}, represents Mixer port to be calculated. 

Return None 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Calc 

Example :SENS:MIXer:SEGM:CALCulate INPut 

 

3.21.1.19 Segment Input Sweep Mode 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:MODE 
<type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:MODE
? 

Instruction This command sets/gets the Input sweep mode of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<type>:={FIXed|SWEPt}, represents Input sweep mode. 

Return Enumeration 

Default SWEPT 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 
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Sweep > Mixer Measure... > Mixer Frequency > Input 

Example :SENS:MIX:SEGM:INP:FREQ:MODE FIXED 

:SENS:MIX:SEGM:INP:FREQ:MODE? 

Return: FIXED 

 

3.21.1.20 Segment Input Fixed Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:FIXed 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:FIXed? 

Instruction This command sets/gets the Input fixed frequency of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric> :Input fixed frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Input > Fixed 

Example :SENS:MIX:SEGM:INP:FREQ:FIX 100000 

:SENS:MIX:SEGM:INP:FREQ:FIX? 

Return: 100000 

 

3.21.1.21 Segment Input Start Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STARt 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STARt? 

Instruction This command sets/gets the Input start frequency value of the 
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segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Input start frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Input > Start/Stop 

Example :SENS:MIX:SEGM:INP:FREQ:STAR 100000 

:SENS:MIX:SEGM:INP:FREQ:STAR? 

Return: 100000 

 

3.21.1.22 Segment Input Stop Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STOP 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:FREQuency:STOP? 

Instruction This command sets/gets the Input stop frequency value of the 
segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Input stop frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 
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Sweep > Mixer Measure... > Mixer Frequency > Input > Start/Stop 

Example :SENS:MIX:SEGM:INP:FREQ:STOP 100000 

:SENS:MIX:SEGM:INP:FREQ:STOP? 

Return: 100000 

 

3.21.1.23 Segment Input Power 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:POWer <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:INPut:POWer? 

Instruction This command sets/gets the value of the Input Power of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Input power in dBm. The range is -10dBm to 10dBm. 

Return Float, in dBm 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Input Power 

Example :SENS:MIX:SEGM:INP:POW 5 

:SENS:MIX:SEGM:INP:POW? 

Return: 5 

 

3.21.1.24 Segment LO Sweep Mode 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:MODE 
<type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:MODE? 

Instruction This command sets/gets the LO sweep mode of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
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not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<type>:={FIXed|SWEPt}, represents LO sweep mode. 

Return Enumeration 

Default FIXED 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Local 

Example :SENS:MIX:SEGM:LO:FREQ:MODE FIXED 

:SENS:MIX:SEGM:LO:FREQ:MODE? 

Return: FIXED 

 

3.21.1.25 Mixer LO Fixed Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:FIXed 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:FIXed? 

Instruction This command sets/gets the fixed frequency of the LO. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: LO fixed frequency in Hz. Choose any number between the 
minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Local > Fixed 

Example :SENS:MIX:LO:FREQ:FIX 100000 

:SENS:MIXer:LO:FREQuency:FIX? 

Return: 100000 
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3.21.1.26 Segment LO Start Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STARt 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STARt? 

Instruction This command sets/gets the LO start frequency value of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: LO start frequency in Hz. Choose any number between the 
minimum and maximum frequency of the SNA.   

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Local > Start/Stop 

Example :SENS:MIX:SEGM:LO:FREQ:STARt 100000 

:SENS:MIX:SEGM:LO:FREQ:STARt? 

Return: 100000 

 

3.21.1.27 Segment LO Stop Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STOP 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:STOP? 

Instruction This command sets/gets the LO stop frequency value of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 
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<numeric>: LO stop frequency in Hz. Choose any number between the 
minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Local > Start/Stop 

Example :SENS:MIX:SEGM:LO:FREQ:STOP 100000 

:SENS:MIX:SEGM:LO:FREQ:STOP? 

Return: 100000 

 

3.21.1.28 Segment LO Frequency State 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:ILTI 
<bool> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:FREQuency:ILTI? 

Instruction This command sets/gets whether to use the Input frequency that is 
greater than the LO or less than the LO of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output > "-" > Local > 
"Input > LO" 

Example :SENS:MIX:SEGM:LO:FREQ:ILTI OFF 

:SENS:MIX:SEGM:LO:FREQ:ILTI? 

Return: 0 
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3.21.1.29 Segment LO Power 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:LO:POWer <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:LO:POWer? 

Instruction This command sets/gets the value of the LO Power of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: LO power in dBm. The range is -10dBm to 10dBm. 

Return Float, in dBm 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Local Power 

Example :SENS:MIX:SEGM:LO:POW 5 

:SENS:MIX:SEGM:LO:POW? 

Return: 5 

 

3.21.1.30 Segment Output Sweep Mode 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency: 
MODE <type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:MO
DE? 

Instruction This command sets/gets the Output sweep mode of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<type>:={FIXed|SWEPt}, represents Output sweep mode. 

Return Enumeration 
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Default SWEPT 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output 

Example :SENS:MIX:SEGM:OUTP:FREQ:MODE FIXED 

:SENS:MIX:SEGM:OUTP:FREQ:MODE? 

Return: FIXED 

 

3.21.1.31 Segment Output Fixed Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:FIXe
d <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:FIXe
d? 

Instruction This command sets/gets the Output fixed frequency of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Output fixed frequency in Hz. Choose any number 
between the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output > Fixed 

Example :SENS:MIX:SEGM:OUTP:FREQ:FIX 100000 

:SENS:MIX:SEGM:OUTP:FREQ:FIX? 

Return: 100000 

 

3.21.1.32 Segment Output Start Frequency 
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Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STA
Rt <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STA
Rt? 

Instruction This command sets/gets the Output start frequency value of the 
segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Output start frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output > Start/Stop 

Example :SENS:MIX:SEGM:OUTP:FREQ:STAR 100000 

:SENS:MIX:SEGM:OUTP:FREQ:STAR? 

Return: 100000 

 

3.21.1.33 Segment Output Stop Frequency 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STO
P <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:STO
P? 

Instruction This command sets/gets the Output stop frequency value of the 
segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 
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<numeric>: Output stop frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output > Start/Stop 

Example :SENS:MIX:SEGM:OUTP:FREQ:STOP 100000 

:SENS:MIX:SEGM:OUTP:FREQ:STOP? 

Return: 100000 

 

3.21.1.34 Segment Output Frequency Calculate Method 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:SIDe
band <type> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:FREQuency:SIDe
band? 

Instruction This command sets/gets whether to select the sum (High) or difference 
(Low) products of the segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<type>:={LOW|HIGH}, represents Sideband value. 

Return Enumeration 

Default HIGH 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output 

Example :SENS:MIX:SEGM:OUTP:FREQ:SID HIGH 

:SENS:MIX:SEGM:OUTP:FREQ:SID? 

Return: HIGH 
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3.21.1.35 Segment Output Power 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:POWer 
<numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:OUTPut:POWer? 

Instruction This command sets/gets the value of the Output Power of the 
segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: Output power in dBm. The range is -10dBm to 10dBm. 

Return Float, in dBm 

Default None 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Output Power 

Example :SENS:MIX:SEGM:OUTP:POW 5 

:SENS:MIX:SEGM:OUTP:POW? 

Return: 5 

 

3.21.1.36 Segment Sweep Points Number 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:POINts <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:POINts? 

Instruction This command sets/gets the number of data points for the sweep 
segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>: represents the sweep points. 

Return Integer 
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Default 21 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > Sweep Point 

Example :SENS:MIX:SEGM:POIN 21 

:SENS:MIX:SEGM:POIN? 

Return: 21 

 

3.21.1.37 Segment IF Bandwidth 

Command Format :SENSe<cnum>:MIXer:SEGMent<segnum>:BWIDth <numeric> 

:SENSe<cnum>:MIXer:SEGMent<segnum>:BWIDth? 

Instruction This command sets/gets the IF Bandwidth for the sweep segment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<segnum>: represents the segment number of segment sweep. If not 
specified, <segnum> defaults to 1. 

<numeric>:={1|2|3|4|5|6|7|10|15|20|30|40|50|70|100|150|200|300|400|
500|700|1E3|1.5E3|2E3|3E3|4E3|5E3|7E3|10E3|15E3|20E3|30E3|40E3|
50E3|70E3|100E3|150E3|200E3|300E3|400E3|500E3|700E3|1E6|1.5E
6|2E6|3E6|4E6|5E6|7E6|10E6}, IF Bandwidth in Hz. 

Return Float, , in Hz. 

Default 10kHz 

Menu Sweep > Mixer Measure... > Sweep > Segment Sweep 

Sweep > Mixer Measure... > Mixer Frequency > IF Bandwidth 

Example :SENS:MIXer:SEGM:BWIDth 1000 

:SENS:MIXer:SEGM:BWIDth? 

Return: 1000 

 

3.21.2 Mixer Input 
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3.21.2.1 Command list 

Mixer Input Sweep Mode :SENSe<cnum>:MIXer:INPut:FREQuency:MODE 

Mixer Input Start Frequency :SENSe<cnum>:MIXer:INPut:FREQuency:STARt 

Mixer Input Stop Frequency :SENSe<cnum>:MIXer:INPut:FREQuency:STOP 

Mixer Input Fixed Frequency :SENSe<cnum>:MIXer:INPut:FREQuency:FIXed 

Mixer Input Divisor :SENSe<cnum>:MIXer:INPut:FREQuency:DENominator 

Mixer Input Multiplier :SENSe<cnum>:MIXer:INPut:FREQuency:NUMerator 

Mixer Input Power :SENSe<cnum>:MIXer:INPut:POWe 

Mixer Input Start Frequency :SENSe<cnum>:MIXer:INPut:POWer:STARt 

Mixer Input Start Frequency :SENSe<cnum>:MIXer:INPut:POWer:STOP 

 

3.21.2.2 Mixer Input Sweep Mode 

Command Format :SENSe<cnum>:MIXer:INPut:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:INPut:FREQuency:MODE? 

Instruction Set or get input sweep mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={FIXed|SWEPt}, Indicates input sweep mode 

Return Enum 

Default SWEPT 

Menu Sweep > Mixer Measure... > Mixer Frequency > Input 

Example :SENS:MIX:INP:FREQ:MODE FIXED 

:SENSe:MIXer:INPut:FREQuency:MODE? 

Return: FIXED 

 

3.21.2.3 Mixer Input Start Frequency 

Command Format :SENSe<cnum>:MIXer:INPut:FREQuency:STARt <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:STARt? 
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Instruction This command sets/gets the Input start frequency value of the mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Input start frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Input > Start/Stop 

Example :SENS:MIX:INP:FREQ:STAR 100000 

:SENS:MIXer:INPut:FREQuency:STARt? 

Return: 100000 

 

3.21.2.4 Mixer Input Stop Frequency 

Command Format :SENSe<cnum>:MIXer:INPut:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:STOP? 

Instruction This command sets/gets the Input stop frequency value of the mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric> Input stop frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Input > Start/Stop 

Example :SENS:MIX:INP:FREQ:STOP 100000 

:SENS:MIXer:INPut:FREQuency:STOP? 

Return: 100000 

 

3.21.2.5 Mixer Input Fixed Frequency 
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Command Format :SENSe<cnum>:MIXer:INPut:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:FIXed? 

Instruction This command sets/gets the fixed frequency of the input. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1.  

<numeric>: Input fixed frequency in Hz. Choose any number between 
the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Input > Fixed 

Example :SENS:MIX:INP:FREQ:FIX 100000 

:SENS:MIXer:INPut:FREQuency:FIXed? 

Return: 100000 

 

3.21.2.6 Mixer Input Divisor 

Command Format :SENSe<cnum>:MIXer:INPut:FREQuency:DENominator <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:DENominator? 

Instruction This command sets/gets the denominator value of the Input Fractional 
Multiplier. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Input denominator value. The range is 1 to 100. 

Return Integer 

Default 1 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIX:INP:FREQ:DEN 2 

:SENS:MIXer:INPut:FREQuency:DENominator? 

Return: 2 
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3.21.2.7 Mixer Input Multiplier 

Command Format :SENSe<cnum>:MIXer:INPut:FREQuency:NUMerator <numeric> 

:SENSe<cnum>:MIXer:INPut:FREQuency:NUMerator? 

Instruction This command sets/gets the numerator value of the Input Fractional 
Multiplier. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Input numerator value. The range is 1 to 100. 

Return Integer 

Default None 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIX:INP:FREQ:NUM 2 

:SENS:MIXer:INPut:FREQuency:NUMerator? 

Return: 2 

 

3.21.2.8 Mixer Input Power 

Command Format :SENSe<cnum>:MIXer:INPut:POWer <numeric> 

:SENSe<cnum>:MIXer:INPut:POWer? 

Instruction This command sets/gets the input power. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Input power level. The range is -55dBm~20dBm. 

Return Float, unit dBm 

Default None 

Menu Sweep > Mixer Measure... > Power > DUT Input Port > Power Level 

Example :SENS:MIX:INP:POW 5 

:SENS:MIXer:INPut:POWer? 

Return: 5 
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3.21.2.9 Mixer Input Start Frequency 

Command Format :SENSe<cnum>:MIXer:INPut:POWer:STARt <numeric> 

:SENSe<cnum>:MIXer:INPut:POWer:STARt? 

Instruction This command sets/gets the input start power, only effective in power 
sweep mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Input start power level. The range is -55dBm~20dBm. 

Return Float, unit dBm 

Default None 

Menu Sweep > Mixer Measure... > Power > DUT Input Port Power Sweep> 
Start Power 

Example :SENS:MIX:INP:POW:STAR 5 

:SENS:MIXer:INPut:POWer:STARt? 

Return: 5 

 

3.21.2.10 Mixer Input Start Frequency 

Command Format :SENSe<cnum>:MIXer:INPut:POWer:STOP<numeric> 

:SENSe<cnum>:MIXer:INPut:POWer:STOP? 

Instruction This command sets/gets the input stop power, only effective in power 
sweep mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Input stoppower level. The range is -55dBm~20dBm. 

Return Float, unit dBm 

Default None 

Menu Sweep > Mixer Measure... > Power > DUT Input Port Power Sweep> 
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Stop Power 

Example :SENS:MIX:INP:POW:STOP 5 

:SENS:MIXer:INPut:POWer:STOP? 

Return: 5 

 

3.21.3 Mixer LO 

3.21.3.1 Command List 

LO Source Name :SENSe<cnum>:MIXer:LO:NAME 

Mixer LO Sweep Mode :SENSe<cnum>:MIXer:LO:FREQuency:MODE 

Mixer LO Start Frequency :SENSe<cnum>:MIXer:LO:FREQuency:STARt 

Mixer LO Stop Frequency :SENSe<cnum>:MIXer:LO:FREQuency:STOP 

Mixer LO Fixed Frequency :SENSe<cnum>:MIXer:LO:FREQuency:FIXed 

Mixer LO Frequency State :SENSe<cnum>:MIXer:LO:FREQuency:ILTI 

Mixer LO Divisor :SENSe<cnum>:MIXer:LO:FREQuency:DENominator 

Mixer LO Multiplier :SENSe<cnum>:MIXer:LO:FREQuency:NUMerator 

Mixer LO Power :SENSe<cnum>:MIXer:LO:POWer 

LO Start Power of Power 
Sweep 

:SENSe<cnum>:MIXer:LO:POWer:STARt 

LO Stop Power of Power Sweep :SENSe<cnum>:MIXer:LO:POWer:STOP 

 

3.21.3.2 LO Source Name 

Command Format :SENSe<cnum>:MIXer:LO:NAME <string> 

:SENSe<cnum>:MIXer:LO:NAME? 

Instruction This command sets/gets the name of the external source to use as 
the LO in a converter measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<string>: LO Source name. 
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Return String 

Default "Not Controlled" 

Menu Sweep > Mixer Measure... > Sweep > Power Sweep > Converter 
Model > Local 

Example :SENS:MIX:LO:NAME "Not Controlled" 

:SENS:MIXer:LO:NAME? 

Return: "Not Controlled " 

3.21.3.3 Mixer LO Sweep Mode 

Command Format :SENSe<cnum>:MIXer:LO:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:LO:FREQuency:MODE? 

Instruction This command sets/gets the LO sweep mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={FIXed|SWEPt}, represents LO sweep mode. 

Return Enumeration 

Default FIXED 

Menu Sweep > Mixer Measure... > Mixer Frequency > Local 

Example :SENSe:MIX:LO:FREQ:MODE FIXED 

:SENSe:MIXer:LO:FREQuency:MODE? 

Return: FIXED 

 

3.21.3.4 Mixer LO Start Frequency 

Command Format :SENSe<cnum>:MIXer:LO:FREQuency:STARt <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:STARt? 

Instruction This command sets/gets the LO start frequency value of the mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO start frequency in Hz. Choose any number between the 
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minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Local > Start/Stop 

Example :SENS:MIX:LO:FREQ:STAR 100000 

:SENS:MIXer:LO:FREQuency:STARt? 

Return: 100000 

 

3.21.3.5 Mixer LO Stop Frequency 

Command Format :SENSe<cnum>:MIXer:LO:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:STOP? 

Instruction This command sets/gets the LO stop frequency value of the mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO stop frequency in Hz. Choose any number between the 
minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Local > Start/Stop 

Example :SENS:MIX:LO:FREQ:STOP 100000 

:SENS:MIXer:LO:FREQuency:STOP? 

Return: 100000 

 

3.21.3.6 Mixer LO Fixed Frequency 

Command Format :SENSe<cnum>:MIXer:LO:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:FIXed? 

Instruction This command sets/gets the fixed frequency of the LO. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO fixed frequency in Hz. Choose any number between the 
minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Local > Fixed 

Example :SENS:MIX:LO:FREQ:FIX 100000 

:SENS:MIXer:LO:FREQuency:FIX? 

Return: 100000 

 

3.21.3.7 Mixer LO Frequency State 

Command Format :SENSe<cnum>:MIXer:LO:FREQuency:ILTI <bool> 

:SENSe<cnum>:MIXer:LO:FREQuency:ILTI? 

Instruction This command sets/gets whether to use the Input frequency that is 
greater than the LO or less than the LO. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > Mixer Measure... > Mixer Frequency > Output > "-" > Local > 
"Input > LO" 

Example :SENS:MIX:LO:FREQ:ILTI OFF 

:SENS:MIXer:LO:FREQuency:ILTI? 

Return: 0 

 

3.21.3.8 Mixer LO Divisor 
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Command Format :SENSe<cnum>:MIXer:LO:FREQuency:DENominator <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:DENominator? 

Instruction This command sets/gets the denominator value of the LO Fractional 
Multiplier. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO denominator value. The range is 1 to 100. 

Return Integer 

Default 1 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIX:LO:FREQ:DEN 2 

:SENS:MIXer:LO:FREQuency:DENominator? 

Return: 2 

 

3.21.3.9 Mixer LO Multiplier 

Command Format :SENSe<cnum>:MIXer:LO:FREQuency:NUMerator <numeric> 

:SENSe<cnum>:MIXer:LO:FREQuency:NUMerator? 

Instruction This command sets/gets the numerator value of the LO Fractional 
Multiplier. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO numerator value. The range is 1 to 100. 

Return Integer 

Default None 

Menu Sweep > Mixer Measure... > Mixer Setup > Converter Model 

Example :SENS:MIX:LO:FREQ:NUM 2 

:SENS:MIXer:LO:FREQuency:NUMerator? 

Return: 2 
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3.21.3.10 Mixer LO Power 

Command Format :SENSe<cnum>:MIXer:LO:POWer <numeric> 

:SENSe<cnum>:MIXer:LO:POWer? 

Instruction This command sets/gets the value of the LO Power. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO power in dBm. The range is -10dBm to 10dBm. 

Return Float, in dBm 

Default None 

Menu Sweep > Mixer Measure... > Mixer Setup > Power Level 

Example :SENS:MIX:LO:POW -5 

:SENS:MIXer:LO:POWer? 

Return: -5 

 

3.21.3.11 LO Start Power of Power Sweep 

Command Format :SENSe<cnum>:MIXer:LO:POWer:STARt <numeric> 

:SENSe<cnum>:MIXer:LO:POWer:STARt? 

Instruction This command sets/gets the LO power start value for an LO power 
sweep. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO start power of power sweep. The range is -10dBm to 
10dBm. 

Return Float, in dBm 

Default -10 dBm 

Menu Sweep > Mixer Measure... > Sweep > Power Sweep 

Sweep > Mixer Measure... > Mixer Setup > Swpet Power > Start 

Example :SENS:MIX:LO:POW:STAR -5 
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:SENS:MIXer:LO:POWer:STARt? 

Return: -5 

 

3.21.3.12 LO Stop Power of Power Sweep 

Command Format :SENSe<cnum>:MIXer:LO:POWer:STOP <numeric> 

:SENSe<cnum>:MIXer:LO:POWer:STOP? 

Instruction This command sets/gets the LO power stop value for an LO power 
sweep. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: LO stop power of power sweep. The range is -10dBm to 
10dBm. 

Return Float, in dBm 

Default -10 dBm 

Menu Sweep > Mixer Measure... > Sweep > Power Sweep 

Sweep > Mixer Measure... > Mixer Setup > Swpet Power > Stop 

Example :SENS:MIX:LO:POW:STOP -5 

:SENS:MIXer:LO:POWer:STOP? 

Return: -5 

 

 

3.21.4 Mixer Output 

3.21.4.1 Command List 

Mixer Output Sweep Mode :SENSe<cnum>:MIXer:OUTPut:FREQuency:MODE 

Mixer Output Start Frequency :SENSe<cnum>:MIXer:OUTPut:FREQuency:STARt 

Mixer Output Stop Frequency :SENSe<cnum>:MIXer:OUTPut:FREQuency:STOP 

Mixer Output Fixed Frequency :SENSe<cnum>:MIXer:OUTPut:FREQuency:FIXed 

Mixer Output Frequency Calculate :SENSe<cnum>:MIXer:OUTPut:FREQuency:SIDeband 
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Method 

Mixer Output Power :SENSe<cnum>:MIXer:OUTPut:POWe 

Mixer Input Start Frequency :SENSe<cnum>:MIXer:OUTPut:POWer:STARt 

Mixer Input Start Frequency :SENSe<cnum>:MIXer:OUTPut:POWer:STOP 

 

3.21.4.2 Mixer Output Sweep Mode 

Command Format :SENSe<cnum>:MIXer:OUTPut:FREQuency:MODE <type> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:MODE? 

Instruction This command sets/gets the Output sweep mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={FIXed|SWEPt}, represents Output sweep mode. 

Return Enumeration 

Default SWEPT 

Menu Sweep > Mixer Measure... > Mixer Frequency > Output 

Example :SENS:MIX:OUTP:FREQ:MODE FIXED 

:SENSe:MIXer:OUTPut:FREQuency:MODE? 

Return: FIXED 

 

3.21.4.3 Mixer Output Start Frequency 

Command Format :SENSe<cnum>:MIXer:OUTPut:FREQuency:STARt <numeric> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:STARt? 

Instruction This command sets/gets the Output start frequency value of the mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Output Start Frequency in Hz. Choose any number 
between the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 
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Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Output > Start/Stop 

Example :SENS:MIX:OUTP:FREQ:STAR 100000 

:SENS:MIXer:OUTPut:FREQuency:STARt? 

Return: 100000 

 

3.21.4.4 Mixer Output Stop Frequency 

Command Format :SENSe<cnum>:MIXer:OUTPut:FREQuency:STOP <numeric> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:STOP? 

Instruction This command sets/gets the Output stop frequency value of the mixer. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Output Stop Frequency in Hz. Choose any number 
between the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Output > Start/Stop 

Example :SENS:MIX:OUTP:FREQ:STOP 100000 

:SENS:MIXer:OUTPut:FREQuency:STOP? 

Return: 100000 

 

3.21.4.5 Mixer Output Fixed Frequency 

Command Format :SENSe<cnum>:MIXer:OUTPut:FREQuency:FIXed <numeric> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:FIXed? 

Instruction This command sets/gets the fixed frequency of the output. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Output fixed frequency in Hz. Choose any number 
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between the minimum and maximum frequency of the SNA. 

Return Float, in Hz. 

Default None 

Menu Sweep > Mixer Measure... > Mixer Frequency > Output > Fixed 

Example :SENS:MIX:OUTP:FREQ:FIX 100000 

:SENS:MIXer:OUTPut:FREQuency:FIX? 

Return: 100000 

 

3.21.4.6 Mixer Output Frequency Calculate Method 

Command Format :SENSe<cnum>:MIXer:OUTPut:FREQuency:SIDeband <type> 

:SENSe<cnum>:MIXer:OUTPut:FREQuency:SIDeband? 

Instruction This command sets/gets whether to select the sum (High) or difference 
(Low) products. 

When using this command to change the calculation method of output 
frequency to difference (LOW), that default input signal frequency > LO 
signal frequency. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={LOW|HIGH}, represents Sideband value. 

Return Enumeration 

Default HIGH 

Menu Sweep > Mixer Measure... > Mixer Frequency > Output 

Example :SENS:MIX:OUTP:FREQ:SID HIGH 

:SENSe:MIXer:OUTPut:FREQuency:SIDeband? 

Return: HIGH 

 

3.21.4.7 Mixer Output Power 

Command Format :SENSe<cnum>:MIXer:OUTPut:POWer <numeric> 
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:SENSe<cnum>:MIXer:OUTPut:POWer? 

Instruction This command sets/gets the output power, which can be used for 
reverse measurement of the mixer. It can only be set when it is not 
coupled with the input port power of the mixer, otherwise it should be 
consistent with the input port power. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Output power level. The range is -55dBm~20dBm. 

Return Float, unit dBm 

Default None 

Menu Sweep > Mixer Measure... > Power > DUT Output Port > Power Level 

Example :SENS:MIX:OUTP:POW 5 

:SENS:MIXer:OUTPut:POWer? 

Return: 5 

 

3.21.4.8 Mixer Output Start Power 

Command Format :SENSe<cnum>:MIXer:OUTPut:POWer:STARt <numeric> 

:SENSe<cnum>:MIXer:OUTPut:POWer:STARt? 

Instruction This command sets/gets the output power, which can be used for 
reverse measurement of the mixer. It can only be set when it is not 
coupled with the input port power of the mixer, otherwise it should be 
consistent with the input port power. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Output start power level. The range is -55dBm~20dBm. 

Return Float, unit dBm 

Default None 

Menu Sweep > Mixer Measure... > Power > DUT Output Port Power Sweep> 
Start Power 

Example :SENS:MIX:OUTP:POW:STAR 5 
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:SENS:MIXer:OUTPut:POWer:STARt? 

Return: 5 

 

3.21.4.9 Mixer Output Stop Power 

Command Format :SENSe<cnum>:MIXer:OUTPut:POWer:STOP<numeric> 

:SENSe<cnum>:MIXer:OUTPut:POWer:STOP? 

Instruction This command sets/gets the output power, which can be used for 
reverse measurement of the mixer. It can only be set when it is not 
coupled with the input port power of the mixer, otherwise it should be 
consistent with the input port power. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>: Output stoppower level. The range is -55dBm~20dBm. 

Return Float, unit dBm 

Default None 

Menu Sweep > Mixer Measure... > Power > DUT Output Port Power Sweep> 
Stop Power 

Example :SENS:MIX:OUTP:POW:STOP 5 

:SENS:MIXer:OUTPut:POWer:STOP? 

Return: 5 

 

 

3.22 TDR Commands(Option) 

3.22.1 Setup 

3.22.1.1 Basic 

3.22.1.1.1 Command list 

TDR State :CALCulate:TDR:STATe 
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TDR Option Preset :SYSTem:TDR:PRESet 

DUT topology :CALCulate:DEVice 

Time Stimulus Voltage :CALCulate:ATRaces:TIME:STEP:AMPLitude 

Measure DUT length :SENSe:DLENgth:AUTO:IMMediate 

DUT length :SENSe:DLENgth:DATA 

 

3.22.1.1.2 TDR State 

Command Format :CALCulate:TDR:STATe <bool> 

:CALCulate:TDR:STATe? 

Instruction This command sets/gets TDR option enable state. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Math > TDR > TDR 

Example :CALC:TDR:STAT ON 

:CALC:TDR:STAT? 

Return: 1 

 

3.22.1.1.3 TDR Option Preset 

Command Format :SYSTem:TDR:PRESet 

Instruction This command sets the TDR option to the default state. Calibration 
data will be lost. 

Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > Preset 

Example :SYST:TDR:PRES 
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3.22.1.1.4 DUT topology 

Command Format :CALCulate:DEVice <type> 

:CALCulate:DEVice? 

Instruction This command sets step amplitude value for the transform function. 

Parameter Type <type>:={SEND1|SEND2|DIF1|SEND4|DIF2} 

Return Enumeration 

Default SEND1 

Menu Setup > Basic > DUT topology 

Example :CALC:DEV SEND2 

:CALC:DEV? 

Return: SEND2 

 

3.22.1.1.5 Time Stimulus Voltage 

Command Format :CALCulate:ATRaces:TIME:STEP:AMPLitude <numeric> 

:CALCulate:ATRaces:TIME:STEP:AMPLitude? 

Instruction This command sets/gets step amplitude value for the transform 
function. 

Parameter Type <numeric>:represents the Stimulus Voltage value, and the parameter 
range: 0.001~5. 

Return Float, unit: V (Voltage) 

Default 0.2 

Menu Setup > Basic > Stim Ampl 

Example :CALC:ATR:TIME:STEP:AMPL 0.5 

:CALC:ATR:TIME:STEP:AMPL? 

Return: 0.5 
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3.22.1.1.6 Measure DUT length 

Command Format :SENSe:DLENgth:AUTO:IMMediate 

Instruction This command executes auto DUT length setting. 

Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > DUT Length > Auto > Measure 

Example :SENS:DLEN:AUTO:IMM 

 

3.22.1.1.7 DUT length 

Command Format :SENSe:DLENgth:DATA <numeric> 

:SENSe:DLENgth:DATA? 

Instruction This command sets DUT length value. 

Parameter Type <numeric>:represents the DUT length value. 

Return Float, unit: s (second) 

Default None 

Menu Setup > Basic > DUT Length 

Example :SENS:DLEN:DATA 6.26e-9 

:SENS:DLEN:DATA? 

Return: 6.26e-09 

 

3.22.1.2 Calibration 

3.22.1.2.1 Command list 

Deskew Standard Type :SENSe:CORRection:EXTension:AUTO:STANdard 

Execute Deskew :SENSe:CORRection:EXTension:AUTO:IMMediate 

Deskew & Loss Open :SENSe:CORRection:COLLection:DLComp:OPEN 
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Deskew & Loss Thru :SENSe:CORRection:COLLection:DLComp:THRU 

Deskew & Loss Load :SENSe:CORRection:COLLection:DLComp:LOAD 

Deskew & Loss Save :SENSe:CORRection:COLLection:DLComp:SAVE 

 

3.22.1.2.2 Deskew Standard Type 

Command Format :SENSe:CORRection:EXTension:AUTO:STANdard <type> 

:SENSe:CORRection:EXTension:AUTO:STANdard? 

Instruction This command sets the standard for auto port extension. 

Parameter Type <type>:={OPEN|SHORt} 

Return Enumeration 

Default OPEN 

Menu Setup > Basic > Deskew > Options > Standard Type 

Setup > Basic > Deskew&Loss > Options > Standard Type 

Example :SENS:CORR:EXT:AUTO:STAN SHOR 

:SENS:CORR:EXT:AUTO:STAN? 

Return: SHOR 

 

 

3.22.1.2.3 Execute Deskew 

Command Format :SENSe:CORRection:EXTension:AUTO:IMMediate 

Instruction This command executes deskew (auto port extension). 

Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > Deskew > Deskew 

Example :SENS:CORR:EXT:AUTO:STAN SHOR 

:SENS:CORR:EXT:AUTO:IMM 
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3.22.1.2.4 Deskew & Loss Open 

Command Format :SENSe:CORRection:COLLection:DLComp:OPEN 

Instruction This command executes an open measurement, as a part of Loss 
Compensation sequence. 

Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > Deskew & Loss > Measure 

Example :SENS:CORR:COLL:DLC:OPEN 

:SENS:CORR:COLL:DLC:SAVE 

 

3.22.1.2.5 Deskew & Loss Thru 

Command Format :SENSe:CORRection:COLLection:DLComp:THRU 

Instruction This command executes a thru measurement, as a part of Loss 
Compensation sequence. 

Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > Deskew & Loss > Measure 

Example :SENS:CORR:COLL:DLC:THRU 

 

3.22.1.2.6 Deskew & Loss Load 

Command Format :SENSe:CORRection:COLLection:DLComp:LOAD 

Instruction This command executes a load measurement, as a part of Loss 
Compensation sequence. 
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Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > Deskew & Loss > Load x 

Example :SENS:CORR:COLL:DLC:LOAD 

 

3.22.1.2.7 Deskew & Loss Save 

Command Format :SENSe:CORRection:COLLection:DLComp:SAVE 

Instruction This command saves the result of Loss Compensation sequence. 

Parameter Type None 

Return None 

Default None 

Menu Setup > Basic > Deskew & Loss > Apply 

Example :SENS:CORR:COLL:DLC:OPEN 

:SENS:CORR:COLL:DLC:THRU 

:SENS:CORR:COLL:DLC:LOAD 

:SENS:CORR:COLL:DLC:SAVE 

 

3.22.1.3 More functions 

3.22.1.3.1 Command List 

System Impedance :SENSe:CORRection:RIMPedance 

Dielectric Constant :SENSe:CORRection:DCONstant 

 

3.22.1.3.2 System Impedance 

Command Format :SENSe:CORRection:RIMPedance <numeric> 

:SENSe:CORRection:RIMPedance? 
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Instruction This command sets reference impedance value. 

Parameter Type <numeric>:represents the reference impedance value. 

Return Float 

Default 50 

Menu Setup > More Functions > Ref. Z 

Example :SENS:CORR:RIMP 75 

:SENS:CORR:RIMP? 

Return: 75 

 

3.22.1.3.3 Dielectric Constant 

Command Format :SENSe:CORRection:DCONstant <numeric> 

:SENSe:CORRection:DCONstant? 

Instruction This command sets dielectric constant value. 

Parameter Type <numeric>:represents the dielectric constant value. 

Return Float 

Default 1 

Menu Setup > More Functions > Dielectric Const 

Example :SENS:CORR:DCON 2 

:SENS:CORR:DCON? 

Return: 2 

 

3.22.1.4 TDR AvgBW 

3.22.1.4.1 Commands List 

Average Enable :TRIGger:AVERage 

 

3.22.1.4.2 Average Enable 
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Command Format :TRIGger:AVERage <bool> 

:TRIGger:AVERage? 

Instruction This command sets averaging trigger on/off. When averaging trigger 
is on, one trigger makes one averaging measurement. For example, if 
the averaging factor is set at 16, one trigger makes a measurement for 
16 times. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Setup > Average > Averaging 

Example :TRIG:AVER ON 

:TRIG:AVER? 

Return: 1 

 

3.22.1.5 Advanced waveform 

3.22.1.5.1 Command List 

Jitter Enable :CALCulate:EYE:INPut:JITTer:STATe 

Jitter Type :CALCulate:EYE:INPut:JITTer:TYPE 

Random Jitter Magnitude :CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude 

Periodic Jitter Frequency :CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency 

Periodic Jitter Magnitude :CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude 

De-embeding Enable State :CALCulate:EMBed:STATe 

Waveform View Point :DISPlay:ATRaces:VIEW 

Port De-embeding S2P Filename :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:FILename 

Port De-embeding Enable State :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:STATe 

Diff Port De-embeding S4P Filename :CALCulate:EMBed:S4P:DIFF<pnum>:FILename 

Diff Port De-embeding Enable State :CALCulate:EMBed:S4P:DIFF<pnum>:STATe 

Emphasis Enable :CALCulate:EMPHasis:STATe 

Emphasis Pre Cursor :CALCulate:EMPHasis:CURSor:PRE1 

Emphasis Post 1 Cursor :CALCulate:EMPHasis:CURSor:POST1 
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Emphasis Post 2 Cursor :CALCulate:EMPHasis:CURSor:POST2 

Equalization Enable :CALCulate:EQUalization:STATe 

Equalizer Type :CALCulate:EQUalization:TYPE 

Equalization DC Gain :CALCulate:EQUalization:CTLE:DC 

Equalization Zero Frequency :CALCulate:EQUalization:CTLE:ZERO1 

Equalization Pole1 Frequency :CALCulate:EQUalization:CTLE:POLE1 

Equalization Pole2 Frequency :CALCulate:EQUalization:CTLE:POLE2 

Equalizer User File :CALCulate:EQUalization:FILename 

 

3.22.1.5.2 Jitter Enable 

Command Format :CALCulate:EYE:INPut:JITTer:STATe <bool> 

:CALCulate:EYE:INPut:JITTer:STATe? 

Instruction This command sets the jitter function state with simulated eye on/off. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Eye/Mask > Advanced Waveform > Jitter > Enable 

Example :CALC:EYE:INP:JITT:STAT ON 

:CALC:EYE:INP:JITT:STAT? 

Return: 1 

 

3.22.1.5.3 Jitter Type 

Command Format :CALCulate:EYE:INPut:JITTer:TYPE <type> 

:CALCulate:EYE:INPut:JITTer:TYPE? 

Instruction This command sets the jitter function type for the simulated eye 
function. 

Parameter Type <type>:={RANDom|PERiodic} 

Return Enumeration 
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Default PERiodic 

Menu Eye/Mask > Advanced Waveform > Jitter > Type > Random/Periodic 

Example :CALC:EYE:INP:JITT:TYPE RAND 

:CALC:EYE:INP:JITT:TYPE? 

Return: RAND 

 

3.22.1.5.4 Random Jitter Magnitude 

Command 

Format 

:CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude <numeric> 

:CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude? 

Instruction This command sets the random jitter magnitude in rms. This value is 
used only when random jitter function type is selected. 

Parameter Type <numeric>:represents the random jitter magnitude in rms, and the 
parameter range: 0~0.25 UI. 

Return Float 

Default 0 

Menu Eye/Mask > Advanced Waveform > Jitter > Random Jitter > 
Magnitude(RMS) 

Example :CALC:EYE:INP:JITT:RAND:MAGN 0.2 

:CALC:EYE:INP:JITT:RAND:MAGN? 

Return: 0.2 

 

3.22.1.5.5 Periodic Jitter Frequency 

Command Format :CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency <numeric> 

:CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency? 

Instruction This command sets the periodic jitter frequency. This value is used only 
when periodic jitter function type is selected. 

Parameter Type <numeric>:represents the periodic jitter frequency, and the parameter 
range: 0~2MHz. 
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Return Float, unit: Hz 

Default 500kHz 

Menu Eye/Mask > Advanced Waveform > Jitter > Periodic Jitter > Frequency 

Example :CALC:EYE:INP:JITT:PER:FREQ 10E3 

:CALC:EYE:INP:JITT:PER:FREQ? 

Return: 10000 

 

3.22.1.5.6 Periodic Jitter Magnitude 

Command Format :CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude <numeric> 

:CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude? 

Instruction This command sets the periodic jitter magnitude in peak-peak value. 
This value is used only when periodic jitter function type is selected. 

Parameter Type <numeric>:represents the periodic jitter magnitude in peak-peak 
value, and the parameter range: 0~1 UI. 

Return Float 

Default 0 

Menu Eye/Mask > Advanced Waveform > Jitter > Periodic Jitter > 
Magnitude 

Example :CALC:EYE:INP:JITT:PER:MAGN 0.2 

:CALC:EYE:INP:JITT:PER:MAGN? 

Return: 0.2 

 

3.22.1.5.7 De-embeding Enable State 

Command Format :CALCulate:EMBed:STATe <bool> 

:CALCulate:EMBed:STATe? 

Instruction This command sets the embed function state on/off. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 
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Default OFF 

Menu Setup > Adv Waveform > De-embeding > Enable 

Example :CALC:EMB:STAT ON 

:CALC:EMB:STAT? 

Return: 1 

 

3.22.1.5.8 Waveform View Point 

Command Format :DISPlay:ATRaces:VIEW <type> 

:DISPlay:ATRaces:VIEW? 

Instruction This command selects the view point for waveform analysis either 
before or after DUT. 

Parameter Type <type>:={STIMulus|RESPonse} 

Return Enumeration 

Default RESPonse 

Menu Setup > Adv Waveform > Emphasis/Equalization > View 

Example :DISP:ATR:VIEW STIMulus 

:DISP:ATR:VIEW? 

Return: STIM 

 

3.22.1.5.9 Port De-embeding S2P Filename 

Command Format :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:FILename <string> 

:CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:FILename? 

Instruction This command sets/gets the filename of the S2P de-embedding user 
file. This file is saved as a 2-port touchstone file with the .s2p extension. 

Parameter Type <pnum>:={[1]|2|3|4}, specifies the measurement port number. 

<string>: represents he filename of the S2P. 

Return String 

Default None 
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Menu Setup > Adv Waveform > De-embeding > Load 

Example :CALC:EMB:S2P:PORT1:DEEM:FIL "local/file.s2p" 

:CALC:EMB:S2P:PORT1:DEEM:FIL? 

Return: local/file.s2p 

 

3.22.1.5.10Port De-embeding Enable State 

Command Format :CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:STATe <bool> 

:CALCulate:EMBed:S2P:PORT<pnum>:DEEMbed:STATe? 

Instruction This command sets the S2P de-embedding function state ON/OFF. To 
turn ON, it is necessary to load the S2P file in advance. 

Parameter Type <pnum>:={[1]|2|3|4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Setup > Adv Waveform > De-embeding > Select De-embeding File > 
Enable 

Example :CALC:EMB:S2P:PORT1:DEEM:STAT ON 

:CALC:EMB:S2P:PORT1:DEEM:STAT? 

Return: 1 

 

3.22.1.5.11Diff Port De-embeding S4P Filename 

Command Format :CALCulate:EMBed:S4P:DIFF<pnum>:FILename <string> 

:CALCulate:EMBed:S4P:DIFF<pnum>:FILename? 

Instruction This command sets the filename of the S4P de-embedding user file. 
This file is saved as a 4-port touchstone file with the .s4p extension. 

Parameter Type <pnum>:={[1]|2|3|4}, specifies the measurement port number. 

<string>: represents he filename of the S4P. 

Return String 
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Default None 

Menu Setup > Adv Waveform > De-embeding > Load 

Example :CALC:EMB:S4P:DIFF1:FIL "local/file.s4p" 

:CALC:EMB:S4P:DIFF1:FIL? 

Return: local/file.s4p 

 

3.22.1.5.12Diff Port De-embeding Enable State 

Command Format :CALCulate:EMBed:S4P:DIFF<pnum>:STATe <bool> 

:CALCulate:EMBed:S4P:DIFF<pnum>:STATe? 

Instruction This command sets the S4P de-embedding function state on/off. 

Parameter Type <pnum>:={[1]|2|3|4}, specifies the measurement port number. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Setup > Adv Waveform > De-embeding > Select De-embeding File > 
Enable 

Example :CALC:EMB:S4P:DIFF1:STAT ON 

:CALC:EMB:S4P:DIFF1:STAT? 

Return: 1 

 

3.22.1.5.13Emphasis Enable 

Command Format :CALCulate:EMPHasis:STATe <bool> 

:CALCulate:EMPHasis:STATe? 

Instruction This command sets the emphasis function state on/off. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 
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Menu Setup > Adv Waveform > Emphasis > Enable 

Example :CALC:EMPH:STAT ON 

:CALC:EMPH:STAT? 

Return: 1 

 

3.22.1.5.14Emphasis Pre Cursor 

Command Format :CALCulate:EMPHasis:CURSor:PRE1 <numeric> 

:CALCulate:EMPHasis:CURSor:PRE1? 

Instruction This command sets the emphasis pre1 level. 

Parameter Type <numeric>:represents the emphasis pre1 level, and the parameter 
range: -20~20 dB. 

Return Float, unit: dB 

Default 0 dB 

Menu Setup > Adv Waveform > Emphasis > Pre Cursor 

Example :CALC:EMPH:CURS:PRE1 3 

:CALC:EMPH:CURS:PRE1? 

Return: 3 

 

3.22.1.5.15Emphasis Post 1 Cursor 

Command Format :CALCulate:EMPHasis:CURSor:POST1 <numeric> 

:CALCulate:EMPHasis:CURSor:POST1? 

Instruction This command sets/gets the emphasis post1 level. 

Parameter Type <numeric>:represents the emphasis post1 level, and the parameter 
range: -20~20 dB. 

Return Float, unit: dB 

Default -3.5 dB 

Menu Setup > Adv Waveform > Emphasis > Post 1 Cursor 
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Example :CALC:EMPH:CURS:POST1 3 

:CALC:EMPH:CURS:POST1? 

Return: 3 

 

3.22.1.5.16Emphasis Post 2 Cursor 

Command Format :CALCulate:EMPHasis:CURSor:POST2 <numeric> 

:CALCulate:EMPHasis:CURSor:POST2? 

Instruction This command sets the emphasis post2 level. 

Parameter Type <numeric>:represents the emphasis post2 level, and the parameter 
range: -20~20 dB. 

Return Float, unit: dB 

Default 0 dB 

Menu Setup > Adv Waveform > Emphasis > Post 2 Cursor 

Example :CALC:EMPH:CURS:POST2 3 

:CALC:EMPH:CURS:POST2? 

Return: 3 

 

3.22.1.5.17Equalization Enable 

Command Format :CALCulate:EQUalization:STATe <bool> 

:CALCulate:EQUalization:STATe? 

Instruction This command sets the equalization function state on/off. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Setup > Adv Waveform > Equalization > Enable 

Example :CALC:EQU:STAT ON 

:CALC:EQU:STAT? 
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Return: 1 

 

3.22.1.5.18Equalizer Type 

Command Format :CALCulate:EQUalization:TYPE <type> 

:CALCulate:EQUalization:TYPE? 

Instruction This command sets the equalization type. 

Parameter Type <type>:={EQUation|USER} 

Return String 

Default EQUation 

Menu Setup > Adv Waveform > Equalization > Type 

Example :CALC:EQU:TYPE USER 

:CALC:EQU:TYPE? 

Return: USER 

 

3.22.1.5.19Equalization DC Gain 

Command Format :CALCulate:EQUalization:CTLE:DC <numeric> 

:CALCulate:EQUalization:CTLE:DC? 

Instruction This command sets the equalization CTLE (Continuous Time Linear 
Equalization) DC gain parameter. 

Parameter Type <numeric>:represents the DC gain parameter, and the parameter 
range: 0~10. 

Return Float 

Default 0.667 

Menu Setup > Adv Waveform > Equalization > DC Gain 

Example :CALC:EQU:CTLE:DC 0.5 

:CALC:EQU:CTLE:DC? 

Return: 0.5 
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3.22.1.5.20Equalization Zero Frequency 

Command Format :CALCulate:EQUalization:CTLE:ZERO1 <numeric> 

:CALCulate:EQUalization:CTLE:ZERO1? 

Instruction This command sets the equalization CTLE (Continuous Time Linear 
Equalization) zero parameter. 

Parameter Type <numeric>:represents the frequency value, and the parameter range: 
0~20GHz. 

Return Float, unit: Hz 

Default 650MHz 

Menu Setup > Adv Waveform > Equalization > Zero Freq 

Example :CALC:EQU:CTLE:ZERO1 7.5E8 

:CALC:EQU:CTLE:ZERO1? 

Return: 750000000 

 

3.22.1.5.21Equalization Pole1 Frequency 

Command Format :CALCulate:EQUalization:CTLE:POLE1 <numeric> 

:CALCulate:EQUalization:CTLE:POLE1? 

Instruction This command sets the equalization CTLE (Continuous Time Linear 
Equalization) Pole1 parameter. 

Parameter Type <numeric>:represents the frequency value, and the parameter range: 
0~20GHz. 

Return Float, unit: Hz 

Default 1.95GHz 

Menu Setup > Adv Waveform > Equalization > Pole 1 Freq 

Example :CALC:EQU:CTLE:POLE1 2.5E9 

:CALC:EQU:CTLE:POLE1? 

Return: 2500000000 
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3.22.1.5.22Equalization Pole2 Frequency 

Command Format :CALCulate:EQUalization:CTLE:POLE2 <numeric> 

:CALCulate:EQUalization:CTLE:POLE2? 

Instruction This command sets the equalization CTLE (Continuous Time Linear 
Equalization) Pole2 parameter. 

Parameter Type <numeric>:represents the frequency value, and the parameter range: 
0~20GHz. 

Return Float, unit: Hz 

Default 5GHz 

Menu Setup > Adv Waveform > Equalization > Pole 2 Freq 

Example :CALC:EQU:CTLE:POLE2 3E9 

:CALC:EQU:CTLE:POLE2? 

Return: 3000000000 

 

3.22.1.5.23Equalizer User File 

Command Format :CALCulate:EQUalization:FILename <string> 

:CALCulate:EQUalization:FILename? 

Instruction This command sets the filename of the equalization equation user file. 

Parameter Type <string>: represents filename. 

Return String 

Default None 

Menu Setup > Adv Waveform > Equalization > File > Load... 

Example :CALC:EQU:FIL "local/equalizer.csv" 

:CALC:EQU:FIL? 

Return: local/equalizer.csv 

3.22.1.6 Hot TDR 

3.22.1.6.1 Command List 
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Avoid Spurious :SENSe:SPURious:AVOid:IMMediate 

Hot TDR State :SENSe:SPURious:STATe? 

Spurious Data Rate :SENSe:SPURious:INPut:DRATe 

Avoid Spurious State :SENSe:SPURious:AVOid:STATe? 

 

3.22.1.6.2 Avoid Spurious 

Command Format :SENSe:SPURious:AVOid:IMMediate 

Instruction This command executes avoid spurious. 

Parameter Type None 

Return None 

Default None 

Menu Setup > Hot TDR > Avoid Spurious 

Example :SENS:SPUR:AVO:IMM 

 

3.22.1.6.3 Hot TDR State 

Command Format :SENSe:SPURious:STATe? 

Instruction This command queries the Hot TDR mode status. 

To turn ON Hot TDR mode, use :SENSe:SPURious:AVOid:IMMediate; 
to turn OFF Hot TDR mode, use :SYSTem:PRESet. 

Parameter Type None 

Return Boolean 

Default OFF 

Menu None 

Example :SENS:SPUR:STAT? 

 

3.22.1.6.4 Spurious Data Rate 
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Command Format :SENSe:SPURious:INPut:DRATe <numeric> 

:SENSe:SPURious:INPut:DRATe? 

Instruction This command sets the value of input bit rate for avoid spurious.  

Parameter Type <numeric>:represents the value of input bit rate for avoid spurious, and 
the parameter range: 20Mb/s~ 2.4Gb/s. 

Return Float, unit: b/s 

Default 1Gb/s 

Menu Setup > Hot TDR > Data Rate 

Example :SENS:SPUR:INP:DRAT 2e9 

:SENS:SPUR:INP:DRAT? 

Return: 2000000000 

 

3.22.1.6.5 Avoid Spurious State 

Command Format :SENSe:SPURious:AVOid:STATe? 

Instruction This command queries the avoid spurious state. This command is ON 
when :SENS:SPURious:AVOid:IMMediate command succeeds. This 
command is OFF when :SENS:SPURious:AVOid:IMMediate command 
fails to find spurious. 

Parameter Type None 

Return Boolean 

Default OFF 

Menu Setup > Hot TDR > Avoid Spurious 

Example :SENS:SPUR:AVO:STAT? 

 

3.22.1.7 Switch Matrix 

3.22.1.7.1 Command list 

Ports Selection :SENSe:SWITch:PORTs 
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3.22.1.7.2 Ports Selection 

Command Format :SENSe:SWITch:PORTs <pnum1>,<pnum2>…,<pnumN> 

:SENSe:SWITch:PORTs? 

Instruction Set or get the TDR expansion ports.  
The number of ports is determined by the topology of the DUT, 

SEND1: The number of ports is 1. 

SEND2|DIF1: The number of ports is 2. 

SEND4|DIF2: The number of ports is 4. 

Parameter Type <pnum1>: Indicates the number of the 1st Port. 

<pnumN>: Indicates the number of the Nth Port. 

Return Data array 

Default Determine based on the topology of the DUT, and the connection 
relationship between the switching matrix and the VNA. 

Menu Setup > Switch Matrix > Ports Selection 

Example :SENSe:SWITch:PORTs 1,2 

:SENSe:SWITch:PORTs? 

Return: 1,2 

 

3.22.2 TDR/TDT 

3.22.2.1 Parameter 

3.22.2.1.1 Command list 

Trace Format :CALCulate:TRACe<tnum>:FORMat 

Time Domain Stimulus Type :CALCulate:TRACe<tnum>:TIME:STIMulus 

Time Domain Window Impulse 
Width 

:CALCulate:TRACe<tnum>:TIME:IMPulse:WIDTh 

Stimulus Rise Time Type :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:THReshold 

Stimulus Rise Time :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:DATA 
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Peeling Enable :CALCulate:TRACe<tnum>:CONVersion:PEELing:STATe 

 

3.22.2.1.2 Trace Format 

Command Format :CALCulate:TRACe<tnum>:FORMat <type> 

:CALCulate:TRACe<tnum>:FORMat? 

Instruction This command sets trace format. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={MLOGarithmic|MLINear|PHASe|GDELay|SCOMplex|POLar 

|SWR|REAL|IMAGinary|UPHase|PPHase|ISMITh|TLOGarithmic|TLINear|
TREAL|IMPedance|VOLT} 

Return Enumeration 

Default Depending on the selected trace. 

Menu TDR/TDT > Parameters > Format 

Example :CALC:TRAC1:FORM VOLT 

:CALC:TRAC1:FORM? 

Return: VOLT 

 

3.22.2.1.3 Time Domain Stimulus Type 

Command Format :CALCulate:TRACe<tnum>:TIME:STIMulus <type> 

:CALCulate:TRACe<tnum>:TIME:STIMulus? 

Instruction This command sets stimulus type for the transform function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={LPSTep|LPIMpulse} 

Return Enumeration 

Default LPSTep 

Menu TDR/TDT > Parameters > Stimulus 
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Example :CALC:TRAC1:TIME:STIM LPIMpulse 

:CALC:TRAC1:TIME:STIM? 

Return: LPIM 

 

3.22.2.1.4 Time Domain Window Impulse Width 

Command Format :CALCulate:TRACe<tnum>:TIME:IMPulse:WIDTh <numeric> 

:CALCulate:TRACe<tnum>:TIME:IMPulse:WIDTh? 

Instruction This command sets/gets the pulse width of the activation trace time 
domain window. 

This command sets/gets the pulse width of the time domain window 
for selecting channel and trace. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the pulse width. 

Return Float, unit s(second) 

Default None 

Menu TDR/TDT > Parameters > Impulse Width 

Example :CALC:TRAC1:TIME:IMP:WIDT 4.7E-11 

:CALC:TRAC1:TIME:IMP:WIDT? 

Return: 7.09810588235294e-11 

 

3.22.2.1.5 Stimulus Rise Time Type 

Command Format :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:THReshold <type> 

:CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:THReshold? 

Instruction This command sets rise time threshold for the transform function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={T1_9|T2_8} 

Return Enumeration 
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Default T1_9 

Menu TDR/TDT > Parameters > Rise Time 

Example :CALC:TRAC1:TIME:STEP:RTIM:THR T2_8 

:CALC:TRAC1:TIME:STEP:RTIM:THR? 

Return: T2_8 

 

3.22.2.1.6 Stimulus Rise Time 

Command Format :CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:DATA <numeric> 

:CALCulate:TRACe<tnum>:TIME:STEP:RTIMe:DATA? 

Instruction This command sets rise time value for the transform function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the rise time value. 

Return Float, unit: s (second) 

Default None 

Menu TDR/TDT > Parameters > Rise Time 

Example :CALC:TRAC1:TIME:STEP:RTIM:DATA 4.7E-11 

:CALC:TRAC1:TIME:STEP:RTIM:DATA? 

Return: 5.24995058823529e-11 

 

3.22.2.1.7 Peeling Enable 

Command Format :CALCulate:TRACe<tnum>:CONVersion:PEELing:STATe <bool> 

:CALCulate:TRACe<tnum>:CONVersion:PEELing:STATe? 

Instruction This command sets state for the peeling function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 
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Default OFF 

Menu TDR/TDT > Parameters > Peeling 

Example :CALC:TRAC1:CONV:PEEL:STAT ON 

:CALC:TRAC1:CONV:PEEL:STAT? 

Return: 1 

 

3.22.2.2 Scale 

3.22.2.2.1 Command List 

Auto Scale All :DISPlay:ATRaces:SCALe:AUTO 

Horizontal Reference Position :DISPlay:ATRaces:SCALe:RPOSition 

Trace X Axis Scale :DISPlay:TRACe<tnum>:X:SCALe:PDIVision 

Trace X Axis Offset :DISPlay:TRACe<tnum>:X:SCALe:RLEVel 

Trace X Axis Auto Scale :DISPlay:TRACe<tnum>:X:SCALe:AUTO 

Trace Y Axis Scale :DISPlay:TRACe<tnum>:Y:SCALe:PDIVision 

Trace Y Axis Offset :DISPlay:TRACe<tnum>:Y:SCALe:RLEVel 

Trace Y Axis Auto Scale :DISPlay:TRACe<tnum>:Y:SCALe:AUTO 

Time Coupling Enable :CALCulate:ATRaces:TIME:COUPle 

 

3.22.2.2.2 Auto Scale All 

Command Format :DISPlay:ATRaces:SCALe:AUTO 

Instruction This command executes auto scale for all traces. 

Parameter Type None 

Return None 

Default None 

Menu TDR/TDT > Auto Scale > All Trace 

Example :DISP:ATR:SCAL:AUTO 
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3.22.2.2.3 Horizontal Reference Position 

Command Format :DISPlay:ATRaces:SCALe:RPOSition <type> 

:DISPlay:ATRaces:SCALe:RPOSition? 

Instruction This command sets x-axis reference position for the time domain 
measurement. 

Parameter Type <type>:={LEFT|CENTer} 

Return Enumeration 

Default LEFT 

Menu TDR/TDT > Horizontal > Reference Position Button 

Example :DISP:ATR:SCAL:RPOSition CENT 

:DISP:ATR:SCAL:RPOSition? 

Return: CENT 

 

3.22.2.2.4 Trace X Axis Scale 

Command Format :DISPlay:TRACe<tnum>:X:SCALe:PDIVision <numeric> 

:DISPlay:TRACe<tnum>:X:SCALe:PDIVision? 

Instruction This command sets value of x-axis scale per division. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the value of x-axis scale per division. 

Return Float, unit: s (second) 

Default None 

Menu TDR/TDT > Horizontal > Scale 

Example :DISP:TRAC1:X:SCAL:PDIV 1E-9 

:DISP:TRAC1:X:SCAL:PDIV? 

Return: 1e-09 

 

3.22.2.2.5 Trace X Axis Offset 
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Command Format :DISPlay:TRACe<tnum>:X:SCALe:RLEVel <numeric> 

:DISPlay:TRACe<tnum>:X:SCALe:RLEVel? 

Instruction This command sets value of x-axis reference line. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the value of x-axis reference line. 

Return Float, unit: s (second) 

Default None 

Menu TDR/TDT > Horizontal > Offset 

Example :DISP:TRAC1:X:SCAL:RLEV 2E-8 

:DISP:TRAC1:X:SCAL:RLEV? 

Return: 2e-08 

 

3.22.2.2.6 Trace X Axis Auto Scale 

Command Format :DISPlay:TRACe<tnum>:X:SCALe:AUTO 

Instruction This command executes x-axis auto scaling. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu TDR/TDT > Auto Scale > X 

Example :DISP:TRAC1:X:SCAL:AUTO 

 

3.22.2.2.7 Trace Y Axis Scale 

Command Format :DISPlay:TRACe<tnum>:Y:SCALe:PDIVision <numeric> 

:DISPlay:TRACe<tnum>:Y:SCALe:PDIVision? 

Instruction This command sets value of y-axis scale per division. 
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Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the value of y-axis scale per division. 

Return Float 

Default None 

Menu TDR/TDT > Vertical > Scale 

Example :DISP:TRAC1:Y:SCAL:PDIV 10 

:DISP:TRAC1:Y:SCAL:PDIV? 

Return: 10 

3.22.2.2.8 Trace Y Axis Offset 

Command Format :DISPlay:TRACe<tnum>:Y:SCALe:RLEVel <numeric> 

:DISPlay:TRACe<tnum>:Y:SCALe:RLEVel? 

Instruction This command sets value of y-axis reference line. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the value of y-axis reference line. 

Return Float 

Default None 

Menu TDR/TDT > Vertical > Offset 

Example :DISP:TRAC1:Y:SCAL:RLEV 20 

:DISP:TRAC1:Y:SCAL:RLEV? 

Return: 20 

 

3.22.2.2.9 Trace Y Axis Auto Scale 

Command Format :DISPlay:TRACe<tnum>:Y:SCALe:AUTO 

Instruction This command executes y-axis auto scaling. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 
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Return None 

Default None 

Menu TDR/TDT > Auto Scale > Y 

Example :DISP:TRAC1:Y:SCAL:AUTO 

 

3.22.2.2.10Time Coupling Enable 

Command Format :CALCulate:ATRaces:TIME:COUPle <bool> 

:CALCulate:ATRaces:TIME:COUPle? 

Instruction This command sets state for the transform couple mode. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu TDR/TDT > Trace Control > Coupling > Time 

Example :CALC:ATR:TIME:COUP OFF 

:CALC:ATR:TIME:COUP? 

Return: 0 

 

3.22.2.3 Marker  

3.22.2.3.1 Command List 

Select Marker :CALCulate:TRACe<tnum>:AMARkers:ACTive 

Reference Marker 
Enable 

:CALCulate:TRACe<tnum>:MARKer<mnum>:REFerence:STATe 

Marker Coupling Enable :CALCulate:ATRaces:MARKer:COUPle 

 

3.22.2.3.2 Select Marker 

Command Format :CALCulate:TRACe<tnum>:AMARkers:ACTive <numeric> 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    519 

:CALCulate:TRACe<tnum>:AMARkers:ACTive? 

Instruction This command sets active marker number. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents active marker number. 

Return Integer 

Default None 

Menu TDR/TDT > Marker 

Example :CALC:TRAC1:AMAR:ACT 3 

:CALC:TRAC1:AMAR:ACT? 

Return: 3 

 

3.22.2.3.3 Reference Marker Enable 

Command Format :CALCulate:TRACe<tnum>:MARKer<mnum>:REFerence:STATe 
<bool> 

:CALCulate:TRACe<tnum>:MARKer<mnum>:REFerence:STATe? 

Instruction This command sets state for the reference marker display. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<mnum>:={[1]-10},represents the marker number. If not specified, 
<mnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu TDR/TDT > Marker > Add Ref 

Example :CALC:TRAC1:MARK1:REF:STAT ON 

:CALC:TRAC1:MARK1:REF:STAT? 

Return: 1 
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3.22.2.3.4 Marker Coupling Enable 

Command Format :CALCulate:ATRaces:MARKer:COUPle <bool> 

:CALCulate:ATRaces:MARKer:COUPle? 

Instruction This command sets state for the marker couple mode. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu TDR/TDT > Trace Control > Coupling > Marker 

Example :CALC:ATR:MARK:COUP OFF 

:CALC:ATR:MARK:COUP? 

Return: 0 

 

3.22.2.4 Search  

3.22.2.4.1 Command List 

Rise Time Search Type :CALCulate:TRACe<tnum>:TTIMe:THReshold 

Rise Time Search Enable :CALCulate:TRACe<tnum>:TTIMe:STATe 

Rise Time Search Result :CALCulate:TRACe<tnum>:TTIMe:DATA? 

Get Delta Time Search Result :CALCulate:TRACe<tnum>:DTIMe:DATA? 

Delta Time Search Position :CALCulate:TRACe<tnum>:DTIMe:POSition 

Delta Time Search Enable :CALCulate:TRACe<tnum>:DTIMe:STATe 

Delta Time Search Target :CALCulate:TRACe<tnum>:DTIMe:TARGet 

 

3.22.2.4.2 Rise Time Search Type 

Command Format :CALCulate:TRACe<tnum>:TTIMe:THReshold <type> 

:CALCulate:TRACe<tnum>:TTIMe:THReshold? 

Instruction This command sets the rise time threshold for the rise time in the 
marker search function. 
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Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={T1_9|T2_8} 

Return Enumeration 

Default T1_9 

Menu TDR/TDT > Marker Search > Rise Time(10-90%)/Rise Time(20-80%) 

Example :CALC:TRAC1:TTIM:THR T2_8 

:CALC:TRAC1:TTIM:THR? 

Return: T2_8 

 

3.22.2.4.3 Rise Time Search Enable 

Command Format :CALCulate:TRACe<tnum>:TTIMe:STATe <bool> 

:CALCulate:TRACe<tnum>:TTIMe:STATe? 

Instruction This command displays the rise time marker. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu TDR/TDT > Marker Search > Rise Time(10-90%)/Rise Time(20-80%) 

Example :CALC:TRAC1:TTIM:STAT ON 

:CALC:TRAC1:TTIM:STAT? 

Return: 1 

 

3.22.2.4.4 Rise Time Search Result 

Command Format :CALCulate:TRACe<tnum>:TTIMe:DATA? 

Instruction This command returns the rise time result value for marker search. You 
can get the data even if Rise Time Search is off. 
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Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: s (second) 

Default None 

Menu None 

Example :CALC:TRAC1:TTIM:DATA? 

 

3.22.2.4.5 Get Delta Time Search Result 

Command Format :CALCulate:TRACe<tnum>:DTIMe:DATA? 

Instruction This command gets delta time result value. You can get the result even 
if Delta Time Search is off. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return Float, unit: s (second) 

Default None 

Menu None 

Example :CALC:TRAC1:DTIM:DATA? 

 

3.22.2.4.6 Delta Time Search Position 

Command Format :CALCulate:TRACe<tnum>:DTIMe:POSition <numeric> 

:CALCulate:TRACe<tnum>:DTIMe:POSition? 

Instruction This command sets delta time reference position. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents delta time reference position, and the 
parameter range: 0 ~ 100. 

Return Float, unit: % 

Default 50 
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Menu TDR/TDT > Srearch > ΔTime... > Position (%) 

Example :CALC:TRAC1:DTIM:POS 20 

:CALC:TRAC1:DTIM:POS? 

Return: 20 

 

3.22.2.4.7 Delta Time Search Enable 

Command Format :CALCulate:TRACe<tnum>:DTIMe:STATe <bool> 

:CALCulate:TRACe<tnum>:DTIMe:STATe? 

Instruction This command displays the delta time marker in the marker search. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu TDR/TDT > Srearch > ΔTime... > ΔTime Enable 

Example :CALC:TRAC1:DTIM:STAT ON 

:CALC:TRAC1:DTIM:STAT? 

Return: 1 

 

3.22.2.4.8 Delta Time Search Target 

Command Format :CALCulate:TRACe<tnum>:DTIMe:TARGet <numeric> 

:CALCulate:TRACe<tnum>:DTIMe:TARGet? 

Instruction This command sets target trace number for the delta time function.  

The <tnum>is the trace number starting point for delta time.  

The <numeric> is the trace number stopping point for delta time. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents target trace number. 
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Return Integer 

Default Depending on the selected trace. 

Menu TDR/TDT > Srearch > ΔTime... > Target(Stop) 

Example :CALC:TRAC1:DTIM:TARG 5 

:CALC:TRAC1:DTIM:TARG? 

Return: 5 

 

3.22.2.5 Gating  

3.22.2.5.1 Command List 

Gating Start :CALCulate:TRACe<tnum>:GATE:STARt 

Gating Stop :CALCulate:TRACe<tnum>:GATE:STOP 

Gating Enable :CALCulate:TRACe<tnum>:GATE:STATe 

Gating Type :CALCulate:TRACe<tnum>:GATE:TYPE 

 

3.22.2.5.2 Gating Start 

Command Format :CALCulate:TRACe<tnum>:GATE:STARt <numeric> 

:CALCulate:TRACe<tnum>:GATE:STARt? 

Instruction This command sets start value for the gating function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the start value for the gating function . 

Return Float, unit: s (second) 

Default None 

Menu TDR/TDT > Gating > Start 

Example :CALC:TRAC1:GATE:STAR 2E-9 

:CALC:TRAC1:GATE:STAR? 

Return: 2e-09 
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3.22.2.5.3 Gating Stop 

Command Format :CALCulate:TRACe<tnum>:GATE:STOP <numeric> 

:CALCulate:TRACe<tnum>:GATE:STOP? 

Instruction This command sets stop value for the gating function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the stop value for the gating function . 

Return Float, unit: s (second) 

Default None 

Menu TDR/TDT > Gating > Stop 

Example :CALC:TRAC1:GATE:STOP 6E-9 

:CALC:TRAC1:GATE:STOP? 

Return: 6e-09 

 

3.22.2.5.4 Gating Enable 

Command Format :CALCulate:TRACe<tnum>:GATE:STATe <bool> 

:CALCulate:TRACe<tnum>:GATE:STATe? 

Instruction This command sets state for the gating function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu TDR/TDT > Gating > Gating 

Example :CALC:TRAC1:GATE:STAT ON 

:CALC:TRAC1:GATE:STAT? 

Return: 1 
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3.22.2.5.5 Gating Type 

Command Format :CALCulate:TRACe<tnum>:GATE:TYPE <type> 

:CALCulate:TRACe<tnum>:GATE:TYPE? 

Instruction This command sets gate type for the gating function. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={BPASs|NOTCh} 

Return Enumeration 

Default BPASs 

Menu TDR/TDT > Gating > Type > Notch/Bandpass 

Example :CALC:TRAC1:GATE:TYPE NOTC 

:CALC:TRAC1:GATE:TYPE? 

Return: NOTC 

 

3.22.2.6 Memory  

3.22.2.6.1 Command List 

Trace Display Type :DISPlay:TRACe<tnum>:DMEMory:TYPE 

 

3.22.2.6.2 Trace Display Type 

Command Format :DISPlay:TRACe<tnum>:DMEMory:TYPE <type> 

:DISPlay:TRACe<tnum>:DMEMory:TYPE? 

Instruction This command sets type of data/memory display. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={OFF|DATA|MEMory|DMEMory} 

Return Enumeration 
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Default DATA 

Menu TDR/TDT > Data/Mem > Off/Data/Memory/Data&Memory 

Example :DISP:TRAC1:DMEM:TYPE DMEMory 

:DISP:TRAC1:DMEM:TYPE? 

Return: DMEM 

 

3.22.2.7 Trace Control 

3.22.2.7.1 Command List 

Trace Count :CALCulate:ATRaces:COUNt? 

Select Trace :CALCulate:ATRaces:ACTive 

Trace Measure Parameter :CALCulate:TRACe<tnum>:PARameter 

Trace Allocation :CALCulate:ALLocate 

Trigger Mode :TRIGger:MODE 

 

3.22.2.7.2 Trace Count 

Command Format :CALCulate:ATRaces:COUNt? 

Instruction This command returns the number of trace. 

Parameter Type None 

Return Integer 

Default Depending on DUT topology setting 

Menu None 

Example :CALC:ATR:COUN? 

 

3.22.2.7.3 Select Trace 

Command Format :CALCulate:ATRaces:ACTive <numeric> 

:CALCulate:ATRaces:ACTive? 
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Instruction This command sets/gets active trace number. 

Parameter Type <numeric>:represents the active trace number. 

Return Integer 

Default None 

Menu TDR/TDT > Trace 

Example :CALC:ATR:ACT 6 

:CALC:ATR:ACT? 

Return: 6 

 

3.22.2.7.4 Trace Measure Parameter 

Command Format :CALCulate:TRACe<tnum>:PARameter <string> 

:CALCulate:TRACe<tnum>:PARameter? 

Instruction This command sets measurement parameter. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<string>:Txy|Tddxy|Tdcxy|Tcdxy|Tccxy|Sxy|Sddxy|Sdcxy|Scdxy|Sccxy
, 

x=1~4, y=1~4 

Return String 

Default Depending on the trace and DUT topology. 

Menu TDR/TDT > Parameter 

Example :CALC:TRAC2:PAR T11 

:CALC:TRAC2:PAR? 

Return: T11 

 

3.22.2.7.5 Trace Allocation 

Command Format :CALCulate:ALLocate <type> 

Instruction This command sets type of the parameter & format allocation for each 
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trace. 

Parameter Type <type>:={SPARameters|TPARameters|MIXed} 

Return None 

Default MIXed 

Menu TDR/TDT > Trace Control > Allocation > Mixed/All T/All S 

Example :CALCulate:ALLocate SPAR 

 

3.22.2.7.6 Trigger Mode 

Command Format :TRIGger:MODE <type> 

:TRIGger:MODE? 

Instruction This command sets/gets trigger mode. 

Parameter Type <type>:={HOLD|SINGle|RUN} 

Return Enumeration 

Default RUN 

Menu TDR/TDT > Run/Stop/Single 

Example :TRIG:MODE HOLD 

:TRIG:MODE? 

Return: HOLD 

 

3.22.2.8 DC 

3.22.2.8.1 Command List 

TDR Auto Extrapolate :CALCulate:TRACe<tnum>:DCSParam:AUTO 

TDR manual Extrapolate value :CALCulate:TRACe<tnum>:DCSParam 

Set TDR Auto Extrapolate to manual 
value 

:CALCulate:TRACe<tnum>:DCSParam:EXTRapolate 

 

3.22.2.8.2 TDR Auto Extrapolate 
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Command Format :CALCulate:TRACe<tnum>:DCSParam:AUTO <bool> 

:CALCulate:TRACe<tnum>:DCSParam:AUTO? 

Instruction sets/gets the TDR automatic DC extrapolation mode. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu TDR/TDT > DC > Auto Extrapolate 

Example :CALCulate:TRACe1:DCSParam:AUTO OFF 

:CALCulate:TRACe1:DCSParam:AUTO? 

Return :0 

3.22.2.8.3 TDR manual Extrapolate value 

Command Format :CALCulate:TRACe<tnum>:DCSParam <numeric> 

:CALCulate:TRACe<tnum>:DCSParam? 

Instruction sets/gets the TDR DC extrapolation mode to manual of selected trace. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>:represents the DC extrapolation value, and the parameter 
range: -1E15~1E15. 

Return Float 

Default 1 

Menu TDR/TDT > DC > Manual Entry 

Example :CALCulate:TRACe1:DCSParam 10 

:CALCulate:TRACe1:DCSParam? 

Return:10 

 

3.22.2.8.4 Set TDR Auto Extrapolate to manual value 
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Command Format :CALCulate:TRACe<tnum>:DCSParam:EXTRapolate 

Instruction Sets the TDR automatic DC extrapolation value to manual value of 
selected trace. 

Parameter Type <tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

Return None 

Default None 

Menu TDR/TDT > DC > Extrapolate 

Example :CALCulate:TRACe1:DCSParam:EXTRapolate 

 

3.22.3 Eye/Mask 

3.22.3.1 Stimulus  

3.22.3.1.1 Command List 

Eye Diagram Display 
Switch 

:CALCulate:EYE:STATe 

Draw Eye Diagram :CALCulate:EYE:EXECute 

Abort Eye Diagram 
Drawing 

:CALCulate:EYE: ABORt 

Bit Pattern Type :CALCulate:EYE:INPut:BPATtern:TYPE 

Load User Bit Pattern :MMEMory:LOAD:EYE:BPATtern 

Bit Pattern Length :CALCulate:EYE:INPut:BPATtern:LENGth 

Input Data Rate :CALCulate:EYE:INPut:DRATe 

Input One Level :CALCulate:EYE:INPut:OLEVel 

Input Zero Level :CALCulate:EYE:INPut:ZLEVel 

Input Rise Time Type :CALCulate:EYE:INPut:RTIMe:THReshold 

Input Rise Time :CALCulate:EYE:INPut:RTIMe:DATA 

Jitter Display Limit :CALCulate:EYE:INPut:JITTer:DLIMit 
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3.22.3.1.2 Eye Diagram Display Switch 

Command Format :CALCulate:EYE:STATe <bool> 

:CALCulate:EYE:STATe? 

Instruction This command displays the EYE/MASK window. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu None 

Example :CALC:EYE:STAT OFF 

:CALC:EYE:STAT? 

 

3.22.3.1.3 Draw Eye Diagram 

Command Format :CALCulate:EYE:EXECute 

Instruction This command performs the calculation for the simulated eye diagram 
for the active trace. 

Parameter Type None 

Return None 

Default None 

Menu Eye/Mask > Trigger > Draw Eye 

Example :CALC:EYE:EXEC 

 

3.22.3.1.4 Abort Eye Diagram Drawing 

Command Format :CALCulate:EYE:ABORt 

Instruction This command aborts the calculation for the simulated eye diagram. 

Parameter Type None 

Return None 
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Default None 

Menu Eye/Mask > Trigger > Abort 

Example :CALC:EYE:ABOR 

 

3.22.3.1.5 Bit Pattern Type 

Command Format :CALCulate:EYE:INPut:BPATtern:TYPE <type> 

:CALCulate:EYE:INPut:BPATtern:TYPE? 

Instruction This command sets the bit pattern type for the simulated eye function. 

Parameter Type <type>:={PRBS|K285|USER|STAT} 

Return Enumeration 

Default PRBS 

Menu Eye/Mask > Stimulus > Type 

Example :CALC:EYE:INP:BPAT:TYPE K285 

:CALC:EYE:INP:BPAT:TYPE? 

Return: K285 

 

3.22.3.1.6 Load User Bit Pattern 

Command Format :MMEMory:LOAD:EYE:BPATtern <string> 

Instruction This command loads the specified user bit pattern file. The extension 
of file should be .txt. 

Parameter Type <string>: represents the specified user bit pattern file(.txt). 

Return None 

Default None 

Menu Eye/Mask > Stimulus > User Pattern > Load 

Example :MMEM:LOAD:EYE:BPAT "local/userbit.txt" 
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3.22.3.1.7 Bit Pattern Length 

Command Format :CALCulate:EYE:INPut:BPATtern:LENGth <numeric> 

:CALCulate:EYE:INPut:BPATtern:LENGth? 

Instruction This command sets bits' power of 2 for PRBS pattern. This value is used 
only when the bit pattern type is selected at PRBS. 

Parameter Type <numeric>:represents the Bit Pattern Length for PRBS pattern, and 
the parameter range: 3, 5, 7, 9, 11, 13, 15. 

Return Discrete 

Default 7 

Menu Eye/Mask > Stimulus > Length 

Example :CALC:EYE:INP:BPAT:LENG 3 

:CALC:EYE:INP:BPAT:LENG? 

Return: 3 

 

3.22.3.1.8 Input Data Rate 

Command Format :CALCulate:EYE:INPut:DRATe <numeric> 

:CALCulate:EYE:INPut:DRATe? 

Instruction This command sets the bit rate for the simulated eye function. 

Parameter Type <numeric>:represents the bit rate, and the parameter range: 100Mb/s 
~ 2.4Gb/s. 

Return Float, unit: b/s (bits/second) 

Default 1Gb/s 

Menu Eye/Mask > Stimulus > Date Rate 

Example :CALC:EYE:INP:DRAT 1.2E9 

:CALC:EYE:INP:DRAT? 

Return: 1200000000 

 

3.22.3.1.9 Input One Level 
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Command Format :CALCulate:EYE:INPut:OLEVel <numeric> 

:CALCulate:EYE:INPut:OLEVel? 

Instruction This command sets the voltage level for bit "1" for the simulated eye 
function. 

Parameter Type <numeric>:represents the voltage level, and the parameter range: -5 
~ 5 V. 

Return Float, unit: V (Voltage) 

Default 0.2V 

Menu Eye/Mask > Stimulus > One Level 

Example :CALC:EYE:INP:OLEV -0.2 

:CALC:EYE:INP:OLEV? 

Return: -0.2 

 

3.22.3.1.10Input Zero Level 

Command Format :CALCulate:EYE:INPut:ZLEVel <numeric> 

:CALCulate:EYE:INPut:ZLEVel? 

Instruction This command sets the voltage level for bit "0" for the simulated eye 
function. 

Parameter Type <numeric>:represents the voltage level, and the parameter range: -5 
~ 5 V. 

Return Float, unit: V (Voltage) 

Default 0 V 

Menu Eye/Mask > Stimulus > Zero Level 

Example :CALC:EYE:INP:ZLEV 0.5 

:CALC:EYE:INP:ZLEV? 

Return: 0.5 

 

3.22.3.1.11Input Rise Time Type 
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Command Format :CALCulate:EYE:INPut:RTIMe:THReshold <type> 

:CALCulate:EYE:INPut:RTIMe:THReshold? 

Instruction This command sets the rise time threshold for the simulated eye. 

Parameter Type <type>:={T1_9|T2_8} 

Return Enumeration 

Default T1_9 

Menu Eye/Mask > Stimulus > Rise Time 

Example :CALC:EYE:INP:RTIM:THR T2_8 

:CALC:EYE:INP:RTIM:THR? 

Return: T2_8 

 

3.22.3.1.12Input Rise Time 

Command Format :CALCulate:EYE:INPut:RTIMe:DATA <numeric> 

:CALCulate:EYE:INPut:RTIMe:DATA? 

Instruction This command sets the rise time value for the simulated eye function. 

Parameter Type <numeric>:represents the rise time value, and the parameter range: 
depending on input data rate. 

Return Float, unit: s (second) 

Default Depending on input data rate. 

Menu Eye/Mask > Stimulus > Rise Time 

Example :CALC:EYE:INP:RTIM:DATA 90e-12 

:CALC:EYE:INP:RTIM:DATA? 

Return: 9e-11 

 

3.22.3.1.13Jitter Display Limit 

Command Format :CALCulate:EYE:INPut:JITTer:DLIMit <numeric> 

:CALCulate:EYE:INPut:JITTer:DLIMit? 
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Instruction This command sets/gets the display limit value. 

Parameter Type <numeric>:represents the display limit value, and the parameter 
range: 0~1. 

Return Float 

Default 1E-8 

Menu Eye/Mask > Advanced Waveform > Jitter > Display Limit 

Example :CALC:EYE:INP:JITT:DLIM 10E-10 

:CALC:EYE:INP:JITT:DLIM? 

Return: 1e-09 

 

3.22.3.2 Result 

3.22.3.2.1 Command List 

Eye Diagram Result Overlay :CALCulate:EYE:RESults:DISPlay:STATe 

Eye Diagram Result Rise Time Type :CALCulate:EYE:RESults:THReshold 

 

3.22.3.2.2 Eye Diagram Result Overlay 

Command Format :CALCulate:EYE:RESults:DISPlay:STATe <bool> 

:CALCulate:EYE:RESults:DISPlay:STATe? 

Instruction This command turns the overlay on/off. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default ON 

Menu Eye/Mask > Resul > Overlay 

Example :CALC:EYE:RES:DISP:STAT OFF 

:CALC:EYE:RES:DISP:STAT? 

Return: 0 
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3.22.3.2.3 Eye Diagram Result Rise Time Type 

Command Format :CALCulate:EYE:RESults:THReshold <type> 

:CALCulate:EYE:RESults:THReshold? 

Instruction This command sets the rise time threshold level for the results of eye 
measurement. 

Parameter Type <type>:={T1_9|T2_8} 

Return Enumeration 

Default T1_9 

Menu Eye/Mask > Resul > Rise Time Def 

Example :CALC:EYE:RES:THR T2_8 

:CALC:EYE:RES:THR? 

Return: T2_8 

 

3.22.3.3 Scale 

3.22.3.3.1 Command List 

Eye Diagram Scale Auto :DISPlay:EYE:Y:SCALe:AUTO 

Eye Diagram Scale Manual :DISPlay:EYE:Y:SCALe:MANual 

Eye Diagram Scale :DISPlay:EYE:Y:SCALe:PDIVision 

Eye Diagram Offset :DISPlay:EYE:Y:SCALe:RLEVel 

Mask Test Enable :CALCulate:EYE:MASK:STATe 

Mask Test Result :CALCulate:EYE:MASK:FAIL? 

Eye Diagram Result Data :CALCulate:EYE:RESults:DATA? 

Load User Mask Pattern :MMEMory:LOAD:EYE:MASK 

 

3.22.3.3.2 Eye Diagram Scale Auto 

Command Format :DISPlay:EYE:Y:SCALe:AUTO 

Instruction This command executes Y axis auto scaling for eye diagram. 
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Parameter Type None 

Return None 

Default None 

Menu Eye/Mask > Scale/Mask > Auto Scale 

Example :DISP:EYE:Y:SCAL:AUTO 

 

3.22.3.3.3 Eye Diagram Scale Manual 

Command Format :DISPlay:EYE:Y:SCALe:MANual 

Instruction This command changes the eye diagram scaling to manual mode. 
This command should be executed before 
the :DISPlay:EYE:Y:SCALe:PDIVision or :DISPlay:EYE:Y:SCALe:RLEVel 
commands are sent. 

Parameter Type None 

Return None 

Default None 

Menu Eye/Mask > Scale/Mask > Manual 

Example :DISP:EYE:Y:SCAL:MAN 

 

3.22.3.3.4 Eye Diagram Scale 

Command Format :DISPlay:EYE:Y:SCALe:PDIVision <numeric> 

:DISPlay:EYE:Y:SCALe:PDIVision? 

Instruction This command sets value of y-axis scale per division for eye diagram. 
The scale mode should be set at manual by the  
:DISPlay:EYE:Y:SCALe:MANual before this command is executed. 

Parameter Type <numeric>:represents the value of y-axis scale. 

Return Float, unit: V (Voltage) 

Default 133mV 
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Menu Eye/Mask > Scale/Mask > Scale/Div 

Example :DISP:EYE:Y:SCAL:PDIV 300E-03 

:DISP:EYE:Y:SCAL:PDIV? 

Return: 0.3 

 

3.22.3.3.5 Eye Diagram Offset 

Command Format :DISPlay:EYE:Y:SCALe:RLEVel <numeric> 

:DISPlay:EYE:Y:SCALe:RLEVel? 

Instruction This command sets value of eye diagram y-axis reference line. The 
scale mode should be set at manual by 
the :DISPlay:EYE:Y:SCALe:MANual before this command is executed. 

Parameter Type <numeric>:represents the value of eye diagram y-axis reference line. 

Return Float, unit: V (Voltage) 

Default 0 

Menu Eye/Mask > Scale/Mask > Offset 

Example :DISP:EYE:Y:SCAL:RLEV 0.5 

:DISP:EYE:Y:SCAL:RLEV? 

Return: 0.5 

 

3.22.3.3.6 Mask Test Enable 

Command Format :CALCulate:EYE:MASK:STATe <bool> 

:CALCulate:EYE:MASK:STATe? 

Instruction This command sets mask test with simulated eye on/off. 

Parameter Type <bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Eye/Mask > Scale/Mask > Mask Test 
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Example :CALC:EYE:MASK:STAT ON 

:CALC:EYE:MASK:STAT? 

Return: 1 

 

3.22.3.3.7 Mask Test Result 

Command Format :CALCulate:EYE:MASK:FAIL? 

Instruction This command returns the mask test result. 

Parameter Type None 

Return Boolean 

Default None 

Menu None 

Example :CALC:EYE:MASK:FAIL? 

3.22.3.3.8 Eye Diagram Result Data 

Command Format :CALCulate:EYE:RESults:DATA? 

Instruction This command returns the results of eye measurement. The 18 values 
are returned. The minimum and maximum values are returned in 
addition of the displayed results (16 values) on the TDR application GUI. 

Parameter Type None 

Return String 

Default None 

Menu Eye/Mask > Result 

Example :CALC:EYE:RES:DATA? 

 

3.22.3.3.9 Load User Mask Pattern 

Command Format :MMEMory:LOAD:EYE:MASK <string> 

Instruction This command loads eye-mask file. The extension of file should 
be .msk. The MASK pattern editing is not available through the 
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command. 

Parameter Type <string>: represents file name of eye mask (.msk). 

Return None 

Default None 

Menu Eye/Mask > Scale/Mask > Mask Pattern > Use User-defined mask 
files > Load 

Example :MMEM:LOAD:EYE:MASK "local/usermask.msk" 

 

3.23 CAT Commands(Only support SHN900A series models) 

 

3.23.1 Command List 

Start Frequency :SENSe<cnum>:CAT:FREQuency:STARt 

Stop Frequency :SENSe<cnum>:CAT:FREQuency:STOP 

Start Distance :CALCulate<cnum>:CAT:TRANsform:DISTance:STARt 

Stop Distance :CALCulate<cnum>:CAT:TRANsform:DISTance:STOP 

Unit Type :CALCulate<cnum>:CAT:TRANsform:DISTance:UNIT 

Coax Loss :SENSe<cnum>:CAT:CORRection:LOSS:COAX 

TDT Stimulus Type :CALCulate<cnum>:TRACe<tnum>:CAT:TRANsform:STIMulus:TYPE 

TDT Window Type :CALCulate<cnum>:TRACe<tnum>:DTF:TRANsform:WINDow 

Kaiser Beta :CALCulate<cnum>:TRACe<tnum>:CAT:WINDow:BETA 

TDT Gate Start Distance :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STARt 

TDT Gate Stop Distance :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STOP 

 

3.23.2 Start Frequency 

Command Format :SENSe<cnum>:CAT:FREQuency:STARt <numeric> 

:SENSe<cnum>:CAT:FREQuency:STARt? 

Instruction This command sets or gets the starting frequency of the selected 
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channel in CAT mode 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the start frequency. 

Return Float, Unit Hz. 

Default 1MHz 

Menu Frequency/Distance > Start Frequency 

Example :SENSe1:CAT:FREQuency:STARt 100e3 

:SENSe1:CAT:FREQuency:STARt? 

Return: 100000 

 

3.23.3 Stop Frequency 

Command Format :SENSe<cnum>:CAT:FREQuency:STOP <numeric> 

:SENSe<cnum>:CAT:FREQuency:STOP? 

Instruction This command sets or gets the starting frequency of the selected 
channel in CAT mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the stop frequency. 

Return Float, Unit Hz. 

Default 200MHz 

Menu Frequency/Distance > Stop Frequency 

Example :SENSe1:CAT:FREQuency:STOP 1e9 

:SENSe1:CAT:FREQuency:STOP? 

Return: 1000000000 

 

3.23.4 Start Distance 

Command Format :CALCulate<cnum>:CAT:TRANsform:DISTance:STARt <numeric> 



VNA Series Programming Guide 

544                                                                                                                                                                                    int.siglent.com 

:CALCulate<cnum>:CAT:TRANsform:DISTance:STARt? 

Instruction This command sets or gets the starting distance of the DTF/TDR 

measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the start distance, the range is zero to max 
measure distance. 

Return Float 

Default 0 m 

Menu Frequency/Distance > Start Distance 

Example :CALCulate1:CAT:TRANsform:DISTance:STARt 1.26 

:CALCulate1:CAT:TRANsform:DISTance:STARt? 

Return: 1.26 

 

 

 

3.23.5 Stop Distance 

Command Format :CALCulate<cnum>:CAT:TRANsform:DISTance:STOP <numeric> 

:CALCulate<cnum>:CAT:TRANsform:DISTance:STOP? 

Instruction This command sets or gets the stopping distance of the DTF/TDR 

measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the stop distance, the range is zero to max 
measure distance. 

Return Float 

Default 100 m 

Menu Frequency/Distance > Stop Distance 
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Example :CALCulate1:CAT:TRANsform:DISTance:STOP 3.26 

:CALCulate1:CAT:TRANsform:DISTance:STOP? 

Return: 3.26 

 

3.23.6 Unit Type 

Command Format :CALCulate<cnum>:CAT:TRANsform:DISTance:UNIT <type> 

:CALCulate<cnum>:CAT:TRANsform:DISTance:UNIT? 

Instruction This command sets or gets the unit of the DTF/TDR distance 

measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={METer|FEET|INCH}. 

Return Enum 

Default METer 

Menu Frequency/Distance > Unit 

Example :CALCulate1:CAT:TRANsform:DISTance:UNIT FEET 

:CALCulate1:CAT:TRANsform:DISTance:UNIT? 

Return: FEET 

 

 

3.23.7 Coax Loss 

Command Format :SENSe<cnum>:CAT:CORRection:LOSS:COAX <numeric> 

:SENSe<cnum>:CAT:CORRection:LOSS:COAX? 

Instruction This command sets or gets the coax loss of the DTF/TDR 

measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>:represents the coax loss, the unit is dB/m. 
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Return Float, Unit dB/m 

Default 0dB/m 

Menu Meas > Meas Setup > Coax Loss 

Example :SENSe1:CAT:CORRection:LOSS:COAX 1.5 

:SENSe1:CAT:CORRection:LOSS:COAX? 

Return: 1.5 

 

3.23.8 TDT Stimulus Type 

Command Format :CALCulate<cnum>:TRACe<tnum>:CAT:TRANsform:STIMulus:TYPE  
<type> 

:CALCulate<cnum>:TRACe<tnum>:CAT:TRANsform:STIMulus:TYPE? 

Instruction This command sets or gets the stimulus type of the DTF/TDR 

measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={BPASs|LPASs}. 

Return Enum 

Default LPASs 

Menu Meas > Meas Setup > Stimulus Type 

Example :CALCulate1:TRACe1:CAT:TRANsform:STIMulus:TYPE BPASs 

:CALCulate1:TRACe1:CAT:TRANsform:STIMulus:TYPE? 

Return: BPAS 

 

3.23.9 TDT Window Type 

Command Format :CALCulate<cnum>:TRACe<tnum>:DTF:TRANsform:WINDow 
<type> 
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:CALCulate<cnum>:TRACe<tnum>:DTF:TRANsform:WINDow? 

Instruction This command sets or gets the window type of the DTF/TDR 

measurement. 

Note: Only in bandpass mode can the window type be customized. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<type>:={OFF|KAISer|HAMMing}. 

Return Enum 

Default OFF 

Menu Meas > Distance to Fault > Meas Setup> DTF window 

Example :CALCulate1:TRACe1:DTF:TRANsform:WINDow HAMMing 

:CALCulate1:TRACe1:DTF:TRANsform:WINDow? 

Return: HAMM 

 

3.23.10 Kaiser Beta 

Command Format :CALCulate<cnum>:TRACe<tnum>:CAT:WINDow:BETA <numeric> 

:CALCulate<cnum>:TRACe<tnum>:CAT:WINDow:BETA? 

Instruction This command sets or gets the kaiser beta value of the DTF/TDR 

measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>: represents the kaiser beta value, the range is zero to 
thirteen. 

Return Float 

Default 6 

Menu Meas > Distance to Fault > Meas Setup> Kaiser Beta 
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Example :CALCulate1:TRACe1:CAT:WINDow:BETA 3.4 

:CALCulate1:TRACe1:CAT:WINDow:BETA? 

Return: 3.4 

 

3.23.11 TDT Gate Start Distance 

 

Command Format :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STARt 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STARt? 

Instruction This command sets or gets the time domain function of TDR 

measurement to select the starting distance. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>: represents the gate start distance, the range is zero to max 
measure distance. 

Return Float 

Default 0 m 

Menu Meas > TDR > Meas Setup > Time Domain > Start 

Example :CALCulate1:TRACe1:TDR:GATE:DISTance:STARt 2.0 

:CALCulate1:TRACe1:TDR:GATE:DISTance:STARt? 

Return: 2 

 

3.23.12 TDT Gate Stop Distance 

Command Format :CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STOP 
<numeric> 

:CALCulate<cnum>:TRACe<tnum>:TDR:GATE:DISTance:STOP? 

Instruction This command sets or gets the time domain function of TDR 
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measurement to select the stopping distance. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<tnum>:={[1]-256}, represents the measurement trace number. If not 
specified, <tnum> defaults to 1. 

<numeric>: represents the gate stop distance, the range is zero to max 
measure distance. 

Return Float 

Default 100 m 

Menu Meas > TDR > Meas Setup > Time Domain > Stop 

Example :CALCulate1:TRACe1:TDR:GATE:DISTance:STOP 51.2 

:CALCulate1:TRACe1:TDR:GATE:DISTance:STOP? 

Return: 51.2 

 

3.24 Material Measurement Commands(Option) 

3.24.1 Command List 

Height of Sample :CALCulate<cnum>:MATerial:SAMPle:HEIGht 

Length of Sample :CALCulate<cnum>:MATerial:SAMPle:LENGth 

Distance from Sample to 
Calibration Plane 

:CALCulate<cnum>:MATerial:DISTance 

Initializing Waveguide Params :CALCulate<cnum>:MATerial:WAVeguide:INIt 

Query Waveguide Information :CALCulate<cnum>:MATerial:WAVeguide:CATalog? 

Height of Waveguide :CALCulate<cnum>:MATerial:WAVeguide:HEIGht 

Width of Waveguide :CALCulate<cnum>:MATerial:WAVeguide:WIDTh 

Length of Waveguide :CALCulate<cnum>:MATerial:WAVeguide:LENGth 

Air Gap Correction :CALCulate<cnum>:MATerial:GAP:CORRection 

Measurement Model :CALCulate<cnum>:MATerial:MODel 

Calculate Type :CALCulate<cnum>:MATerial:DIRection 

Estimation of Permittivity :CALCulate<cnum>:MATerial:ESTimate:EPSilon 

Port for Material Measurement :SENSe<cnum>:MATerial:PMAP 
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3.24.2 Height of Sample 

Command Format :CALCulate<cnum>:MATerial:SAMPle:HEIGht <numeric> 

:CALCulate<cnum>:MATerial:SAMPle:HEIGht? 

Instruction This command set or get the sample height of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the height of sample. 

Return Float, unit:m 

Default 0m 

Menu Meas > Meas Setup >  Meas Setup > Waveguide Gap Correction >  

Small Width Of Sample  

Example :CALCulate1:MATerial:SAMPle:HEIGht 3 

:CALCulate1:MATerial:SAMPle:HEIGht? 

 Return: 3 

 

3.24.3 Length of Sample 

Command Format :CALCulate<cnum>:MATerial:SAMPle:LENGth <numeric> 

:CALCulate<cnum>:MATerial:SAMPle:LENGth? 

Instruction This command set or get the sample length of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the length of sample. 

Return Float, unit:m 

Default 10mm 

Menu Meas > Meas Setup >  Meas Setup > Sample Holder > Sample 
Thickness 
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Example :CALCulate1:MATerial:SAMPle:LENGth 0.05  

:CALCulate1:MATerial:SAMPle:LENGth? 

Return: 0.05 

 

3.24.4 Distance from Sample to Calibration Plane 

Command Format :CALCulate<cnum>:MATerial:DISTance <numeric> 

:CALCulate<cnum>:MATerial:DISTance? 

Instruction This command set or get the distance from sample to calibration plane 
of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the distance from sample to calibration plane. 

Return Float, unit:m 

Default 0m 

Menu Meas > Meas Setup >  Meas Setup > Sample Holder > Distance To 
Sample 

Example :CALCulate1:MATerial:DISTance 0.7 

:CALCulate1:MATerial:DISTance? 

Return: 0.7 

 

3.24.5 Initializing Waveguide Params 

Command Format :CALCulate<cnum>:MATerial:WAVeguide:INIt <type> 

Instruction Initialize waveguide related parameters according to the waveguide 
type, and the initialized parameters include: Start Freq, Stop Freq, 
Cutoff Frequency, Waveguide Width and Small Width Of Waveguide. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={X|P|K|Q|R|U|V|W} 

Return Enumeration 



VNA Series Programming Guide 

552                                                                                                                                                                                    int.siglent.com 

Default None 

Menu Meas > Meas Setup >  Meas Setup > Preset > Lookup… > Lookup Table 

Example :CALCulate1:MATerial:WAVeguide:INIt X 

 

3.24.6 Query Waveguide Information 

Command Format :CALCulate<cnum>:MATerial:WAVeguide:CATalog? 

Instruction Query all waveguide information saved by material measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return String 

Default "X,P,K,R,Q,U,V,W" 

Menu Meas > Meas Setup >  Meas Setup > Preset > Lookup… > Lookup Table 

Example :CALCulate1:MATerial:WAVeguide:CATalog? 

Return: "X,P,K,R,Q,U,V,W" 

 

3.24.7 Height of Waveguide 

Command Format :CALCulate<cnum>:MATerial:WAVeguide:HEIGht <numeric> 

:CALCulate<cnum>:MATerial:WAVeguide:HEIGht? 

Instruction This command set or get the waveguide height of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the height of waveguide. 

Return Float, unit:m 

Default 0m 

Menu Meas > Meas Setup >  Meas Setup > Waveguide Gap Correction >  

Small Width Of Waveguide 

Example :CALCulate1:MATerial:WAVeguide:HEIGht 0.1 
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:CALCulate1:MATerial:WAVeguide:HEIGht? 

Return: 0.1 

 

3.24.8 Width of Waveguide 

Command Format :CALCulate<cnum>:MATerial:WAVeguide:WIDTh <numeric> 

:CALCulate<cnum>:MATerial:WAVeguide:WIDTh? 

Instruction This command set or get the waveguide width of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the width of waveguide. 

Return Float, unit:m 

Default 20mm 

Menu Meas > Meas Setup >  Meas Setup >Sample Holder > Waveguide >  

Waveguide Width 

Example :CALCulate1:MATerial:WAVeguide:WIDTh 0.3 

:CALCulate1:MATerial:WAVeguide:WIDTh? 

Return: 0.3 

 

3.24.9 Length of Waveguide 

Command Format :CALCulate<cnum>:MATerial:WAVeguide:LENGth <numeric> 

:CALCulate<cnum>:MATerial:WAVeguide:LENGth? 

Instruction This command set or get the waveguide length of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric>:represents the length of waveguide. 

Return Float, unit:m 

Default 100mm 

Menu Meas > Meas Setup > Meas Setup > Sample Holder > Sample Holder  
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Length 

Example :CALCulate1:MATerial:WAVeguide:LENGth 0.4 

:CALCulate1:MATerial:WAVeguide:LENGth? 

Return: 0.4 

 

3.24.10 Air Gap Correction 

Command Format :CALCulate<cnum>:MATerial:GAP:CORRection <bool> 

:CALCulate<cnum>:MATerial:GAP:CORRection? 

Instruction This command set or get the waveguide air gap correction status of the 
selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default 0 

Menu Meas > Meas Setup > Meas Setup >  Waveguide Gap Correction >  

Correction On 

Example :CALCulate1:MATerial:GAP:CORRection ON 

:CALCulate1:MATerial:GAP:CORRection? 

Return: 1 

 

3.24.11 Measurement Model 

Command Format :CALCulate<cnum>:MATerial:MODel <type> 

:CALCulate<cnum>:MATerial:MODel? 

Instruction This command set or get the measurement model of the selected 
channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={NRW|NIST|FNRW} 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    555 

Return Enumeration 

Default NIST 

Menu Meas > Meas Setup > Meas Setup > Measurement Model > 

Measurement Model 

Example :CALCulate1:MATerial:MODel NRW 

:CALCulate1:MATerial:MODel? 

Return: NRW 

 

3.24.12 Calculate Type 

Command Format :CALCulate<cnum>:MATerial:DIRection <type> 

:CALCulate<cnum>:MATerial:DIRection? 

Instruction This command set or get the calculate type of the selected channel. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<type>:={AVG|FWD|REV} 

Return Enumeration 

Default AVG 

Menu Meas > Meas Setup > Meas Setup > Measurement Model > 

Calculate Type 

Example :CALCulate1:MATerial:DIRection FWD 

:CALCulate1:MATerial:DIRection? 

Return: FWD 

 

3.24.13 Estimation of Permittivity 

Command Format :CALCulate<cnum>:MATerial:ESTimate:EPSilon<numeric1>, 

<numeric2> 

:CALCulate<cnum>:MATerial:ESTimate:EPSilon? 

Instruction When the measurement model is Ref/Tran ε Precision, set or get an 
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estimated value of the permittivity. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<numeric1>:represents the real part value of the permittivity, float 
type. 

<numeric2>:represents the imaginary part value of the permittivity, 
float type. 

Return Data array 

Default 1,0 

Menu Meas > Meas Setup > Meas Setup > Measurement Model >  

Ref/Tran ε Precision > Permittivity 

Example :CALCulate1:MATerial:ESTimate:EPSilon 3,4 

:CALCulate1:MATerial:ESTimate:EPSilon? 

Return: 3.000000000000e+00,4.000000000000e+00 

 

3.24.14 Port for Material Measurement 

Command Format :SENSe<cnum>:MATerial:PMAP <pnum1>,<pnum2> 

:SENSe<cnum>:MATerial:PMAP? 

Instruction This command set or get the forward and reverse ports for material 
measurement. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<pnum1>:={1|2|3|4},represents 1st Port. 

<pnum2>:={1|2|3|4},represents 2nd Port. 

<pnum1> and <pnum2> cannot be the same. 

Return Data array 

Default 1,2 

Menu Meas > Meas Setup > Meas Setup > Preset > Select Ports 

Example :SENSe1:MATerial:PMAP 3,2 

:SENSe1:MATerial:PMAP? 



VNA Series Programming Guide 

int.siglent.com                                                                                                                                                                                    557 

Return: 3,2 

 

 

3.25 Gain Compression Commands(Option, SHN900A series models do 

not support) 

3.25.1 Frequency 

3.25.1.1 Command List 

Data Acquisition Mode :SENSe<cnum>:GCSetup:AMODe 

Frequency Points :SENSe<cnum>:GCSetup:SWEep:FREQuency:POINts 

 

3.25.1.2 Data Acquisition Mode 

Command Format :SENSe<cnum>:GCSetup:AMODe <type> 

:SENSe<cnum>:GCSetup:AMODe? 

Instruction Set and read the method by which gain compression data is acquired. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={SMARtsweep|FPOWer|PFREQuency} 

SMARtsweep: Smart Sweep 

FPOWer: Sweep Frequency Per Power 

PFREQuency: Sweep Power Per Frequency 

Return Enumeration 

Default SMARtsweep 

Menu Sweep > GC Setup... > Frequency > Data Acquisition Mode 

Example :SENS:GCS:AMOD FPOW 

:SENS:GCS:AMOD? 

Return: FPOW 
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3.25.1.3 Frequency Points 

Command Format :SENSe<cnum>:GCSetup:SWEep:FREQuency:POINts <numeric> 

:SENSe<cnum>:GCSetup:SWEep:FREQuency:POINts? 

Instruction Set and read the number of data points in each frequency sweep. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Frequency points. Do not exceed the max number of data 
points. 

Return Integer 

Default 201 

Menu Sweep > GC Setup... > Frequency > Frequency Setting >  Frequency 
Points 

Example :SENS:GCS:SWE:FREQ:POIN 10 

:SENS:GCS:SWE:FREQ:POIN? 

Return: 10 

 

3.25.2 Power 

3.25.2.1 Command List 

DUT Port Map :SENSe<cnum>:GCSetup:PMAP 

DUT Input Port Query :SENSe<cnum>:GCSetup:PMAP:INPut? 

DUT Output Port Query :SENSe<cnum>:GCSetup:PMAP:OUTPut? 

Linear Input Power :SENSe<cnum>:GCSetup:POWer:LINear:INPut:LEVel 

Reverse Power :SENSe<cnum>:GCSetup:POWer:REVerse:LEVel 

Power Points :SENSe<cnum>:GCSetup:SWEep:POWer:POINts 

Start Power :SENSe<cnum>:GCSetup:POWer:STARt:LEVel 

Stop Power :SENSe<cnum>:GCSetup:POWer:STOP:LEVel 

 

3.25.2.2 DUT Port Map 

Command Format :SENSe<cnum>:GCSetup:PMAP <pnum1>,<pnum2> 
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Instruction This command sets the VNA to DUT port map for the GC 
measurements. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

<pnum1>: SNA port to connect to the DUT input. 

<pnum2>: SNA port to connect to the DUT output. 

Return None 

Default 1,2 

Menu Sweep > GC Setup... > Power > Port Setting >  Input Port / Output Port 

Example :SENS:GCS:PMAP 2,1 

 

3.25.2.3 DUT Input Port Query 

Command Format :SENSe<cnum>:GCSetup:PMAP:INPut? 

Instruction This command gets the SNA port that is mapped to the DUT input. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 

Return Integer. Input port number. 

Default 1 

Menu Sweep > GC Setup... > Power > Port Setting >  Input Port 

Example :SENS:GCS:PMAP:INP? 

Return: 1 

 

3.25.2.4 DUT Output Port Query 

Command Format :SENSe<cnum>:GCSetup:PMAP:OUTPut? 

Instruction This command gets the SNA port that is mapped to the DUT output. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum>defaults to 1. 
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Return Integer. Output port number. 

Default 2 

Menu Sweep > GC Setup... > Power > Port Setting >  Output Port 

Example :SENS:GCS:PMAP:OUTP? 

Return: 2 

 

3.25.2.5 Linear Input Power 

Command Format :SENSe<cnum>:GCSetup:POWer:LINear:INPut:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:LINear:INPut:LEVel? 

Instruction Set and read the input power at which Linear Gain and all S-parameters 
are measured. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Input power level in dBm. Choose a value from +20 to (-
20). 

Return Float 

Default -20, unit: dBm 

Menu Sweep > GC Setup... > Power > Port Setting >  Linear Input Power  

Example :SENS:GCS:POW:LIN:INP:LEV 0 

:SENS:GCS:POW:LIN:INP:LEV? 

Return: 0 

 

3.25.2.6 Reverse Power 

Command Format :SENSe<cnum>:GCSetup:POWer:REVerse:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:REVerse:LEVel? 

Instruction Set and read the reverse power level to the DUT. This is applied to the 
DUT output port when making reverse measurements like S22. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Reverse power level in dBm. Choose a value from +20 to (-
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20). 

Return Float 

Default -20, unit: dBm 

Menu Sweep > GC Setup... > Power > Port Setting >  Reverse Output Power  

Example :SENS:GCS:POW:REV:LEV 0 

:SENS:GCS:POW:REV:LEV? 

Return: 0 

 

3.25.2.7 Power Points 

Command Format :SENSe<cnum>:GCSetup:SWEep:POWer:POINts <numeric> 

:SENSe<cnum>:GCSetup:SWEep:POWer:POINts? 

Instruction Set and read the number of data points in each power sweep. Applies 
ONLY to 2D acquisition modes. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Power points. Do not exceed the max number of data 
points. 

Return Integer 

Default 21 

Menu Sweep > GC Setup... > Power > Power Setting > Power Points  

Example :SENS:GCS:SWE:POW:POIN 10 

:SENS:GCS:SWE:POW:POIN? 

Return: 10 

 

3.25.2.8 Start Power 

Command Format :SENSe<cnum>:GCSetup:POWer:STARt:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:STARt:LEVel? 

Instruction Set and read the start power level. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Start power level in dBm. Choose a value from +20 to (-
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20). 

Return Float 

Default -10, unit: dBm 

Menu Sweep > GC Setup... > Power > Power Setting > Start(Min) Power  

Example :SENS:GCS:POW:STAR:LEV 0 

:SENS:GCS:POW:STAR:LEV? 

Return: 0 

 

3.25.2.9 Stop Power 

Command Format :SENSe<cnum>:GCSetup:POWer:STOP:LEVel <numeric> 

:SENSe<cnum>:GCSetup:POWer:STOP:LEVel? 

Instruction Set and read the stop power level. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Stop power level in dBm. Choose a value from +20 to (-20). 

Return Float 

Default 0, unit: dBm 

Menu Sweep > GC Setup... > Power > Power Setting > Stop(Max) Power  

Example :SENS:GCS:POW:STOP:LEV 0 

:SENS:GCS:POW:STOP:LEV? 

Return: 0 

 

3.25.3 Comression 

3.25.3.1 Command List 

Compression Method :SENSe<cnum>:GCSetup:COMPression:ALGorithm 

Back Off Level :SENSe<cnum>:GCSetup:COMPression:BACKoff:LEVel 

Delta X :SENSe<cnum>:GCSetup:COMPression:DELTa:X 

Delta Y :SENSe<cnum>:GCSetup:COMPression:DELTa:Y 

Interpolation State :SENSe<cnum>:GCSetup:COMPression:INTerpolation 
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Comression Level :SENSe<cnum>:GCSetup:COMPression:LEVel 

Saturation Compression Level :SENSe<cnum>:GCSetup:COMPression:SATuration:LEVel 

End of Condition :SENSe<cnum>:GCSetup:EOSoperation 

Safe Mode State :SENSe<cnum>:GCSetup:SAFE:ENABle 

Coarse Increment :SENSe<cnum>:GCSetup:SAFE:CPADjustment 

Fine Increment :SENSe<cnum>:GCSetup:SAFE:FPADjustment 

Fine Threshold :SENSe<cnum>:GCSetup:SAFE:FTHReshold 

Max Output Power :SENSe<cnum>:GCSetup:SAFE:MLimit 

Maximum Iterations :SENSe<cnum>:GCSetup:SMARt:MITerations 

Show Iterations State :SENSe<cnum>:GCSetup:SMARt:SITerations 

Settling Time :SENSe<cnum>:GCSetup:SMARt:STIMe 

Tolerance :SENSe<cnum>:GCSetup:SMARt:TOLerance 

 

3.25.3.2 Compression Method 

Command Format :SENSe<cnum>:GCSetup:COMPression:ALGorithm <type> 

:SENSe<cnum>:GCSetup:COMPression:ALGorithm? 

Instruction Set and read the algorithm method used to compute gain 
compression. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={CFLG|CFMG|BACKoff|XYCOM|SAT} 

CFLG: Compression from Linear Gain 

CFMG: Compression from Maximum Gain 

BACKoff: Compression from BackOff 

XYCOM: X/Y Compression 

SAT: Compression from Saturation 

Return Enumeration 

Default CFLG 

Menu Sweep > GC Setup... > Compression > Compression Method  

Example :SENS:GCS:COMP:ALG XYCOM 

:SENS:GCS:COMP:ALG? 
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Return: XYCOM 

 

3.25.3.3 Back Off Level 

Command Format :SENSe<cnum>:GCSetup:COMPression:BACKoff:LEVel <numeric> 

:SENSe<cnum>:GCSetup:COMPression:BACKoff:LEVel? 

Instruction Set and read value for the BackOff compression algorithm. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Backoff value in dB. Choose from 0.01 to 20 

Return Float 

Default 10, unit: dB 

Menu Sweep > GC Setup... > Compression > Compression Method > Back 
Off  

Example :SENS:GCS:COMP:BACK:LEVEL 10 

:SENS:GCS:COMP:BACK:LEVEL? 

Return: 10 

 

3.25.3.4 Delta X 

Command Format :SENSe<cnum>:GCSetup:COMPression:DELTa:X <numeric> 

:SENSe<cnum>:GCSetup:COMPression:DELTa:X? 

Instruction Set and read the 'X" value in the delta X/Y compression algorithm. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: X value in dB. Choose from 0.01 to 20 

Return Float 

Default 10, unit: dB 

Menu Sweep > GC Setup... > Compression > Compression Method > Delta X  

Example :SENS:GCS:COMP:DELT:X 10 

:SENS:GCS:COMP:DELT:X? 

Return: 10 
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3.25.3.5 Delta Y 

Command Format :SENSe<cnum>:GCSetup:COMPression:DELTa:Y <numeric> 

:SENSe<cnum>:GCSetup:COMPression:DELTa:Y? 

Instruction Set and read the 'Y" value in the delta X/Y compression algorithm. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Y value in dB. Choose from 0.01 to 20 

Return Float 

Default 9, unit: dB 

Menu Sweep > GC Setup... > Compression > Compression Method > Delta Y  

Example :SENS:GCS:COMP:DELT:Y 9 

:SENS:GCS:COMP:DELT:Y? 

Return: 9 

 

3.25.3.6 Interpolation State 

Command Format :SENSe<cnum>:GCSetup:COMPression:INTerpolation <bool> 

:SENSe<cnum>:GCSetup:COMPression:INTerpolation? 

Instruction Sets whether or not interpolation should be performed on 2D 
measured compression data. Applies ONLY to 2D acquisition modes. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > GC Setup... > Compression > 2D Sweep > Compression Point 
Interpolation  

Example :SENS:GCS:COMP:INT 1 

:SENS:GCS:COMP:INT? 

Return: 1 
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3.25.3.7 Comression Level 

Command Format :SENSe<cnum>:GCSetup:COMPression:LEVel <numeric> 

:SENSe<cnum>:GCSetup:COMPression:LEVel? 

Instruction Set and read the desired gain reduction (from reference gain).This 
value is used for Compression from Linear Gain and Compression from 
Maximum Gain. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Compression level in dB.  Choose a value greater than 0.1 
dB. 

Return Float 

Default 1, unit: dB 

Menu Sweep > GC Setup... > Compression > Compression Method > Level  

Example :SENS:GCS:COMP:LEV 1 

:SENS:GCS:COMP:LEV? 

Return: 1 

 

3.25.3.8 Saturation Compression Level 

Command Format :SENSe<cnum>:GCSetup:COMPression:SATuration:LEVel <numeric> 

:SENSe<cnum>:GCSetup:COMPression:SATuration:LEVel? 

Instruction Set and read the deviation dB from the maximum Pout. This is the point 
of saturation. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Saturation level in dB.  Choose a value greater than 0.01 
dB. 

Return Float 

Default 1, unit: dB 

Menu Sweep > GC Setup... > Compression > Compression Method > Level  

Example :SENS:GCS:COMP:SAT:LEV 1 

:SENS:GCS:COMP:SAT:LEV? 
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Return: 1 

 

3.25.3.9 End of Condition 

Command Format :SENSe<cnum>:GCSetup:EOSoperation <type> 

:SENSe<cnum>:GCSetup:EOSoperation? 

Instruction Set and read the This setting is used to protect a sensitive device from 
too much power during the sweep retrace. Other instrument settings 
or channels may over-ride this setting. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<type>:={DEFault|STANdard|POFF| PSTArt |PSTOp} 

DEFault: Use the default VNA method 

STANdard: Use the default VNA method 

POFF: Always turn power OFF while waiting 

PSTArt: Sweep Start power 

PSTOp: Sweep Stop power 

Return Enumeration 

Default DEFault 

Menu Sweep > GC Setup... > Compression > End of Sweep Condition  

Example :SENS:GCS:EOS POFF 

:SENS:GCS:EOS? 

Return: POFF 

 

3.25.3.10 Safe Mode State 

Command Format :SENSe<cnum>:GCSetup:SAFE:ENABle <bool> 

:SENSe<cnum>:GCSetup:SAFE:ENABle? 

Instruction Set and read the (ON | OFF) state of Safe Sweep mode. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 



VNA Series Programming Guide 

568                                                                                                                                                                                    int.siglent.com 

Default OFF 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Safe Mode… > 
Safe Mode 

Example :SENS:GCS:SAFE:ENAB 1 

:SENS:GCS:SAFE:ENAB? 

Return: 1 

 

3.25.3.11 Coarse Increment 

Command Format :SENSe<cnum>:GCSetup:SAFE:CPADjustment <numeric> 

:SENSe<cnum>:GCSetup:SAFE:CPADjustment? 

Instruction Set and read the Safe Sweep COARSE power adjustment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Coarse power adjustment setting in dB. Choose a value 
from +20 to (-20). 

Return Float 

Default 3, unit: dB 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Safe Mode… > 
Coarse Increment 

Example :SENS:GCS:SAFE:CPAD 1 

:SENS:GCS:SAFE:CPAD? 

Return: 1 

 

3.25.3.12 Fine Increment 

Command Format :SENSe<cnum>:GCSetup:SAFE:FPADjustment <numeric> 

:SENSe<cnum>:GCSetup:SAFE:FPADjustment? 

Instruction Set and read the Safe Sweep FINE power adjustment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Fine power adjustment setting in dB. Choose a value from 
+20 to (-20). 
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Return Float 

Default 1, unit: dB 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Safe Mode… > 
Fine Increment 

Example :SENS:GCS:SAFE:FPAD 0.5 

:SENS:GCS:SAFE:FPAD? 

Return: 0.5 

 

3.25.3.13 Fine Threshold 

Command Format :SENSe<cnum>:GCSetup:SAFE:FTHReshold <numeric> 

:SENSe<cnum>:GCSetup:SAFE:FTHReshold? 

Instruction Set and read the compression level in which Safe Sweep changes from 
the COARSE power adjustment to the FINE power adjustment. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Threshold setting in dB. Choose a value from +20 to (-20). 

Return Float 

Default 0.5, unit: dB 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Safe Mode… > 
Fine Threshold 

Example :SENS:GCS:SAFE:FTHR 1 

:SENS:GCS:SAFE:FTHR? 

Return: 1 

 

3.25.3.14 Max Output Power 

Command Format :SENSe<cnum>:GCSetup:SAFE:MLimit <numeric> 

:SENSe<cnum>:GCSetup:SAFE:MLimit? 

Instruction When the VNA port that is connected to the DUT Output measures this 
value, the input power to the DUT is no longer incremented at that 
frequency. 
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Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Maximum power limit in dBm. 

Return Float 

Default 30, unit: dBm 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Safe Mode… > 
Max Output Power 

Example :SENS:GCS:SAFE:ML 20 

:SENS:GCS:SAFE:ML? 

Return: 20 

 

3.25.3.15 Maximum Iterations 

Command Format :SENSe<cnum>:GCSetup:SMARt:MITerations <numeric> 

:SENSe<cnum>:GCSetup:SMARt:MITerations? 

Instruction Set and read the maximum permitted number of iterations which 
SMART Sweep may utilize to find the desired compression level, to 
within the specified tolerance. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Maximum number of iterations. Choose a value between 1 
and 500 

Return Integer 

Default 20 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Maximum 
Iterations  

Example :SENS:GCS:SMAR:MIT 10 

:SENS:GCS:SMAR:MIT? 

Return: 10 

 

3.25.3.16 Show Iterations State 

Command Format :SENSe<cnum>:GCSetup:SMARt:SITerations <bool> 
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:SENSe<cnum>:GCSetup:SMARt:SITerations? 

Instruction Set and read enable for showing intermediate results for each iteration 
of SMART Sweep. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0 

Return Boolean 

Default OFF 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Show Iterations  

Example :SENS:GCS:SMAR:SIT 1 

:SENS:GCS:SMAR:SIT? 

Return: 1 

 

3.25.3.17 Settling Time 

Command Format :SENSe<cnum>:GCSetup:SMARt:STIMe <numeric> 

:SENSe<cnum>:GCSetup:SMARt:STIMe? 

Instruction Set and read the amount of time SMART Sweep will dwell at the first 
point where the input power changes by the Backoff or X level. Applies 
only to SMART Sweep when Backoff or XY compression methods are 
selected. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Settling time in seconds. Choose any positive value. 

Return Float 

Default 0, unit: seconds 

Menu Sweep > GC Setup... > Compression > Settling Time 

Example :SENS:GCS:SMAR:STIM 1 

:SENS:GCS:SMAR:STIM? 

Return: 1 

 

3.25.3.18 Tolerance 
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Command Format :SENSe<cnum>:GCSetup:SMARt:TOLerance <numeric> 

:SENSe<cnum>:GCSetup:SMARt:TOLerance? 

Instruction Set and read the acceptable range SMART Sweep will allow for the 
measured compression level. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. If 
not specified, <cnum> defaults to 1. 

<numeric>: Tolerance level in dBm. Choose a value between 0.01 and 
10 

Return Float 

Default 0.05, unit: dB 

Menu Sweep > GC Setup... > Compression > Smart Sweep > Tolerance 

Example :SENS:GCS:SMAR:TOL 0.1 

:SENS:GCS:SMAR:TOL? 

Return: 0.1 

 

3.26 Noise Figure Commands(Option, SHN900A series models do not support) 

3.26.1 Noise Figure 

3.26.1.1 Command List 

Noise Figure Method :SENSe<cnum>:NOISe:METhod 

Noise Average Number :SENSe<cnum>:NOISe:AVERage 

Noise Average Switch :SENSe<cnum>:NOISe:AVERage:STATe 

Noise Bandwidth :SENSe<cnum>:NOISe:BWIDth[:RESolution] 

Noise Ambient Temperature :SENSe<cnum>:SWEep:TEMPerature:AMBient 

 

3.26.1.2 Noise Figure Method 

Command Format :SENSe<cnum>:NOISe:METhod <char> 

:SENSe<cnum>:NOISe:METhod? 
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Instruction Set or obtain the noise figure measurement method. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. 

If not specified, <cnum> defaults to 1. 

<char>:={ CSCALAR|CVECTOR|YFACTOR } 

CSCALAR: Scalar Cold Source 

CVECTOR: Vector Cold Source 

YFACTOR: Y Factor 

Return Enum 

Default CSCALAR 

Menu Sweep >Noise Figure... > Noise Figure > Noise Figure Method 

Example :SENS:NOIS:MET CVECTOR 

:SENS:NOIS:MET? 

Return: CVECTOR 

 

3.26.1.3 Noise Average Number 

Command Format :SENSe<cnum>:NOISe:AVERage[:COUNt] <numeric> 

:SENSe<cnum>:NOISe:AVERage[:COUNt]? 

Instruction Set or obtain the noise figure average number. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. 

If not specified, <cnum> defaults to 1. 

<numeric> integer, Indicate the average number. 

Return Integer 

Default 20 

Menu Sweep >Noise Figure... > Noise Figure > Average 

Example :SENS:NOIS:AVER 30 

:SENS:NOIS:AVER? 
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Return: 30 

 

 

 

3.26.1.4 Noise Average Switch 

Command Format :SENSe<cnum>:NOISe:AVERage:STATe <bool> 

:SENSe<cnum>:NOISe:AVERage:STATe? 

Instruction Turn on or off noise average. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. 

If not specified, <cnum> defaults to 1. 

<bool>:= ON|OFF|1|0. 

Return Boolean (1=ON,0=OFF) 

Default ON 

Menu Sweep >Noise Figure... > Noise Figure > Average 

Example :SENS:NOIS:AVER:STAT ON 

:SENS:NOIS:AVER:STAT? 

Return: 1 

 

3.26.1.5 Noise Bandwidth 

Command Format :SENSe<cnum>:NOISe:BWIDth[:RESolution] <numeric> 

:SENSe<cnum>:NOISe:BWIDth[:RESolution]? 

Instruction Set or obtain the noise bandwidth. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. 

If not specified, <cnum> defaults to 1. 

<numeric> integer, Unit Hz, Indicate the noise bandwidth. 
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Return Integer 

Default 1MHz 

Menu Sweep >Noise Figure... > Noise Figure > Bandwidth 

Example :SENSe:NOIS:BWID 1e6 

:SENSe:NOIS:BWID? 

Return: 1000000 

 

3.26.1.6 Noise Ambient Temperature 

Command Format :SENSe<cnum>:SWEep:TEMPerature:AMBient <numeric> 

:SENSe<cnum>:SWEep:TEMPerature:AMBient? 

Instruction Set or obtain the noise measurement ambient temperature. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. 

If not specified, <cnum> defaults to 1. 

<numeric> integer, Indicate the ambient temperature. 

Return Integer, Unit K. 

Default 290 

Menu Sweep >Noise Figure... > Noise Figure > Ambient Temperature 

Example :SENS:NOIS:TEMP:AMB 300 

:SENS:NOIS:TEMP:AMB? 

Return: 300 

 

 

 

3.26.2 Power 
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3.26.2.1 Command List 

Receiver Correction Power :SENSe<cnum>:NOISe:RECeiver:CORRection:POWer:LEVel 

 

3.26.2.2 Receiver Correction Power 

Command Format :SENSe<cnum>:NOISe:RECeiver:CORRection:POWer:LEVel <numeric> 

:SENSe<cnum>:NOISe:RECeiver:CORRection:POWer:LEVel? 

Instruction Set or obtain the receiver correction power level. 

Parameter Type <cnum>:={[1] -256}, represents the measurement channel number. 

If not specified, <cnum> defaults to 1. 

<numeric> Indicate the power level, the range is -55~20. 

Return Float, Unit dBm. 

Default -40 

Menu Sweep >Noise Figure... > Power > Receiver Cali 

Example :SENS:NOIS:REC:CORR:POW:LEV -40 

:SENS:NOIS:REC:CORR:POW:LEV? 

Return: -40 
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4 SCPI Programming Examples 

This chapter gives some examples for the programmer. In these examples you can see how to use 

the VISA or sockets, in combination with the commands have been described above to control the 

SNA. By following these examples, you can develop many more applications. 

4.1 Select Measurement Mode using SCPI 
""" 

This example program shows how to use SCPI command to Switch Measurement Mode. 

The following program does the following: 

    1,Preset SNA 

    2,Switch Measurement Mode 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.13.234::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

# Preset the SNA 

SNA.write(':SYSTem:PRESet') 

# Select Measurement Mode to SMM, measurement mode include:VNA/SA/SMM 

SNA.write(':CALCulate1:INSTrument SMM') 

 

4.2 Channels Windows and Measurements using SCPI 
""" 

This example program explains how to use SCPI command to create windows, channels and 

measurements. 

 

The following program does the following: 

 

    1,Presets SNA 

    2,Create a new window and a new channel 

    3,Create Measurements for each channel 

    4,Change frequency ranges for each channel 
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    5,Select active trace 

    6,Turn marker 1 ON for each measurement 

 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.13.234::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

# Create a new window and a new channel 

SNA.write(':DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC') 

 

# Create Measurements for each channel,Parameters that can be set include:S-

Params/Balanced/Receiver/Wave/Ratio 

SNA.write(':CALCulate1:PARameter1:DEFine S12') 

SNA.write(':CALCulate2:PARameter2:DEFine S12') 

 

# Set channel 1 start frequency to 1GHz and stop frequency to 3 GHz 

SNA.write(':SENSe1:FREQuency:STARt 1e9') 

SNA.write(':SENSe1:FREQuency:STOP 3e9') 

 

# Set channel 2 start frequency to 2GHz and stop frequency to 4 GHz 

SNA.write(':SENSe2:FREQuency:STARt 2e9') 

SNA.write(':SENSe2:FREQuency:STOP 4e9') 

 

# Select active trace 

SNA.write(':CALCulate1:PARameter1:SELect') 

 

# Turn marker 1 ON for each measurement 

SNA.write(':CALCulate1:TRACe1:MARKer1:ACTivate') 

SNA.write(':CALCulate2:TRACe2:MARKer1:ACTivate') 

 

4.3 Setup Sweep Parameters using SCPI 
""" 

This Python program sets up sweep parameters on the Channel 1 measurement. 
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To run this program, you need : 

    An established USB interface or LAN connection  

""" 

 

import pyvisa 

 

#Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.13.219::INSTR' 

 

#Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

#preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

#Select the measurement 

SNA.write('CALCulate1:PARameter1:DEFine S21') 

 

#Set formate type to smith 

SNA.write(':CALCulate1:TRACe1:FORMat SMITh') 

 

#Set start frequency to 1GHz and stop frequency to 5 GHz 

SNA.write(':SENSe1:FREQuency:STARt 1e9') 

SNA.write(':SENSe1:FREQuency:STOP 5e9') 

 

#Set IF Bandwidth to 1500 

SNA.write(':SENSe1:BANDwidth 15e3') 

 

#Set number of points to 251 

SNA.write(':SENSe1:SWEep:POINts 251') 

 

#Set the channel triggers indefinitely 

SNA.write(':SENSe:SWEep:MODE CONTinuous') 

 

4.4 Waiting for Trigger(OPC?) 

""" 

The example program demonstrates how to use the :TRIG:SING command to start a sweep 

(measurement) cycle, then 

uses the *OPC command to wait until the measurement cycle is completed, then prints a message 
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The following program does the following: 

    1.Presets SNA 

    2,Turn on continuous initiation mode for the channel 

    3,Set the trigger source to Bus Trigger 

    4,Trigger the instrument to start a sweep cycle 

    5,Execute the *OPC? command 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

 

import pyvisa 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 

# Turn on continuous initiation mode for the channel 

SNA.write(':INITiate 1:CONTinuous 1') 

# Set the trigger source to Bus Trigger 

SNA.write(':TRIGger:SEQuence:SOURce BUS') 

# Trigger the instrument to start a sweep cycle 
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SNA.write(':TRIGger:SEQuence:SINGle') 

# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 

completed). 

flag = SNA.query('*OPC?') 

if flag.replace("\n", "") == '1': 

    print(f'the measurement is completed') 

 

4.5 Getting and Putting Data with Ascii Format 
""" 

This example program shows how to store data in ASCII format and put it back. 

 

The following program does the following: 

 

    1,Preset the SNA 

    2,Create a Measurements 

    3,Set the channel trigger mode to single 

    4,Execute the *OPC? command 

    5,Set data format to ASCII 

    6,Read trace data 

    7,Preset the SNA again 

    8,Set data format to ASCII 

    9,Write data in ASCII format 

 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 
import pyvisa 
 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 
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# Create a Measurements 

SNA.write(':CALCulate1:PARameter1:DEFine S21') 

 

# Set the trigger source to Bus Trigger 

SNA.write(':TRIGger:SEQuence:SOURce BUS') 

 

# Trigger the instrument to start a sweep cycle 

SNA.write(':TRIGger:SEQuence:SINGle') 

 

# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 

completed). 

while True: 

    if int(SNA.query('*OPC?'))==1: 

        break 

 

# Set data format to ASCII 

SNA.write(':FORMat:DATA ASC') 

 

# Read trace data 

fdata = SNA.query_ascii_values(':CALCulate1:DATA:FDATa?') 

 

# Preset the SNA again 

SNA.write(':SYSTem:PRESet') 

 

# Set data format to ASCII 

SNA.write(':FORMat:DATA ASC') 

 

# Write data in ASCII format 

SNA.write_ascii_values(':CALCulate1:DATA:FDATa ', fdata) 

 

4.6 Getting and Putting Data with Binary(IEE32) Format 
""" 

This example program shows how to store data in binary(IEEE 32) format and put it back. 

 

The following program does the following: 

 

    1,Preset the SNA 

    2,Create a Measurements 

    3,Set the channel trigger mode to single 

    4,Execute the *OPC? command 

    5,Set data format to IEEE 32-bit floating-point binary 

    6,Read trace data  

    7,Preset the SNA again 
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    8,Set data format to IEEE 32-bit floating-point binary 

    9,Write data in IEEE 32-bit floating-point binary format 

 

 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

# Create a Measurements 

SNA.write(':CALCulate1:PARameter1:DEFine S21') 

 

# Set the trigger source to Bus Trigger 

SNA.write(':TRIGger:SEQuence:SOURce BUS') 

 

# Trigger the instrument to start a sweep cycle 

SNA.write(':TRIGger:SEQuence:SINGle') 

 

# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 

completed). 

while True: 

    if int(SNA.query('*OPC?'))==1: 

        break 

 

# Set data format to IEEE 32-bit floating-point binary 

SNA.write(':FORMat:DATA REAL32') 

 

# Read trace data 

fdata = SNA.query_binary_values(':CALCulate1:DATA:FDATa?', datatype='f') 

 

# Preset the SNA again 

SNA.write(':SYSTem:PRESet') 

 

# Set data format to IEEE 32-bit floating-point binary 

SNA.write(':FORMat:DATA REAL32') 

 

# Write data in IEEE 32-bit floating-point binary format 

SNA.write_binary_values(':CALCulate1:DATA:FDATa ', fdata, datatype='f') 
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4.7 Getting and Putting Data with Binary(IEE64) Format 
""" 

This example program shows how to store data in binary(IEEE 64) format and put it back. 

 

The following program does the following: 

 

    1,Preset the SNA 

    2,Create a Measurements 

    3,Set the channel trigger mode to single 

    4,Execute the *OPC? command 

    5,Set data format to IEEE 64-bit floating-point binary 

    6,Read trace data  

    7,Preset the SNA again 

    8,Set data format to IEEE 64-bit floating-point binary 

    9,Write data in IEEE 64-bit floating-point binary format 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

# Create a Measurements 

SNA.write(':CALCulate1:PARameter1:DEFine S21') 

 

# Set the trigger source to Bus Trigger 

SNA.write(':TRIGger:SEQuence:SOURce BUS') 

 

# Trigger the instrument to start a sweep cycle 

SNA.write(':TRIGger:SEQuence:SINGle') 

 

# Execute the *OPC? command and wait until the command returns 1 (the measurement cycle is 

completed). 

while True: 

    if int(SNA.query('*OPC?'))==1: 
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        break 

 

# Set data format to IEEE 64-bit floating-point binary 

SNA.write(':FORMat:DATA REAL') 

 

# Read trace data 

fdata = SNA.query_binary_values(':CALCulate1:DATA:FDATa?', datatype='d') 

 

# Preset the SNA again 

SNA.write(':SYSTem:PRESet') 

 

# Set data format to IEEE 64-bit floating-point binary 

SNA.write(':FORMat:DATA REAL') 

 

# Write data in IEEE 64-bit floating-point binary format 

SNA.write_binary_values(':CALCulate1:DATA:FDATa ', fdata, datatype='d') 

 

4.8 Perform Bandwidth Search using SCPI 
""" 

This example program shows how to use SCPI command to do a bandwidth search. 

 

The following program does the following: 

 

    1,Preset SNA 

    2,Create a Measurements to S21 

    3,Change channel frequency ranges 

    4,Set number of points  

    5,Auto scales the Trace 

    6,Create a marker 

    7,Set BW Ref to Peak 

    8,Set BW Level 

    9,Enable Bandwidth Search 

    10,Read bandwidth search results and print them out 

 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 
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# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

#Create a Measurements to S21 

SNA.write(':CALCulate1:PARameter1:DEFine S21') 

 

# Set channel start frequency to 1GHz and stop frequency to 6GHz 

SNA.write(':SENSe1:FREQuency:STARt 1e9') 

SNA.write(':SENSe1:FREQuency:STOP 6e9') 

 

# Set number of points 11 

SNA.write(':SENSe1:SWEep:POINts 11') 

 

# Auto scales the Trace 

SNA.write(':DISPlay:WINDow1:TRACe1:Y:AUTO') 

 

# Create a marker 

SNA.write(':CALCulate1:TRACe1:MARKer1:ACTivate') 

 

# Set BW Ref to Peak 

SNA.write(':CALCulate1:SELected:MARKer1:BWIDth:REF MARKer') 

 

# Set BW Level -3.5 

SNA.write(':CALCulate1:TRACe1:MARKer1:BWIDth:THReshold -3.5') 

 

# Enable BandWidth Search 

SNA.write(':CALCulate1:MARKer:BWIDth ON') 

 

# Read bandwidth search results and print them out 

bandwidth = SNA.query(':CALCulate1:MARKer1:BWIDth:DATA?') 

bandwidth_value = list(map(float, bandwidth.split(','))) 

print(f'Bandwidth search results : BW:{bandwidth_value[0]},Center 

freq:{bandwidth_value[1]},Q:{bandwidth_value[2]},Loss:{bandwidth_value[3]}') 

 

4.9 Perform Maximum Peak Search using  Marker 
""" 

This example program shows how to use Marker command to perform maximum peak search. 

 

The following program does the following: 

 

    1,Preset SNA 

    2,Change channel frequency ranges 
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    3,Create a marker 

    4,Perform maximum search 

    5,Read the X-axis and Y-axis values of the maximum value cursor 

 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

# Set channel start frequency to 100MHz and stop frequency to 200MHz 

SNA.write(':SENSe1:FREQuency:STARt 1e6') 

SNA.write(':SENSe1:FREQuency:STOP 2e6') 

 

# Create a marker 

SNA.write(':CALCulate1:TRACe1:MARKer1:ACTivate') 

 

# Perform maximum search,before sending the execution command, you need to set the search mode to 

maximum search 

SNA.write(':CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE MAXimum') 

SNA.write(':CALCulate1:TRACe1:MARKer1:FUNCtion:EXECute') 

 

# Read the X-axis and Y-axis values of the maximum value cursor 

x_value = SNA.query(':CALCulate1:MARKer1:X?') 

y_value = SNA.query(':CALCulate1:TRACe1:MARKer1:Y?') 

 

4.10 Save and  Recall files 

""" 

This example program shows how to use SCPI command to save and recall files.    

 

The following program does the following: 
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    1,Preset the SNA 

    2,Create a Measurements 

    3,Change channel frequency ranges 

    4,Set number of points  

    5,Save file 

    6,Preset the SNA again 

    7,Recall the file 

 

To run this program, you need : 

    An established USB interface or LAN connection 

""" 

import pyvisa 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.64::INSTR' 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

# Create a Measurements to S21 

SNA.write(':CALCulate1:PARameter1:DEFine S21') 
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# Set channel start frequency to 1GHz and stop frequency to 6GHz 

SNA.write(':SENSe1:FREQuency:STARt 1e9') 

SNA.write(':SENSe1:FREQuency:STOP 6e9') 

 

# Set number of points 100 

SNA.write(':SENSe1:SWEep:POINts 100') 

 

# Save file,file type include:CSA files,STA files,CSV files,CAl files and SnP files,example using CSA files 

SNA.write(':MMEMory:STORE "local/test.csa"') 

 

# preset the SNA again 

SNA.write(':SYSTem:PRESet') 

 

# Recall saved CSV file 

SNA.write(':MMEMory:LOAD "local/test.csa"') 

 

4.11 Transfer File using SCPI 

""" 

The following Python examples transfer files to and from a remote PC using the MMEM:TRANsfer 

command. 

 

The following program does the following: 
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    1,Open file to be stored on local computer. Creates file if not already existing 

    2,Query SNA default saved files 

    3,Transferring SNA file data to computer files 

    4,Read PC file data 

    5,Transferring computer file data to SNA files 

 

To run this program, you need : 

    An established USB interface or LAN connection  

""" 

 

import pyvisa 

 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.53::INSTR' 

 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 

 

# ==================Transferring from the SNA to the remote PC===================== 

# Open file to be stored on local computer. Creates file if not already existing 

pc_file = open("D:\sna_to_pc.csv", 'wb') 
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# Analyzer has file 'sna.csv' in default directory. 

# The default directory is where the VNA saves files to on default 

data_binary = SNA.query_binary_values(f'MMEMory:TRANsfer? "/local/sna.csv"', datatype='B', 

container=bytearray, is_big_endian=False) 

 

# Now save the file locally to pc.csv 

pc_file.write(data_binary) 

pc_file.close() 

 

# ==================Transferring from the remote PC to the SNA ===================== 

 

# PC Local file to be transferred 

pc_file = open("D:\pc.csv", 'rb') 

 

# Store file content into variable 

# Data to be transferred to analyzer file 'pc_to_sna.csv' in default directory. 

data_binary = pc_file.read() 

SNA.write_binary_values(f':MMEMory:TRANsfer "/local/pc_to_sna.csv",', data_binary, datatype='B', 

is_big_endian=False) 

pc_file.close() 

 

4.12 Query the storage data of FIFO 

""" 
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This example program is used to query the storage data of FIFO. 

 

The following program does the following: 

    1,Preset SNA 

    2,Set Trigger Source to manual/bus/External,using Bus Trigger as an example 

    3,Enable FIFO function  

    4,Set Trigger mode to Single 

    5,Query the storage data of FIFO 

    6,Disable FIFO function 

 

To run this program, you need: 

    An established USB interface or LAN connection 

""" 

 

import pyvisa 

 

# Change this variable to the address of your instrument 

VISA_ADDRESS = 'TCPIP0::10.11.22.218::INSTR' 

 

# Create a connection (dev) to the instrument 

resourceManager = pyvisa.ResourceManager() 

SNA = resourceManager.open_resource(VISA_ADDRESS) 
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# preset the SNA 

SNA.write(':SYSTem:PRESet') 

 

# Set Trigger Source to manual/bus/External,using Bus Trigger as an example 

SNA.write('TRIGger:SEQuence:SOURce BUS') 

 

# Enable FIFO function 

# Execute the *OPC? command and wait until the command returns 1. 

SNA.write(':SYSTem:FIFO ON') 

SNA.query('*OPC?') 

 

# Trigger the instrument to start a sweep cycle 

# Execute the *OPC? command and wait until the command returns 1. 

SNA.write(':TRIGger:SEQuence:SINGle') 

SNA.query('*OPC?') 

 

# Query the storage data of FIFO. 

fifo_data = SNA.query(':SYSTem:FIFO:DATA? 201') 

print(fifo_data) 

 

# Disable FIFO function 

# Execute the *OPC? command and wait until the command returns 1. 

SNA.write(':SYSTem:FIFO OFF') 
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SNA.query('*OPC?') 
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